BMC Remedy Change Management User Guide

Supporting

BMC Remedy Change Management version 7.6.04

January 2011
Contacting BMC Software

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information about the company, its products, corporate offices, special events, and career opportunities.

**United States and Canada**

<table>
<thead>
<tr>
<th>Address</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC SOFTWARE INC</td>
<td>1 713 918 8800</td>
<td>1 713 918 8000</td>
</tr>
<tr>
<td>2101 CITYWEST BLVD</td>
<td>or</td>
<td>or</td>
</tr>
<tr>
<td>HOUSTON TX 77042-2827 USA</td>
<td>1 800 841 2031</td>
<td>1 800 841 2031</td>
</tr>
</tbody>
</table>

**Outside United States and Canada**

<table>
<thead>
<tr>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>+01 713 918 8800</td>
<td>+01 713 918 8000</td>
</tr>
</tbody>
</table>


BMC, BMC Software, and the BMC Software logo are the exclusive properties of BMC Software, Inc., are registered with the U.S. Patent and Trademark Office, and may be registered or pending registration in other countries. All other BMC trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

BladeLogic and the BladeLogic logo are the exclusive properties of BladeLogic, Inc. The BladeLogic trademark is registered with the U.S. Patent and Trademark Office, and may be registered or pending registration in other countries. All other BladeLogic trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

Current and Notes are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

IT Infrastructure Library® is a registered trademark of the Office of Government Commerce and is used here by BMC Software, Inc., under license from and with the permission of OGC.

ITIL® is a registered trademark, and a registered community trademark of the Office of Government Commerce, and is registered in the U.S. Patent and Trademark Office, and is used here by BMC Software, Inc., under license from and with the permission of OGC.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Crystal Reports is a trademark or registered trademark of SAP AG in Germany and in several other countries.

The information included in this documentation is the proprietary and confidential information of BMC Software, Inc., its affiliates, or licensors. Your use of this information is subject to the terms and conditions of the applicable End User License agreement for the product and to the proprietary and restricted rights notices included in the product documentation.

**Restricted rights legend**

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED—RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to this address.
Customer support

Support website
You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support. From this website, you can

- read overviews about support services and programs that BMC offers
- find the most current information about BMC products
- search a database for problems similar to yours and possible solutions
- order or download product documentation
- download products and maintenance
- report a problem or ask a question
- subscribe to receive proactive e-mail alerts
- find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and telephone numbers

Support by telephone or e-mail
In the United States and Canada, if you need technical support and do not have access to the web, call 800 537 1813 or send an e-mail message to customer_support@bmc.com. (In the subject line, enter SupID:yourSupportContractID, such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC
Have the following information available so that Customer Support can begin working on your issue immediately:

- product information
  - product name
  - product version (release number)
  - license number and password (trial or permanent)
- operating system and environment information
  - machine type
  - operating system type, version, and service pack or other maintenance level such as PUT or PTF
  - system hardware configuration
  - serial numbers
  - related software (database, application, and communication) including type, version, and service pack or maintenance level
- sequence of events leading to the problem
- commands and options that you used
- messages received (and the time and date that you received them)
  - product error messages
  - messages from the operating system, such as file system full
  - messages from related software
License key and password information

If you have questions about your license key or password, use one of the following methods to get assistance:

- Send an e-mail to customer_support@bmc.com.
# Contents

## About this Book
- BMC Remedy IT Service Management Suite documents ........................................... 15
- Conventions ..................................................................................................................... 19
- Syntax statements ........................................................................................................... 19

## Chapter 1  Introducing BMC Remedy Change Management
- About BMC Remedy Change Management ............................................................... 21
- BMC Remedy ITSM usability enhancements ............................................................. 22
  - What’s new in BMC Remedy Change Management .................................................. 26
  - Where to find features and fields that have moved .............................................. 26
- Process flow and the stages of a change request .......................................................... 28
- Change Request form views .......................................................................................... 32
  - Best Practice view—Change Request form ............................................................... 32
  - Classic view—Change Request form ...................................................................... 34
- Calbro Services sample data ......................................................................................... 35
- User roles in the change request lifecycle .................................................................. 36
  - Additional Change Management user roles ............................................................ 40
  - SMPM user roles ...................................................................................................... 43
- Change request lifecycle .............................................................................................. 47
- User scenarios ................................................................................................................. 50
  - Calbro Services ........................................................................................................... 50
  - BMC Remedy Change Management user scenarios .............................................. 51

## Chapter 2  Introducing Release Management
- About Release Management ......................................................................................... 59
- Milestones in the release request lifecycle ..................................................................... 60
- Release Management form views ................................................................................. 65
  - Best Practice view—Release Request form ............................................................... 66
  - Classic view—Release Request form ...................................................................... 67
- Best practices for managing release requests - Using this guide ..................................... 68
- User scenarios ............................................................................................................... 70
  - BMC Remedy Release Management use cases ...................................................... 71

## Chapter 3  Using the Change Management Console and the Change form
- About the IT Home Page ............................................................................................... 75
- Configuring the IT Home Page ..................................................................................... 78
Chapter 6  Change coordinator role 207

Implement stage - Working as a change coordinator .................................................. 207
  Implementing a change request ........................................................................... 209
Identifying change requests as rollbacks ................................................................. 210
Using the Change Management Console as a change coordinator ....................... 211
Working with change request assignments ............................................................. 211
  Automatically assigning changes ....................................................................... 212
Creating a release request at the initiate milestone—Best Practice view .......................................................... 277
Creating a release request at the initiate milestone—Classic view .......................................................... 282
Specifying the business justification .............................................................................................................. 286
Creating a manifest ........................................................................................................................................ 288
Detecting CI collisions between change requests ............................................................................................ 291
Scheduling releases ........................................................................................................................................ 294
Performing additional functions from the Process Flow Status bar ................................................................. 299
Recording release activities ........................................................................................................................... 301
Modifying release requests - Moving the release forward .................................................................................. 304
Planning milestone - Planning and scheduling the release request ................................................................. 305
Build milestone - Building a controlled environment for the release ............................................................ 308
Test milestone - Testing the release .................................................................................................................. 310
Deployment milestone - Rolling out the release to the business ........................................................................ 311
Close Down milestone - Completing release requests .................................................................................... 312
Monitoring the progress of a release request ................................................................................................... 314
Working with release request assignments .................................................................................................... 316
  Automatically assigning releases ................................................................................................................ 318
  Reassigning release requests ....................................................................................................................... 318
  Working with release reassignment requests .............................................................................................. 319
Tracking efforts for a release record ................................................................................................................ 320
Performing additional release request functions ............................................................................................. 320
Receiving notifications of release request assignments ................................................................................... 321
Assigning release requests .............................................................................................................................. 322
Working with release manifests ....................................................................................................................... 323
  Using Quick Actions on changes and activities .......................................................................................... 324
  Performing other functions with related release requests ......................................................................... 325
Managing release activities ............................................................................................................................. 325
  Creating activities - basic steps .................................................................................................................. 326
  Creating activity assignments ...................................................................................................................... 328
Working with release relationships ................................................................................................................ 330
  Defining release relationships ................................................................................................................... 330
  Searching for request types and establishing the relationship type ............................................................ 333
  Using Quick Actions on relationships ........................................................................................................ 335
Rolling up costs - Working with financial information ..................................................................................... 337
Understanding the approval process ................................................................................................................. 339
  Approving or rejecting release requests ..................................................................................................... 339
  Performing additional functions with related change requests ................................................................. 340

Chapter 8  Task implementer role 341
Working with BMC Remedy Change Management as a task implementer ...................................................... 341
Implement stage - Working on task assignments ................................................................. 343
  Receiving notification of task assignment by BMC Remedy Alert  .................. 343
  Working on assigned tasks ...................................................................................... 344
  Performing additional task functions ................................................................. 345
Using CCM tasks .............................................................................................................. 347
  Best practice CCM task templates and templates ............................................. 353

**Chapter 9**  Change Management approver role ........................................... 355
  Working with BMC Remedy Change Management as an approver .................. 355
  Approval processes provided out-of-the-box ................................................... 357
  Approving changes using Approval Central ..................................................... 362
    Multiple approvers and multiple approval levels ........................................... 364
  Approving changes using the Process Flow Status bar ..................................... 364
  Handling approvals for emergency change requests ....................................... 365
  Resubmitting a rejected change request ........................................................... 366
  Adding approvers .............................................................................................. 367
    Adding additional approvers ...................................................................... 368
    Adding alternate approvers ....................................................................... 369
    Acting as an alternate approver .................................................................. 370
  Viewing and remove non-approver notifications .......................................... 371
  Adding non-approval notifications .................................................................. 372

**Chapter 10**  Activity assignee role ................................................................. 375
  Working with activities as an activity assignee ................................................. 375
    Using the Release Management Console .................................................... 376
  Activities ............................................................................................................ 376
  Working on activities ......................................................................................... 377
  Accepting activity assignments ....................................................................... 379
    Reviewing activity assignments ................................................................ 379
    Receiving notifications of activity assignments ......................................... 380
    Reassigning activities ............................................................................... 381
  Entering work information ............................................................................ 381
    Modifying an activity .................................................................................. 382
  Creating activity task groups and tasks ........................................................... 383
  Planning financial information for activities ................................................... 385
  Planning dates ................................................................................................. 386
  Closing the activity ......................................................................................... 387

**Chapter 11**  Supplemental Change Management tasks .................................. 389
  Setting application preferences and options .................................................... 389
  Setting application preferences - Change Management .................................... 390
Setting the BMC Remedy Change Management view .............................................. 392
Viewing your profile ........................................................................................................ 393
  Updating assignment availability ..................................................................................... 394
Working with records ........................................................................................................ 394
  Searching all records ........................................................................................................ 395
  Printing records .............................................................................................................. 395
  Modifying records ............................................................................................................ 396
Working with requester records .......................................................................................... 396
  Creating a requester record .............................................................................................. 397
Using Reminders ................................................................................................................ 398
  Creating and viewing reminders ......................................................................................... 398
  Modifying and deleting reminders ...................................................................................... 400
Sending and receiving change notifications ........................................................................ 400
  Notifications by groups ........................................................................................................ 400
  Notifications by roles .......................................................................................................... 401
Broadcasting messages ......................................................................................................... 402
  Managing broadcasts ........................................................................................................... 403
  Creating broadcast messages ............................................................................................. 404
Sending pages and email messages ...................................................................................... 406
  Sending email .................................................................................................................... 406
  Paging a person or on-call group ....................................................................................... 407
Searching for records ........................................................................................................... 408
  Using custom searches ........................................................................................................ 409
  Manage My Searches - Creating a custom search with advanced qualifications .................................................................................................................. 409
Working with reports ......................................................................................................... 411
  Generating a report ............................................................................................................. 412
  BMC Remedy Change Management predefined reports .................................................. 416
Using the Change Management KPI flashboards ............................................................. 420
  Change Management KPIs ................................................................................................. 421
  Change Management KPI flashboard variables .................................................................. 422
  Opening the KPI flashboards from the BMC Remedy Change Management console .............................................................................................................. 423
  Viewing and displaying data from the KPI flashboards .................................................... 424
Using the Change Management ROI flashboard ............................................................... 425
  Opening the ROI flashboards ............................................................................................ 426
  Configured parameters ....................................................................................................... 427
  Viewing and displaying data ............................................................................................... 428
  Active variables .................................................................................................................. 428
Selecting change templates ................................................................................................. 429
Associating custom process flows to a change template ................................................... 430

Contents
<table>
<thead>
<tr>
<th>Chapter 12</th>
<th>Supplemental Release Management tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting application preferences and options</td>
<td>439</td>
</tr>
<tr>
<td>Setting application preferences - Release Management</td>
<td>440</td>
</tr>
<tr>
<td>Setting the Release Management view</td>
<td>442</td>
</tr>
<tr>
<td>Sending release or activity notifications</td>
<td>443</td>
</tr>
<tr>
<td>Release Management predefined reports</td>
<td>444</td>
</tr>
<tr>
<td>Managing SLM service targets</td>
<td>445</td>
</tr>
<tr>
<td>Working with release request approvals</td>
<td>446</td>
</tr>
<tr>
<td>Viewing release requests awaiting approval</td>
<td>446</td>
</tr>
<tr>
<td>Approving or rejecting release requests</td>
<td>447</td>
</tr>
<tr>
<td>Performing additional approval functions</td>
<td>447</td>
</tr>
<tr>
<td>Selecting release templates</td>
<td>448</td>
</tr>
<tr>
<td>Selecting activity templates</td>
<td>450</td>
</tr>
<tr>
<td>Using the Release Management KPI flashboards</td>
<td>450</td>
</tr>
<tr>
<td>Release Management KPIs</td>
<td>451</td>
</tr>
<tr>
<td>Release Management KPI dashboard variables</td>
<td>451</td>
</tr>
<tr>
<td>Viewing and displaying data</td>
<td>452</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 13</th>
<th>Managing configuration items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview - Configuration items</td>
<td>453</td>
</tr>
<tr>
<td>Creating a CI</td>
<td>454</td>
</tr>
<tr>
<td>Searching for CIs from the Change Management console</td>
<td>459</td>
</tr>
<tr>
<td>Inventory management</td>
<td>460</td>
</tr>
<tr>
<td>Placing bulk CIs in inventory</td>
<td>460</td>
</tr>
<tr>
<td>Placing non-bulk CIs in inventory</td>
<td>461</td>
</tr>
<tr>
<td>Managing inventory tasks</td>
<td>462</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 14</th>
<th>Working with the Overview console</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional areas</td>
<td>465</td>
</tr>
<tr>
<td>Console List table</td>
<td>468</td>
</tr>
<tr>
<td>Selecting status values</td>
<td>469</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 15</th>
<th>Working with the Requester console</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requester role</td>
<td>471</td>
</tr>
</tbody>
</table>
Requester console users ..........................................................................................................472
Working with service requests ..............................................................................................473
  Defining a service request ..................................................................................................474
  Performing other service request functions ..................................................................476
  Troubleshooting service requests with errors ..................................................................477
  Viewing service request details from a change request form ..............................................479

Appendix A         Change request status transitions 481
State transitions - Draft to Closed ....................................................................................481
State transitions of change requests .................................................................................487
Additional status values for change requests ....................................................................490
  Requirements for status reasons ..................................................................................491

Appendix B         Change and Configuration Management (CCM) 493
About Change and Configuration Management (CCM) ......................................................493
Processing Configuration Management tasks .....................................................................495
  Policy-based tasks .........................................................................................................495
  Deployment-based tasks ................................................................................................496
  Verification-based tasks ...............................................................................................496
CCM solution overview ........................................................................................................496
About this Book

This guide describes how to use the BMC Remedy Change and Release Management applications, which are a part of the BMC Remedy IT Service Management (BMC Remedy ITSM) Suite. The suite also includes the following applications:

- The BMC Remedy Asset Management applications.
- The BMC Remedy Service Desk solution (which includes the BMC Remedy Incident Management application and the BMC Remedy Problem Management application).

The applications run in conjunction with the BMC Remedy Action Request System platform (BMC Remedy AR System platform) and share a common database. The applications consume data from the BMC Atrium Configuration Management Database (BMC Atrium CMDB) application.

BMC Remedy IT Service Management Suite documents

The following table lists the documentation available for BMC Remedy Change Management 7.6.03. It also lists relevant documents for related solutions and products.

Unless otherwise noted, online documentation in Adobe Acrobat (PDF) format is available on product installation CDs, on the Customer Support website [http://www.bmc.com/support](http://www.bmc.com/support), or both.

<table>
<thead>
<tr>
<th>Title</th>
<th>Document provides</th>
<th>Audience</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC Remedy Change Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>BMC Remedy ITSM Configuration Quick Start</em></td>
<td>A reference card to quickly install and configure applications in the BMC Remedy ITSM suite.</td>
<td>Administrators</td>
</tr>
<tr>
<td>Title</td>
<td>Document provides</td>
<td>Audience</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td><strong>BMC Remedy Change Management User's Guide</strong></td>
<td>Procedures for using the BMC Remedy Change Management applications; includes new features and overview.</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>BMC Remedy IT Service Management Concepts Guide</strong></td>
<td>Conceptual overview of the applications that make up the BMC Remedy ITSM suite of applications</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>BMC Remedy IT Service Management Administration Guide</strong></td>
<td>Procedures for configuring the BMC Remedy ITSM applications.</td>
<td>Administrators</td>
</tr>
<tr>
<td><strong>BMC Remedy IT Service Management Data Management Administrator’s Guide</strong></td>
<td>Procedures for using the Data Management tool that is part of the BMC Remedy ITSM suite.</td>
<td>Administrators</td>
</tr>
<tr>
<td><strong>BMC Remedy IT Service Management Guide to Multi-Tenancy</strong></td>
<td>Scenarios for implementing multi-tenancy. It also describes how multi-tenancy is implemented in the BMC Atrium CMDB product and how that implementation relates to multi-tenancy as implemented in the BMC Remedy ITSM applications.</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>BMC Remedy IT Service Management Release Notes</strong></td>
<td>Information about known issues in each release of BMC Remedy ITSM. Also provides a list of new features included with the applications.</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Help for using BMC Remedy Change Management, available by clicking Help in the product interface. Available from help links after help is installed.</td>
<td>Everyone</td>
</tr>
</tbody>
</table>

**Other BMC Remedy IT Service Management products**
<table>
<thead>
<tr>
<th>Title</th>
<th>Document provides</th>
<th>Audience</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BMC Remedy Asset Management User’s Guide</strong></td>
<td>Procedures for using the BMC Remedy Asset Management application; includes new features and overview.</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>BMC Remedy ITSM Virtualization Lifecycle Management</strong></td>
<td><strong>BMC Remedy IT Service Management Virtualization Lifecycle Management Getting Started Guide</strong> Procedures to install the BMC Remedy ITSM Virtualization Lifecycle Management extension. Also includes procedures to configure and use the functionality provided by the extension.</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>BMC Remedy IT Service Management Virtualization Lifecycle Management Release Notes</strong> Information about known issues in the BMC Remedy ITSM Virtualization Lifecycle Management extension and a list of new features provided by the extension</td>
<td>Everyone</td>
<td></td>
</tr>
<tr>
<td><strong>Solutions</strong></td>
<td><strong>BMC Dashboards for Business Service Management Getting Started</strong> Information about installing, configuring, and using BMC Dashboards for BSM.</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>BMC Atrium Core</strong></td>
<td><strong>BMC Atrium CMDB Administrator’s Guide</strong> Information about configuring the BMC Atrium CMDB application to manage data about your IT environment</td>
<td>Administrators</td>
</tr>
<tr>
<td><strong>BMC Atrium CMDB Common Data Model Diagram</strong></td>
<td>Hierarchical diagram of all classes in the CDM, including unique attributes and applicable relationships.</td>
<td>Administrators</td>
</tr>
<tr>
<td><strong>BMC Atrium CMDB Normalization and Reconciliation Guide</strong></td>
<td>Information about configuring and managing jobs that normalize and reconcile product information from data providers that is used to update the BMC Atrium CMDB.</td>
<td>Administrators</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Document provides</strong></td>
<td><strong>Audience</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>BMC Atrium Core Concepts and Planning Guide</strong></td>
<td>Information about BMC Atrium CMDB concepts and best practices for planning your BMC Atrium CMDB implementation.</td>
<td>Executives and administrators</td>
</tr>
<tr>
<td><strong>BMC Atrium CMDB User’s Guide</strong></td>
<td>Information about using BMC Atrium CMDB, including how to search for CIs and relationships, launch federated data, generate reports, and run reconciliation jobs.</td>
<td>Users</td>
</tr>
<tr>
<td><strong>BMC Atrium Discovery and Dependency Mapping</strong></td>
<td>Information about configuring a connection to BMC Atrium CMDB, synchronizing discovery data, and reconciling and maintaining the data.</td>
<td>Administrator</td>
</tr>
<tr>
<td><strong>BMC BladeLogic Client Automation</strong></td>
<td>Instructions about planning, installing, and configuring the Configuration Discovery integration. This guide also includes information about relationship classes and mapping, data exchanges, and reconciliation definitions.</td>
<td>Administrator</td>
</tr>
<tr>
<td><strong>BMC Remedy Action Request System</strong></td>
<td>Concepts for using the BMC Remedy Action Request System.</td>
<td>Administrators</td>
</tr>
<tr>
<td><strong>BMC Remedy Action Request System: BMC Remedy Approval Server Guide</strong></td>
<td>Topics on installation and configuration of the Approval Server, how to use the Approval Server, and understanding the approval workflow.</td>
<td>Users and administrators</td>
</tr>
<tr>
<td><strong>BMC Service Level Management</strong></td>
<td>Procedures for configuring the BMC Service Level Management application.</td>
<td>Administrators</td>
</tr>
<tr>
<td><strong>BMC Service Level Management User’s Guide</strong></td>
<td>Procedures for using the BMC Service Level Management application.</td>
<td>Everyone</td>
</tr>
<tr>
<td><strong>BMC Remedy ITSM 7.6.00 Patch 001(document used by multiple applications)</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Conventions

This document uses the following special conventions:

- All syntax, operating system terms, and literal examples are presented in this typeface.

- Variable text in path names, system messages, or syntax is displayed in italic text: `testsys/instance/fileName`

- This document uses a symbol to show menu sequences. For example, `Actions => Create Test` instructs you to choose the `Create Test` command from the `Actions` menu.

Syntax statements

This topic explains conventions for showing syntax statements.

A sample statement follows:

```
COMMAND KEYWORD1 [KEYWORD2 | KEYWORD3] KEYWORD4={YES | NO} fileName...
```

<table>
<thead>
<tr>
<th>Convention</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items in italic type represent variables that you must replace with a name or value. If a variable is represented by two or more words, initial capitals distinguish the second and subsequent words.</td>
<td><code>alias</code> <code>databaseDirectory</code> <code>serverHostName</code></td>
</tr>
<tr>
<td>Brackets indicate a group of optional items. Do not type the brackets when you enter the option. A comma means that you can choose one or more of the listed options. You must use a comma to separate the options if you choose more than one option.</td>
<td><code>[tableName, columnName, field] [-full, -incremental, -level] (UNIX)</code></td>
</tr>
<tr>
<td>Convention</td>
<td>Example</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Braces indicate that at least one of the enclosed items is required. Do not type the braces when you enter the item. | \{DBDName | tableName\}  
UNLOAD device={disk | tape, fileName | deviceName}  
{-a | -c} (UNIX) |
| A vertical bar means that you can choose only one of the listed items. In the example, you would choose either `commit` or `cancel`. | \{commit | cancel\}  
{-commit | -cancel} (UNIX) |
| An ellipsis indicates that you can repeat the previous item or items as many times as necessary. | `columnName...` |
Introducing BMC Remedy Change Management

This section helps you get started using the BMC Remedy Change Management application.

About BMC Remedy Change Management

The IT Infrastructure Library (ITIL) specifies that the primary objective of Change Management is to enable beneficial changes to be made, with minimum disruption to IT services.” As part of the BMC Business Service Management strategy, BMC Remedy Change Management applies a repeatable process for production changes to improve the stability of business service and required changes.

BMC Remedy Change Management includes change requests and approval, risk analysis, planning, orchestration of tasks, verification, and recording changes to the production environment in the BMC Atrium Configuration Management Database (BMC Atrium CMDB). The BMC Remedy Change Management part of the BSM strategy enables you to gain control of the IT environment and automate the entire change lifecycle, thus reducing the business impact of changes.

Using ITIL V3 best practices, BMC Remedy Change Management provides scheduling and task assignment functionality, and reporting capabilities for reviewing performance and improving processes. Because BMC Remedy Change Management is integrated with the BMC Atrium CMDB, it enables you to relate changes to other records, such as configuration items (including services) and incidents.

BMC Remedy Change Management provides a system of planning, scheduling, implementing, and tracking changes that need to be completed within your organization. BMC Remedy Change Management is closely aligned with standard ITIL service management processes. It works in conjunction with the BMC Remedy Approval Server and the other BMC Remedy IT Service Management (BMC Remedy ITSM) applications. Using BMC Remedy Change Management in combination with these applications enables you to assess the scope of the change, analyze the costs associated with the change (in terms of time and expense), perform impact and risk
analysis, and schedule the resources needed to complete the change. Using the BMC Service Level Management (BMC SLM) application enables you to define service targets and measure the efforts of your support staff as they implement the changes.

BMC Remedy ITSM usability enhancements

The BMC Remedy ITSM 7.6.04 release contains the following usability enhancements. These enhancements are available only when the applications are accessed through a web browser.

Table 1: BMC Remedy ITSM usability enhancements

<table>
<thead>
<tr>
<th>Description</th>
<th>Affected applications and modules</th>
</tr>
</thead>
</table>
| To help you retrieve information faster, the type-ahead search functionality is available on more fields. When you start to type a query into a field that has the type-ahead search functionality, one or more possible matches are immediately presented for selection in a drop-down list. As you type more characters, the list changes to match what you type. | ■ BMC Remedy Change Management  
■ Release Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management  
■ BMC Remedy Knowledge Management  
■ BMC Service Request Management |
| To improve application usability when using the Best Practice and Classic view, a system-generated record ID is assigned to all new record types immediately when the application displays the form in New mode. | ■ BMC Remedy Change Management  
■ Release Management  
■ BMC Remedy Incident Management  
■ BMC Problem Management  
■ BMC Service Request Management (work order) |
### Description

To improve application performance, system administrators can configure system messages from filters and servers to appear in a message bar instead of in pop-up windows. For information about this configuration, see the *BMC Remedy Action Request System 7.6.04 Configuration Guide*.

Using the Application Preferences settings, you can configure the system to display a confirmation message when you submit a new record. For information about these settings, see your application's user guide.

To provide easier access to the BMC Service Management Process Model (SMPM) from the applications, the Process Overview link is available from the Quick Actions navigation area of the main forms. The Process Overview link is also available above the main tables on the consoles.

<table>
<thead>
<tr>
<th>Description</th>
<th>Affected applications and modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>To improve application performance, system administrators can configure</td>
<td>■ BMC Remedy Asset Management</td>
</tr>
<tr>
<td>system messages from filters and servers to appear in a message bar instead</td>
<td>■ BMC Remedy Change Management</td>
</tr>
<tr>
<td>of in pop-up windows. For information about this configuration, see the</td>
<td>■ Release Management</td>
</tr>
<tr>
<td></td>
<td>■ BMC Remedy Problem Management</td>
</tr>
<tr>
<td></td>
<td>■ BMC Remedy Knowledge Management</td>
</tr>
<tr>
<td></td>
<td>■ BMC Service Request Management</td>
</tr>
<tr>
<td></td>
<td>■ BMC Service Level Management</td>
</tr>
</tbody>
</table>

| Using the Application Preferences settings, you can configure the system    | ■ BMC Remedy Change Management                                         |
| to display a confirmation message when you submit a new record. For        | ■ Release Management                                                    |
| information about these settings, see your application's user guide.       | ■ BMC Remedy Incident Management                                       |
|                                                                             | ■ BMC Remedy Problem Management                                        |
|                                                                             | ■ BMC Service Request Management (work order)                           |

| To provide easier access to the BMC Service Management Process Model (SMPM) | ■ BMC Remedy Asset Management                                          |
| from the applications, the Process Overview link is available from the     | ■ BMC Remedy Change Management                                         |
| Quick Actions navigation area of the main forms. The Process Overview link | ■ BMC Remedy Incident Management                                       |
| is also available above the main tables on the consoles.                    | ■ BMC Remedy Problem Management.                                        |
### BMC Remedy ITSM usability enhancements

<table>
<thead>
<tr>
<th>Description</th>
<th>Affected applications and modules</th>
</tr>
</thead>
</table>
| To improve overall system performance, most consoles and forms now open inside a single view area, instead of in individual windows. | ■ BMC Remedy Asset Management  
■ BMC Remedy Change Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management  
■ BMC Service Request Management (work order)  
■ BMC Remedy Knowledge Management |
| To make navigation through the BMC Remedy ITSM suite of applications easier, a more consistent navigation model is used on the IT Home Page, consoles, and forms. For example, the application menu that appeared on the IT Home page in earlier releases of the BMC Remedy ITSM suite of applications is now used on all of the application consoles and main forms. | ■ BMC Remedy Asset Management  
■ BMC Remedy Change Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management  
■ BMC Service Request Management (work order)  
■ BMC Remedy Knowledge Management |
| To make required fields more obvious, when you save a record, a red box outlines required fields that do not contain valid information. | ■ BMC Remedy Asset Management  
■ BMC Remedy Change Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management  
■ BMC Service Request Management |
| To improve usability, the number of steps needed to create a work info entry has been reduced. See the applicable application user guide for information about how to create work info entries. | ■ BMC Remedy Change Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management  
■ BMC Service Request Management |
<table>
<thead>
<tr>
<th>Description</th>
<th>Affected applications and modules</th>
</tr>
</thead>
</table>
| To make searching for information across applications easier and more intuitive, a global search option is available. The search scans and retrieves information from the installed BMC Remedy ITSM applications and presents it in a readable, consumable format. See the applicable application user guide for information about how the global search function works. | ■ BMC Remedy Asset Management  
■ BMC Remedy Change Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management  
■ BMC Service Request Management (work order) |
| To make creating Relationships easier, a new link called Create Relationship to is available. See the applicable application user guide for information about how the link works. | ■ BMC Remedy Change Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management |
| To help you find field-level details more easily, you can use the new Detail icon to display detailed information about the field’s content. For example, if you click the Detail icon associated with the Customer field, the People form appears with information about the customer whose name appears in the field. This new feature replaces the hyperlinked field labels in earlier versions of the applications. | ■ BMC Remedy Change Management  
■ Release Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management  
■ BMC Service Request Management (work order) |
| To quickly access BMC Atrium Explorer from the Service and CI fields, you can click the new Explore CI icon. | ■ BMC Remedy Asset Management  
■ BMC Remedy Change Management  
■ BMC Remedy Incident Management  
■ BMC Remedy Problem Management |
To improve search capabilities, a new search icon is added to the fields that open a search dialog box or form.

- BMC Remedy Change Management
- Release Management
- BMC Remedy Incident Management
- BMC Remedy Problem Management
- Task Management
- BMC Service Request Management (work order)

## What's new in BMC Remedy Change Management

The following topics are new features in this release:

- The Vendor Management feature has been included in this release of BMC Remedy Change Management. For more information, see the *BMC Remedy IT Service Management Release Notes*.

- The Assignment fields in the Change Template have been updated to include all assignment fields including Change Manager fields. For more information, see the *BMC Remedy IT Service Management Configuration Guide*.

For information on additional enhancements to BMC Remedy Change Management, see “BMC Remedy ITSM usability enhancements” on page 22.

## Where to find features and fields that have moved

This section lists features and fields that have moved from their previous locations on the user interface and provides you with their new location.

### On the console

The following console features and links have moved.

- **Defined Searches** — You now access Defined Searches from the *Filter By* drop down menu at the top of the console.
- **Manage My Searches**— You now access Manage My Searches by clicking the magnifying glass icon beside the Filter By field.

- **Process Overview**— You now access Process Overview from a link above the console table.

- **KPIs**— You now access the KPIs by clicking the KPIs link in the Functions menu on the navigation pane.

- **Consoles**— You now access other consoles from the Applications menu.

### On the form

The following application form features, fields, and links have been added or moved.

- You now access these fields from the main body of the form:
  - Assigned Group
  - Assignee
  - Vendor Group
  - Vendor Ticket Number
  - Status
  - Status Reason

- The following links are available on the top of the Relationships tab:
  - Impact Analysis
  - Quick Actions menu

- The Console link is no longer available in the left Navigation pane.

- You now access the following links from the Quick Action section of the Navigation pane.
  - **Create Relationship to**— for creating relationships between the current record and other record types.
  - **Create Related Request**— for creating other record types.
  - **Process Overview**— for opening a process flow diagram.
  - **Work Info**— Changes have been made to the way that you create work information entries in Best Practice view. For information about creating work
information entries in this view, see “Recording activities for a change request” on page 130.

— Relationships — Changes have been made to the way you create relationships in the Best Practice view. For information about how to create relationships in this view, see “Defining relationships” on page 231.

- Tool bar — The Change form tool bar is removed. The following tool bar functions have been retained and are available from other locations on the interface:

  — Return to Home Page — To close the application and return to the Home page, click the Home icon on the breadcrumb bar. This function replaces the Close button, which has been removed from the interface.

  — New mode — To invoke new mode, open the Applications menu, select Change Management, and click New Change.

  — Modify mode — If your installation is configured to open a new change request form after you click save when creating a new change request record, then to invoke Modify mode you must open the change request record that you want to modify from the console.

  — Search mode — From the breadcrumb bar, return to the Change console and use Search Change in the Navigation pane.

### Process flow and the stages of a change request

The user interface in BMC Remedy Change Management enables managers, administrators, users, and approvers to perform regular tasks simply and efficiently. The Process Flow Status bar on the Change form steps you through the change process from the Initiate stage to the Closed stage. It provides a visual mechanism to track the five stages of a change request, as indicated by best practices that are rooted in ITIL processes.

(For more information, see User roles in the change request lifecycle on page 36.)

The current stage of the change is highlighted on the Change form by color and by text.
**Note**  
The Process Flow Status bar and the status of a change request may not be in sync if in a single session the status is updated by the same user. To synchronize the status bar and the status of the change request, close the change request and reopen it.

**Figure 1: Process Flow Status bar on the Change form**

The Process Flow Status bar functions similarly to a wizard, guiding you through the stages of the change life cycle from stage to stage. To advance through the change request, click the process flow accelerators (as shown in Figure 2 on page 29) to move to the next stage. At each stage, the status bar provides accelerators applicable to the current stage. For example, you can use accelerators to move the request to a Pending status, cancel it, or forward it to the next stage. By using the process flow accelerators, you are following ITIL best practices.

If a custom process flow is associated with a change template, when you select the change template, the next stages indicated in the Process Flow Status bar change to reflect the process for the type of change. For example, the process for provisioning a new virtual machine might skip the Plan & Schedule stage. If you do not select a change template, or if the change template is not associated with a custom process flow, the standard change process is followed.

**Note**  
If you use the Back option to move the change to a previous stage, all required approvals must be performed again as defined for any stage that is repeated.

**Best practice**  
Do not manually set the **Status** and **Status Reason** fields in the Change Request form. Using the Process Flow Status bar automatically changes the value in the **Status** field based on what you select from the status bar menus.

The **Status** field selections are limited to valid status values for the transition.

**Figure 2: Selecting an accelerator from the Process Flow Status bar**
When you select an accelerator, you might be prompted to enter the data required to complete the stage. For example, when you are in the Plan & Schedule stage you are prompted to enter the required start and end date of the change request and its tasks.

**Figure 3: Example of a process flow dialog box**

You use the Process Flow Status bar to control the progression of the request and perform approvals at different stages in the lifecycle. If approval is required within any of the stages, the Process Flow Status area highlights the stage in green (as shown in Figure 5 on page 31). The request will not move to the next stage until all required approvals for that stage have been granted. For example, if an approval is required in the Initiate stage, the required users are prompted to approve, cancel, or
reject the change request before the change request can move to the Review & Authorize stage.

Figure 4: Approval status of a change request (Best Practice view)

Figure 5: Approval status of a change request (Classic view)

The current and overall approval status of the change is highlighted by the following colors:

- **Yellow** – Pending
- **Green** – Approved
- **Red** – Rejected
Change Request form views

BMC Remedy Change Management release 7.6.00 provides you with different ways to view the Change Request form:

- Best Practice view
- Classic view

The view that you see is configured for you by your system administrator. The Best Practice view is the default view. For a description of the Best Practice view, see Best Practice view—Change Request form on page 32. For a description of the Classic view, see Classic view—Change Request form on page 34.

Note
When documenting procedures in this guide, if there is a difference between how to do something in the Best Practice view and in the Classic view, both methods are described. Instructions for the Best Practice view are provided first.

Some of the fields from the Classic view are not displayed in the Best Practice View. To access fields that were removed use the Classic view.

Best Practice view—Change Request form

The Best Practice view is an improved version of the Change Request form. In this view, the fields most commonly used for creating change requests are immediately visible. You can access additional, less frequently used functionality from the tabbed sections of the form or from the links in the Navigation pane.

The following list outlines Best Practice view features:

- Coordinator Group field—The Coordinator Group and the Change Coordinator field replace the Change Assignee fields. Use the Coordinator Group field to select a support group. The support groups that appear in the menu each have at least one member with a Change Coordinator functional role. From the Coordinator Group menu, you select the company, the organization, and then the support group. Only the selected support group name appears in the Coordinator Group field. You can type only a few characters and press Enter. If a unique match is
found, the field is populated with the value or a list of coordinator groups is displayed from which you can select a value, if multiple matches are found.

- **Change Coordinator field** — Use the Change Coordinator field to select a Change Coordinator for the change request. The people whose names appear on this menu belong to the support group selected in the Coordinator Group field and have a Change Coordinator functional role. You can type only a few characters and press Enter. If a unique match is found, the field is populated or a list of change coordinator belonging to the selected coordinator group is displayed from which you can select a value, if multiple matches are found.

- **Service field** — The Service field relates business service configuration items (CIs) to the change request at the time it is created.

- **Template field** — The Template field encourages the use of templates. For information about the benefits of using templates and how to select a template for a change request, see Selecting change templates on page 429.

- **Class field** — The Class field now behaves as the Change Timing field. It specifies the relative urgency of the change, so that the approvers can assess its magnitude.
**Best practice**

The Best Practice view is recommended for all BMC Remedy Change Management users, regardless of their role. For information about BMC Remedy Change Management roles, see User roles in the change request lifecycle on page 36. Figure 6 on page 34 illustrates the Best Practice view.

**Figure 6: Change Request form—Best Practice view**

---

**Classic view—Change Request form**

The Classic view is the Change Management Console as it appeared in previous releases of BMC Remedy Change Management. This view is provided for customers who are upgrading from earlier versions of BMC Remedy Change Management and who are not yet ready to adopt the Best Practice view.

The following changes have been made to the classic view:

- The Change Assignee field has been replaced with Coordinator Group and Change Coordinator fields.
- The Change Manager fields have been changed to Manager Group and Change Manager fields.
The Change Timing field has been renamed to Class field. It specifies the relative urgency of the change, so that the approvers can assess its magnitude. This field can be found on the Classification tab of the change request.

The following figure illustrates the Classic view.

**Figure 7: Change Request form—Classic view**

---

**Calbro Services sample data**

In the BMC Remedy ITSM 7.5.00 documentation set, a fictional company named Calbro Services helps explain how ITSM principles and procedures are used in practice. Although Calbro Services is a fictional company, it is based on research of actual BMC Software customers. Learning how Calbro Services manages the change request lifecycle should prove useful as you use BMC Remedy Change Management in your own environment.

Calbro Services, a large, global company, is headquartered in New York City and publicly traded on the New York Stock Exchange. The company has 27,000 employees in 240 offices located in 20 countries. The following table describes key business services in Calbro Services.
Table 2: Key business services

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online banking</td>
<td>500 ATMs in major cities</td>
</tr>
<tr>
<td>WWW presence</td>
<td>Corporate site and online brokerage services</td>
</tr>
<tr>
<td>Discount equity brokerage</td>
<td>Online and storefront services</td>
</tr>
<tr>
<td>Sales force automation</td>
<td>Automated sales activities such as leads, orders, reports, and so on</td>
</tr>
<tr>
<td>Customer support</td>
<td>Support centers in the United States, Europe, and Asia</td>
</tr>
<tr>
<td>Mass marketing</td>
<td>World-wide marketing campaigns aimed at making Calbro Services a household name</td>
</tr>
</tbody>
</table>

Tip

If the Calbro Services sample data is installed on your server, you can log in to BMC Remedy Change Management and follow the use cases described in this guide.

User roles in the change request lifecycle

BMC Remedy Change Management is a role-based application. What applications you can access, and how much information you can view or modify depends upon your role. As the Process Flow Status bar steps you through the stages of a change request, different roles perform different tasks. The change manager creates the change request at the Initiate stage, the task implementer works on the tasks that are assigned to the change at the Implement stage, and so on.

Figure 8: Using the Process Flow Status bar in the stages of a change request

A user with the Change Manager functional role can view functionality in the application that other users cannot. For example, the change manager can access the KPI flashboards, while the change coordinator does not have access to them.

Change requests track the progress of a change through its entire lifecycle, from the Initiation stage to the Closed stage. To manage a change request from start to finish, the main user roles listed in Table 3 on page 37 are required. Although the responsibilities of these users can vary from organization to organization (and in some organizations, one person can fulfill several roles), they generally include the following roles and functions. In a small company, the same person can function as change manager, approver, and task implementer.
Table 3: IT Support user roles

<table>
<thead>
<tr>
<th>Change management role</th>
<th>Calbro user</th>
<th>Function</th>
<th>More information</th>
</tr>
</thead>
</table>
| Change Coordinator     | Allen Allbrook    | Member of a support group responsible to provide one or more services. The change coordinator is responsible to create, plan, implement, track, and close changes related to services that the support group is responsible for.  
- Assesses requests for change that originated from Incident Management, Problem Management, Release Management or Continuity Management.  
- Registers changes as needed to handle requests for change.  
- Determines the risk & impact for requested changes.  
- Prepares implementation plans by creating tasks.  
- Monitors the progress of changes.  
For more information, see:  
- Requester role on page 471  
- Implement stage - Working as a change coordinator on page 207 |
| Change Manager         | Mary Mann         | Operations manager who has a complete overview of the infrastructure and must know details of what is to be changed.  
- Reviews the risk & impact analysis to ensure that this has been performed thoroughly.  
- Ensures that appropriate actions have been planned to minimize both the risk of failure and the impact on users during change implementations.  
- Ensures that the timing of planned implementations does not conflict with other planned changes or events.  
- Obtains approval for changes.  
Working as a change manager on page 111 |
### Change management roles

<table>
<thead>
<tr>
<th>Change management role</th>
<th>Calbro user</th>
<th>Function</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task implementer</td>
<td>Ian Plyment</td>
<td>Support staff member or group who performs the tasks associated with a change request. For example, a change request for upgrading a mission-critical server might include backing up data in the server, uninstalling the old hard drive, and installing the new hard drive.</td>
<td>Working with BMC Remedy Change Management as a task implementer on page 341</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Member of Front Office Support or Back Office Support</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Uses the Change Management Console to perform the tasks associated with a change request</td>
<td></td>
</tr>
</tbody>
</table>

For more information about permissions and roles, see the BMC Remedy IT Service Management Configuration Guide. For information about other roles important in Change Management, see Additional Change Management user roles on page 40.

Figure 9 on page 38 illustrates the different Change Management support staff roles. It also shows where each role fits into the stages of the change request lifecycle.

**Figure 9: BMC Remedy Change Management support and management roles**

Table 4 on page 39 summarizes the best practices required for managing change requests at each stage of the lifecycle. It provides a map of best practices which BMC recommends that you should follow, when you use the BMC Remedy Change Management application.
The following stages might not apply to all change requests. For example, you see the Review & Authorize stage only if the application administrator mapped an approver to the Business Approval phase.

### Table 4: Best practices for managing change requests

<table>
<thead>
<tr>
<th>Request stage</th>
<th>Request status</th>
<th>Role and task</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1a Initiate</td>
<td>Draft</td>
<td>Change manager creates the change request.</td>
<td>Initiate stage - Creating change requests on page 113</td>
</tr>
<tr>
<td>1b Initiate</td>
<td>Request For Authorization</td>
<td>Change approver approves the change request.</td>
<td>Approval processes provided out-of-the-box on page 357</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Handling approvals for emergency change requests on page 366</td>
</tr>
<tr>
<td>2a Review &amp; Authorize</td>
<td>Not applicable</td>
<td>Change coordinator performs risk assessment and impact analysis of the change request.</td>
<td>Review and Authorize stage - Risk and impact analysis on page 139</td>
</tr>
<tr>
<td>2b Review &amp; Authorize</td>
<td>Request For Change</td>
<td>Change approver approves the business case for the change.</td>
<td>Approval processes provided out-of-the-box on page 357</td>
</tr>
<tr>
<td>3a Plan &amp; Schedule</td>
<td>Planning In Progress</td>
<td>Change coordinator plans and schedules the details associated with the change.</td>
<td>Plan and Schedule stage - Planning the change request on page 149</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 Reviews change calendar.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Relates CIs to the change request.</td>
<td></td>
</tr>
<tr>
<td>3b Plan &amp; Schedule</td>
<td>Not applicable</td>
<td>Change manager reviews the change plan and sends it for approval.</td>
<td>Approval processes provided out-of-the-box on page 357</td>
</tr>
<tr>
<td>3c Plan &amp; Schedule</td>
<td>Scheduled For Approval</td>
<td>Change approver approves the execution of the change before it can be scheduled.</td>
<td>Approval processes provided out-of-the-box on page 357</td>
</tr>
<tr>
<td>4a Implement</td>
<td>Implementation in Progress</td>
<td>Change coordinator starts work on the change request.</td>
<td>Implement stage - Working as a change coordinator on page 207</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 Relates CIs, incidents, and services to the change request.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Creates tasks.</td>
<td></td>
</tr>
</tbody>
</table>
Additional Change Management user roles

The following user roles also have important responsibilities in typical companies.

*Note*
For more information about permissions and roles, see the *BMC Remedy IT Service Management Configuration Guide*.

Change implementer

Change implementers are support people or groups responsible for change requests that do not require tasks. You can designate a member of your support staff as a change implementer in the Change form.

*Note*
As a best practice one or more tasks must be associated to a change request for actual activities that need to be completed. The Change Implementer field is not present when using the Best Practice view in Change Management.

Change implementers have their own assignment fields in the Change form when using the Classic view. The changes assigned to the change implementer can be any type of routine activity that must be accomplished, for example:

- Reviewing the weekly error log report
- Rotating a backup tape
- Turning off the server room lights
Replacing an office chair

**Figure 10: Change implementer**

- **Note**
  - If a change request includes one or more related tasks, the Change Implementer fields do not appear on the Assignment tab.

For more information, see Assigning changes to change implementers on page 216.

**Change approvers and the CAB**

According to ITIL recommendations, the Change Advisory Board (CAB) should approve all changes to the IT infrastructure. The CAB is a cross-functional group that is set up to evaluate change requests for their business need, priority, cost benefit, and other potential impacts to systems or processes. In BMC Remedy Change Management, approvers are notified of change requests that require their review.

- **Note**
  - No change approvers are mapped out-of-the-box for Calbro Services. Your application administrator must configure them. As a result, if you move a change request through its lifecycle and you arrive at an approval phase, you simply need to refresh the change request to move it forward. If an approver has been mapped for an approval phase (for example, Review), click the Approver tab to review who must approve the change request to move it forward. For more information, see the *BMC Remedy IT Service Management Configuration Guide*.

The change approver requires the following permissions and functional roles:

- **Explicit change permission is not needed for access to change approval records. But only people defined within the People form can be chosen as approvers.**
**Note**

The minimum permissions in Change Management to approve change requests is Infrastructure Change Viewer. Users with this permission can view change requests in the Change form, but they must use Approval Central to approve them.

- The Change Approver functional role is required to create an Approval mapping record for the users. The Change Approver functional role is also required to approve or reject changes on behalf of the approver support group.

- Users with the Change Manager or Change Coordinator functional role can approve changes on behalf of their support group if they are defined as alternate approvers or as a global approver.

For information about the approver role and step-by-step procedures associated with approvers, see [Change Management approver role on page 355](#).

**Company executives**

Company executives such as CIOs can use BMC Remedy Change Management consoles to understand trends relating to change configuration management, and take appropriate action to balance the flow.

For example, CIOs can use the BMC Remedy Change Management Dashboard to view important data points in an easy-to-read graphical display. They can select appropriate flashboards to appear on the Dashboard, with a time period that applies to all flashboards. CIOs can also use the Change Calendar to manage change and release activities. Executives can see a holistic picture of changes occurring in the enterprise, and associated business activities or events. Some of this information comes from the BMC Remedy Change Management application and some through referencing objects in the BMC Atrium CMDB.

For more information, see [Using the Change Management Dashboard on page 203](#) and [Using the Change Calendar on page 194](#).

**Application administrator**

The responsibilities of the application administrator, also known as the change administrator, might include installing and licensing the application, and configuring it to meet the organization’s business needs. Some of the configuration tasks include:

- Creating and maintaining change request and task categorization.

- Defining and adding members to support and general staff notification groups in the People form.
Assigning licenses.

Configuring approvals, risk, cost, templates, assignments, and change settings.

For more information about configuring the BMC Remedy Change Management application, see the *BMC Remedy IT Service Management Configuration Guide*.

**SMPM user roles**

The following roles are developed from the BMC Remedy Service Management Process Model (SMPM), which is a companion product to BMC Remedy Change Management. The SMPM describes a set of predefined processes for the delivery and support of information technology (IT) services. The processes described by the SMPM are aligned with ITIL good practices. BMC Remedy Change Management provides functionality for these additional SMPM defined change management roles.

Table 5 on page 44 maps the SMPM defined change management roles to the equivalent permissions that each role needs in BMC Remedy Change Management.

*Note*

This section does not list all permission groups and functional roles defined in BMC Remedy Change Management, only those that are mapped to SMPM roles.
### Table 5: SMPM roles for Change Management

<table>
<thead>
<tr>
<th>SMPM Role name</th>
<th>Responsibility</th>
<th>BMC Remedy Problem Management permission groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Coordinator</td>
<td>Change coordinators are a management role. They perform the following tasks:</td>
<td>▪ Infrastructure Change User&lt;br&gt;▪ Functional role: Infrastructure Change Coordinator&lt;br&gt;▪ Incident User&lt;br&gt;▪ Problem User&lt;br&gt;▪ Asset Viewer</td>
</tr>
<tr>
<td></td>
<td>▪ Assess requests for change that originated from Incident Management, Problem Management, Release Management, or Continuity Management.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Register changes as needed to handle requests for change.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Determine the risk &amp; impact for requested changes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Prepare implementation plans by creating tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Monitor the progress of changes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Review the return-to-production tasks after the service owner has requested the return to production for a service infrastructure that is providing a service in continuity mode.</td>
<td></td>
</tr>
<tr>
<td>Change Manager</td>
<td>Change managers are a management role. They can perform the following tasks:</td>
<td></td>
</tr>
<tr>
<td>Note: The SMPM</td>
<td>▪ Review the risk and impact analysis to make sure that this has been performed thoroughly.</td>
<td></td>
</tr>
<tr>
<td>change manager role</td>
<td>▪ Make sure that appropriate actions have been planned to minimize both the risk of failure and the impact on users during change implementations.</td>
<td></td>
</tr>
<tr>
<td>role includes a few</td>
<td>▪ Make sure that the timing of planned implementations does not conflict with other planned changes or events.</td>
<td></td>
</tr>
<tr>
<td>more permissions</td>
<td>▪ Obtain approval for changes.</td>
<td></td>
</tr>
<tr>
<td>than the ITSM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>change manager role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMPM Role name</td>
<td>Responsibility</td>
<td>BMC Remedy Problem Management permission groups</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Representative</td>
<td>Customer representatives are a support staff role. They make sure that planned application changes are tested before they are transferred to production.</td>
<td>■ Task User</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Infrastructure Change Viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Incident Viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Problem Viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Asset Viewer</td>
</tr>
<tr>
<td>Specialist</td>
<td>Specialists are a support staff role. They perform the following tasks:</td>
<td>■ Incident User</td>
</tr>
<tr>
<td></td>
<td>■ Resolve incident requests.</td>
<td>■ Problem User</td>
</tr>
<tr>
<td></td>
<td>■ Update incident requests with relevant information and status changes.</td>
<td>■ Task User</td>
</tr>
<tr>
<td></td>
<td>■ Escalate incidents, which resolution may only be implemented through the Change Management process, to the service owner of the affected service.</td>
<td>■ Infrastructure Change Viewer</td>
</tr>
<tr>
<td></td>
<td>■ Suggest workarounds for problems.</td>
<td>■ Asset Viewer</td>
</tr>
<tr>
<td></td>
<td>■ Establish the root causes of identified problems.ian.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Propose structural solutions for problems.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Implement structural solutions for problems if Change Management is not required.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Update the problem investigations with relevant information and status changes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Complete tasks and updates them with relevant information and status changes.</td>
<td></td>
</tr>
<tr>
<td>SMPM Role name</td>
<td>Responsibility</td>
<td>BMC Remedy Problem Management permission groups</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Release administrator| Release administrator are a support staff role. They perform the following tasks: |▪ Release User  
▪ Task User  
▪ Infrastructure Change Viewer  
▪ Incident Viewer  
▪ Problem Viewer  
▪ Asset Viewer |
|                      | ■ Transfer releases after their development in the development environment to the test environment. |                                                                 |
|                      | ■ Transfer releases after they have been tested in the test environment to the production environment. |                                                                 |
| Release coordinator  | Release coordinators are a support staff role. They perform the following tasks:  |▪ Release User  
▪ Functional role: Release Coordinator  
▪ Infrastructure Change User  
▪ Functional role: Infrastructure Change Coordinator  
▪ Functional role: Infrastructure Change Manager  
▪ Incident User  
▪ Problem User  
▪ Asset Viewer |
|                      | ■ Review the requests for change for the service(s) for which they act as the release coordinator after they have been passed on from Change Management. |                                                                 |
|                      | ■ Organizes and facilitates the CAB meetings for the service(s) for which they act as the release coordinator. |                                                                 |
|                      | ■ Splits the requirements of releases into logical groups that can be handled efficiently by change coordinators. |                                                                 |
|                      | ■ Prepares a business case for a new release when additional funding is needed for its implementation. |                                                                 |
|                      | ■ Initiates the implementation of releases and decides on corrective actions as needed. |                                                                 |
|                      | ■ Organizes and conducts postimplementation meetings to collect improvement suggestions for future releases. |                                                                 |

For more information, see the *Service Management Process Model Role Mapping to IT Service Management* white paper.
Change request lifecycle

This section uses the following business scenario to explain Change Management features and processes. Calbro Services has discovered that a mission-critical server is almost reaching capacity. It must replace the current server with a model that has more capacity. The change manager initiates a change request to replace the server. The figure in this section illustrates the lifecycle of a typical change request.

**Note**
For more information about this use case, see Upgrading server hardware on page 53.

**Figure 11: Stages in the lifecycle of a change request**

The typical lifecycle of a change request consists of the following major stages and approvals.

**Note**
Within these stages, different organizations might experience slight variations. For example, an organization might not divide a specific type of change request into various tasks, but work only at the change request level.

1. **Initiate**—In the upgrade server hardware use case, the change coordinator, Allen Allbrook, creates the change request from the Change Management Console to
replace the mission-critical server. He must properly classify its Class (for example, Normal), add relevant information (dates, configuration items, and so on), and assign a support group or change manager. When change requests are assigned to them, support staff members are notified. When the request moves into a new status, for example, Request For Authorization, the application generates notifications to the assignee group and the support group.

New change requests can be created in other ways. Examples include:

- Problem coordinators can create a change request from a Known Error.

- Using the Requester Console, a user can request a service that generates a change request.

- A technician who made changes to a database server during non-work hours can create an after the fact latent change request from the Overview Console.

- BMC Remedy AR System workflow in the BMC Service Request Management application can automatically generate change requests (for example, a service request to replace a mission-critical server).

- The discovery process can automatically generate a change request if it detects that a server does not have the latest patches loaded.

- BMC Remedy Asset Management can automatically generate a change request from a purchase requisition (for example, purchasing a laptop for a new employee).

- BMC Performance Manager can automatically generate a change request if it detects that a mirrored web server has failed and needs to be replaced.

Mary Mann, the change manager, receives a notification that a change request has been assigned to her. She opens the Change Management Console and reviews the change request assigned to her.

At the Initiate stage, she estimates the risk impact and costs associated with the change request. She chooses to compute the risk level of the request. If the change request requires tasks, she can create and schedule these tasks.

**Note**

If an approver is mapped to the approval phase, the change approver must approve the change request before it can move to the Review & Authorize stage. For more information, see Working with BMC Remedy Change Management as an approver on page 355.
2 **Review & Authorize** — If no approvers are mapped to this stage, change requests bypass the Review & Authorize stage entirely.

But if the application administrator added approvers, each level of approvers must review the request and approve it before it can move forward.

After the request is approved, the change coordinator can move the change request to the Plan & Schedule stage. After the change planning is completed, the change is sent to the change manager who reviews the change to ensure the information is complete and accurate, before submitting it for approval. Tasks are automatically assigned to the appropriate task implementers. Mary continues to fill in additional details about the change request (for example, she revises the start and end dates).

3 **Plan & Schedule** — The change coordinator relates the server CI to the change request. Mary then uses the Collision Detection tool to detect if there are other change requests scheduled to work on the same CI during the same time. After she resolves any conflicts, she plans a forward schedule of changes (FSC). She opens the Change Calendar and views the current schedule of change activities and business events. She then blocks out a time segment to work on the change request by targeting the scheduled start and end dates. Larger projects can include planning all the changes approved for implementation. In this scenario, Mary then assigns the change request to the change coordinator, Ian Plyment.

If the change request needs additional tasks, the change coordinator can create and schedule these tasks.

4 **Implement** — Ian Plyment, the change coordinator, receives notification that a task is assigned to him, to replace the server. He opens the request in the Change Management Console. He creates a task to replace the server, and then assigns it to himself as the task implementer who specializes in Front Office Support.

As the change request enters the Implement stage, the BMC Atrium CMDB is modified by Configuration Discovery, BMC Service Impact Manager (SIM), or other types of discovery tools as the task assignee works on the CI that needs extra memory. Ian logs his progress as he works on the tasks that need to be completed in order to get the change implemented (for example, uninstall the old server, install the new server, and so on). When a task is completed, the implementer of the next task in the sequence is notified of the task assignment. Task implementers can calculate the cost of implementing their tasks.

When Allen Allbrook the change requester has verified that the change request was resolved satisfactorily, he can set the change request to Closed. If the requester does not close the change request, the request closes automatically after a preconfigured time. If the change request is part of a dependent sequence, the change manager for the next change request in the sequence is notified.

Before the change request can move out of the Implement stage, the change coordinator must enter its actual start and end dates, and then assign a performance rating to the work performed on the change.

5 **Closed** — The change request enters the Closed stage. The change manager Mary must verify that the change request was completed. She also might analyze key
performance indicators (KPIs)—for example, whether the change successful, or how many incidents were resolved by the installation of the new server. Reviewers also must analyze the accuracy of the BMC Atrium CMDB.

User scenarios

This section describes common BMC Remedy IT Service Management user scenarios that you encounter as IT support staff. Calbro Services user personas help to illustrate the user scenarios. The typical steps described by these user scenarios are in keeping with BMC best practices as outlined by BMC Service Management Process Model (BMC SMPM).

The user scenarios indicate people that are included with sample data. For each of these people, the user name is the person's first name, and the password is password.

The user scenarios do not necessarily refer to specific Calbro Services sample data (for information about Calbro Services, see “Calbro Services” on page 50). To follow the user scenarios, in some instances, you might need to create your own sample data (for example, bulk inventory CIs). In addition, you might need to grant additional permissions to certain users.

Calbro Services

In the BMC Remedy ITSM documentation set, a fictional company named Calbro Services helps explain how BMC Remedy ITSM principles and procedures are used in practice.

Although Calbro Services is a fictional company, it is based on research of actual BMC Software customers. Learning how Calbro Services manages common IT Service Management scenarios should prove useful as you use the BMC Remedy ITSM applications in your own environment.

Calbro Services, a large, global company, is headquartered in New York City and publicly traded on the New York Stock Exchange. The company has 27,000 employees in 240 offices located in 20 countries. Table 6 on page 50 describes key business services in Calbro Services.

Table 6: Key business services

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online banking</td>
<td>500 ATMs in major cities</td>
</tr>
<tr>
<td>WWW presence</td>
<td>Corporate site and online brokerage services</td>
</tr>
</tbody>
</table>
### BMC Remedy Change Management user scenarios

This section describes at a high-level common BMC Remedy Change Management user scenarios that you typically encounter as IT support staff. The Calbro Services sample data is used to illustrate the user scenarios.

The following user scenarios are provided:

- “Adding laptop memory” on page 51
- “Upgrading server hardware” on page 53
- “Releasing a new software program” on page 55

#### Adding laptop memory

Joe Unser is an employee at Calbro Services. To improve the performance of his laptop, he needs 3 GB additional memory added. He submits a request to install memory for his laptop.

The Calbro Services business process has predefined that this type of change request does not require the standard Review and Business Approval processes. Mary Mann is the change coordinator at Calbro Services. Mary schedules and plans the change request. Ian Plyment, who is part of Mary’s Front Office Support team, implements the change request.

Table 7 on page 52 describes the typical steps involved in this user scenario.
### Table 7: Adding laptop memory

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer</td>
<td>On the Requester console, the customer creates a service request to install hardware.</td>
<td>Joe Unser, the customer, uses the predefined menus to select the appropriate item and enter more information. His selection drives the predefined process to create the change request. This request is a standard change that is pre-approved and does not require any formal approvals. <strong>Note:</strong> If Calbro Services has BMC Service Request Management, the business user creates the request from BMC Service Request Management, instead of from the Requester console.</td>
</tr>
<tr>
<td>Change manager</td>
<td>The change manager views the change request:</td>
<td>Mary Mann, the change manager, logs in and views all open change requests in the Change Management console. This type of change request involves minimal risk. This request is pre-approved and does not require any formal approvals.</td>
</tr>
<tr>
<td>Change coordinator</td>
<td>The change coordinator schedules the change request:</td>
<td>Mary Mann schedules the change request.</td>
</tr>
<tr>
<td>Change coordinator</td>
<td>The change coordinator relates the CI to the change request:</td>
<td>The change coordinator relates the CI to the change. The change coordinator then creates a task to add the laptop memory and assigns the task to the task implementer.</td>
</tr>
<tr>
<td>Change coordinator</td>
<td>The change coordinator creates tasks:</td>
<td>The change coordinator creates a task to add the laptop memory and assigns the task to the task implementer (Ian Plyment).</td>
</tr>
</tbody>
</table>
In the Implement stage, the task moves to Assigned status and Ian Plyment, the task implementer, can start working on the task. When the Ian finishes the task, he sets its status to Closed.

Mary Mann, the change coordinator, can now close the change request.

Mary Mann, the change coordinator, runs a simulated impact analysis on the CI. She verifies what devices and applications in the network would be affected if she takes the server offline. Mary then creates a change request from the Atrium Impact Simulator. The CI is automatically related to the change request.
<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change coordinator</td>
<td>In the Change form, the change coordinator selects the Install Server Hard Drive template. The change coordinator moves the change request to the next stage and completes the required information.</td>
<td>Mary uses a predefined change template that supports the business process and accelerates the change request process. It prepopulates fields on the change request with information. This change template also includes a predefined Task Group template (Upgrade Server Hard Drive). The Task Group template contains three predefined Tasks Templates that are individual work items.</td>
</tr>
<tr>
<td>Change coordinator</td>
<td>The change coordinator schedules the change request and runs collision detection: The change coordinator views the calendar and checks for possible conflicts. The change coordinator enters the scheduled dates. The change coordinator might use the Schedule Assist tool to search for available times. To check whether other change requests are scheduled to work on the CI at the same time, the change coordinator runs Collision Detection.</td>
<td>Mary opens the change calendar to see if there are any conflicting change requests or business events. She uses the Schedule Assist tool to schedule the start and end dates. Mary then determines if this change request collides with other changes.</td>
</tr>
<tr>
<td>Change coordinator and change manager</td>
<td>The change coordinator adds task assignments: On the Change form, the change manager relates the Upgrade Server Hard Drive task group template to the change request. The change manager views the details of the task. The change manager views the task flow of the task group. The change manager moves the change request to the Scheduled For Review stage.</td>
<td>Mary adds the task and task assignments. She then views the tasks relates to the change request and makes adjustments if needed. A predefined process is already set up for this type of change, which speeds the planning and process. Mary sees that Ian Plyment has been predefined as the task implementer assigned to work on this change. Mary has additional opportunity to review change plans, schedules, and so on.</td>
</tr>
<tr>
<td>Change approver</td>
<td>From Approval Central, the change approver approves the change request.</td>
<td>If approvers are mapped to any approval phases, the change approver must approve the change to move it forward. Otherwise, the change manager can refresh the change request to move it to the next status.</td>
</tr>
<tr>
<td>Change manager</td>
<td>The change manager reviews task assignments and makes any necessary changes. The change manager moves the change request to the Implement stage.</td>
<td>When the change request reaches the Implement stage, the task moves to Assigned status and the task implementer can start working on the first task.</td>
</tr>
<tr>
<td>Role</td>
<td>Actions</td>
<td>Explanation</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Task implementer</td>
<td>The task implementer completes the Backup System task:</td>
<td>Ian Plyment, the task implementer, opens the first task in the task group, relates the server CI to it, and then completes the task.</td>
</tr>
<tr>
<td></td>
<td>From the Change Management Support console, the task implementer searches for assigned tasks. The task implementer views the Backup System task, and relates the server CI to the task.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>After performing the task, the task implementer records information about performing the task and changes the status to Closed.</td>
<td></td>
</tr>
<tr>
<td>Task implementer</td>
<td>The task implementer completes the Uninstall Hard Drive task:</td>
<td>Ian opens the second task, relates the server CI to it, and then completes the task.</td>
</tr>
<tr>
<td></td>
<td>From the Change Management Support console, the task implementer searches for assigned tasks. The task implementer views the Uninstall Hard Drive task, and relates the server CI to the task.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>After performing the task, the task implementer records information about performing the task and changes the status to Closed.</td>
<td></td>
</tr>
<tr>
<td>Task implementer</td>
<td>The task implementer completes the Install Hard Drive task:</td>
<td>Ian opens the third task, relates the server CI to it, and then completes the task. When the last task is closed, the status of the Upgrade Server Hard Drive task group changes to Closed.</td>
</tr>
<tr>
<td></td>
<td>From the Change Management Support console, the task implementer searches for assigned tasks. He views the Install Hard Drive task, and relates the server CI to the task.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>After performing the task, the task implementer records information about performing the task and changes the status to Closed.</td>
<td></td>
</tr>
<tr>
<td>Change coordinator</td>
<td>The change coordinator completes the change request:</td>
<td>Mary completes and closes the change request.</td>
</tr>
<tr>
<td></td>
<td>The change coordinator moves the change request to the Closed stage.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The change coordinator enters the actual dates of the change.</td>
<td></td>
</tr>
</tbody>
</table>

**Releasing a new software program**

Allen Allbrook, the release coordinator, has created a request to release a new version of the payroll service.
This release is composed of two work items to be rolled out during the Deployment milestone:

- **Install a new server.**
  
  Allen creates a change request to include in the release manifest.

- **Train the users on the new payroll service.**
  
  Since this work item is not a change request that needs to be completed by the Change Management team, Allen instead creates an Activity as part of the manifest.

Mary Mann is the change coordinator.

Depending on how your application administrator has configured phases and exit criteria, the activity and change must be completed in the Deployment milestone before the release request can be closed.

*Table 9 on page 56* describes the typical steps involved in this user scenario.

### Table 9: Releasing a new software program

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release coordinator</td>
<td>From the Release Management console, the release coordinator creates a release request.</td>
<td>Allen creates a new request to add a new Payroll Service and would like it by September 1, 2009. Release starts at the Initiate milestone. The service will be released in multiple phases.</td>
</tr>
</tbody>
</table>
| Release coordinator   | On the Release form, the release coordinator creates a new change request and assigns it to the change coordinator.  
                        | The release coordinator relates the Install Server task to the change request.  
                        | On the Release form, the release coordinator assigns the activity to the Deployment milestone.  
                        | The release coordinator can see the change request listed on the manifest of the release. | Allen creates a change request to install the payroll service on a new server as part of the release manifest. |
| Release coordinator   | On the Release form, the release coordinator creates a new activity.  
                        | The release coordinator assigns this activity to the Deployment milestone.  
<pre><code>                    | The release coordinator can see the activity listed on the manifest of the release. | Allen creates an activity to train employees on the new payroll service as part of the release manifest. He assigns the activity to Francie Stafford. |
</code></pre>
<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Release coordinator       | To check whether other change requests are scheduled to work on the same CI, the release coordinator runs collision detection.  
                           | The release coordinator sets the scheduled, actual, and deployment start and end dates for the release. The release coordinator uses the Schedule Assist tool to search for available time segments.  
<pre><code>                       | The release coordinator moves the request to the Initiate Approval milestone.                                                           |
</code></pre>
<p>|                           |                                                                         | Allen schedules the change request. He then runs the Collision Detection tool to see if there are any conflicting change requests.          |
| Release approver          | On the Approval Central console, the release approver approves the request to initiate the release.                                 |
|                           |                                                                         | If approvers are mapped to any approval phases, the release approver must approve the release to move it forward. Otherwise, the release coordinator refreshes the release request to move it to the next status. |
| Release coordinator       | The release coordinator moves the release to the Planning milestone.     | Allen opens the change calendar to see if there are any conflicting releases, change requests, or business events.                        |
|                           |                                                                         | Allen opens the change calendar to see if there are any conflicting releases, change requests, or business events.                        |
| Activity assignee         | On the Release Management console, the activity assignee views assigned activity.                                               |
|                           |                                                                         | Activity is routed to the Francie Stafford, the activity assignee.                                                                         |
| Activity assignee         | On the Activity form, the activity assignee attaches the training plan to work information.                                      |
|                           |                                                                         | Francie schedules a training session on how to use the new payroll application.                                                            |
| Activity assignee         | On the Activity form, the activity assignee creates tasks and assigns them to task implementers.                                 |
|                           |                                                                         | Francie creates tasks to assign the trainers to train Calbro users in Boston, Tokyo, and so on.                                           |
| Activity assignee         | On the Activity form, the activity assignee verifies assignments, adds financial information, and schedules the start and end dates. |
|                           |                                                                         | Francie adds financial and scheduling information to the activity.                                                                         |</p>
<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release coordinator</td>
<td>The release coordinator oversees building the controlled environment before the release goes into production. On the Release form, the release coordinator moves the release request to the Build milestone.</td>
<td>Allen oversees assembly of CIs needed to create the new payroll service.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator moves the release request to the Test milestone.</td>
<td>Allen oversees the testing of the new service, to make sure that the CIs, IT service, or process meets the specifications and requirements.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator moves the release request to the Deployment milestone.</td>
<td>Phased deployment of the new service can start.</td>
</tr>
<tr>
<td>Change coordinator</td>
<td>The change coordinator opens the change request and moves it to the Implement stage. The change coordinator relates tasks to the change requests and assigns the tasks to the task implementer.</td>
<td>In the Deployment milestone, Mary Mann, the change coordinator, moves the change request through its stages.</td>
</tr>
<tr>
<td>Task implementer</td>
<td>The task implementer closes each task when it is completed: From the Change Management Support console, the task implementer searches for assigned tasks. After performing the task, the task implementer records information about performing the task and changes the status to Closed.</td>
<td>In the Deployment milestone, the task moves to Assigned status and Ian Plyment, the task implementer, can start installing the server. Ian completes the task.</td>
</tr>
<tr>
<td>Change coordinator</td>
<td>The change coordinator completes the change request. The change coordinator opens the change request and moves it to the Completed status.</td>
<td>Mary completes the change request to install the server.</td>
</tr>
<tr>
<td>Activity assignee</td>
<td>The activity assignee performs activities: On the Release Management console, the activity assignee opens the activity and views the status of the assigned tasks. After all training tasks are finished, the activity assignee changes the status of the activity to Completed.</td>
<td>In the Deployment milestone, the trainers can start training users at different Calbro locations. A training task has its own independent lifecycle and continues on its own path, but all tasks must be finished in order for the activity to be completed.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator completes the release: On the Release form, the release coordinator moves the release request to the Close Down milestone.</td>
<td>Allen completes and closes the release request.</td>
</tr>
</tbody>
</table>
Introducing Release Management

This section helps you get started using Release Management.

About Release Management

Release management is the process responsible for planning, scheduling, and controlling the movement of releases to test and live environments. ITIL specifies that the primary objective of Release Management is to make sure that the integrity of the live environment is protected and that the correct components are released.” A release is a collection of related authorized changes to an IT service that are tested and introduced into the live environment together. Release management works closely with Configuration Management and Change Management to make sure that changes to the IT infrastructure are implemented to keep the functionality and service levels of the services aligned with the ever-changing business needs of their customers.

As part of BMC’s Business Services Management (BSM) strategy, the Release Management module that is included with BMC Remedy Change Management includes built-in ITIL V3 best practices to track and manage change and deployment activities. The goal of Release Management is provide enhanced out-of-the-box support for managing standard release activities from request to planning and design, build, test, deployment, and acceptance.

Release Management includes default support for managing standard release work items by:

- Tracking and managing change and deployment activities
- Automatically notifying stakeholders at every phase of the release process
- Contributing to meeting auditable requirements for traceability through service transition
- Delivering changes faster and at an optimum cost and minimized risk
- Assuring that customers and users can use the new or changed service in a way that supports the business goals
Improving consistency in the implementation approach across the business change, service teams, suppliers, and customers

With numerous changes occurring daily, Release Management is the key component in making sure that applications are successfully deployed without compromising the integrity or availability of the production environment. Using a systematic and repeatable release process, organizations can achieve greater success rates of change rollout, higher quality of IT service, and accelerated time-to-market.

Milestones in the release request lifecycle

The release request process uses the following business scenario to explain Release Management features and processes. Calbro Services must install a new payroll service by a certain date. The release coordinator initiates a release request to install the new application. To complete the release, the release coordinator must perform the following work items:

- Create a change request to install the server that runs the application
- Create an activity record to train users on the new application

Note
For more information about this use case, see BMC Remedy Release Management use cases on page 71.

A release request tracks the progress of a release through its entire lifecycle, from the Initiate milestone to the Close Down milestone. The Process Flow Status bar on the Release form steps you through the release process from the Initiate to the Close Down milestone. It provides a visual mechanism to track the milestones of a release request.

Figure 12: Process Flow Status bar on the Release form

Note
Your application administrator might have configured milestone enforcement in Release Management. Milestone enforcement requires that all change requests and activities must be completed before the release can move to the next milestone.

To work a release request from start to finish, the user roles listed in Table 10 on page 61 are required. Although the responsibilities of these users can vary from organization to organization (and in some organizations, one person can fulfill several roles), they generally include the following roles and functions.
Tip
If the Calbro Services sample data is installed on your server, you can log in to Release Management as these users and follow the use cases with some simple modifications in their permissions.

Table 10: IT Support user roles

<table>
<thead>
<tr>
<th>User</th>
<th>Release management role</th>
<th>Function</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allen Allbrook</td>
<td>Release Coordinator</td>
<td>Reviews the RFCs for the services for which he acts as the release coordinator after they have been passed on from Change Management. He organizes and facilitates the CAB meetings for the services for which he acts as the release coordinator. Allen splits the requirements of releases into logical groups that can be handled efficiently by change managers. He prepares a business case for a new release when additional funding is needed for its implementation. He initiates the implementation of releases and decides on corrective actions as needed. Finally, he organizes and conducts post-implementation meetings to collect improvement suggestions for future releases. <strong>Note</strong>: Make sure that Allen Allbrook has Release Master or Release User permissions.</td>
<td>Working as a release coordinator on page 275</td>
</tr>
<tr>
<td>Mary Mann</td>
<td>Change Manager</td>
<td>Reviews the risk and impact analysis to make sure that this has been performed thoroughly. Mary makes sure that appropriate actions have been planned to minimize both the risk of failure and the impact on users during change implementations. She makes sure that the timing of planned implementations does not conflict with other planned changes or events. Finally, Mary obtains approval for changes. Mary uses the Change Management Console to handle the specific details of the change request. If Mary is given Release Viewer or Release User permissions, she can use the Release Management Console to review the overall details of the release request.</td>
<td>Working with change request assignments on page 211</td>
</tr>
<tr>
<td>Ian Plyment</td>
<td>Task Implementer</td>
<td>Support staff member who performs the tasks associated with a change request. In this example, Ian’s responsibility is to install the new server.</td>
<td>Working with BMC Remedy Change Management as a task implementer on page 341</td>
</tr>
<tr>
<td>User</td>
<td>Release management role</td>
<td>Function</td>
<td>More information</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Francie Stafford</td>
<td>Activity Assignee</td>
<td>Staff members or groups who perform the activities associated with a release request. For example, a release request to install a new software application might include these activities: Create training materials, or Train employees. If Francie is given Release Viewer and Activity User permissions, she can use the Release Management Console and the Activity form to perform the activity associated with a change request.</td>
<td>Working with activities as an activity assignee on page 375</td>
</tr>
</tbody>
</table>

**Note**

For more information about permissions and roles, see the *BMC Remedy IT Service Management Configuration Guide*. For information about Change Management roles, see *User roles in the change request lifecycle on page 36, Additional Change Management user roles on page 40, and SMPM user roles on page 43.*
Figure 13 on page 63 illustrates the lifecycle of a typical release request. A release usually includes multiple approvals, depending on your business needs.

**Figure 13: Release lifecycle**

The following section walks you through the milestones of a release request lifecycle. In the Release Management module, a milestone is a significant event in the release project, which includes a major deliverable. For example, when you complete the Initiate milestone, you have successfully created a release request that has been approved by the CAB.

1. **Initiate milestone** — Allen Allbrook the release coordinator creates the release request. When the release must be divided into several changes and activities, Allen can create and schedule these in a release manifest. A manifest provides him a consolidated view of the tasks that the release management team must perform to drive the completion of the change requests and activities required to close the release.

   He performs the following actions:
- Creates a change request to install the new server for the payroll service at the Deployment milestone. He assigns the change request to Mary Mann, the change manager.

- Creates an activity to train employees on the new payroll service. He assigns it to Francie Stafford, the activity assignee.

If an unforeseen situation arises that he did not anticipate, he can create or add changes and activities at later milestones.

**Note**

If your application administrator has configured milestone phases, you can specify that staff must work on their change requests and activities at a certain phase (for example, installing the server at Phase 1 or training users at Phase 5 of the Deployment milestone). But no phases are mapped out-of-the-box for Calbro Services.

He then blocks out a time segment to work on the release by indicating the scheduled start and end dates. Larger projects can include planning all the releases and changes approved for implementation. He then budgets the estimated costs and rolls up the risk level from all the related change requests. Release Management provides rollup of all costs, budgets, time, and resources.

Collision detection is automatically run when he saves the release. The Collision Detection tool determines if there are other change requests scheduled to work on the same CI during the same scheduled time, and helps him manage and resolve these potentially harmful conflicting change requests.

**Note**

If an approver is mapped to the approval phase, the release approver must approve the release request before it can move to the Planning milestone. But no release approvers are mapped out-of-the-box for Calbro Services. Your application administrator must configure them. For more information, see Working with BMC Remedy Change Management as an approver on page 355.

---

2 **Plan milestone** — Allen reviews the release plan. He opens the Change Calendar and views the current schedule of releases, change requests, and business events for any potential conflicts. He adjusts the start and end dates accordingly.

Allen reviews these requests for change with Mary Mann, the change manager of the service for which the release is to be implemented. Together they divide the requirements of the different RFCs amongst them and they draft a high-level implementation plan that indicates the duration of each change, and the dependencies between these changes.

Francie Stafford the activity assignee plans to add training tasks to the activity that will be implemented in the last deployment phase. Trainers must provide training and user documentation to all Calbro Services staff. She includes costs and attaches a training schedule in the activity.
3 **Build milestone**—Allen establishes the approach to building the controlled environments before the release goes into production. For example, after a change has been approved, he oversees the final build delivery of the new service. The Build milestone assembles the CIs that are needed to create the release package before it goes into service.

4 **Test milestone**—The release coordinator makes sure that the CIs, IT service, or process meet their specifications and requirements. When all the tests have been completed satisfactorily, the release coordinator seeks approval from BMC Remedy Change Management for the actual deployment.

5 **Deployment milestone**—Release is rolled out to the Business. In this use case, the change request and release activity that make up the release are marked Closed during the Deployment milestone:

- Mary Mann the change manager opens the change request and moves it to the Implement stage. She creates the installation task and assigns it to Ian Plyment, the task implementer. He installs the new server. Mary then closes the change request.

- Francie Stafford the activity assignee executes the training activity. When all the trainers finish their tasks, she marks the activity as Completed.

6 **Close Down milestone**—The release request enters the Close Down milestone. Reviewers provide feedback on the effectiveness of the release, and record metrics for deployment to make sure the release met its service targets. Allen verifies there is minimal unpredicted impact to the IT infrastructure and makes sure the users are satisfied with the user documentation and training.

## Release Management form views

BMC Remedy Release Management provides you with different ways to view the Release Management form:

- **Best Practice view**

- **Classic view**

The view that you see is configured for you by your system administrator. The Best Practice view is the default view. For a description of the Best Practice view, see **Best Practice view — Release Request form on page 66**. For a description of the Classic view, see **Classic view — Release Request form on page 67**.
**Note**

When documenting procedures in this guide, if there is a difference between how to do something in the Best Practice view and how to do it in the Classic view, both methods are described. Instructions for the Best Practice view are provided first.

---

**Best Practice view—Release Request form**

The Best Practice view is an improved version of the Release Management form. In this view, the fields most commonly used for creating release requests are immediately visible. You can access additional, less frequently used functionality from the tabbed sections of the form or from the links in the Navigation pane.

Figure 14 on page 67 illustrates the Best Practice view.

The following list outlines Best Practice view features:

- **Coordinator Group field**—Use the Coordinator Group field to select a support group. The support groups that appear in the menu each have at least one member with a Release Coordinator functional role. From the Coordinator Group menu, you select the company, the organization, and then the support group. Only the selected support group name appears in the Coordinator Group field. You can type only a few characters and press Enter. If a unique match is found, the field is populated with the value or a list of coordinator groups is displayed from which you can select a value, if multiple matches are found.

- **Release Coordinator field**—Use the Release Coordinator field to select a Release Coordinator. The people whose names appear on this menu belong to the support group selected in the Coordinator Group field and have a Release Coordinator functional role. You can type only a few characters and press Enter. If a unique match is found, the field is populated or if multiple matches are found a list of release coordinators belonging to the selected coordinator group is displayed from which you can select a value.

- **Service field**—The Service field relates business service configuration items (CIs) to the release at the time it is created.

- **Template field**—The Template field encourages the use of templates. For information about the benefits of using templates and how to select a template for a release request, see Selecting release templates on page 448.

- **Business Justification**—The Business Justification field indicates the business reason for the release request. It specifies the importance of the release so that the approvers can assess its magnitude.
**Best practice**

The Best Practice view is recommended for all BMC Remedy Release Management users, regardless of their role.

**Figure 14: Release Request form—Best Practice view**

---

**Classic view—Release Request form**

The Classic view is the Release Management Console as it appeared in previous releases of BMC Remedy Release Management. This view is provided for customers who are upgrading from earlier versions of BMC Remedy Release Management and who are not yet ready to adopt the Best Practice view.

A new functional role, Release Coordinator, has been introduced in BMC Remedy Release Management version 7.6.00. The following fields corresponding to this role have been added to the classic view:

- Coordinator Group
- Release Coordinator
These fields replace the Release Manager field on the Assignment tab in the Release Request form.

Figure 15 on page 68 illustrates the Classic view.

Figure 15: Release Request form—Classic view

Best practices for managing release requests - Using this guide

As with BMC Remedy Change Management, the Release Management module is role-based. What applications you can access, and how much information you can view or modify is dependent upon your role. As the Process Flow Status bar steps you through the milestones of a release request, different roles perform different tasks. The Release Coordinator creates the release request at the Initiate milestone, the Release Approver approves the release at the Build milestone, and the Activity Assignee completes the activity at the Deployment milestone.
Defining approvals at the Build milestone is a best practice. However, approvals can be defined at each milestone of the Release Management process.

How each person uses Release Management depends on their role. Figure 17 on page 69 illustrates the different Release Management support staff roles. It also shows where each role fits into the milestones of the release request lifecycle.

To simplify the release request process, Table 11 on page 70 navigates you through the BMC Remedy Change and Release Management User’s Guide. It provides a map of best practices which BMC recommends that you should follow, when you use the Release Management module.
### Table 11: Best practices for managing release requests

<table>
<thead>
<tr>
<th>Milestone</th>
<th>Role and task</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1a</td>
<td>Initiate</td>
<td>Release Coordinator creates the release request, change request, and activity.</td>
</tr>
<tr>
<td>1b</td>
<td>Initiate</td>
<td>CAB approves the release request.</td>
</tr>
<tr>
<td>2a</td>
<td>Planning</td>
<td>Release Coordinator plans release request, uses Change Calendar to check for conflicts.</td>
</tr>
<tr>
<td>2b</td>
<td>Planning</td>
<td>CAB approves the release request.</td>
</tr>
<tr>
<td>3a</td>
<td>Build</td>
<td>Release Coordinator oversees the release builds.</td>
</tr>
<tr>
<td>3b</td>
<td>Build</td>
<td>CAB approves the release request.</td>
</tr>
<tr>
<td>4a</td>
<td>Test</td>
<td>Release Coordinator oversees the testing of the new service, to make sure CIs meet specifications and requirements.</td>
</tr>
<tr>
<td>4b</td>
<td>Test</td>
<td>CAB approves the release request.</td>
</tr>
<tr>
<td>5a</td>
<td>Deployment</td>
<td>Release Coordinator rolls release out to the business. Starts phased or non-phased deployment of release.</td>
</tr>
<tr>
<td>5b</td>
<td>Deployment</td>
<td>CAB approves the release request.</td>
</tr>
<tr>
<td>5c</td>
<td>Deployment</td>
<td>Change Manager executes change request in its Deployment phase.</td>
</tr>
<tr>
<td>5d</td>
<td>Deployment</td>
<td>Task Implementer executes task in its Deployment phase.</td>
</tr>
<tr>
<td>5e</td>
<td>Deployment</td>
<td>Activity Assignee executes task in its Deployment phase.</td>
</tr>
<tr>
<td>6</td>
<td>Closed</td>
<td>Release Coordinator completes the change request.</td>
</tr>
</tbody>
</table>

### User scenarios

This section describes common BMC Remedy IT Service Management user scenarios that you encounter as IT support staff. Calbro Services user personas help to illustrate the user scenarios. The typical steps described by these user scenarios are

The user scenarios indicate people that are included with sample data. For each of these people, the user name is the person's first name, and the password is password.

The user scenarios do not necessarily refer to specific Calbro Services sample data (for information about Calbro Services, see “Calbro Services” on page 50). To follow the user scenarios, in some instances, you might need to create your own sample data (for example, bulk inventory CIs). In addition, you might need to grant additional permissions to certain users.

**BMC Remedy Release Management use cases**

The following sections describe at a high-level common BMC Remedy Release Management use cases that you typically encounter as IT support staff. The Calbro Services sample data is used to illustrate the use cases. The Explanation column provides relevant cross-references in the BMC Remedy Change and Release Management User’s Guide for more details.

For other use cases that involve Change Management and the Calbro Services user data, see “BMC Remedy Change Management user scenarios” on page 51. For use cases that demonstrate how BMC Remedy Release Management integrates with other products in the BMC Remedy ITSM suite, see the BMC IT Service Management Concepts Guide.

**Releasing a new software program**

Allen Allbrook, the release coordinator, has created a request to release a new version of the payroll service.

This release is composed of two work items to be rolled out during the Deployment milestone:

- Install a new server.
  
  Allen creates a change request to include in the release manifest.

- Train the users on the new payroll service.
  
  Since this work item is not a change request that needs to be completed by the Change Management team, Allen instead creates an Activity as part of the manifest.

Mary Mann is the change coordinator.
Depending on how your application administrator has configured phases and exit criteria, the activity and change must be completed in the Deployment milestone before the release request can be closed.

Table 9 on page 56 describes the typical steps involved in this user scenario.

**Table 12: Releasing a new software program**

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release coordinator</td>
<td>From the Release Management console, the release coordinator creates a release request.</td>
<td>Allen creates a new request to add a new Payroll Service and would like it by September 1, 2009. Release starts at the Initiate milestone. The service will be released in multiple phases.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>On the Release form, the release coordinator creates a new change request and assigns it to the change coordinator. The release coordinator relates the Install Server task to the change request. On the Release form, the release coordinator assigns the activity to the Deployment milestone. The release coordinator can see the change request listed on the manifest of the release.</td>
<td>Allen creates a change request to install the payroll service on a new server as part of the release manifest.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>On the Release form, the release coordinator creates a new activity. The release coordinator assigns this activity to the Deployment milestone. The release coordinator can see the activity listed on the manifest of the release.</td>
<td>Allen creates an activity to train employees on the new payroll service as part of the release manifest. He assigns the activity to Francie Stafford.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>To check whether other change requests are scheduled to work on the same CI, the release coordinator runs collision detection. The release coordinator sets the scheduled, actual, and deployment start and end dates for the release. The release coordinator uses the Schedule Assist tool to search for available time segments. The release coordinator moves the request to the Initiate Approval milestone.</td>
<td>Allen schedules the change request. He then runs the Collision Detection tool to see if there are any conflicting change requests.</td>
</tr>
<tr>
<td>Role</td>
<td>Actions</td>
<td>Explanation</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Release approver</td>
<td>On the Approval Central console, the release approver approves the request to initiate the release.</td>
<td>If approvers are mapped to any approval phases, the release approver must approve the release to move it forward. Otherwise, the release coordinator refreshes the release request to move it to the next status.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator moves the release to the Planning milestone.</td>
<td>Allen opens the change calendar to see if there are any conflicting releases, change requests, or business events.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator reviews the calendar:</td>
<td>Allen opens the change calendar to see if there are any conflicting releases, change requests, or business events.</td>
</tr>
<tr>
<td></td>
<td>The release coordinator sets the request status to In Progress.</td>
<td>Allen opens the change calendar to see if there are any conflicting releases, change requests, or business events.</td>
</tr>
<tr>
<td></td>
<td>The release coordinator views the calendar and makes sure that the release requests are shown in the calendar.</td>
<td>Allen opens the change calendar to see if there are any conflicting releases, change requests, or business events.</td>
</tr>
<tr>
<td></td>
<td>On the Release form, the release coordinator adjusts the scheduled start and end dates.</td>
<td>Allen opens the change calendar to see if there are any conflicting releases, change requests, or business events.</td>
</tr>
<tr>
<td>Activity assignee</td>
<td>On the Release Management console, the activity assignee views assigned activity.</td>
<td>Activity is routed to the Francie Stafford, the activity assignee.</td>
</tr>
<tr>
<td>Activity assignee</td>
<td>On the Activity form, the activity assignee attaches the training plan to work information.</td>
<td>Francie schedules a training session on how to use the new payroll application.</td>
</tr>
<tr>
<td>Activity assignee</td>
<td>On the Activity form, the activity assignee creates tasks and assigns them to task implementers.</td>
<td>Francie creates tasks to assign the trainers to train Calbro users in Boston, Tokyo, and so on.</td>
</tr>
<tr>
<td>Activity assignee</td>
<td>On the Activity form, the activity assignee verifies assignments, adds financial information, and schedules the start and end dates.</td>
<td>Francie adds financial and scheduling information to the activity.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator oversees building the controlled environment before the release goes into production.</td>
<td>Allen oversees assembly of CIs needed to create the new payroll service.</td>
</tr>
<tr>
<td></td>
<td>On the Release form, the release coordinator moves the release request to the Build milestone.</td>
<td>Allen oversees assembly of CIs needed to create the new payroll service.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator moves the release request to the Test milestone.</td>
<td>Allen oversees the testing of the new service, to make sure that the CIs, IT service, or process meets the specifications and requirements.</td>
</tr>
<tr>
<td>Release coordinator</td>
<td>The release coordinator moves the release request to the Deployment milestone.</td>
<td>Phased deployment of the new service can start.</td>
</tr>
<tr>
<td>Role</td>
<td>Actions</td>
<td>Explanation</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Change coordinator      | The change coordinator opens the change request and moves it to the Implement stage.  
The change coordinator relates tasks to the change requests and assigns the tasks to the task implementer. | In the Deployment milestone, Mary Mann, the change coordinator, moves the change request through its stages.                                 |
| Task implementer        | The task implementer closes each task when it is completed:  
From the Change Management Support console, the task implementer searches for assigned tasks.  
After performing the task, the task implementer records information about performing the task and changes the status to Closed. | In the Deployment milestone, the task moves to Assigned status and Ian Plyment, the task implementer, can start installing the server. Ian completes the task. |
| Change coordinator      | The change coordinator completes the change request.  
The change coordinator opens the change request and moves it to the Completed status.                                                 | Mary completes the change request to install the server.                                                                                   |
| Activity assignee       | The activity assignee performs activities:  
On the Release Management console, the activity assignee opens the activity and views the status of the assigned tasks.  
After all training tasks are finished, the activity assignee changes the status of the activity to Completed. | In the Deployment milestone, the trainers can start training users at different Calbro locations. A training task has its own independent lifecycle and continues on its own path, but all tasks must be finished in order for the activity to be completed. |
| Release coordinator     | The release coordinator completes the release:  
On the Release form, the release coordinator moves the release request to the Close Down milestone.                                      | Allen completes and closes the release request.                                                                                           |
Using the Change Management Console and the Change form

This section contains information about getting started with BMC Remedy Change Management, including information about using the Change Management Console, the Change form, and the Overview Console.

About the IT Home Page

When you start the BMC Remedy IT Service Management Suite, the IT Home Page displays the Overview console by default. However, you can set up what you want to see on the IT Home Page. If you are a system administrator, you can configure the page for all users. Otherwise, you can configure your own user ID to see your views.
The following figure illustrates the functional areas of the IT Home Page.

**Figure 18: IT Home Page and its functional areas**

The following table describes each of the functional areas of the IT Home Page.

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Page header</td>
<td></td>
</tr>
<tr>
<td>Logout</td>
<td>Click <strong>Logout</strong> to exit the application.</td>
</tr>
<tr>
<td>Breadcrumb bar</td>
<td>The breadcrumb bar helps you keep track of the records you are viewing and helps with navigation. For more information about breadcrumbs, refer to “Navigating consoles, forms, and modules ” on page 79.</td>
</tr>
<tr>
<td>Global search</td>
<td>Type in a word or a phrase in the search area, and the application will search across multiple forms for records that match your input. For more information about global search, refer to “Using Global search” on page 82.</td>
</tr>
<tr>
<td>Navigation pane</td>
<td></td>
</tr>
<tr>
<td>Functional area</td>
<td>Purpose</td>
</tr>
<tr>
<td>----------------</td>
<td>---------</td>
</tr>
<tr>
<td>Applications</td>
<td>Depending on your permissions and other installed applications, the following links are displayed. Use them to open applications.</td>
</tr>
<tr>
<td>■ Quick Links</td>
<td></td>
</tr>
<tr>
<td>■ AR System Administration</td>
<td></td>
</tr>
<tr>
<td>■ Analytics</td>
<td></td>
</tr>
<tr>
<td>■ BMC Atrium Core</td>
<td></td>
</tr>
<tr>
<td>■ BMC Atrium Integration Engine</td>
<td></td>
</tr>
<tr>
<td>■ Administrator Console</td>
<td></td>
</tr>
<tr>
<td>■ Asset Management</td>
<td></td>
</tr>
<tr>
<td>■ Change Management</td>
<td></td>
</tr>
<tr>
<td>■ Change Management Dashboard</td>
<td></td>
</tr>
<tr>
<td>■ Contract Management</td>
<td></td>
</tr>
<tr>
<td>■ Product Catalog</td>
<td></td>
</tr>
<tr>
<td>■ Foundation Elements</td>
<td></td>
</tr>
<tr>
<td>■ Incident Management</td>
<td></td>
</tr>
<tr>
<td>■ Problem Management</td>
<td></td>
</tr>
<tr>
<td>■ Return On Investment</td>
<td></td>
</tr>
<tr>
<td>■ Release Management</td>
<td></td>
</tr>
<tr>
<td>■ Requestor Console</td>
<td></td>
</tr>
<tr>
<td>■ Task Management</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When you run your mouse over the applications, you see a second menu. You can select one of those options to go directly to a form. For example, roll over **Change Management** and select **Change/Release Calendar**. The Calendar screen appears.

<table>
<thead>
<tr>
<th>Configuration Buttons</th>
<th>Use these buttons to configure your panel display.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview console</td>
<td></td>
</tr>
</tbody>
</table>
### Functional area

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Company and View By</strong></td>
<td>These fields combine to provide a way to indicate the company name and the assigned-to categories filtering the records in the Console List table.</td>
</tr>
<tr>
<td><strong>Refresh</strong></td>
<td>This button refreshes the data in the table.</td>
</tr>
<tr>
<td><strong>Preferences</strong></td>
<td>This button allows you to set preferences for the console list table. You can remove columns, set refresh intervals, reset and save your preferences.</td>
</tr>
<tr>
<td><strong>Console List table</strong></td>
<td>This table lists the different types of requests.</td>
</tr>
</tbody>
</table>

### Configuring the IT Home Page

You can configure the IT Home Page to display information of your choice. For example, Bob Baxter is the Manager for payroll at Calbro Services. He likes to keep track of all potential problems, changes, and incidents pertaining to his department. He also tracks software license contracts so that he knows which ones are about to expire. Bob configures his panels to display all the information he is looking for, as follows:

- **Asset Management** => **Contracts About to Expire in 90 Days**
- **Change Management** => **All Open Changes with Extensive Impact**
- **Incident Management** => **All Open Incidents with Extensive Impact**
- **Problem Management** => **All Open Problems by Status and Priority**

#### To add or delete panels

You can specify how many panels to display on your IT Home Page up to a maximum of four panels.

1. In the IT Home Page, click the **Add panels to layout** button.

   Four panels appear.

2. To delete a panel, click the **Close** button on the panel.

#### To configure panels

You can select what to display on your IT Home Page.

**Note**

You can configure your panels only with options for which you have permissions.
1 In the panel, click the **Show** list and run your cursor over the list of options.

2 From the list of work areas for each option, select the one to display (for example, **Asset Management => Software Certificates**).

   The panel displays your selection.

3 Repeat **Step 1** to for your other panels.

   To change display on a panel, click the **Edit** button to display the **Show** list, and make another selection.

4 Click the **Save Current Layout** button to save your IT Home Page.

   A dialog box confirms that your customized layout has been saved.

5 Click **OK**.

   When you next log in, you will see your saved IT Home Page.

**To expand and collapse panels**

1 In the panel, click the **Collapse** button. The panel will collapse. In the panel click the **Expand** button. The panel will expand to its original size.

**To restore a default IT Home Page view**

1 In the IT Home Page, click the **Restore Default Layout** button. A dialog box informs you that the default layout for this page will be brought back. Click **OK** to proceed or **Cancel** to retain your current layout. If you click **OK**, the panels on the IT Home Page disappear and the Overview Console is displayed.

**To hide or show the navigation pane**

1 In the IT Home Page, click the **Applications** button to hide or show the navigation pane.

---

**Navigating consoles, forms, and modules**

This section describes how to navigate around BMC Remedy ITSM consoles, forms, and modules.
In most cases, when you open consoles, forms, and modules from the IT Home page, they open inside the IT Home page view. Similarly, if you open a form from a console, the form replaces the console in the view.

If you open a related record from a form, the related record opens in the view that was occupied by the form. For example, if you are working with a problem investigation (the "parent" record) and from the parent record you open a related incident request, the incident request replaces the parent record in the view. If you then open a change request from the incident request, the change request replaces the incident request in the view, and so on. To help you keep track of the records you are viewing and to help with navigation, there is a breadcrumb bar across the top of the view field.

**Note**

Not all of the consoles, forms, and modules open in the view area. For example, the BMC Remedy AR System Approval Central module opens in a new window. When a console, module, or form opens in a window, it is not added to the breadcrumb bar.

The breadcrumb bar contains links to the records that you opened from the parent record. When you open a record, the breadcrumb trail expands along the breadcrumb bar to the right, with the new link. If there are more than six links in the breadcrumb trail, arrows appear at one or both ends of the bar that let you scroll back and forward on the bar to see links not currently in the view.

The first link in the breadcrumb trail indicates the place from which you started. It can be a console or a form. For example, if you open a change request record directly from the IT Home page, the first link in the breadcrumb trail takes you to the change request.

The last link corresponds to the record currently in the view. If you open a link to the left of the record currently in view, the system truncates the breadcrumb trail to that link. The history is retained, however, so you can use the back and forward arrows in the navigation controls to move through the bar one record at a time. There is also a history of your most recently viewed records, which you can use to move directly to a record. Click the down arrow to open the history list.

**Note**

The Forward button is only visible after you move back down the breadcrumb bar by opening a link to a record that you previously viewed.

**Figure 19: The breadcrumb navigation buttons and bar**

If you are viewing a record from the middle of the breadcrumb trail and then branch off to another parent-type record, the system removes the forward breadcrumb trail from the point where you branched off and starts a new history from there, using the new parent-type record as the starting point. For example: You open a problem investigation, then open a related incident request, and from the incident request...
you open a related change request. If you go back to the incident request record and then open a second problem investigation, the breadcrumb bar no longer contains a link to the change request. The breadcrumb trail now shows the original problem investigation, the incident request, and the second problem investigation. It then shows any related records that you subsequently open from the second problem investigation.

When you close the parent record, the system removes the breadcrumb history.

What happens to data as I move back and forth on the breadcrumb trail?

If you are entering information into a record and open another record from the breadcrumb trail, the system prompts you to save the work, if you have not done so. If you do not save the information, the system does not preserve it on the record and you must re-enter it later.

If someone updates a record on your breadcrumb trail that is not currently in the view, those changes are visible to you when you open the record again.

How does the breadcrumb trail behave with forms in Search mode?

If you run a search from a form that is in Search mode, the last entry in the breadcrumb trail is the name of the form.

When you open a record from the search results table, that record does not appear in the breadcrumb trail. However, if you drill down through that record to open other related records, those related records will appear in the breadcrumb trail.

To return to the originating record, use the history list.

Note

All of the records that you open from a form in Search mode are added to the history list.

To return to the results table, click the name of the form in the breadcrumb trail.

Can I force a second window to open?

If you press the Shift key and then double-click a record entry in any table, the record opens in a second window. Also, if you hold the Shift key and click a link, button, and so on, the form or dialog box associated with the link or button opens in another window.
Note
If there is a record in the history list that you want to open in a second window, press the Shift key and then double-click the entry.

If you are working in a new record that has not yet been saved and open a new child type record (task, activity, CI, and so on), the system will open a new window automatically to accommodate the new child record. This prevents the information in the new, unsaved parent record from being lost.

Which consoles, forms, and modules open in a new window?

Not all of the consoles, forms, and modules open in the IT Home page's view. The consoles, forms, and modules in the following list open in a new window. If you open one of these from the IT Home page, any unsaved changes to the IT Home page are lost.

Tip
Before you open any of these consoles, forms, or modules, save the changes to the IT Home page that you want to keep.

- BMC Action Request System Administrator
- Application Administration
- BMC Service Level Management
- Analytics
- Service Management Process Model

Using Global search

If you have BMC Remedy Knowledge Management installed, you can use the Global search feature. Global search searches across multiple forms for records that match a word or phrase that you type in the search area.
To use Global search

1. In the text field to the right of the breadcrumb bar, type your search string and then click the Search icon.

   Figure 20: Global search

2. Locate the record you want in the search results table and double-click it.

   The record opens in the viewing area and the system updates the breadcrumb trail with an entry for the record you opened.

   **Note**

   As you drill down through the record, each record you open is also added to the breadcrumb trail.

   If you want to maintain the contents of the search results table to view later, do not change the text in the Search field. If you do, when you click the Search icon to return to the search results table, the search feature will execute a new search based on the changed content of the Search field.

3. To return to the search results table, click the Search icon again.

User interface standards for field labels

On BMC Remedy ITSM forms, field labels provide data entry hints.

Table 13 on page 83 lists the significance of field-label formats and special characters.

Table 13: Significance of field labels for data entry

<table>
<thead>
<tr>
<th>Field-label format or special characters</th>
<th>Significance for data entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold label followed by an asterisk (*)</td>
<td>Field is required to submit and update the form. <strong>Note:</strong> If you leave the field blank when you attempt to submit the form, the field is highlighted with a red border.</td>
</tr>
<tr>
<td>Field label not bolded</td>
<td>Field is optional.</td>
</tr>
<tr>
<td>Italicized label</td>
<td>System-generated value for this field. Typically this field is read-only for the user.</td>
</tr>
</tbody>
</table>
Field-label format or special characters | Significance for data entry
--- | ---
Label followed by a plus sign (+) | Additional functionality is associated with this field. Typically, you access this functionality by pressing **Enter**. For example, you might press **Enter** in a field to access a search dialog box or to perform a search based on the value typed into the field. If a field label followed by a plus sign is also bolded, the field is required. Otherwise, the field is optional.

## Icons used in the interface

This table describes the icons used on the consoles and in the Best Practice view of the application interface.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Detail icon" /></td>
<td><strong>Detail</strong> — Displays detailed information about the field's content. For example, if you click the Detail icon associated with the Customer field, the People form appears with information about the customer whose name appears in the field.</td>
</tr>
<tr>
<td><img src="image" alt="Search icon" /></td>
<td><strong>Search</strong> — Searches for field contents. This icon is associated with fields that have the ability to open a search dialog box or form.</td>
</tr>
<tr>
<td><img src="image" alt="Explore CI icon" /></td>
<td><strong>Explore CI</strong> — Opens the BMC Atrium Explorer for the CIs selected in the <strong>Service</strong> and <strong>CI</strong> fields.</td>
</tr>
<tr>
<td><img src="image" alt="Clear field contents icon" /></td>
<td><strong>Clear field contents</strong> — Clears the contents of the field and allows you to make another selection. It does not delete the record.</td>
</tr>
</tbody>
</table>

## Change Management Console functional areas

The Change Management Console provides a dedicated workspace for managing change requests. This console enables change managers and change coordinators to use BMC Remedy Change Management to plan their days more effectively.
The roles of change manager and change coordinator display the same console, but with different options. The change management console optimizes your visual work space so that you can track changes quickly and efficiently. For more information, see:

- Using the Change Management Console as a change manager on page 113
- Using the Change Management Console as a change coordinator on page 211

**Change Management Console**

Various functions are available in the Change Management Console depending on your permissions. These functions provide quick ways to go to different areas in BMC Remedy Change Management and to perform other functions.

Table 15 on page 85 describes what you can do in each of the functional areas.

### Table 15: Change Management Console functional areas

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Console tab</td>
<td>Displays changes and tasks.</td>
</tr>
</tbody>
</table>
## Functional area | Purpose
--- | ---
**Change Management Console header**

**Search** | The Global search feature lets you search across multiple forms for records that match a key term.

**Show** | This area contains the following fields: Show, Filter By, and Search. These fields combine to provide a way that you can filter the change records in the Changes table.

**Filter By** | The **Show** field has a menu from which you select the basic criteria by which you want to filter the contents of the Change table, the menu choices include:

- **Submitted by me** - All change requests created by you.
- **All** - All change requests, regardless of who created them.
- **Assigned to me** - All change requests assigned to you.
- **Assigned to my group** - All change requests assigned to a specific support group of which you are a member. If you select this, you are prompted to select the support group.
- **Assigned to all my groups** - All change requests assigned to all of the support groups of which you are a member.

**Magnifying glass icon** | The **Filter By** field places conditions on the basic criteria that you choose in the Show field. This helps you manage the number of records returned by the Show field. If you select Assigned to me in the Show field and All Open > All Priorities from the Filter By field, then the Changes table contains all open change records, regardless of their priority, that are assigned to you.

**More filters** | The **Magnifying glass icon** opens a dialog box from which you can edit, save, and delete custom searches. Saved custom searches appear in the My Searches node of the Defined Searches list. For more information about Manage My Searches, see "Creating a custom search," later in this guide.

**Refresh icon** | Updates the console with the latest information.

**Navigation pane**
<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| View Broadcast, or New Broadcast | Click this link to open the broadcast dialog box, from where you can view, create, modify, and delete broadcasts.  
When there are unread broadcast messages, this area displays the icon followed by the number of new messages.  
For more information on broadcasting messages, see Broadcasting messages on page 402. |
| Counts              | Displays Open, Waiting Approval, In Progress, and Pending metrics that are calculated when the console opens.  
**Note:** The count of Open requests and the actual number of requests displayed in the Changes table may vary because change requests with Draft status are also displayed in the change table when viewing Open requests. However, when calculating the total count of Open records, the number of change requests with status Draft are not included. |
<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functions</td>
<td>Use the links in this area to do the following actions:</td>
</tr>
<tr>
<td>- New Change</td>
<td>Opens the Change form in New mode. For information, see</td>
</tr>
<tr>
<td></td>
<td>* Initiate stage - Creating change requests on page 113.</td>
</tr>
<tr>
<td>- Search Change</td>
<td>Opens the Change form in Search mode. You enter search</td>
</tr>
<tr>
<td></td>
<td>criteria into the fields, and then click Search. For more information,</td>
</tr>
<tr>
<td></td>
<td>* Searching for records on page 408.</td>
</tr>
<tr>
<td>- My Profile</td>
<td>Lets you set your profile. For more information, see</td>
</tr>
<tr>
<td></td>
<td>* Viewing your profile on page 393.</td>
</tr>
<tr>
<td>- Application</td>
<td>Preferences - Lets you set your application preferences and</td>
</tr>
<tr>
<td>Preferences</td>
<td>options. This function is also available from the BMC Remedy Change</td>
</tr>
<tr>
<td></td>
<td>Management console. For more information, see</td>
</tr>
<tr>
<td></td>
<td>* Setting application preferences and options on page 389.</td>
</tr>
<tr>
<td>- Reminders</td>
<td>Opens the Reminders dialog box. For information, see</td>
</tr>
<tr>
<td></td>
<td>* Using Reminders on page 398.</td>
</tr>
<tr>
<td>- Reports</td>
<td>Opens the Reporting Console. For information, see</td>
</tr>
<tr>
<td></td>
<td>* “Working with reports” on page 411.</td>
</tr>
</tbody>
</table>

If you are logged on as a Change Manager, the following additional options are displayed:

- Configuration Manager - Opens BMC Configuration Manager console (if the integration is enabled). For more information, see *Using the Configuration Manager on page 438.*

- Surveys - Lets you select a survey. To enable surveys, they must defined for your company and the option must be selected.

- KPIs - Displays the KPI flashboards available. Select to view the KPI dashboard. The dashboards that appear represent, in graphical format:
  - **Total Open Changes** - Filters by Priority, Categorization, or Impact.
  - **Changes Pending** - Filters by Categorization.
  - **Change Risk** - Filters by Categorization, Impact, or Support Group.
## Functional area | Purpose
--- | ---
**Advanced Functions** | Use the links in this area to do the following actions:

- **Manage CIs** - For information, see Managing configuration items on page 453.

- **Manage Inventory** - Opens the Inventory Management screen, if you have Asset Management application. For information, see “Managing inventory locations” on page 436.

- **View Calendar** - Opens the calendar. For information, see Using the Change Calendar on page 194.

- **Time Segments** - Search, select, or create the following time segments:
  - Create Business Event
  - Modify Business Event
  - Create Op. Category Location
  - Modify Op. Category Location
  - Configuration Item (CI)
    For more information, see Registering time segments on page 157.

- **Atrium Impact Simulator** - Opens Atrium Impact Simulator. For more information, see Atrium Impact Simulator analysis for change requests on page 134.

**Applications** | This area contains links to other BMC applications, consoles, and modules. The contents of this area depend on what other applications and so on are installed. Click the double greater-than sign to open or close this panel.

**Changes table** | The Changes table displays high-level details about the change records that match the criteria specified in the Company and Assigned To fields, or that were found by the most recently completed search. The CRQ prefix identifies the change requests. You can filter the requests in the table by using the Show and Filter By fields.

**Create** | Opens the New Change form so you can create a new change request record.

**View** | Opens the change request record selected in the table.

**Print** | Displays the details of the change request record selected in the table as a report.

**Process Overview** | Opens the detailed SMPM change management process diagram, if the full SMPM application is installed. Otherwise, it opens a high-level diagram of the change management process.
## Change Management Console functional areas

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays details or related tasks of the record selected in the Changes table.</td>
<td></td>
</tr>
</tbody>
</table>
| **Change Details** | When selected, contains detailed read-only information about the record selected in the Changes table. To see Details when the Tasks table is showing, click **Show Details**.  
You can add notes to the Notes section from the Change Management Console. |
| **Work Info** | Shows activity associated with the change.  
The Work Info area enables change coordinators to view or define actions performed or information gathered about a change request. For example, you can define a work information entry that documents the installation and back-out procedures for a change.  
You can perform the following actions in this area:  
- **Create** - Create a new activity  
- **View** - Displays details of the selected activity  
- **Report** - Displays a report of the Change Work Info history |
| **Show Tasks** | When selected, lets you view tasks associated with the record that is selected in the Changes table. To see Tasks when Details is showing, click **Show Tasks**. |

## Tooltip data shown in consoles

To reduce the clutter on the Consoles, tooltips in the Change Management and Release Management Consoles display additional data that is not directly available to users. Point your mouse over the Change ID or Release ID, and the tooltip appears. Tooltips display the Change or Release ID, Impact, Priority, and so on.
Company and Console View

The Company and Console View shows changes that are assigned to you or to the support groups you belong to.

- The Company field is typically left blank if you support only one company. If you support multiple companies and you wish to view only the tickets for one company, select the appropriate company from the attached menu. Otherwise, you will view all tickets for all companies you support.

- The Console View provides options to look at work assigned specifically to you or to your support groups. When you select an option, a search is performed.

You can change the table by using the Company and Console Views at the upper right corner of the console. Select the following options to filter out which requests you see.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>Shows requests for a particular company. This field is especially useful in a multi-tenancy environment.</td>
</tr>
<tr>
<td>Personal</td>
<td>Shows the requests that are assigned to you.</td>
</tr>
<tr>
<td>Selected Groups</td>
<td>Shows the requests that are assigned to your support group.</td>
</tr>
<tr>
<td>All My Groups</td>
<td>Shows the requests that are assigned to all support groups that you belong to. If you belong to more than one support group, the requests for all those groups are shown.</td>
</tr>
</tbody>
</table>
You can view requests and refresh the items that appear in the table. For more information about viewing and refreshing requests, see Searching for records on page 408.

Change form functional areas

The Change form is used to request a change and track the progress from the Initiate stage to the Closed stage. This form also shows the impact that the change has on the organization. The Change form is used to relate tasks to different support groups. You can relate the change to configuration items that are being modified.
Figure 23: Change form and its functional areas (Best Practice view)

Figure 24: Change form and its functional areas (Classic view)
Before you begin creating or modifying information in the Change form, you should understand the information relationships in the different areas of this form. The Change form provides an example of the level of integration that can occur between the various modules in BMC Remedy ITSM, such as a change request that occurs due to an incident, a change to a configuration item, or a known error correction as a result of problem investigation.

**Tip**
As you work with the forms and dialog boxes, you might see a plus (+) sign included in a field label. You can type part of the information in these fields and press ENTER. If an exact match is found, the field is automatically completed. If a selection list appears, double-click the item to put in the field. Using auto-fill fields and lists is faster, more consistent, and more accurate than typing the information.

**Note**
You might see additional links in the navigation pane for applications that are installed in addition to BMC Remedy Change Management.

The Change form has the following functional areas.

**Table 16: Change form functional areas**

<table>
<thead>
<tr>
<th>Form Area</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change form header</strong></td>
<td></td>
</tr>
<tr>
<td>Breadcrumb bar</td>
<td>A navigation aid that contains links to related records that you opened from the current release record.</td>
</tr>
<tr>
<td>Breadcrumb navigation controls</td>
<td>Back button - Takes you back one link in the breadcrumb trail.</td>
</tr>
<tr>
<td></td>
<td>Forward button - Takes you forward one link in the breadcrumb trail.</td>
</tr>
<tr>
<td></td>
<td>The Forward button is only visible if you have returned to a record on the breadcrumb trail that you previously viewed.</td>
</tr>
<tr>
<td></td>
<td>Drop down menu - Contains links to all the records that you viewed from the current release record, including records that are not currently visible in breadcrumb trail.</td>
</tr>
<tr>
<td></td>
<td>Home icon - Takes you to the IT Home page.</td>
</tr>
<tr>
<td><strong>Process Flow Status bar</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Click the change stages in the Process Flow Status bar to move through the change request lifecycle from the Initiate stage to the Closed stage.</td>
</tr>
<tr>
<td><strong>View Broadcasts</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Opens the View Broadcasts dialog box. For information, see Broadcasting messages on page 402.</td>
</tr>
<tr>
<td><strong>Navigation Pane</strong></td>
<td></td>
</tr>
<tr>
<td>Form Area</td>
<td>Function</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quick Action</td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Broadcast Change</strong>—To broadcast the current change, you must have a</td>
</tr>
<tr>
<td></td>
<td>Broadcast Submitter functional role. For information, see <em>Broadcasting</em></td>
</tr>
<tr>
<td></td>
<td>messages on page 402.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Impact Simulator</strong>—Opens Atrium Impact Simulator. For more information,</td>
</tr>
<tr>
<td></td>
<td>see <em>Atrium Impact Simulator analysis for change requests</em> on page 134.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Create Relationship to</strong>—Opens the search dialog to search for existing</td>
</tr>
<tr>
<td></td>
<td>CIs and to other modules inside BMC Remedy Change Management and creates</td>
</tr>
<tr>
<td></td>
<td>a relationship to the current change request. For more information, see</td>
</tr>
<tr>
<td></td>
<td>“Defining relationships” on page 231.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Create Related Request</strong>—Creates and relates Change, Release, Incidents,</td>
</tr>
<tr>
<td></td>
<td>Problems and Known Errors. Opens the selected application form with</td>
</tr>
<tr>
<td></td>
<td>relevant details from the change record copied to the new record.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Process Overview</strong>—Opens the detailed SMMP change management process</td>
</tr>
<tr>
<td></td>
<td>diagram, if the full SMMP application is installed. Otherwise, it opens a</td>
</tr>
<tr>
<td></td>
<td>high-level diagram of the change management process.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Select Operational</strong>—Opens the Operational Catalog Listing dialog box.</td>
</tr>
<tr>
<td></td>
<td>You can search for an operational categorization to fill the Operational</td>
</tr>
<tr>
<td></td>
<td>Categorization fields of the change (in the Classification tab).</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Select Product</strong>—Opens the Product Selection dialog box. You can search</td>
</tr>
<tr>
<td></td>
<td>for a product categorization to fill the Product Categorization fields of</td>
</tr>
<tr>
<td></td>
<td>the change (in the Classification tab).</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Requested For</strong>—Opens the Requested for dialog, where you can update</td>
</tr>
<tr>
<td></td>
<td>details related to the customer company and user for whom the request was</td>
</tr>
<tr>
<td></td>
<td>created. For more information, see “Adding Requester information” on page</td>
</tr>
<tr>
<td></td>
<td>124.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>View Calendar</strong>—Opens the Change Calendar. For information, see <em>Using</em></td>
</tr>
<tr>
<td></td>
<td>the Change Calendar on page 194.</td>
</tr>
<tr>
<td>Form Area</td>
<td>Function</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Links</strong></td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td>■ <strong>Financials</strong> — Opens the Financials dialog box where you can add costing related information. For more information, see “Working with costs” on page 183.  &lt;br&gt;<strong>Note:</strong> This option is not available when you are creating the change.</td>
<td></td>
</tr>
<tr>
<td>■ <strong>Impacted Areas</strong> — Opens Impacted Areas Update dialog box. For more information, see Viewing affected areas on page 182.</td>
<td></td>
</tr>
<tr>
<td>■ <strong>Categorizations</strong> — Opens the Change Categorization dialog box. For more information, see “Adding classification information” on page 126.</td>
<td></td>
</tr>
<tr>
<td>■ <strong>View Audit Log</strong> — For information, see Viewing the audit log on page 181.  &lt;br&gt;<strong>Note:</strong> This option is not available when you are creating the change.</td>
<td></td>
</tr>
<tr>
<td>■ <strong>View Risk Report</strong> — Opens Risk Report. For information, see Review and Authorize stage - Risk and impact analysis on page 139.  &lt;br&gt;<strong>Note:</strong> This option is not available when you are creating the change.</td>
<td></td>
</tr>
<tr>
<td><strong>Functions</strong></td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td>■ <strong>Copy Change</strong> — Activated only in Modify mode. For information, see Copying change requests on page 431.</td>
<td></td>
</tr>
<tr>
<td>■ <strong>Email System</strong> — For information, see Sending email on page 406.</td>
<td></td>
</tr>
<tr>
<td>■ <strong>Reminders</strong> — For information, see Using Reminders on page 398.  &lt;br&gt;<strong>Note:</strong> This option is not available when you are creating the change.</td>
<td></td>
</tr>
</tbody>
</table>
### Advanced Functions

Performs the following specialized actions:

- **Advanced Search** — Opens Advanced Search Selection dialog box. You can search for release requests by related work information or related relationships. For a complete list, see Searching for records on page 408.

- **Collision Detection** — Determines if there are other change requests scheduled to work on the same CI during the same blackout schedule. For information, see “Detecting CI collisions between change requests” on page 176.

  **Note:** This option is not available when you are creating the change.

- **Modify Business Events** — Searches, selects, modifies, and deletes business events. For information, see Registering unique business events and operational categorizations on page 158.

- **Modify Operational Category Location** — Searches, selects, modifies, and deletes operational category locations. For information, see Performing additional time segment functions for business events and operational categories on page 161.

- **Time Segments** — Searches, selects, and creates the following time segments:
  - Business Event — For information, see Registering unique business events and operational categorizations on page 158.
  - Operational Category Location — For information, see Registering unique business events and operational categorizations on page 158.
  - Configuration Item (CI) — For information, see Registering time segments for CIs - Creating a blackout schedule on page 164.

### Other functionality

**Note:** These options are enabled only when applicable.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves the form contents.</td>
</tr>
<tr>
<td>Next Stage</td>
<td>Moves the change to the next logical stage.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays a report of the form contents that can be printed.</td>
</tr>
</tbody>
</table>
Using the Release Management Console and the Release form

This section contains information about getting started with Release Management, including using the Release Management Console.

The following sections described for Change Management Console are also applicable to the Release Management Console:

- “About the IT Home Page” on page 75
- “Configuring the IT Home Page” on page 78
- “Navigating consoles, forms, and modules” on page 79
- “Using Global search” on page 82
- “User interface standards for field labels” on page 83
- “Icons used in the interface” on page 84

Release Management Console functional areas

The Release Management Console provides a dedicated workspace for managing release requests. This console provides quick access to the information you need and to the procedures that you perform most often. This console optimizes your visual work space so that you can track releases quickly and efficiently. Figure 25 on page 100 illustrates the functional areas of the Release console.
The Release Management Console lets you see the most important details associated with release requests (for example, change requests and activities linked to releases, tasks allocated to release requests, work information, and important broadcasts). It is designed to give you quick access to the information and procedures that you need daily so that you do not have to open other BMC Remedy ITSM applications. Finally, if you point your cursor over the Release ID, tooltip information is displayed. (For more information, see Tooltip data shown in consoles on page 90.)

Table 17 on page 100 describes what you can do in each of the functional areas.

Table 17: Release console functional areas

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Console tab</td>
<td>Displays releases and related changes and activities.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Release Management Console header</td>
<td></td>
</tr>
<tr>
<td>Search</td>
<td>The Global search feature lets you search across multiple forms for records that match a key term.</td>
</tr>
</tbody>
</table>
### Functional area

| Show             | This area contains the following fields: Show, Filter By and Search. These fields combine to provide a way that you can filter the release records in the Releases table. The Show field has a menu from which you select the basic criteria by which you want to filter the contents of the Releases table, the menu choices include: Submitted by me - All release requests created by you. All - All release requests, regardless of who created them. Assigned to me - All release requests assigned to you. Assigned to my group - All release requests assigned to a specific support group of which you are a member. If you select this, you are prompted to select the support group. Assigned to all my groups - All release requests assigned to all of the support groups of which you are a member. The Filter By field places conditions on the basic criteria that you choose in the Show field. This helps you manage the number of records returned by the Show field. If you select Assigned to me in the Show field and All Open > All Priorities from the Filter By field, then the Releases table contains all open release records, regardless of their priority, that are assigned to you. The Magnifying glass icon opens a dialog box from which you can edit, save, and delete custom searches. Saved custom searches appear in the My Searches node of the Defined Searches list. For more information about Manage My Searches, see "Creating a custom search," later in this guide. More filters provides a way for you to further filter the contents of the Releases table. If you still have a large number of records after using the Filter By field, click Advanced to open a dialog box that contains fields in which you can indicate even more precise information, such as product or operational categories. For example, using the advanced field you can add the product category Hardware to the filter. When added to the Show and Filter by fields, the Releases table now contains all open hardware releases, regardless of their priority, that are assigned to you. A checkbox appears in the More filters label to indicate when a filter from this area is active. |
| Filter By        | |
| Magnifying glass icon | |
| More filters     | |

| Refresh icon     | Updates the console with the latest information. |

### Navigation pane

| View Broadcast, or New Broadcast | Click this link to open the broadcast dialog box, from where you can view, create, modify, and delete broadcasts. When there are unread broadcast messages, this area displays the icon followed by the number of new messages and the message New Broadcast. When there are new broadcast messages, the area also turns red. For more information on broadcasting messages, see Broadcasting messages on page 402. **Note:** If you open the Release Management console with no new broadcast messages, but the View Broadcast link is red, open the Application Preferences dialog box and make sure that a Console View preference has been selected. See Viewing your profile on page 393 for information about how to view and select Console View preferences. |

---

**Chapter 4  Using the Release Management Console and the Release form** 101
<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Milestones</td>
<td>Displays Plan, Build, Test, and Deploy milestone metrics that are calculated when the console opens.</td>
</tr>
<tr>
<td>Functions</td>
<td>Use the links in this area to do the following actions:</td>
</tr>
<tr>
<td></td>
<td>- <strong>New Release</strong> — Opens the Release form in New mode. For information, see <a href="#">Initiate milestone - Creating release requests on page 276</a>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Search Release</strong> — Opens the Release form in Search mode. For more information, see <a href="#">Searching for records on page 408</a>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>My Profile</strong> — Sets your personal profile. See <a href="#">Viewing your profile on page 393</a>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Application Preferences</strong> — Sets your program preferences and options. This function is also available from the Release Management console. See “Setting application preferences - Release Management” on page 440.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Reminders</strong> — Opens the Reminders dialog box. For information, see <a href="#">Using Reminders on page 398</a>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Reports</strong> — Opens the Reporting Console. For information, see “Working with reports” on page 411.</td>
</tr>
<tr>
<td></td>
<td>- <strong>KPIs</strong> - Displays the KPI flashboards available. Select to view flashboards. The flashboards that appear represent, in graphical format:</td>
</tr>
<tr>
<td></td>
<td>- Process KPIs - View KPI flashboards</td>
</tr>
<tr>
<td></td>
<td>- Total Open Releases — Filters by Service or Priority</td>
</tr>
<tr>
<td></td>
<td>- Total Pending Approval — Filters by Service, Impact, or Business Justification</td>
</tr>
<tr>
<td></td>
<td>- Total By Risk — Filters by Service, Impact, or Milestone</td>
</tr>
<tr>
<td>Functional area</td>
<td>Purpose</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Advanced Functions</td>
<td>Use the links in this area to do the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>View Calendar</strong> — Opens the calendar. For information, see Using the Change Calendar on page 194.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Time Segments</strong> — Create, modify, or search the following time segments:</td>
</tr>
<tr>
<td></td>
<td>— Business Event</td>
</tr>
<tr>
<td></td>
<td>— Operational Category Location</td>
</tr>
<tr>
<td></td>
<td>— Configuration Item (CI)</td>
</tr>
<tr>
<td></td>
<td>For information, see Registering time segments on page 157.</td>
</tr>
<tr>
<td>Applications</td>
<td>This area contains links to other BMC applications, consoles, and modules. The contents of this area depend on what other applications and so on are installed. Click the double greater-than sign to open or close this panel.</td>
</tr>
<tr>
<td>Releases table</td>
<td>The Releases table displays high-level details about the release records that match the criteria specified in the Company and Assigned To fields, or that were found by the most recently completed search. The RLM prefix identifies the release requests. You can filter the requests in the table by using the Show and Filter By fields.</td>
</tr>
<tr>
<td>Create</td>
<td>Opens the New Release form so you can create a new release request record.</td>
</tr>
<tr>
<td>View</td>
<td>Opens the release request record selected in the Releases table.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the details of the release request record selected in the Releases table.</td>
</tr>
<tr>
<td>Process Overview</td>
<td>Opens the detailed SMPM release management process diagram, if the full SMPM application is installed. Otherwise, it opens a high-level diagram of the release management process.</td>
</tr>
<tr>
<td>Show Details/Hide Details</td>
<td>When selected, displays the work information table with details about the record selected in the Releases table. It also displays the Create and View links to create or view release activities from the Release Management Console. For more information, see the section on Recording Release Activities.</td>
</tr>
<tr>
<td>Changes and Activities</td>
<td></td>
</tr>
<tr>
<td>Create</td>
<td>Opens the New Change or Activity form so you can create a new record.</td>
</tr>
<tr>
<td>View</td>
<td>Opens the record selected in the Releases table.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays details of the release request record selected in the Releases table as a report.</td>
</tr>
<tr>
<td>Show Details/Hide Details</td>
<td>Displays the work information and tasks table with records selected in the Changes and Activities table. You can create or view release work information on the Work Info tab. You can view tasks on the Tasks tab.</td>
</tr>
</tbody>
</table>
Release form functional areas

The Release form is used to request a release and track the progress from initiation to completion. This form also shows the impact that the release has on the organization. The Release form is used to assign tasks to different support groups, and you can associate the release to configuration items that are being modified.
Figure 26: Release form and its functional areas (Best Practice view)

Figure 27: Release form and its functional areas (Classic view)
Before you begin searching, creating, or modifying information in the Release form, you must understand the information relationships involved in the different areas of this form.

First, you must create assignment mappings to assign a release to a Release Management support group, to an individual, or to both. An individual in the Release Management group must assume the role of Release Coordinator. For information about functional roles and assignment mappings, see the BMC Remedy IT Service Management Configuration Guide.

The Release form provides an excellent example of the level of integration that can occur between the various modules available among the BMC Remedy ITSM suite as a release request can occur due to an incident, a change to a configuration item, or a known error correction as a result of problem investigation.

**Note**
You might see additional links appear in the navigation pane for applications that are installed in addition to BMC Remedy Change Management.

The Release form has the following functional areas.

Table 18: Release form functional areas

<table>
<thead>
<tr>
<th>Form Area</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release form header</td>
<td></td>
</tr>
<tr>
<td>Breadcrumb bar</td>
<td>A navigation aid that contains links to related records that you opened from the current release record.</td>
</tr>
<tr>
<td>Breadcrumb navigation controls</td>
<td>Back button - Takes you back one link in the breadcrumb trail. Forward button - Takes you forward one link in the breadcrumb trail. The Forward button is only visible if you have returned to a record on the breadcrumb trail that you previously viewed. Drop down menu - Contains links to all the records that you viewed from the current release record, including records that are not currently visible in breadcrumb trail. Home icon - Takes you to the IT Home page.</td>
</tr>
<tr>
<td>Process Flow Status bar</td>
<td>Click the milestones in the Process Flow Status bar to steps you through the release request lifecycle from the Initiate milestone to the Close Down milestone.</td>
</tr>
<tr>
<td>View Broadcasts</td>
<td>Opens the View Broadcasts dialog box. For information, see Broadcasting messages on page 402.</td>
</tr>
<tr>
<td>Navigation Pane</td>
<td></td>
</tr>
<tr>
<td>Form Area</td>
<td>Function</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quick Action</td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Broadcast Release</strong>— To broadcast the current release, you must have a Broadcast Submitter functional role. For information, see Broadcasting messages on page 402.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Create Relationship to</strong>— Opens the search dialog to search for existing CIs and to other modules inside BMC Remedy Change Management and creates a relationship to the current release request. For more information, see “Defining relationships” on page 231.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Create Related Request</strong>— Creates and relates Change, Release, Incidents, Problems and Known Errors. Opens the selected application form with relevant details from the release record copied to the new record.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Process Overview</strong>— Opens the detailed SMPM release management process diagram, if the full SMPM application is installed. Otherwise, it opens a high-level diagram of the release management process.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Select Operational</strong>— Opens the Operational Catalog Listing dialog box. You can search for an operational categorization to fill the Operational Categorization fields of the release (on the Classification tab when using the Classic view).</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Select Product</strong>— Opens the Product Selection dialog box. You can search for a product categorization to fill the Product Categorization fields of the release (on the Classification tab when using the Classic view).</td>
</tr>
<tr>
<td></td>
<td>■ <strong>View Calendar</strong>— Opens the Change Calendar. For information, see Using the Change Calendar on page 194.</td>
</tr>
<tr>
<td>Links</td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Categorizations</strong>— Opens the Categorization dialog box. For more information, see “Specifying the business justification” on page 286.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>View Audit Log</strong>— For information, see Viewing the audit log on page 181. Note: This option is not available when you are creating the release request.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Financials</strong>— Opens the Financials dialog box where you can add costing related information. For more information, see “Working with costs” on page 183. Note: This option is not available when you are creating the release request.</td>
</tr>
<tr>
<td>Form Area</td>
<td>Function</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Functions</strong></td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Copy Release</strong> — Activated only in Modify mode.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Email System</strong> — For information, see Sending email on page 406.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Reminders</strong> — For information, see Using Reminders on page 398.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Performs the following specialized actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Collision Detection</strong> — Determines if there are other requests scheduled to work on the same CI during the same blackout schedule. For information, see Detecting CI collisions between change requests on page 176.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Modify Business Events</strong> Searches, selects, modifies, and deletes business events. For information, see Registering unique business events and operational categorizations on page 158.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Time Segments</strong> — Searches, selects, and creates the following time segments:</td>
</tr>
<tr>
<td></td>
<td>– <strong>Business Event</strong> — For information, see Registering unique business events and operational categorizations on page 158.</td>
</tr>
<tr>
<td></td>
<td>– <strong>Configuration Item (CI)</strong> — For information, see Registering time segments for CIs - Creating a blackout schedule on page 164.</td>
</tr>
<tr>
<td><strong>Consoles</strong></td>
<td>Opens other installed BMC Remedy IT Service Management consoles.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Overview</strong> — Opens the Overview Console. For information, see Working with the Overview console on page 465.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Release Management</strong> — Opens the Release Management Console.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Reports</strong> — Opens the Reporting console. For information, see “Working with reports” on page 411.</td>
</tr>
<tr>
<td><strong>Other functionality</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>These options are enabled only when applicable.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the form contents.</td>
</tr>
<tr>
<td><strong>Next Stage</strong></td>
<td>Moves the release to the next logical milestone.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Displays a report of the form contents that can be printed.</td>
</tr>
</tbody>
</table>
Activity form functional areas

Release Management provides basic facilities for assignment, status, work information, and task management. The Activity form is used to manage a release and track its progress from initiation to completion. The Activity form is also used to assign tasks to different support groups.

**Figure 28: Release Activity form**

You use the Activity form to add a set of activities to a release request. You can track release states and requester information, relate and assign tasks, and enter work log information.

For more information, see Managing release activities on page 325.

**Note**

Any other links that are displayed in the navigation pane are determined by the applications that are installed in addition to Release Management.

The Activity form has the following functional areas.

**Table 19: Activity form functional areas**

<table>
<thead>
<tr>
<th>Form Area</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation Pane</td>
<td></td>
</tr>
</tbody>
</table>
## Activity form functional areas

<table>
<thead>
<tr>
<th>Form Area</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick Links</strong></td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>View Broadcasts</strong> — Opens the View Broadcasts dialog box. For more information, see Broadcasting messages on page 402.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Select Template</strong> — Selects any templates made available for your support group. For information, see Selecting activity templates on page 450.</td>
</tr>
<tr>
<td><strong>Functions</strong></td>
<td>Performs the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Reminders</strong> — For information, see Using Reminders on page 398.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Paging System</strong> — For information, see Sending pages and email messages on page 406.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>View Audit Log</strong> — For information, see Viewing the audit log on page 181. Note: This option is not available when you are creating the activity.</td>
</tr>
<tr>
<td><strong>Consoles</strong></td>
<td>Opens other installed BMC Remedy IT Service Management consoles.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Release Console</strong> — Opens the Release Management Console.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Reports</strong> — Opens the Reporting console. For information, see “Working with reports” on page 411.</td>
</tr>
</tbody>
</table>

**Other functionality**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save</strong></td>
<td>Saves the form contents.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Displays a report of the form contents that can be printed.</td>
</tr>
</tbody>
</table>
Change Manager role

This section describes how change managers can use the BMC Remedy Change Management application to monitor issues pertaining to the daily aspects of change management activities and how they can help their staff meet their commitments to the organizations that they support.

Working as a change manager

The change manager is a person or a group usually within an organization’s support department. The change manager is responsible for the quality and integrity of the change management process. In large companies, the change manager’s main responsibilities usually involve planning and oversight. In small companies, however, the change manager can function as the change coordinator who is performing the change. To be the change manager, a user must have the Infrastructure Change Manager functional role in BMC Remedy Change Management.

The change manager requires the following permissions and functional roles:

- The Infrastructure Change User or Change Master application permission is required for access to change and task records.
- Infrastructure Change Manager functional role is required to be assigned as the change manager for individual changes.
- Membership in a company’s support group is required to create change templates for that group.

**Note**

To understand the overall change request process, change managers should also read Change coordinator role on page 207.

Typical change manager activities include handling assignments and monitoring support staff activity involved in implementing the change request. Even though change managers have the same permissions as support staff and can do the same
procedures in BMC Remedy Change Management, they usually do not perform support staff activities.

The typical responsibilities of a change manager are describe in Table 20 on page 112.

**Table 20: Change manager responsibilities**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a change request</td>
<td>Anyone can create a change request by using the Requester Console. Usually, a change manager creates change requests in BMC Remedy Change Management. For more information, see Initiate stage - Creating change requests on page 113.</td>
</tr>
<tr>
<td>Accepting a change request</td>
<td>When the change request is created it must be assigned to a change manager. If the assignment engine is configured for automatic assignments it is automatically assigned to the appropriate change manager, based on an organization’s support staff grouping and the change request’s categorization. The change manager is notified of assigned changes. The change manager can choose to view all assigned change requests when logging in to Change Management Console. For more information, see Working with change request assignments on page 211.</td>
</tr>
<tr>
<td>Planning and scheduling a change request</td>
<td>Planning activities include:</td>
</tr>
<tr>
<td></td>
<td>■ Scheduling the change request</td>
</tr>
<tr>
<td></td>
<td>■ Identifying, defining, and sequencing tasks that must be performed to accomplish the change</td>
</tr>
<tr>
<td></td>
<td>■ Determining the impact by assessing the different kinds of risks</td>
</tr>
<tr>
<td></td>
<td>■ Creating plans</td>
</tr>
<tr>
<td></td>
<td>■ Scheduling people and resources to implement each task</td>
</tr>
<tr>
<td></td>
<td>■ Estimating the costs of the change request</td>
</tr>
<tr>
<td></td>
<td>For more information, see Working with relationships on page 220.</td>
</tr>
<tr>
<td>Submitting a change request for approval</td>
<td>An organization’s business rules determine whether a change request requires approval. The application administrator configures the approval process to determine which approval phases are available for the change request. If appropriate, the change manager can designate ad hoc approvers for emergency change approvals. After the request is approved, the change manager updates the request’s status to Scheduled by moving to the next stage on the Process Flow bar. The change manager can assign the tasks to the appropriate task implementers manually, or they can be assigned automatically. For more information about submitting the change for approval, see Approvals - Approving change requests on page 144.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Logging and tracking a change request</td>
<td>The change manager can track a request’s progress as task implementers fulfill their assignments. For more information, see Tracking efforts for a change request on page 217 and Responding to task reassignments as a change coordinator on page 272.</td>
</tr>
<tr>
<td>Assessing the cost of a change request</td>
<td>The coordinator can assess the cost of a change request and charge accordingly. For more information, see Working with costs on page 183.</td>
</tr>
<tr>
<td>Resolving change requests</td>
<td>A change request is resolved when all the tasks are closed or cancelled. For more information, see Closed stage - Completing change requests on page 153.</td>
</tr>
</tbody>
</table>

The change manager is also typically responsible for addressing general, day-to-day issues from a personnel and customer satisfaction standpoint.

### Using the Change Management Console as a change manager

The Change Management Console is the primary interface for change managers. It provides quick access to the information you need and to the procedures that you perform most often. This console is designed for change managers who work with BMC Remedy Change Management daily and do not want to view other BMC Remedy ITSM applications.

For more information, see Change Management Console functional areas on page 84.

### Initiate stage - Creating change requests

Changes start at the Initiate stage of the change request lifecycle. Most change requests are generated from a incident, problem investigation, an RFC proposed by Problem Management, or a known error. When change requests are generated by any of these records, some information is copied from the record. For example, when a change request is generated from an incident, the Description, Impact and Urgency, and the Product and Service Categorization fields are copied to the change request. The Requester Information defaults to the user initiating the change request.
In addition, BMC Remedy Change Management enables any user with Change Submit permissions to enter change requests. Change managers (and change coordinators) can enter and resolve change requests quickly with the option to define and relate items before saving the change request.

How you create a change request depends on which view of the BMC Remedy Change Management application you use, Classic View or Best Practice View.

Creating a change request at the initiate stage—Best Practice view

The section describes how to create a change request at the Initiate stage when using the Best Practice view of BMC Remedy Change Management.

To create a change request

1. On the Management Console of BMC Remedy Change Management, click Create to open the Change form.

   The Change ID field is automatically filled with an ID number for the change request.

   In the Initiate stage, the change request initially appears in Draft status. The change request has not yet been submitted to the Change Management process.

2. Use the following fields to specify the change coordinator:
Coordinator Group

Specify the group of people with the Infrastructure Change Coordinator functional role. This list is populated with groups that have at least one user with a Infrastructure Change Coordinator functional role.

Change Coordinator

Specify the user responsible for the change. The list is populated with people with the Change Coordinator functional role and who are included in the Coordinator Group selected.

3 From the Service field, select the business service configuration item (CI) that relates to the change request that you are creating.

The Service field relates business service configuration items (CIs) to the change request at the time it is created. Business service CIs are related either to the customer directly or to the customer’s company, organization, or department.

Note

The business service CI is not a physical CI (such as a printer or a router); it is a logical CI. In this context, a logical CI is a business service that can be provided from one business, or organization within a business, to another. Service CIs can include customer support, employee provisioning, web farms, storage, and so on. When business service CIs are created and made available on the Service field menu, they are related either to a customer directly or to the customer’s company, organization, or department. If you need to have a new business service CI added to the Service field menu, you must notify a system administrator with Asset Administrator privileges.

4 (optional) Select a template to complete part of the change request.

Change templates are especially useful in any change request that follows well-defined methods for specific and repeated requirements.

The template is attached to the change request. The custom process flow associated with the change template applies to the change request. A new Work Info record is created that includes a textual representation of the change process flow. In the process flow bar, the options for next and back are changed to reflect the process flow.
Note

If you start to enter fields in the change request and then select a change template, the change template overwrites any field values that are already present in the change request. Any relationships or tasks included with the change request are not overwritten. Any additional tasks from the template are added as peers, and additional relationships (for example, CIs) are included with the change request.

5 (optional) Enter a date in the Target Date field.

The target date is the date by when the change must be completed, according to the applicable service level target. Alternatively, the target date can be a date that is agreed to on an ad hoc basis, per change.

6 Complete the following fields:

Summary

Provide a brief description of the change.

Class

Specify the relative urgency of the change, so that the approvers can assess its magnitude.

You have the following options:

- **Standard** indicates a change (for example, a computer upgrade) that is typically pre-approved and requires only approval by the change manager. Standard changes follow the out-of-box change process defined as per ITIL specifications.

- **Emergency** indicates a change that resolves an incident or problem deemed critical to business continuity and for which a workaround is not sufficient.

- ** Expedited** indicates that a change has an enterprise-wide impact with an associated risk. If you select **Expedited**, you must also select the **Timing Reason** (for example, Known error correction).

- ** Latent** indicates a change that has already been performed (for example, if a task implementer is assigned to replace the hard drive on a computer and then decides to upgrade the memory while the computer is open). Latent timing automatically sets the request status to Completed after you save the change request.

- ** Normal** indicates a standard change that is typically pre-approved and requires only approval by the change manager. The default value is Normal.
No Impact indicates a change that has no impact on the infrastructure and requires no approval.

By default, No Impact changes follow the Business Approval - No Impact phase and move forward to the Scheduled status. Use this process for pre-approved No Impact changes where the change is automatically scheduled after the approval phase is satisfied.

Impact

Specify the extent to which the change affects the business. The default value is 4-Minor/Localized. Impact is often directly related to the extent to which the service has degraded from agreed service levels. Impact can be measured by the number of people affected, the criticality of the system affected, and the loss of revenue as a result of the service degradation or disruption.

Urgency

Specify a value that indicates the importance of the change request, and reflects how quickly a change must be implemented, or the time available to reduce the impact of the change on the business. The default value of the Urgency field is Low.

Use the following factors to determine Impact and Urgency:

- Number of customers affected by associated Incidents
- Duration and scope of the service disruption
- Availability of a solution or workaround
- The type of service being disrupted, usually based on the CI involved
- Awareness of the future impact on the business

Priority

Specify the importance that you (as support staff) assign to the change request.

Priority indicates the relative order in which to address the changes. It is influenced by considerations of risk and resource availability, but is primarily driven by the combination of Urgency and Impact. The default value of the Priority field is Low.

7 The system automatically performs the risk assessment for the change request in the Risk Level field.

The risk level is calculated from the entries that you make in the Impact, Urgency, and Priority fields. The risk level is used as a criterion to determine required
approvals. The default risk level is Level 1, which is the lowest level. The highest risk level is Level 5.

8 In the Initiate stage of the Process Flow Status bar, click the arrow and choose Next Stage.

9 Review the information in the Change Initiation dialog box, and then click Save. The newly created change is assigned to the appropriate group based on the predefined assignment routing.

If there is no appropriate assignment routing, you are prompted to assign the change request manually.

Creating a change request at the Initiate stage — Classic View

This section describes how to create a change request at the Initiate stage when using the Classic View of BMC Remedy Change Management.

To create a change request at the Initiate stage

1 From the IT Home Page, open the BMC Remedy Change Management application.

   For more information, see Configuring the IT Home Page on page 78.

2 On the BMC Remedy Change Management Console, click Create.

   The Change form appears with the Change ID field is automatically filled with an ID number for the change request.

   In the Initiate stage, the change request initially appears in Draft status. The change request has not yet been submitted to the Change Management process.

   **Note**

   If you create a new change from the Incident or Problem console, the change appears in Request for Authorization status because the reason for creating the change is already known. This information has been entered by the Incident or Problem before the new change is created.

3 By default, the Requested By fields are auto-populated with the details of the user who creates the change. If this user is not associated to a support group, the Support Company is set to the Location Company of the user. If this user is associated to a support group, the Support Company, Support Organization, and Support Group is set to the user's default Support Group.
You can modify the Requested By fields, if required. The Support Company field list is based on the user selected in the Last Name field of the Requested By information.

- If the selected user does not belong to the support staff group all companies are listed similar to Change Location companies.

- If the selected user belongs to the support staff group this list is restricted to his Support Group companies.

4 The Requested for fields provide details of the company and user for which the change request is created. To enter this information, search for the appropriate user based on the last name field. The Change Location can, by default, be update to the selected user's location.

**Note**

Once updated, the Requested for fields cannot be modified.

5 (optional-recommended) Select a template to complete part of the change request.

Change templates are especially useful in any change request that follows well-defined methods for specific and repeated requirements. Change templates can do more than pre-populate fields; they can also include CIs and tasks with the change request. BMC provides change templates for virtual machines that include standard tasks with the change request. For more information, see Selecting change templates on page 429.

The template is attached to the change request. The custom process flow associated with the change template applies to the change request. A new Work Info record is created that includes a textual representation of the change process flow. In the process flow bar, the options for next and back are changed to reflect the process flow.

**Note**

If you start to enter fields in the change request and then select a change template, the change template overwrites any field values that are already present in the change request. Any relationships or tasks included with the change request are not overwritten. Any additional tasks from the template are added as peers, and additional relationships (for example, CIs) are included with the change request.

6 In the Initiate stage of the Process Flow Status bar, click the arrow and choose Next Stage.

The two tabs in the Change Initiation dialog box prompt you to enter required and optional information.
Enter the following information in the Required Information tab of the Change Initiation dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Brief description of the change.</td>
</tr>
<tr>
<td>Class</td>
<td>Specifies the relative urgency of the change, so that the approvers can assess its magnitude.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Standard</strong> indicates a change (for example, a computer upgrade) that is typically pre-approved and requires only approval by the change manager. Standard changes follow the out-of-box change process defined as per ITIL specifications.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Emergency</strong> indicates a change that resolves an incident or problem deemed critical to business continuity and for which a work-around is not sufficient. For more information, see Creating emergency change requests on page 133.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Expedited</strong> indicates that a change has an enterprise-wide impact with an associated risk. If you select <strong>Expedited</strong>, you must also select the <strong>Timing Reason</strong> (for example, Known error correction). For more information, see Timing Reason under “Adding classification information” on page 126.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Latent</strong> indicates a change that has already been performed (for example, if a task implementer is assigned to replace the hard drive on a computer and then decides to upgrade the memory while the computer is open). Latent timing automatically sets the request status to Completed after you save the change request.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Normal</strong> indicates a standard change (for example, the creation of a virtual machine with standard specifications) that is typically pre-approved and requires only approval by the change manager. Normal changes do not follow the standard out of the box change process. The default value is Normal.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>No Impact</strong> indicates a change that has no impact on the infrastructure and requires no approval. By default, No Impact changes follow the Business Approval - No Impact phase and move forward to the Scheduled status. Use this process for pre-approved No Impact changes where the change is automatically scheduled after the approval phase is satisfied. For more information, see Approval processes provided out-of-the-box on page 357.</td>
</tr>
<tr>
<td>Impact</td>
<td>Reflects the extent to which the change affects the business. The default value is 4-Minor/Localized. Impact is often directly related to the extent to which the service has degraded from agreed service levels. Impact can be measured by the number of people affected, the criticality of the system affected, and the loss of revenue as a result of the service degradation or disruption.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Urgency               | Defines the importance the requester assigns to the change request and reflects how quickly a change must be implemented, or the time available to reduce the impact of the change on the business. The default value of the Urgency field is Low.  
Use the following factors to determine Impact and Urgency:  
- Number of customers affected by associated Incidents  
- Duration and scope of the service disruption  
- Availability of a solution or workaround  
- The type of service being disrupted, usually based on the CI involved  
- Awareness of the future impact on the business. |
| Priority              | Identifies the importance you (as support staff) assign to the change request. Priority indicates the relative order in which to address the changes. It is influenced by considerations of risk and resource availability, but is primarily driven by the combination of Urgency and Impact. The default value of the Priority field is Low. |
| Risk Level            | Defines the relative risk associated with the change, from 5 (highest risk) to 1 (lowest risk). The default value is Risk Level 1. The Risk Level is used as a criterion to determine required approvals.  
You can click the Risk Info icon to compute the risk level for the request. For more information, see Review and Authorize stage - Risk and impact analysis on page 139. |
| Coordinator Group     | Defines the groups of people with the Change Coordinator functional role.  
**Note:** If the user creating the change has the functional role of a Change Coordinator, the Coordinator Group, Change Coordinator, and Change location fields are auto filled with the user's details. |
| Change Coordinator    | Defines the user responsible for the change. The list is populated with people with the Change Coordinator functional role and included in the Coordinator Group selected.  
**Note:** The Change Coordinator field is found on the Assignment tab. |
| Change location       | Location of the company defined for the user requesting the change. Information for this field is related to the Requested By information provided for the change.  
**Note:** The Change location details are found on the Assignment tab of the Change form. |
### Change Type

Change Type categorizes the request according to your organization’s change type definitions. This value does not have any associated workflow.

- **Project** - Change requests that are part of larger scale changes, and usually consist of multiple change requests related to each other.
- **Change** - A simple stand-alone change activity.
- **Release** - Prior to the introduction of the Release Management module in BMC Remedy Change Management 7.5.00, this option was used to classify a change request as a release request. After a release request has been established, subsequent change records can be related as children or peer requests.
- **Asset Configuration** - Change request related to an asset configuration
- **Asset Management** - Change request related to managing an asset
- **Asset Lease** - Change request related to an asset lease
- **Asset Maintenance** - Change request related to maintenance of an asset
- **Purchase Requisition** - Change request related to a purchase requisition

Depending on which applications are installed, you might see other options.

**Note:** Asset type options only apply when BMC Remedy Asset Management is installed. It is used for integrations and workflow between BMC Remedy Asset Management and BMC Remedy Change Management applications.

### Lead Time

Defines the amount of preparation time you need prior to implementing the change. The system uses Lead Time to determine the earliest start date and time by adding the Lead Time to the Submit date. For example, if the Submit date is 5/18/2010 1:50:29 AM and you type 8 hours in the Lead Time field, the system determines that 5/18/2010 9:50:29 AM is the earliest start date.

8 Click the Optional Information tab, and then enter the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Categorization</td>
<td>Operational values are data-driven and are defined by the application administrator (for example, Tier 1 is Install, Tier 2 is Server, and Tier 3 is Hard Drive).</td>
</tr>
<tr>
<td>Product Categorization</td>
<td>Product values are data-driven and are defined by the application administrator (for example, Tier 1 is Hardware, Tier 2 is Disk Device, and Tier 3 is Disk Array).</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product Name</td>
<td>Product Name is data-driven and are defined by the application administrator (for example, Dell).</td>
</tr>
<tr>
<td>Model/Version</td>
<td>Model/Version is data-driven and are defined by the application administrator (for example, PowerEdge).</td>
</tr>
<tr>
<td>Model/Manufacturer</td>
<td>Manufacturer is the auto filled with the manufacturer defined for the selected Product.</td>
</tr>
</tbody>
</table>

9  Click **Save** on the Change Initiation dialog box to generate the change request.

   **Tip**
   After you become familiar with Change Management functionality, you can bypass the Change Initiation dialog box and enter the required information directly into the Change form.

   The Initiate Change dialog box automatically closes. You return to the New Change form, and the newly-created change is assigned to the appropriate group based on the predefined assignment routing.

   If there was no appropriate assignment routing, you must manually assign the change request. For more information, see Working with change request assignments on page 211.

   **Note**
   Most change requests must be approved before they move to the Review & Authorize stage. For more information, see Handling approvals for emergency change requests on page 366.

10 From the Service field, select the business service configuration item (CI) that relates to the change request that you are creating.

   **Note**
   This field lists the CIs created under the Logical Entity > Business Service category. The business service CI is not a physical CI (such as a printer or a router); it is a **logical** CI. In this context, a logical CI is a business service that can be provided from one business, or organization within a business, to another. Service CIs can include customer support, employee provisioning, web farms, storage, and so on. When business service CIs are created and made available to the Service field menu, they are related either to a customer directly or to the customer's company, organization, or department. If you need to have a new business service CI added to the Service field menu, you must notify a system administrator with Asset Administrator privileges.

   Selecting a business service CI automatically performs the following actions:
- Relates the business service CI to the change request as a Related to association type when the release is submitted. After it is established, you cannot remove the association created between the release request and the business service CI from the Relationships tab. However, you can select another service from the Service field when the change request is in Modify mode.

- Populates the Product Categorization of the change request based on the categorization of the business service CI. You can modify the Product Categorization values later.

### Adding Requester information

Enter additional information about the requester on the Change form as needed.

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the change request and choose Quick Actions =&gt; Requested for in the left frame of the Change form.</td>
<td>Add this information to the Requester tab displayed on the Change form.</td>
</tr>
</tbody>
</table>

**Note**
Requested for information can be modified only when the change is in the Initiate stage.

**To enter requester information using the Best Practice view**

1. Open the change request.
2. Choose Quick Actions => Requested for.
3. Enter information about the requester in the Requested For dialog box.

   The Requested For information provides details about the company, user details, organization and department for which the request has been created.

   **Note**
   The Requested By information provided in the Classic view is not available in the Best Practice view.

4. Click OK.
5. Click Save.

**To enter requester information using the Classic view**

1. Open the change request.
2 Click the Requester tab on the Change form.

3 Modify information as needed in the required fields on the Requester tab (for example, Support Company, First Name, and Last Name).

This information is supplied automatically, based on your login. The Support Company is the organization or group to which the change request is assigned.

**Tip**

Type a letter or name into fields with a plus sign (+) on the field label, and press Enter to automatically fill the field. If multiple choices exist, a selection list or dialog box appears, to help you enter a name. Otherwise, you receive a prompt if the letter or person is not found.

4 Enter information about the requester in the Requested For dialog box.

5 Enter information into the required Change Location Company field.

The Change Location Company field is especially important in a multi-tenancy environment. In this field, you can specify the company, department, or other group that controls access to the change request.

6 *(optional)* After you respond to the change requester, click the **Requester** Contacted icon.

The Requester Contacted icon is used to record if the requester has been contacted about the change request. This data is useful when service providers are organizing their work queue. If you click the Requester Contacted icon, the hidden Requester Contacted field is set to Yes when you save your changes. The Requester Contacted icon now appears in Yes mode.

If the change was generated from a service request, workflow in the BMC Remedy Change Management application sets the SLA Responded field on the Service Requests form to Yes.

**Note**

This field is applicable only if the SLM application is installed.

7 Click **Save**.
Adding classification information

Classification information is used to describe the business justification of a request (for example, Sarbanes-Oxley requirements) and show which products and services are affected by the request. This information can be helpful when the request goes through the approval process.

To enter classification information when using the Best Practice view

1. On the Change form, choose Links => Categorizations in the left navigation frame of the Change form.

2. Enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Defines the urgency of the change (for example, Normal). For more information, see “Creating a change request at the initiate stage—Best Practice view” on page 114.</td>
</tr>
</tbody>
</table>

3. Change Reason 

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Reason</td>
<td>Defines the business reason for implementing the change request. Available options include:</td>
</tr>
<tr>
<td></td>
<td>■ Upgrade</td>
</tr>
<tr>
<td></td>
<td>■ New functionality</td>
</tr>
<tr>
<td></td>
<td>■ Maintenance</td>
</tr>
<tr>
<td></td>
<td>■ Upgrade</td>
</tr>
<tr>
<td></td>
<td>■ Other</td>
</tr>
</tbody>
</table>

If the request needs to go through the approval process, change reason information can be helpful.

3. Choose Links => Categorizations and enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Categorization</td>
<td>Operational categorization is based on a three-tier hierarchy that is configured in the Operational Catalog.</td>
</tr>
<tr>
<td>Product Categorization</td>
<td>Product categorization is based on a five-tier hierarchy that is configured in your Product Catalog.</td>
</tr>
</tbody>
</table>

4. Click Save.
To enter classification information when using the Classic view

1. On the Change form, click the Classification tab.

2. Enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Defines the urgency of the change (for example, Normal). For more information, see &quot;Creating a change request at the Initiate stage — Classic View&quot; on page 118.</td>
</tr>
<tr>
<td>Timing Reason</td>
<td>Defines the reason for creating a change request with a Timing of Expedited (for example, Insufficient lead-time). For more information, see Plan and Schedule stage - Planning the change request on page 149.</td>
</tr>
<tr>
<td>Lead Time</td>
<td>Defines the amount of time that you need to prepare for a change implementation. The system adds Lead Time to the Submit date to determine the Earliest Start date and time. For example, if the Submit date is 5/18/2010 1:50:29 AM and you type 8 in the Lead Time field, the system determines that the Earliest Start Date is 5/18/2010 9:50:29 AM. Note: The Lead Time field is available only from the Classification tab of BMC Remedy Change Management Classic view.</td>
</tr>
<tr>
<td>Change Reason</td>
<td>Defines the business reason for implementing the change request. Available options include: Upgrade, New functionality, Maintenance, Upgrade, Other. If the request needs to go through the approval process, change reason information can be helpful.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Business Justification | Tracks the business reason for request. Available options include:  
  ■ Corporate Strategic  
  ■ Business Unit Strategic  
  ■ Maintenance  
  ■ Defect  
  ■ Upgrade  
  ■ Enhancement  
  ■ Customer Commitment  
  ■ Sarbanes-Oxley  
  Note: Select an option based on the classification defined by your company. |
| Change Environment  | Defines the environment where the change will be implemented. Available options include:  
  ■ Production  
  ■ Model Office  
  ■ Hot Backup  
  ■ Development  
  This field is useful when mapping approvers and for reporting purposes. An approver can be mapped for a selected environment. |
| Sequence            | Defines whether you want the change request to take place in a particular order relative to other change requests. For more information, see Planning dependencies for change requests on page 143. |
| Performance Rating  | Rates the work done by support staff or the manager in completing the change request.  
  Note: Do not enter information into the Performance Rating field when you are creating a change request. The manager of the support staff assigned to the change request typically enters this rating after the change request reaches the Completed status. For more information, see Closed stage - Completing change requests on page 153. |
| Notes               | Defines a more detailed description of the change request. |
### Adding vendor information

A vendor is a third-party company that provides services that might be required to complete a request. Vendors can use their own tracking systems to create and manage tickets for these services.

The Vendor Management feature of BMC Remedy Change Management enables users to maintain details of the vendor and the vendor ticket within a change request to track a vendor's involvement in a change. Users can extract the vendor details from change requests for reporting purposes using the custom reports feature.

For more information on generating custom reports, see the *BMC Remedy Mid Tier Guide*.

**Note**

When you create a change request from an existing incident or problem request, vendor information in the related request is not automatically copied to the change request created.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Categorization</td>
<td>Operational categorization is based on a three-tier hierarchy that is configured in the Operational Catalog.</td>
</tr>
<tr>
<td>Product Categorization</td>
<td>Product categorization is based on a five-tier hierarchy that is configured in your Product Catalog.</td>
</tr>
</tbody>
</table>

3  Click **Save**.

---

**To enter vendor information when using the Best Practice view**

1  Open the change request.

2  On the change form select the vendor group from the Vendor Group field.

3  If the vendor's ticket number is available, enter this information in the Vendor Ticket Number field.

4  Click **Save**.

**To enter vendor information when using the Classic view**

1  Open the change request.

2  Click the Vendor tab and enter the following information:
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Information</td>
<td>Enter the name, organization, and vendor group of the vendor.</td>
</tr>
<tr>
<td>Vendor Contact</td>
<td>Enter information about the designated contact person for the vendor company.</td>
</tr>
<tr>
<td>Vendor Ticket Information</td>
<td>Enter details of the vendor's ticket. Details include:</td>
</tr>
<tr>
<td></td>
<td>■ If the change request has been assigned to a vendor</td>
</tr>
<tr>
<td></td>
<td>■ Vendor ticket number</td>
</tr>
<tr>
<td></td>
<td>■ Date when the service was requested from the vendor</td>
</tr>
<tr>
<td></td>
<td>■ Date when the vendor responded to the service request</td>
</tr>
<tr>
<td></td>
<td>■ Date when the vendor completed the requested service</td>
</tr>
</tbody>
</table>

3 Click **Save**.

### Recording activities for a change request

You might need to modify a change request with work history entries that you add during its lifecycle, in order to document activities performed or information gathered.

For example, you can track a change request’s progress by recording the steps that you took to implement it in the work history.

You might want to add work information about the following activities:

- **General Information** — Notes about the record. For example, you might want to add a note that a particular CI was deployed, and include the date.

- **Planning** — Notes about a plan to implement a global change throughout your organization.

- **Implementation** — Installation and backout procedures for the change.

- **Costing and Charging** — Additional information about the cost of the current CI, incident, change, and so on. For example, you might want to add a note that the cost of maintaining a CI was split between two cost centers, or that the cost to implement a change was under budget.
Recording the change activities

Use the following procedure to add work information about activities performed for the current change request.

**To add or modify work information in a change request when using the Best Practice view**

1. Open the change request.

2. To add new work information, under the Add Work Info details section on the Work Detail tab, enter the following information:
   - **Notes** - Enter the details of your work information record.
   - **Attachment** - Click to add any attachments related to the work information. You can add up to three files.

3. Click **Advanced** to select the work information type and add any additional attachments.
   - From the Work Info Type list, select the type of work information to add.
   - In the **Attachment** fields, add any additional attachments required for the work information. You can add up to three files.

4. When you finish updating the change request, under Add Work Info, click **Save**.
   The Save operation adds your entry to the work history.

5. To view or update the entries in the work information, select the work info record and click View . Under the Edit Work Info section:
   - Update the required fields.
   - To delete an attachment, click delete for that attachment.
   - Click **Save**.

6. To view a report of selected activities that you performed against this request, select the records from the work info table and click Report .

7. To view the history of when and by whom each of the work information was added, click History .
8 Click Save.

**To add work information to a change request when using the Classic view**

1. Open the Change request.

2. On the Work Info tab click **Create**.

3. From the Work Info Type list, select the type of work information to add.

4. From the Source list, select the source of this information.
   
   Information sources can include email, system assignment, or the web.

5. Enter the details of your work information record in the Summary and Details or Notes fields.

6. To add an attachment to the record, right-click in the attachment table, and then choose **Add**.

7. From the Locked list, select Yes or No to lock the log.

   **WARNING**
   
   If you select Yes, you cannot modify the work log after you save it. A locked work log can only be modified by a user with the functional role of a Infrastructure Change Master.

8. From the View Access list, specify the level of access to the work entry:
   
   - Select **Internal** if you want only users with application permissions for BMC Remedy Change Management to see the entry.
   
   - Select **Public** if you want everyone with access to the system to see the entry, including requesters.

9. When you finish updating the change request, click **Save**.

   The Save operation adds your entry to the work history. The Show field enables you to filter specific work entries based on the type of activity that appears in the table.

10. To view a report of selected activities that you performed against this request, select the records from the work info table and click **Report**.

11. To view the history of when and by whom the work information was added, click **History**.
12 To view or update all entries in the work information, click **View**.

In the Change Work Info dialog box, select the work info record you want to change, update the required fields, and then click **Save**.

**Note**

When you return to the request, refresh the Work Info table to see all the modified records.

13 Click **Save**.

---

### Creating emergency change requests

An emergency change is implemented when there is an Incident that requires a change. Depending on how your application administrator has configured the BMC Remedy Change Management application, emergency change requests bypass the normal approval process. When you create an Emergency change the new approval process phase will be used, bypassing the normal change states. For example, if emergency requests are configured to bypass the Review approval stage, the change is not held up waiting for approvals, but is automatically approved. The request skips to the next stage in its lifecycle.

**WARNING**

Your application administrator must configure the approval process that bypasses the normal approval process for emergency change requests. For more information, see the *BMC Remedy IT Service Management Configuration Guide*.

**Note**

Previously, Problem records could not be related to Emergency change requests. You can now relate Problem records to the emergency change.

### To create emergency change requests

1. As a manual step, make sure that an open incident refers to this change request.

2. Create a new change request as described in *Initiate stage - Creating change requests* on page 113 or “Creating a change request at the initiate stage—Best Practice view” on page 114.

3. Select Emergency from the **Class** field.

   The following message is displayed:
Make sure an open incident references this change. (ARWARN 1440110)

4. Enter the required information for the change record, and then click **Save**.

5. Add the related Incident or Problem requests in the Relationship tab of the record.

**Atrium Impact Simulator analysis for change requests**

You can create a new change request, based on a simulated impact analysis generated by the Atrium Impact Simulator tool. You can use the BMC Atrium Impact Simulator application to proactively determine how a change to the availability of a CI affects other CIs and services. For example, you could run a simulation in BMC Atrium Impact Simulator to learn what devices and applications in the network would be affected if you were to take a server offline.

Using this tool provides many benefits for the change management staff:

- Generates "What if?" impact simulations to determine if the change request will affect critical upstream business services. Using the Atrium Impact Simulator could potentially reduce the number of CAB meetings.

- Determines the approvers for the change request, based on the simulation result.

- Generates simulation reports for audit or compliance purposes.

You might also use BMC Atrium Impact Simulator to plan for disaster recovery. You can run simulations to determine where the network is weakest, and plan accordingly.

BMC Atrium Impact Simulator uses the impact relationships that you create between CIs. For information about creating relationships, see *Working with relationships on page 220*.

When you run a simulation, you can specify an impact state for each CI in the simulation. *Table 21 on page 134* lists the states that you can select in BMC Atrium Impact Simulator.

**Table 21: Impact states in BMC Atrium Impact Simulator**

<table>
<thead>
<tr>
<th>BMC Atrium Impact Simulator state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slightly Impaired</td>
<td>The CI is delivering services normally, but some problem might affect it.</td>
</tr>
<tr>
<td>Impaired</td>
<td>The CI’s delivery of service is slightly affected.</td>
</tr>
<tr>
<td>Very Impaired</td>
<td>The CI’s delivery of service is affected.</td>
</tr>
</tbody>
</table>
When you run a simulation, BMC Atrium Impact Simulator uses these states and the impact relationships defined between CIs to predict the corresponding impact on those CIs. For example, a simulation that includes a server with an impact state of Unavailable might return several related CIs that are predicated to be unavailable as a result of the unavailable server. However, an Impaired server in that same simulation might return impacted CIs that are predicted to be only Slightly Impaired.

Priorities can help you understand the problems that you should address first if you were to make the changes that you simulated. For example, a simulation might reveal that if a server were to fail, email and payroll services might be disabled. The computed priority for these services would help you decide which service to restore first.

For more information, see the *BMC Atrium CMDB User’s Guide*. See also *Viewing the impact of CIs on change requests* on page 237.

### Creating a change request from Atrium Impact Simulator

This section describes the procedure to perform an impact simulation for CIs and create a new change request related to this analysis using the Atrium Impact Simulator.
To create a change request from Atrium Impact Simulator

1. On the BMC Remedy Change Management Console, choose **Advanced Functions => Atrium Impact Simulator**.

**Figure 30: Atrium Impact Simulator**

Figure 30 on page 136 illustrates the functional areas of the BMC Atrium Impact Simulator console. Table 22 on page 136 describes what you can do in each of the functional areas.

**Table 22: BMC Atrium Impact Simulator console functional areas**

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CIs for Simulation</strong></td>
<td></td>
</tr>
<tr>
<td>CIs for Simulation table</td>
<td>The left column of this table contains the Set CI’s State for Simulation field. Use this field to assign an impact state to the CI selected in the table.</td>
</tr>
<tr>
<td>Add CI</td>
<td>Click to search for one or more CIs to add to the table.</td>
</tr>
<tr>
<td>Remove CI</td>
<td>Click to remove the selected CI from the table.</td>
</tr>
<tr>
<td>Simulate Impact</td>
<td>Click to run an impact simulation for the CIs in the table.</td>
</tr>
<tr>
<td><strong>Results</strong></td>
<td></td>
</tr>
<tr>
<td>Results in Topology</td>
<td>Shows the results of a simulation as a topology, including any impact relationships between the CIs. An icon on each CI image represents the predicted impact state for each CI, based on the simulation criteria.</td>
</tr>
</tbody>
</table>
Here you choose the source CIs to include in a simulation. You can select one or several CIs, each with their own simulated impact state.

2 Click **Add CI** to search for and select CIs to add to the change request.

   a In the Query window, run a query to return the CIs that you wish to include in a simulation.

   b In the results list, select one or more CIs to include in your simulation.

   c In the CIs for Simulation section, select a CI, and then select an impact state in the Set CI’s State for Simulation field.

   d Repeat this step until every CI in the CIs for Simulation section has the impact state you want to simulate.

3 Click **Simulate Impact** to run an impact simulation for the CIs in the table.

   You can view the results of the simulation on the Results in Table and Results in Topology tabs. You can filter the CIs by severity level or other options provided by the Atrium Impact Simulator.

4 To save the simulation, complete the following steps:

   a Click **Save Simulation**.

   b In the dialog box, enter a name for the simulation.

   c Provide a description of the simulation, such as its purpose, and the source CIs used in the simulation.

   d Click **OK**.

5 To create a new change request, choose **Relate to New => Change Request**.

   The Change form opens. The CIs from the Atrium Impact Simulator are related to the request in the Relationship tab. Work information is created for the change request, along with a simulation `.csv` file attached.

   For more information, see Working with relationships on page 220.
6 Enter the remaining information to create the request.

7 Save your work when you are finished.

Modifying change requests - Additional information you can enter

As you track and supervise a change request, you move it from one stage to another (for example, from Initiate to Review and Authorize). When you choose different stages, messages alert you if you need to complete more fields in the request.

**Note**

A request should follow the stages in the recommended lifecycle of a change request, as described in Change request lifecycle on page 47. Manually setting the status values can disrupt the lifecycle in which you enter information about and resolve the change request.

**To modify change requests**

1 Use one of the following methods to locate the change request:

   - On the BMC Remedy Change Management Console, select the change request from the Assigned Change table, and click **View**.

   - Search for the change request.

2 On the Change form, make the appropriate changes.

3 Use the Process Status Flow area to move the change request from one status to the next.

![Figure 31: Moving change request into a different status](image)

If you need to suspend work temporarily on the change request you are working on, select Enter Pending and an appropriate status reason (for example, Manager Intervention) from the Process Flow Status menu. When you are ready to continue work on the change request, select Resume from the Process Flow Status menu.
The Change Manager or Change Coordinator can resume a pending change request. Otherwise, the Status field is updated automatically during the Process Flow.

4  *(optional)* Perform the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a task to the change request.</td>
<td>See Implement stage - Working with tasks on page 260.</td>
</tr>
<tr>
<td>Modify the change request assignments.</td>
<td>See Working with change request assignments on page 211.</td>
</tr>
<tr>
<td>Relate a CI or some other object to the change request.</td>
<td>See Working with relationships on page 220.</td>
</tr>
<tr>
<td>Modify the start and end dates of the change request.</td>
<td>See Plan and Schedule stage - Planning the change request on page 149.</td>
</tr>
</tbody>
</table>

5  Click *Save*.

**Review and Authorize stage - Risk and impact analysis**

No change to the IT infrastructure is without risk. Therefore, your change requests should minimize the severity of any impact and disruption. They also should be successful at the first attempt. The change manager is responsible for planning and scheduling change requests, which includes assessing their risk and impact. During the Risk & Authorize stage, the change manager should estimate the impact by using the risk assessment functionality.
**Note**

You reach the Review & Authorize stage only if an approver is mapped to the Business Approval phase. If no approvers are mapped to the Business Approval phase, the request moves to the Planning in Progress status. You should then perform risk and impact analysis during the Plan & Schedule stage. For more information, see Plan and Schedule stage - Planning the change request on page 149.

When you are working on a change request, you use the Change form to describe the change and to show which products and services are affected by the change. Before you can submit a change, you must define the Change Type, Impact, Risk Level, and Urgency.

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>You also specify the Class of the change on the Change form.</td>
<td>You also must use the Classification tab to specify the Class of the change.</td>
</tr>
</tbody>
</table>

Selecting these values automatically determines the Risk Level and Lead Time for the change.

**Risk assessment**

Risk assessment helps you achieve greater productivity by combining qualitative and quantitative criteria for assessing the risk level associated with a change. You can raise the accuracy of the changes by assessing risks with a consistent and standard process. The end output is a Change Risk Report, which can provide a key decision in change planning.
When approvers review a proposed change request, they want to see an analysis of potential risks and the impact of the change request.

During the planning phase, assess the risk of your change request. Risks can include the number of people affected, financial concerns, loss of productivity due to system or network downtime, resource allocation, and seasonal considerations, such as vacations, holidays, and weather. Impact analysis needs to be based on how many people are affected by the proposed change, and where those people are located. Here you can select the anticipated risk that this proposed change has—from 5 (highest risk) to 1 (lowest risk).

You can also compute the risk of a change request. Risk factors can include a set of questions used to calculate the risk value. During configuration, your application administrator defines a set of questions that apply to a specific company, to the operational categorization of a change request, or globally to all change requests, and a weight for each question. For example, your application administrator can define a set of questions that apply only to change requests regarding decommissioning virtual machines, if those change requests are identified by operational categorization.

The support staff assigned to each change request provides the risk value and probability for each question as it pertains to their specific request. The system calculates the total risk and saves the value in the Risk Level field of the Change form.

Finally, you can view a report of the total impact of your risk changes.

The Change form includes the following fields for risk management:

- **Risk Level** — Enter the anticipated risk that this proposed change has—from 5 (highest risk) to 1 (lowest risk).

- **Impact** — Determine the impact of this change based on the number of affected users.

- **Performance Rating** — When using the Classic view, in the Classification tab, rate the work done by support staff or the manager in completing the change request. Usually, the manager of the support staff assigned to the change request enters this rating after the change request is closed. This field is not displayed in the Best Practice view.
Note
To configure the risk levels, see the *BMC Remedy IT Service Management Configuration Guide*.

Specifying risk level at the Review and Authorize stage

This section describes how to define a risk level for a change.

**To specify the risk level at the Review and Authorize stage**

1. Open the change request.
2. Use the Process Flow Status bar to move the change request to Review & Authorize stage.
3. In the Risk Level field on the Change form, select the appropriate level of risk for the change request, and then click **Save**.

   The range of risk runs from Risk Level 5, the highest risk, to Risk Level 1, the lowest risk. You can also selected a computed risk value, based on your answers to a series of predefined questions (as described in the section that follows).

Computing risk levels

If you are uncertain if the risk level is appropriate for the change, you can let the system compute the risk level. For more information about how risk assessment is computed, see the *BMC Remedy ITSM Configuration Guide*.

**To compute risk levels**

1. Open the change request in the Change form.
2. Click the Risk Level icon.
3. In the Risk Assessment Questions dialog box, answer the questions, and then click **Save**.

   These risk questions are defined and created by the application administrator. They might be specific to the company or to the operational categorization of the change request.
4  Save the Change request.

5  To view and print a report of the total impact of your risk changes, click **View Risk Report**.

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose <strong>Links</strong> =&gt; <strong>View Risk Report</strong> in the left frame of the Change form.</td>
<td>Choose <strong>Advanced</strong> =&gt; <strong>View Risk Report</strong> in the left frame of the Change form.</td>
</tr>
</tbody>
</table>

The Change Risk Report dialog box displays the summary, which includes the questions and responses, and the derived factors if applicable. The derived factors section includes the change impact, change priority, CI impact, and CI priority.

**Planning dependencies for change requests**

When planning how to implement a series of change requests, determine in what order, if any, they must be completed. To set dependencies, you assign a sequence number to each request. Requests with a lower sequence number must be completed before those with higher numbers can be completed; otherwise, you are notified by a warning message (by default). More than one request can have the same sequence number; requests with the same sequence number are considered peers. For example, a request with the sequence number 3 can be completed only after all requests with sequence numbers 1 and 2 are completed. Peer requests can be completed in any order among themselves.

To implement sequence numbers in requests, see Assigning sequence numbers to dependent change requests on page 243.

---

**Note**

Your application administrator can configure the level of enforcement of the change dependency rules. For example, BMC Remedy Change Management can be configured so that users see an error, not just a warning, if they complete requests out of sequence. For more information, see the *BMC Remedy IT Service Management Configuration Guide*.

---

A change request can include multiple tasks. When a change request is scheduled, the first task is activated and set to Assigned. When the last task is completed and its status is set to Closed, the request is Completed.

To implement sequence numbers for tasks, see Assigning a sequence number to task groups and tasks on page 268.
Risk Recalculation

Risks can be configured within a change template and are applied when the template is used to create a change. Additionally, risk calculations can be configured on the Risk Factor Configuration form. Configuring risk factors overrides any risks set in the change template.

In certain scenarios, risks are recalculated due to configuration conflicts. For example, when the user uses a change template that has a risk value defined, the risk level for the change is set to this value. If at some point this change is reassigned to a user for whom risk settings have been configured, risk is recalculated based on the configuration defined. The value defined in the change template is overwritten and the following error message is displayed: The system has computed a new value for Risk level. To use this computed value, clear the value in the Risk Level field and press Save. ARNOTE 48140

To configure risk within a change template, select Administrator Console => Application Administration Console => Custom Configuration => Change Management => Template => Template and define a Risk Level.

To configure risk calculations on the Risk Factor Configuration form select Administrator Console => Application Administration Console => Custom Configuration => Change Management => Risk Factors => Change Risk Selection and define risk calculation factors.

For more information on configuring change risk calculation, see the BMC Remedy ITSM Configuration Guide.

Approvals - Approving change requests

Within the life cycle of the change request, approvals might be required. There are several approval phases possible, which vary depending on how your organization configures and implements the possible changes. Some changes bypass the approval process altogether. The application administrator determines which change requests require approval, what kind of approval process the change requests must undergo, and who the approvers are. Support staff and management can add more approvers to the list.

Tip

The SMPM process model specifies that the best practice is to include an approval after the risk and impact analysis of a change request.
For more information, see Adding approvers on page 367.

**Figure 33: Approving changes**

When you have finished planning the change request, and have supplied all the information that the approvers require to review the change request, you can submit the change request for approval.

When an approval is required to move the change request to the next stage, the Process Status Flow bar prompts you to approve, cancel, put on hold, or reject the approval. You can configure the approval settings to require one or all approvers to approve the change before it can be moved to the next stage. For more information on configuration options, see the *BMC Remedy Action Request System BMC Remedy Approval Server Guide* in the section on roles.

It is important to understand that the change manager (or change coordinator) controls the overall progression of a change request. Change managers submit the requests for approval and monitor the approval process. As a manager, you might be required to review change requests for approval. You review change requests and provide approval through BMC Remedy Change Management.

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>The approvers and the approval phase are viewable on the Change Request form.</td>
<td>The approvers and the approval phase are viewable on the Approvers tab.</td>
</tr>
</tbody>
</table>

Approvers are notified when a change request requires their approval. After reviewing the change request, approvers can approve it, reject it or put it on hold if more information is required.

See the following procedures:
For information about reviewing proposed change requests and providing or
denying approval, see Handling approvals for emergency change requests on
page 366.

For information about reviewing the approval process, see Working with BMC
Remedy Change Management as an approver on page 355.

For information about adding approvers, see Adding approvers on page 367.

Understanding the change management approval process

After a change is planned and scheduled, the change request is set to a status of
Scheduled for Review. The change manager or change coordinator have the
opportunity to review change plans, schedules, and so on, before moving the change
to the Implementation Approval phase.

To access functions involving Approvers:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Work Detail tab on the Change form.</td>
<td>Use the Approvers tab on the Change form.</td>
</tr>
</tbody>
</table>

The following buttons in the Change form control functions involving approvers:

- **View Notifications** — Opens the APR:Non-ApprovalNotifications form so that
  you can view notifications in either Pending or Notified status. Notifications are
  listed in the table on the form. For more information, see “Viewing and remove non-
  approver notifications ” on page 371.

  **Note**
  The same forms allows you to add notifications for the change.

- **Add** — Creates a new individual or group to approve the change. For more
  information, see “Adding approvers” on page 367.

- **Approve** — Allows an approver or a change manager or coordinator defined as
  alternate approvers, to approve the change request. For more information, see
  “Adding alternate approvers “ on page 369.

- **Reject** — Allows an approver or a change manager or coordinator defined as
  alternate approvers, to reject the change request. For more information, see
  “Adding alternate approvers “ on page 369.
Approving or rejecting requests

When an approval is required to move the change request to the next status, the Process Status Flow area prompts you to approve, cancel, or reject the approval. You cannot move the change request to the next status unless you first receive an approval.

When a change requires an approval, its approvers are notified. Notifications are sent according to the method specified in the Notifications tab of the approver’s record in the People form.

When you finish planning the change request, and have supplied all the information that the approvers require to review the change request, you can submit the change request for approval.

Note

For more information, see Handling approvals for emergency change requests on page 366 and Working with BMC Remedy Change Management as an approver on page 355.

Performing additional approval functions

In addition to approving or rejecting approvals, you can perform the functions listed in the following table.

Table 23: Additional approval functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resubmit a rejected release request</td>
<td>If an approver rejects a request, the approval process is stopped. You can resubmit the request for approval.</td>
</tr>
<tr>
<td></td>
<td>1  Open the request record.</td>
</tr>
<tr>
<td></td>
<td>2  From the process flow bar, at the stage the request was rejected, select <strong>Restart</strong>. The request status is set to Pending Approval for the stage at which it was cancelled.</td>
</tr>
<tr>
<td></td>
<td>3  When approving the request after it was restarted, users can enter details for restarting the request in the Work Info. When using the Best Practice view: On the Work Detail tab, select the Work Info and click <strong>View</strong>. When using the Classic view, click the Work Info tab.</td>
</tr>
</tbody>
</table>
Viewing change requests awaiting approval

You can view a list of all change requests that are awaiting approval.

To view change requests awaiting approval

1. In the Change Management console, under Counts in the left navigation pane, click Waiting Approval.
   
The Changes table shows the change requests waiting approval.

2. Select the change request to review, and then click View.

   The approver can approve or reject the change request the Change Request form, or request further information.

Viewing approvers for a change request

In the Approvers table on the Work Detail tab of the Infrastructure Change form, you can see the approvers for the change request.

Initially, the table displays all pending reviewers for the current approval phase. The Show list provides filters so that you can display all approvers or a subset of approvers. The following filters are new:

Future Approvers

Displays approvers for future phases. This filter is useful when a change request must go through multiple approval phases.

Tip

To see which approvers are required for a specific future phase, view the future approvers and sort on the process column.

All Approvers

Displays all approvers for all approval phases, including approvers who have already approved or rejected the change request.

For each approver, the table displays the following information:

- The approval status, such as Approved or Pending
- The approver's login ID and name
- The approval process, such as Change Level-Review
Plan and Schedule stage - Planning the change request

In the Plan & Schedule stage, the change manager (or change coordinator) plans a forward schedule of changes (or FSC). This includes planning all the requests approved for implementation, setting target dates, and estimating the risks and costs involved. When you have finished planning the request, and have supplied all the information that the approvers require to review the request, you can submit it to the approval process.

Figure 34: Planning and scheduling change requests

Plan for the following important details:

- Set the request’s status to Planning, and specify the planned dates.
- Estimate the time that the project will take.
- Estimate any applicable down time associated with the request.
- Register an available or unavailable time segment to perform the request.
- Assess the risks and impact of the request.
- Specify the business justification for the request if necessary.
- Define the tasks.
- Calculate the costs associated with the request.
- Submit the request for approval.
Approvers require all this planning information to decide whether to approve or reject the change request.

### Planning the change request at the Plan and Schedule stage

This section describes the procedure to plan the change request in the Plan & Schedule stage.

#### To plan the change request at the Plan & Schedule stage

1. Open the Change Calendar.
   a. Open the Change request.
   b. Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Quick Action =&gt; View Calendar.</td>
<td>Choose Quick Links =&gt; View Calendar.</td>
</tr>
</tbody>
</table>

   c. On the Change Calendar, select how many days’ worth of change requests and business events to show.

   For more information, see Using the Change Calendar on page 194.

   d. View requests as needed.

   e. Select the requests and business events for a specific day.

   f. Close the Change Calendar when you are finished.

   For more information, see Using the Change Calendar on page 194.

2. Register available or unavailable time segments for your business event, operational categorization, or CI.

   For more information, see:
   - Registering time segments on page 157
   - Registering unique business events and operational categorizations on page 158
   - Registering time segments for CIs - Creating a blackout schedule on page 164
3 Use the Process Flow Status bar to move the request to Planning in Progress status in the Plan & Schedule stage.

a Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Date/System tab.</td>
<td>Click the Dates tab.</td>
</tr>
</tbody>
</table>

When planning a change request, use the Date/System or the Dates tab to track the requested, scheduled, and actual start and end dates of changes.

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Earliest Start Date is determined by the Submit Date.</td>
<td>The Earliest Start Date is determined by the Lead Time field (in the Classification tab) for the change request. If it is not already specified, the Requested Start Date is automatically set to the Earliest Start Date.</td>
</tr>
</tbody>
</table>

If the change status is not Draft, the Class (on the Change form when using the Best Practice view and in the Classification Tab when using the Classic view) is automatically set to Expedited when:

- Actual Start Date or End Date is earlier than the Submit Date
- Requested Start Date is earlier than the Earliest Start Date

When the Class is changed, you are prompted to select a Timing Reason.

If many tasks are required for the request you are planning, it might be best to create the tasks before you enter the dates. The Task Dates table displays the task dates and times to help you determine the start and end dates of the change request. For more information, see Implement stage - Working with tasks on page 260.

4 (optional) Use the Schedule Assist utility to search for available times for the change request.

For more information, see Using Schedule Assist to search for available times on page 170.

5 In the Change Dates region of the form, provide dates for the Scheduled Start Date and Scheduled End Date fields.

If the new dates fall outside the range of the task’s Scheduled Dates, changes to the Scheduled Dates (both Start and End) can result in notifications being sent to task implementers.
The Scheduled Start Date and Scheduled End Date fields are required when moving a change status beyond Planning in Progress.

6 **(optional)** Review the RFC Date information.

This field contains the date and time information at which the change was requested.

7 If the change request did not pass through the Review & Authorize stage, assess the risks and impact of the change request.

You can compute the risk level of the change. For more information, see **Computing risk levels on page 142**.

8 When using the Classic view, click the Classification tab, and then select a Business Justification.

The Classification tab is used to describe the business justification of the request (for example, Sarbanes-Oxley requirements) and show which products and services are affected by the request. This information can be helpful when the request goes through the approval process. For more information, see **Adding classification information on page 126**.

9 **(optional)** Use the Process Flow Status bar to relate a CI to the change request.

**Figure 35: Relating a CI to the request at the Plan & Schedule stage**

When the CI Relationships Search dialog box appears, you can search for a CI and then relate it to the request. For more information, see **Working with related configuration items on page 246**.

10 **(optional)** Click the Tasks tab.

You can plan and create the tasks that make up the change request. For more information, see **Implement stage - Working with tasks on page 260**.

11 **(optional)** Do one of the following to calculate the costs associated with the change request:
When using the Best Practice view

| Choose Links => Financials. |

When using the Classic view

| Click the Financials tab. |

For more information, see Working with costs on page 183.

12 Click Save.

13 Click Next Stage in the Process Flow Status bar to move the change request forward.

When the change request reaches Scheduled For Approval status, it must be approved to move forward. For more information, see Approval processes provided out-of-the-box on page 357.

Closed stage - Completing change requests

In the Closed stage of the change request’s lifecycle, the change manager reviews all the implemented changes to make sure that each objective was met. A request cannot be closed until all tasks are closed. When all the tasks related to a request are closed due to success, cancellation, or failure, the requester and the change manager are notified that the change is resolved.

**Note**

Change requests can be closed by users with the functional role of a Change Manager or Change Coordinator.

In this final stage, the process of closing the change request varies based on whether the request requires Close Down approval or not.

- If no approval is required, the requester can set the request to Closed after confirming that the request was resolved to his or her satisfaction. If the requester does not close the change request within the allowed response time of it being resolved, the request is closed automatically after a specified period of time. The Status Reason for the request indicates that the request was automatically closed. The allowed response time depends on how the application administrator configured the BMC Remedy Change Management application. The default is 10 days. If the requester is not satisfied with the change request, the requester can reopen it. The change manager is notified that the request is reopened, and must respond.

- If the request requires Close Down approval, the change request moves to the Completed status with the status reason Final Review Pending. The approvers approve it and moves the change to the status Final Review Completed. When
moved to the next stage, the change request is set to status Closed with a status reason of Successful.

After IT and the business unit (BU) have completed the review, no further activities are performed on this request.

**Figure 36: Closing change requests**

To reach Closed status, you must enter actual start and end dates. You must also enter a performance rating from 1 (the worst rating) to 5 (the best rating) for the entire change process. You should consider all aspects of the change request’s performance. This includes looking at how the change manager performed, how well things went with this operational Category Type and Item (CTI), and any other risk factors. The performance rating stored on the request is then used, in combination with previous historical ratings, to compute an overall performance for each of the risk factors.

The performance history of a change manager becomes more meaningful as more changes are accomplished. The performance rating is an average of the performance of the assigned manager or the chosen operational CTI. This in turn helps a more accurate risk assessment to be performed on new requests.

**Note**

Performance ratings for requests are not rolled into the average performance until the request is Closed. A request in Completed status does not have the performance rating averaged into the overall rating yet.

When a change request fixes a known error, the owner of the known error is notified, so that its status can be updated.
Closing a change request

This section describes the procedure to close a change request.

**To close change requests**

1. Open the change request.

2. Use the Process Flow Status bar to move the request forward to Completed status.

   The Change Closure dialog box appears.

3. Click the Dates tab.

4. Review the Completed Date information.

   This field is automatically set to the current date and time when the status of the request is set to Completed.

5. Enter the actual start date and end date of the request.

6. Enter the In Production Date information.

   Use this field to specify the date and time at which the request was taken into production.

7. Click the Classification tab.

8. In the Performance Rating field, rate the work done by support staff or the manager in completing the request.

   This performance value is a combined consideration of all derived factors on a request, ranging from 1 (the lowest rating) to 5 (the highest rating).

9. Add the status reason and work information.

10. Click **Save**.

    **Note**

    After a change request is closed, it cannot be reopened.
Creating change requests as rollbacks

You should create a back-out plan for restoring the IT infrastructure to its initial situation. If the actions associated with a change request need to be reversed, support staff and managers can create a change request for the system that needs to be rolled back. This means that impacted systems need to be restored to their previous status before the change request was implemented.

**To identify a change request as a rollback**

1. Create a new change request.
2. Create a related task to implement the rollback for this change request.
   
   For more information, see Implement stage - Working with tasks on page 260.
3. Use one of the following options to add a work info record to enter information about why you are rolling back the change request:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update the fields on the Work Detail tab.</td>
<td>Update the fields on the Work Info tab.</td>
</tr>
</tbody>
</table>

4. Close the task.
5. Complete the change request.

Working with reassignment requests

Change managers are responsible for responding to reassignment requests. When a change manager reassigns a change request to another manager, the person is notified. Upon reviewing the change, the manager can reassign the change to another qualified change manager.

**To respond to reassignment requests**

1. Open the Overview Console or the Change Management Console.

   For information, see:

   - Working with the Overview console on page 465
   - Change Management Console on page 85
All reassignment requests appear in the table along with other change requests. BMC recommends regularly monitoring your assigned work to keep track of any change requests reassigned to you.

2. Select the appropriate change request.

3. Click View.

After reviewing the change request, you can manually reassign the change manager or change coordinator. When using the Classic view, you have an additional option of reassigning it to the change implementer.

4. Click the Assignment tab.

To deny the reassignment request, you must reassign it to another change manager, coordinator, or implementer.

a. To reassign the change request, select the appropriate manager, assignee, or implementer.

b. Select an assignment method (for example, Auto Assign), and then click Set.

5. Click Save.

If you reassign the change request, the new assignee is automatically notified of the changed assignment.

For more information, see Assigning change requests on page 214.

Registering time segments

Registering time segments in BMC Remedy Change Management works like a calendering system—if you schedule a meeting in a certain conference room, nobody else can reserve the conference room at the same time. Similarly, you can block out time segments around business events (such as company holidays), categorizations (Operational Category 1, 2, or 3, and location of the change), or CIs. Time segments enable you to define windows of time that you can designate as available or unavailable when working on a change request. An available time segment can specify that a CI is available for use, while an unavailable time segment can be used to schedule planned maintenance.

When you create a change request that modifies a CI—for example, you must replace a mission-critical server—you can schedule a time segment for the CI that shows it is unavailable to the rest of the support staff. If another member of the
support staff wants that CI to be *available*, they should schedule their own change in a different time segment.

Time segments enable you to perform the following tasks:

- Search available time segments to schedule the change request.
- Connect the selected time segments to the change request’s operational categorization or to a business event based on location.
- Create time segments or use time segments around the associated CIs.
- Select unavailable time segments from the associated CIs to help you plan the Scheduled Start or End Date and time for the change request.
- Select from available time segments from the associated CIs to help schedule work to be done.

For more information about business time and time segments, see the *BMC Remedy Action Request System Configuration Guide*.

### Registering unique business events and operational categorizations

You must register business events and operational categorizations that are unique, based on their particular attributes.

Business event uniqueness is based on its title *plus* its specified attributes. For example, you might define three different business events that all use the same title, but if each has a different company location, each combination of title plus company is unique.

In much the same way, you can only define a single categorization based on all its attributes. Use a descriptive title specifying what particular categorization you are looking at (for example, Calbro Services - Hardware). To save the categorization, you must also enter the Company and Category 1 fields.

If you define a categorization that has the attributes Company (Calbro Services) and Category 1 (Hardware), you cannot define another categorization with the same attributes of Company (Calbro Services) and Category 1 (Hardware). You can define another entity where the Company is Calbro Services, Region is North, and Category 1 is Hardware. Optionally you might define a categorization where Company is Calbro Services and Category 1 is Software. You define any attribute as long as no other categorization exists where all the attributes are an exact match of another categorization. The purpose is to prevent the creation of duplicate categorizations.
To create and register a time segment for a business event or an operational category

1. Open the Change request.

2. In the navigation pane choose Advanced Functions => Time Segments.

3. Click one of the following options:
   - Business Event
   - Op. Category Location

4. In the resulting dialog box, click New.

   Depending on what you selected in the navigation pane, the Search Business Event/Location Definition dialog box or Search Operational Categorization/Location Definition dialog box appears.

5. Enter the minimum information required to define a unique time segment for the business event or categorization.

   For example, define a time segment with a title of "Holiday Shut Down" and Calbro Services as the company.

6. Click Save.

   The Registration for Shared Time Segment window is displayed.

7. Click Add.

8. In the Description field on the Business Time Segment dialog box, enter a description for the time segment.

9. In the Availability field, select Available or Unavailable.

   Use the availability function to block periods of time.

   - Select Available to define a time segment open for normal use (for example, routine scheduled maintenance).

   - Select Unavailable to define a time segment that is not available for any other use (for example, a CI outage when you shut down a server to add more memory).

10. In the Level field, select a level of 10 or higher.
Change management activities start with a default level of 10, but you can change this level to a number from 11 through 1000. Level 1 is Workday activities and Level 2 is Holiday activities.

If the schedules for two activities conflict, the event with the highest number takes priority. For more information, see the BMC Remedy Action Request System Configuration Guide.

11 In the Duration Type field, select One time (which generates a single occurrence of the time segment) or Recurring (which cannot span multiple days, but must be scheduled within a 24-hour period). If you select Recurring, you must specify the recurrence.

12 Enter the starting and ending dates and times for the duration of the time segment.

**Tip**
To define an all-day event, select 12:00:00 a.m. of the first day for the start time, and select 12:00:00 a.m. of the following day for the end time.

13 (optional) For a one-day event, use the same start day and end day and then select End of Day.

This action sets the End Time to 11:59:59 p.m. When the calculation is performed the end of day is considered the whole day, including the final second.

14 Click Save, and then click Finish.

**Note**
For information about time zones, see Performing additional time segment functions for business events and operational categories on page 161.

15 Select Quick Action => View Calendar.

The time segment appears in the Business Events section of the Calendar.

**Searching for business time or operational time segments**

You can search for business time or operational time segments that have already been defined. You then can modify or delete them, as needed.

**To search for time segments**

1 Open the change request.

2 In the navigation pane choose Advanced Functions => Time Segments.
3 Click one of the following options:
   - Modify Business Event
   - Modify Op. Category Location

   Depending on what you selected in the navigation pane, the Search Business Event/Location Definition dialog box or Search Operational Categorization/Location Definition dialog box appears. This forms works like a wizard. Use this form to search for and select a time segment.

4 Enter the search parameters to find a time segment.

5 Select a time segment from the results list and click Select.

6 Click Finish in the Registration for Shared Time Segment dialog displayed.

**Performing additional time segment functions for business events and operational categories**

In addition to creating time segments for business events and operational categories, you can perform the functions listed in the following table.
### Registering time segments

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View time segments</td>
<td>1  Choose <strong>Advanced Functions =&gt; Time Segments.</strong></td>
</tr>
<tr>
<td></td>
<td>2  Click one of the following options:</td>
</tr>
<tr>
<td></td>
<td>■ Business Event</td>
</tr>
<tr>
<td></td>
<td>■ Op. Category Location</td>
</tr>
<tr>
<td></td>
<td>3  Enter search parameters to find a time segment.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <a href="#">Searching for business time or operational time segments on page 160</a>.</td>
</tr>
<tr>
<td></td>
<td>1  Select a time segment from the results list.</td>
</tr>
<tr>
<td></td>
<td>2  On the Registration for Shared Time Segment form, select a time segment.</td>
</tr>
<tr>
<td></td>
<td>3  Click <strong>View</strong>.</td>
</tr>
<tr>
<td></td>
<td>4  Modify the time segment.</td>
</tr>
<tr>
<td></td>
<td>5  Close the form.</td>
</tr>
<tr>
<td></td>
<td>6  Click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>
Function | Action
---|---
Relate time segments | 1 Choose **Advanced Functions => Time Segments**.
 | 2 Click one of the following options:
 | ■ Business Event
 | ■ Op. Category Location
 | 3 Enter search parameters to find a time segment.
 | 4 Select a time segment from the results list.
 | 5 On the Registration for Shared Time Segment form, select a time segment.
 | 6 Click **Search**.
 | 7 In the Search Time Segment dialog box, select as many time segments as needed.
 | 8 Click **Relate**.
 | 9 Close the Search Time Segment dialog box.
 | 10 Click **Finish**.
Registering time segments

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove time segments</td>
<td>1. Choose <strong>Advanced Functions =&gt; Time Segments</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Click one of the following options:</td>
</tr>
<tr>
<td></td>
<td>■ Business Event</td>
</tr>
<tr>
<td></td>
<td>■ Op. Category Location</td>
</tr>
<tr>
<td></td>
<td>3. Enter search parameters to find a time segment.</td>
</tr>
<tr>
<td></td>
<td>4. Select a time segment from the results list.</td>
</tr>
<tr>
<td></td>
<td>5. On the Registration for Shared Time Segment form, select a time segment.</td>
</tr>
<tr>
<td></td>
<td>6. Click <strong>Remove</strong>.</td>
</tr>
<tr>
<td></td>
<td>7. Click <strong>Finish</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Removing time segments does not physically delete them or the business event. Instead, it removes the link between the business event and the time segment.</td>
</tr>
</tbody>
</table>

**Registering time segments for CIs - Creating a blackout schedule**

**Note**

If BMC Remedy Asset Management is installed, use the Maintenance Schedule or Blackout Schedule to create time segments for CIs. This section describes using the Registration for Shared Time Segment window in BMC Remedy Change Management, which does not have the same functionality as BMC Remedy Asset Management. For more information, see the **BMC Remedy Asset Management User’s Guide**.

You create times when the current CI will be unavailable or available. This is known as a blackout schedule.

- During times when the current CI is unavailable, a CI must not be brought down. The server used by payroll might have a blackout schedule to indicate that the CI is not available for other tasks (for example, upgrades or routine maintenance) when paychecks are processed.
During times when the current CI is available, you can schedule the CI for upgrade, maintenance, change requests, or release requests. This is a scheduled outage. Other users can share this time segment and conduct multiple requests.

When creating the blackout schedule, you can also specify the levels of availability. For example, you decide that a specific application service CI must be unavailable to Calbro Services IT during the core hours Monday through Friday 8:00 A.M. to 5:00 P.M. PST. You can then schedule routine change requests during the specified Saturday 8:00 P.M. to 10:00 P.M. maintenance window. More urgent change requests can be scheduled outside the core hours.

As a result, you can set up the following blackout schedule for the application service CI:

- Core hours Monday to Friday 8:00 A.M. to 5:00 P.M. PST, the CI is listed as unavailable at Level 15.
- Everything except Saturday 8 P.M. to 10 P.M. is listed as available at Level 20.
- Everything except the core hours is listed as available at Level 25.

**To define time segments for CIs**

1. Open the change request.
2. In the navigation pane choose Advanced Functions => Time Segments => Configuration Item (CI).
3. In the CI Advanced Search form, enter the information necessary to search for a CI and then click Search.
   
   The available CIs based on your search criteria appear in the results table.
4. Select a CI from the search results.
5. (optional) Click Explore CI to view a CI and its relationship in a tree structure.
   
   For information, see Viewing CI relationships on page 168.
6. Click Select.
   
   You return to the Registration for Shared Time Segment window.
7. Click Add.
8. In the Description field on the Business Time Segment dialog box, enter a useful description for the time segment.
For example, your naming convention for change request time segments can include the CRQ ID and a brief description of what the intended change, or the name of the business service affected.

9 In the Availability field, select Available or Unavailable.

Use the availability function to block periods of time.

- Select Available to define a time segment open for normal use (for example, routine scheduled maintenance).
- Select Unavailable to define a time segment that is not available for any other use (for example, a CI outage when you shutdown a server to add more memory).

10 In the Level field, select a level of 10 or higher.

Change management activities start with a default level of 10, but you can change this level to a number from 11 through 1000. Level 1 is Workday activities and Level 2 is Holiday activities.

If the schedules for two activities conflict, the event with the highest number takes priority. For more information, see the BMC Remedy Action Request System Configuration Guide.

11 In the Duration Type field, select One time (which generates a single occurrence of the time segment) or Recurring (which cannot span multiple days, but must be scheduled within a 24-hour period). If you select Recurring, you must specify the recurrence.

12 Enter the starting and ending dates and times for the duration of the time segment.

Tip
To define an all-day event, select 12:00:00 a.m. of the first day for the start time, and select 12:00:00 a.m. of the following day for the end time.

13 (optional) For a one-day event, use the same start day and end day and then select End of Day.

This action sets the End Time to 11:59:59 p.m. When the calculation is performed the end of day is considered the whole day, including the final second.

14 Click Save to associate the time segment to the CI, and then click Finish.

After you build the blackout schedule for one CI, you can reuse it for other CIs if they have the same schedule.
For important information about time zones, see Understanding server time, time zones, and time segments on page 169.

15 Create a schedule for your change request.

For more information, see Using Schedule Assist to search for available times on page 170.

**Performing additional time segment functions for CIs**

In addition to creating time segments for CIs, you can perform the functions listed in the following table.

<table>
<thead>
<tr>
<th>Table 24: Additional time segment functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>View CI time segments</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
**Viewing CI relationships**

The BMC Atrium Explorer shows CIs and their relationships to other CIs within the BMC Atrium CMDB. The BMC Atrium Explorer enables you to improve the accuracy of change planning by locating the CI. For more information, see the *BMC Remedy Asset Management User's Guide* or the *BMC Atrium Configuration Management Database User’s Guide*.

---

### Relate CI time segments

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relate CI time segments</td>
<td>1. Choose Advanced Functions =&gt; Time Segments =&gt; Configuration Item (CI).</td>
</tr>
<tr>
<td></td>
<td>2. Search for a CI, and then select it.</td>
</tr>
<tr>
<td></td>
<td>3. On the Registration for Shared Time Segment form, select a time segment.</td>
</tr>
<tr>
<td></td>
<td>4. Click Search.</td>
</tr>
<tr>
<td></td>
<td>5. In the Search Time Segment dialog box, select as many time segments as needed.</td>
</tr>
<tr>
<td></td>
<td>6. Click Relate.</td>
</tr>
<tr>
<td></td>
<td>7. Close the Search Time Segment dialog box.</td>
</tr>
<tr>
<td></td>
<td>8. Click Finish.</td>
</tr>
</tbody>
</table>

### Removing CI time segments

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing CI time segments</td>
<td>1. Choose Advanced Functions =&gt; Time Segments =&gt; Configuration Item (CI).</td>
</tr>
<tr>
<td></td>
<td>2. Search for a CI, and then select it.</td>
</tr>
<tr>
<td></td>
<td>3. On the Registration for Shared Time Segment form, select a time segment.</td>
</tr>
<tr>
<td></td>
<td>4. Click Remove.</td>
</tr>
<tr>
<td></td>
<td>5. Click Finish.</td>
</tr>
</tbody>
</table>

**Note:** Removing time segments does not physically delete them or the CI, because there is a many-to-many relationship between entities and time segments. One time segment can be related to many entities. Instead, it removes the link between the CI and the time segment.
To use the BMC Atrium Explorer to view CI relationships

1. In the Change form, choose Advanced => Time Segments => Configuration Item (CI).

2. In the CI Advanced Search dialog box, search for a CI.

3. From the CI Search Results table, select a CI and then click Explore CI.

4. From the Template list of the BMC Atrium Explorer, select the filter to use to limit the data shown in the relationship viewer.

   A filter template specifies a criteria for the relationship information that appears in the relationship viewer.

5. Click Refresh to apply the selected filter template.

   The relationship image is reloaded with the selected data. The Legend on the right pane shows the relationship types.

Understanding server time, time zones, and time segments

When adding time segments if the client and the server are in different time zones, all dates and times for the Business Time Segments appear in the adjusted server time. That is, the Start Date, Start Time, End Date, and End Time on the Business Time Segment form, and the time segments date and times that are shown in the table appear in the adjusted server time. Other dates and times on the remainder of the form are in the client’s time.

For example, your server is in EST and your client is in PST. Adjusted server time is determined converting the time at the place the Business Time Segment was created to the time at the physical location of the server. For example, if the client is located in PST, and the server is located in CST, the time shown on the server is increased by two hours (to include both MST and PST time zones). Similarly, if the client is located in EST, the time shown on the server is decreased by one hour.

Also, all time segments must be adjusted into the time zone of the client. For example, if the ticket was created in PST, the details need to be adjusted into PST. If a Time Segment for a server was defined in CST, adjust it into PST when creating the time segment for the client.

For more information about adjusting for the time zone differences between the client and the server, see the BMC Remedy Action Request System Configuration Guide.
Using Schedule Assist to search for available times

The Schedule Assist tool helps you create schedules. You can search for available time segments that you can schedule a change request around. Your search takes into account the selected time segments tied to the change request’s categorization. You can define time segments or use time segments around the associated CIs. Finally, you can include the associated CIs unavailable time segments to find a Scheduled Start or Scheduled End Date and Time for the change request.

**Note**
The Schedule Assist tool is also available on the Release form. For more information, see Specifying the business justification on page 286.

Items shown in the Global Time Segments table displayed on the Time Segment Analysis window are based upon the following criteria:

- Start Search Date Range
- End Search Date Range

The table shows Business Events and Operational Categorization Location time segments that match the Operational Categorization, and the Change Location of the current change, and any items that are global.

It also shows items that are an exact match of the Categorization and Location and those above it. For example, suppose that the Location of the change request uses the following parameters:

- Company = Calbro Services
- Region = West
- Site Group = California
- Site = Sunnyvale

After determining the existence of any Location matches, the search would then match any business event records that match all four parameters or less. If a business event existed for Company = Calbro Services, this time segment would match also.

The date range also influences which time segments appear. This criterion affects all tables that show time segments. The table shows any items that intersect the Start Date and End Date search range. If the Start Date range is 3/1/08 and the End Date Range is 3/15/08, examples of what it might include are the following business time segments:
- Business time segment 1/1/08 to 3/8/08
- Business time segment 3/10/08 to 3/31/08
- Business time segment 1/1/08 to 7/1/08

For example, you create a normal change request to upgrade the application server. The change manager relates the application service CI to the change request. Then you use the Schedule Assist tool to determine the next available window to schedule this change request. You indicate the potential start and end dates, that the Unavailability times at Level 20 should be used, and that the window needs to be scheduled for 1 hour. When you click the Find Next Avail Time button, the next available time is displayed, given those criteria. After you locate an available time, you can schedule that time segment to block out that time so it is no longer available for the next change request.

**Note**

Schedule Assist does not enforce that a change request has to be scheduled in certain windows or prevent you from scheduling a change request during any unavailable or available time. You might have valid reasons for scheduling a change request during an unavailable window. For example, if you know System A is down for maintenance from 9:00 P.M. to 10:00 P.M. on Saturday night, you might schedule another change request for related System B during that same window since System A would already be down.

**To search available times for change requests**

1. Open a change request.
2. Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. On the Change Form, to search for available times, make sure you enter the Change Location information.</td>
<td>1. Click the Requester tab. To search for available times, make sure you enter the Change Location information.</td>
</tr>
<tr>
<td>2. Choose <strong>Links =&gt; Categorization</strong>. Make sure you enter the Operational Category information and click <strong>Save</strong>.</td>
<td>2. Click the Classification tab. Make sure you enter the Operational Category information and click <strong>Save</strong>.</td>
</tr>
<tr>
<td>3. Click the Date/System tab.</td>
<td>3. Click the Dates tab.</td>
</tr>
</tbody>
</table>

3. Click the **Schedule Assist** icon.
Use Time Segment Analysis window displayed to analyze the time segments and search for available times. The following fields are available.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Search Date</td>
<td>Set by default to the current date.</td>
</tr>
<tr>
<td>End Search Date</td>
<td>Set by default to the current date plus 30 days. Use these dates to filter the information in</td>
</tr>
<tr>
<td></td>
<td>the table fields.</td>
</tr>
<tr>
<td>Global Time Segments</td>
<td>Shows all time segments tied to the change. By default, all Time Segments are selected.</td>
</tr>
<tr>
<td>Associated CI’s</td>
<td>Shows a list of the CIs tied to the change that have an entity tied to CI.</td>
</tr>
<tr>
<td>CI’s Available/Unavailable Times</td>
<td>Shows available or unavailable times tied to the selected CI.</td>
</tr>
<tr>
<td></td>
<td>If one CI is selected from the Associated CIs table and you press =&gt;, only the Time</td>
</tr>
<tr>
<td></td>
<td>segment tied to that CI appears. For each additional CI selected on the Associated CIs table,</td>
</tr>
<tr>
<td></td>
<td>all the associated time segments to each of the selected CIs appear when you click =&gt;.</td>
</tr>
<tr>
<td></td>
<td>■ If you select Available times as a type, the Use Available button is enabled.</td>
</tr>
<tr>
<td></td>
<td>Clicking Use Available fills the Available Start Date/Time+ and Available End Date/Time+</td>
</tr>
<tr>
<td></td>
<td>fields from the selected record.</td>
</tr>
<tr>
<td></td>
<td>If more than one record is selected, only the first selected record is used to fill the</td>
</tr>
<tr>
<td></td>
<td>fields. If more than one CI is selected when you click Use Available, only the first</td>
</tr>
<tr>
<td></td>
<td>selected record is used.</td>
</tr>
<tr>
<td></td>
<td>■ If there are unavailable times, all times that are selected from the unavailable table,</td>
</tr>
<tr>
<td></td>
<td>plus the selected global blackouts on the top, plus the Duration and Level fields are used</td>
</tr>
<tr>
<td></td>
<td>in the calculation when you use the Find Next Avail Time button or the Create Next Free Time</td>
</tr>
<tr>
<td></td>
<td>button (except for those times defined using the Schedule Time Segment button).</td>
</tr>
<tr>
<td>Duration</td>
<td>Defines the length and level of the time segment. For example, you can define a level 10</td>
</tr>
<tr>
<td></td>
<td>time segment of 2 hours.</td>
</tr>
<tr>
<td>Available Start Date/Time+</td>
<td>Start date and time of available time segment.</td>
</tr>
<tr>
<td>Find Next Avail Time</td>
<td>Factors in the duration you specified and returns the next available time. The time</td>
</tr>
<tr>
<td></td>
<td>segment is then entered into the Available Start Date/Time+ and Available End Date/Time+</td>
</tr>
<tr>
<td></td>
<td>fields.</td>
</tr>
<tr>
<td></td>
<td>If you press ENTER in the Available Start Date/Time+ field, the duration is added to the</td>
</tr>
<tr>
<td></td>
<td>Available Start Date/Time+ field and the Available End Date/Time fields. You can manually</td>
</tr>
<tr>
<td></td>
<td>set the TS Start Date/Time+ field to a specific date or time to give a new start Date to find</td>
</tr>
<tr>
<td></td>
<td>the next available time segment.</td>
</tr>
</tbody>
</table>
Schedule Time Segment | Generates the next available time segment based on all the selected time segments in the tables on the Time Segment Analysis form. You can then can associate it to a particular CI that is tied to the change request. Time segments that were created using this button are not included in the calculation with the Create Next Free Time button or the Find Next Avail Time button. Because the next free time was generated for a particular change request, the time that was set for the current change is not blocked out.

Next | Goes to the next page of the form.

Close | Closes the window without returning the information to the change request.

4 In the Time Segment Analysis window, enter information to define the time segments needed for the CIs.

This enables you to define new time segments for CIs based on selected time segments and unavailable times of other CIs. In BMC Remedy Change Management, you can only define time segments with a duration type of One Time.

After you define the time segments, the change coordinator or the change manager can schedule the change request based on the selected unavailable items or based on an Available schedule.

5 Click **Find Next Available Time**.

Based on all the selected time segments in the tables on the Time Segment Analysis form, the time segment is entered into the Available Start Date/Time+ and Available End Date/Time+ fields.

6 Click **Schedule Time Segment**.

7 On the The Associate Time Segment to CIs dialog box, use the following steps to associate CIs to time segments.

a Select the CI to associate the time segment to.

b Enter a description of the time segment.

If your server is in a different time zone than the client, make sure you include this in your description. For more information, see Understanding server time, time zones, and time segments on page 169.

c Click **Create Time Segment**.

d Close the dialog box.

The time segment is generated and associated to the CI.
The actual date and time might not be exactly what you specified, if the same time segment has been selected. If so, the first available time is used for the specified CIs. This functionality is similar to a calendar system. If you try to reserve a conference room, and you do not book it immediately, someone might take the room before you book it.

8 Click Next.

The Time Segment Analysis window helps the support person pick a scheduled start date and end date of the change request. From looking at the time segments, you can try to plan your change around the specified time segment.

The Time Segment Analysis window redisplays, to enable you schedule dates. The scheduled start date and end date of the change request does not have to match the unavailable time segments. If you have a time segment from 1/30/06 from 2:00 p.m. to 3:00 p.m., your scheduled change does not have to be 1/30/06 from 2:00 p.m. to 3:00 p.m. The actual change process can be much longer. Your scheduled change might go from 1/25/06 8:00 a.m. to 2/2/06 8:00 a.m. You might need to perform additional duties to prepare for the change and then allot additional time afterwards to verify that the change was successful.

Figure 37: Time Segment Analysis window—Scheduling dates

The CI’s Available/Unavailable Time table shows all time segments associated to all the CIs.
The following fields are available to set the Schedule Start and Scheduled End Date/Time of the change request.

<table>
<thead>
<tr>
<th>Start Search Date Range</th>
<th>Set by default to the current date.</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Search Date Range</td>
<td>Set by default to current date plus 30 days. Use these dates to filter what appears in the table fields.</td>
</tr>
<tr>
<td>Global Time Segments</td>
<td>Shows all time segments for the change request.</td>
</tr>
<tr>
<td>CI’s Available/Unavailable Times</td>
<td>Shows available or unavailable times that are tied to the selected CI.</td>
</tr>
<tr>
<td></td>
<td>■ If you select Available in the Type field, you can use one of the Available times to set the scheduled start and end dates.</td>
</tr>
<tr>
<td></td>
<td>■ If you select Unavailable, you can manually enter a date, or use the date based on the information about the Available times shown for the global time segments.</td>
</tr>
<tr>
<td>Use Available</td>
<td>If you select Available times as a type, the Use Available button is enabled. Clicking Use Available fills the Available Start Date/Time+ and Available End Date/Time+ fields from the selected record. If more than one record is selected, only the first selected record is used to fill the fields. If more than one CI is selected when you click the Use Available, only the first selected record is used.</td>
</tr>
<tr>
<td>Scheduled Start Date/Time</td>
<td>Enables you select a start date and time.</td>
</tr>
<tr>
<td>Scheduled End Date/Time</td>
<td>Enables you to select an end date and time.</td>
</tr>
<tr>
<td>Previous</td>
<td>Goes to the previous page of the form.</td>
</tr>
<tr>
<td>Next</td>
<td>Returns the Schedule Start Date/Time+ and Scheduled End Date/Time+ values back to the change request.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the window without returning the information to the change request.</td>
</tr>
</tbody>
</table>

9. Enter the scheduled start date and end date.

10. Click Next.

The change request appears, with the time segment values returned.

11. Save the change request.
Detecting CI collisions between change requests

The Collision Detection tool (under Advanced Functions in the left navigation pane) determines if there are other change requests scheduled to work on the same CI during the same scheduled time, and helps you manage and resolve these potentially harmful conflicting change requests. For Release Management, Collision Detection is run against the changes in the release manifest, not the changes related to the release in the Relationships tab. Collision Detection does not apply to release activities in the release manifest.

**Note**

The Collision Detection tool works with Release Management a little bit differently than with BMC Remedy Change Management. The Collision Detection link does not turn red when a collision is detected. Also, you fix collisions in the Manifest tab of the release form.

**Figure 38: CI collisions detected with change requests**

It consists of two sections:

- The Exclude Collision State section at the top lets you exclude (or include) change requests that have already run through Collision Detection. The following collision states are detected:
The Change Requests with Identified Collisions section at the bottom identifies the current CI collisions for the change request. It lists the CI affected, the change request ID, the scheduled start and end dates, and the ID and Scheduled Start and End dates of the change request causing the conflict.

The first time you run the Collision Detection tool, it shows you by design only the current collisions in the release manifest. If you open the Collision Detection tool a second time and maintain the default settings (all Exclude Collision State fields selected), only new collisions are shown. Previously detected collisions that need corrective action are not listed. To see all CI collisions that need corrective action, you must clear the Exclude Collision State fields and then click the Identify Collisions button, as shown in Figure 38 on page 176.

**To detect CI collisions between change requests**

1. Open the request.
2. Click the Tasks tab on the change form or the Manifest tab on the release form, and then add change requests to the request.

You must add at least one change request to the request before running Collision Detection.

3. Choose **Advanced => Collision Detection**.

The Collision Detection dialog box appears (Figure 38 on page 176). In the Include Collision State section, you now must choose to exclude or include the collision states (for example, Detected) the next time you run the tool. For example, if Detected is selected, then any records that were previously flagged as Detected...
are excluded from collision detection the next time the tool is run. If you clear Detected, then these records are again run through collision detection.

4 Select or clear collision states as needed, and then click **Identify Collisions**.

5 Close the Collision Detection tool when you finish.

6 Click the Tasks tab in the change form or the Manifest tab in the release form.

The table displays the collision state of each change request that is included in the request.

7 Use the drop-down menu in the Collision column to update the collision state.

New changes that you add to the request appear in black until you run Collision Detection.

8 To fix the CI collision:

   a Change the collision state from Detected to Resolved.

   b Save and close the request.

   Collision states are not saved to the database until you save the request.

   c Click **View** to open the change request.

   d Run Collision Detection from the change request to determine which CIs are causing the collision.

   e Click the Dates tab of the change request.

   f Enter a new Scheduled Start Date and End Date that avoids the CI collision.

   g Save and close the change request.

   h Run the Collision Detection tool one more time in the request to make sure that no other collisions are detected.

   Make sure all the Exclude Collision States are cleared before you click **Identify Collisions**.

   i Save and close the Collision Detection tool.

9 Save the request.

Collision states are not saved to the database until you click **Save**.
Monitoring the progress of a change request

As the change request is being planned, you can follow its progress by viewing the Work Info details.

For example, during its Implementation stage, you can follow the progress of the tasks in the request as they are being completed.

**To view the progress of a change request when using the Best Practice view**

1. Open the change request.

   The Change form provides information about the status, potential risks, and whether it is escalated.

2. The left frame of the change form displays the details about who is assigned to the change request as the change coordinator.

3. View progress details of the change request by clicking the appropriate tab:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| Work Detail  | View information about each step in the process in the work information history area.  
               | View who is assigned to the change request as change manager.  
               | Review the current stage in the approval process for the change request, including the next approval phase.  
               | **Note:** The Work Detail tab is displayed when you open the Change form. |
| Tasks        | View the progress of the tasks associated with the change request.                                                                                           |
| Relationships| View all the related change requests, dependent change requests, related CIs, and so on.                                                                                       |
| Date/System  | View the dates related to the change, time spent on the change and details of the change submitter.                                                                                   |
| SLM          | Review the agreed-upon service targets for the request. This tab is visible only if the BMC Service Level Management application is installed.                                                      |

4. View additional details by clicking the appropriate links:

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Action =&gt; Requested For</td>
<td>View for whom the change request was created. When the change request was created, the change request was automatically assigned to the appropriate support staff group or person.</td>
</tr>
</tbody>
</table>
5 Close the Change form.

**To view the progress of a change request when using the Classic view**

1 Open the change request.

The Change form provides information about the status, potential risks, and whether it is escalated.

2 View progress details of the change request by clicking the appropriate tab:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requester</td>
<td>View for whom the change was requested and who is assigned to the request. When the change request was created, it was automatically assigned to the appropriate support staff group or person.</td>
</tr>
<tr>
<td>Classification</td>
<td>View the timing of the change request and its categorizations.</td>
</tr>
<tr>
<td>Work Info</td>
<td>View information about each step in the process in the work information history area.</td>
</tr>
<tr>
<td>Tasks</td>
<td>View the progress of the tasks associated with the change request.</td>
</tr>
<tr>
<td>Assignments</td>
<td>View who is assigned to the change request as change manager, change coordinator, or change implementer.</td>
</tr>
<tr>
<td>Relationships</td>
<td>View all the related change requests, dependent change requests, related CIs, and so on.</td>
</tr>
<tr>
<td>Approvers</td>
<td>Review the current stage in the approval process for the change request, including the next approval phase.</td>
</tr>
<tr>
<td>SLM</td>
<td>Review the agreed-upon service targets for the request. This tab is visible only if the BMC Service Level Management application is installed.</td>
</tr>
<tr>
<td>Financials</td>
<td>View information relating to cost types, total costs, and the total costs in a specific currency.</td>
</tr>
<tr>
<td>Dates</td>
<td>View the planned dates.</td>
</tr>
</tbody>
</table>

3 Close the Change form.
Monitoring associated tasks

As change manager or change coordinator, you must keep track of the change request to which you have been assigned. This includes monitoring tasks associated with the change request.

To view a task associated with a change request

1. Open the change request.
2. Click the Tasks tab.
   
   All the tasks for that change request are listed.
3. To view details about a task, select the task in the list and click View.
4. In the work history on the Work Info tab of the Task form, you can view information about each step in the process. You can also view work information for each task in the Work Info of the Selected Task table on the Change form.
5. If you modified the task, click Save.

Viewing the audit log

Viewing audit logs enables you to view field and notification audits against the request. When certain fields are changed, when the status is changed, or when system notifications are sent, an audit entry is generated to track the modification. The Login ID of the individual making the change appears next to the audit entry.

Note
The View Audit Log function is not available until you create and display the request.

To filter the information shown, you can select the Audit Type to view (for example, All, Change Coordinator, or Priority).

To view audit logs

1. Open the change request, from which to view the log.
2. Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the left navigation pane, choose <strong>Links</strong> =&gt; View Audit Log.</td>
<td>From the left navigation pane, choose <strong>Functions</strong> =&gt; View Audit Log.</td>
</tr>
</tbody>
</table>
3 (optional) Use the Audit Type list to filter out audit log entries.

4 Click the Notification Audit tab to view notification audit entries against the request.

**Figure 39: Notification audit log entries**

The audit trail displays all the notifications that were generated.

5 Select a notification audit entry, and then click View.

**Viewing affected areas**

The Impacted Areas dialog box shows which companies, sites, and organizations are affected by the change. By default, the information entered in the Change Location on the Requester tab is automatically entered as one of the Impacted Areas. Use the Impacted Areas dialog box to define approvals for the change request.

**Note**

Impacted Areas, which automatically defaults to the change location, must be specified to generate automatic approval requests.

**To view affected areas**

1 Open a change request.

2 Do one of the following:
When using the Best Practice view

From the left navigation pane, choose Links => Impacted Areas.

When using the Classic view

From the left navigation pane, choose Advanced => Impacted Areas.

3 On the Impacted Areas dialog box, complete the required fields and enter any other information, as needed.

4 Click Add to add each area to the Impacted Areas table.

You can add as many impacted areas for a particular change as necessary. You can also delete impacted areas that you have previously chosen in this form.

5 Click Close.

The additional impacted areas are added to the change request.

## Working with costs

In the Financials tab, the change manager or the release coordinator can specify and assess the costs of the change request or release request including parts, labor, and other associated costs. The cost can be related to services or a configuration item (CI). The total of all allocated costs for a change request or a release request is automatically calculated.

You can calculate the financial affect in implementing a change request. You can calculate costs after a request has been created; however, usually you do this when the change request has been resolved. You can calculate the various kinds of costs, and you can associate costs with CIs.

**Note**

Only users with Cost Manager permissions can define, modify, or delete cost entries, including the costs that they have submitted. If you make a mistake when adding a cost entry—for example, if you charge too much for a service—you cannot delete the record. However, you can reverse the cost of the record by adding a new cost record, and then entering a negative value equal to the amount to negate. If you negate a cost, make sure that you document this in the **Description** field.

### To add a cost to a change request

1 Open the change request in the Change form.

2 Do one of the following:
When using the Best Practice view

From the left navigation pane, choose **Links => Financials.**

<table>
<thead>
<tr>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Financials tab.</td>
</tr>
</tbody>
</table>

**Note**

The Financials option is not available when the change request is in New mode or in the Draft status.

3 Click **Add.**

4 In the Costs dialog box, enter the relevant information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>This field is automatically filled with the cost center specified in the Cost Center Code field. The company field identifies the company charged for servicing the change request.</td>
</tr>
<tr>
<td>Cost Center Code</td>
<td>Identifies the code name for the business unit or organization within the company that is charged for servicing the change request. The default cost center is the business unit to which the user logging the change request belongs, but you can modify this.</td>
</tr>
<tr>
<td>Cost Center Name</td>
<td>This field is automatically filled with the name of the cost center specified in the Cost Center Code field.</td>
</tr>
<tr>
<td>Cost Category</td>
<td>This field is automatically filled according to the application you are working in.</td>
</tr>
<tr>
<td>Cost Type</td>
<td>Enter the cost type. Options are Fixed, Labor, Other, or Parts. (These values can differ depending on how your application administrator has configured cost categorizations and the chosen company.)</td>
</tr>
<tr>
<td>Cost Classification</td>
<td>Options are Actual or Budget.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a cost description.</td>
</tr>
<tr>
<td>Related Cost</td>
<td>Enter the rate. You select the Currency from the list. Your administrator sets the available currencies.</td>
</tr>
<tr>
<td>Related Units</td>
<td>Enter how many units (for example, hours or minutes) were required to implement the change.</td>
</tr>
<tr>
<td>Unit Type</td>
<td>Choose how to measure the cost. Choices are Flat Rate, Hours, or Minutes.</td>
</tr>
<tr>
<td>Date Incurred</td>
<td>Date the charge was incurred. If you leave this field blank, it is set to the current date when you save the cost.</td>
</tr>
</tbody>
</table>

5 Click **Save.**

6 Perform steps Step 3 on page 184 through Step 5 on page 184 for each cost associated with the change request.
The totals for budgeted and actual costs appear at the bottom of the table.

Calculating the costs of a change request

When a change request has been resolved, you can calculate the cost involved in implementing it. If a change manager or task implementer has already added a cost calculation, you can view the calculation.

You can calculate the various kinds of costs, and you can associate costs with CIs. All the costs of a change request are totaled automatically.

To modify a cost

1. Open the change request in the Change form.
2. Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the left navigation pane, choose Links =&gt; Financials.</td>
<td>Click the Financials tab.</td>
</tr>
<tr>
<td>In the Show field, select the type of cost to view.</td>
<td></td>
</tr>
<tr>
<td>From the table, select the cost to modify, and then click View.</td>
<td></td>
</tr>
</tbody>
</table>

   The Costs dialog box contains information about the kind of cost. You cannot make changes in the Cost Category field.

5. Change the Cost Center Code, Cost Type, Description, or other information as appropriate and click Save.

Note
To delete a cost from a change request, select it, and then click Delete.

Using auto-cost estimates

You can include auto-cost estimates in a change request.

To use auto-cost estimates

1. Open the change request in the Change form.
2 Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the left navigation pane, choose Links =&gt; Financials.</td>
<td>Click the Financials tab.</td>
</tr>
</tbody>
</table>

3 In the **Calculation Unit Type** select Flat Rate, Hours, or Minutes.

4 In the **Budget Estimated Total Time** enter the time based on unit type.

   Use this information to forecast the cost. For example, you budget that the change will take 2 hours to perform.

5 In the **Actual Total Time**, enter the time according to the calculation unit type.

   Enter this information *after* the change is completed (for example, you budgeted two hours to do the change but it took three hours).

6 Save the change request.

   If a matching cost rate is found, a cost is generated.

## Allocating costs to configuration items

When relating CIs to a change request, you need only one related CI to generate the allocation. If you have two or more CIs related to a change request, you can distribute the costs of the change request between the different CIs.

You cannot perform these steps *until* you relate the CIs to the change request. For more information, see Working with related configuration items on page 246.

### To allocate costs to configuration items

1 Open the change request in the Change form.

2 Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the left navigation pane, choose Links =&gt; Financials.</td>
<td>Click the Financials tab.</td>
</tr>
</tbody>
</table>

3 Click Create Allocation.
In the Cost Allocation form, the following sets of information appear:

- **Cost Information**—Shows information used to calculate the cost of the change request.

- **Relate To CIs**—Shows all CIs that are related to the change request.

- **Related CIs With Cost Allocated**—Shows all the CIs after you have allocated the costs to them.

**Note**
When you are viewing financials on CIs, only actual costs are shown. As a result, a budgeted cost that is allocated to a CI appears on the change, but does not appear on the CIs financial table.

4 Enter missing information for cost type, cost rate, and so on.

5 In the Relate To CIs? field, specify whether to relate the cost to a CI:

- **Divide evenly between CIs**—Divides the cost between all the CIs (including services) that are related to the change. Doing so divides the Current Total by the number of related CIs.

- **Let me allocate to CIs**—Distributes the cost among the different CIs. If you choose this option, the Selected Ci Desc and Allocate To Selected Ci fields become active. If you do not have CIs or services related to this change request, you cannot choose this option.

The Related CIs Count field automatically shows the number of CIs that are related to the change request. You cannot change this information.

6 In the Relate To CIs table, click the CI to which to allocate a cost. The ID appears in the Selected Ci Desc field.

7 In the Allocate to Selected Ci field, enter the amount that to allocate to the CI.

8 Click **Create Cost Record**.

This allocates costs according to your input. The cost record appears in the Related CIs with Costs Allocated table, and the Unallocated Cost decreases by the amount applied to the CI.

The remaining fields in the form are read-only. They provide the following information:

- **Unallocated Cost**—Displays the Current Total less the amount already allocated to CIs during this session.
- **Average Cost Per CI**—Displays the Current Total divided by Related CIs Count. This field indicates the amount that each cost record would be if you chose to automatically allocate the costs to the CIs.

9 Continue selecting CIs from the Related CIs table, and apply costs until the Unallocated Cost is equal to 0.

10 Click **Close**.

The table in the Costs tab shows the cost records you have created. You cannot modify or delete these records.

### Performing additional functions with costs

You can perform the additional functions with costs that are listed in the following table:

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the cost of a change request</td>
<td>1  Open the change request in the Change form.</td>
</tr>
<tr>
<td></td>
<td>2  When using the Best Practice view, choose <strong>Links =&gt; Financials</strong>.</td>
</tr>
<tr>
<td></td>
<td>When using the Classic view, Click the Financials tab.</td>
</tr>
<tr>
<td></td>
<td>1  In the Show field, select the type of cost to view.</td>
</tr>
<tr>
<td>Delete costs</td>
<td>1  Open the change request in the Change form.</td>
</tr>
<tr>
<td></td>
<td>2  When using the Best Practice view, choose <strong>Links =&gt; Financials</strong>.</td>
</tr>
<tr>
<td></td>
<td>When using the Classic view, Click the Financials tab.</td>
</tr>
<tr>
<td></td>
<td>1  Select a cost entry, and then click <strong>Delete</strong>.</td>
</tr>
</tbody>
</table>

### Using BMC Service Level Management with BMC Remedy Change Management

If you have BMC Service Level Management (BMC SLM) installed, the Change form shows both overview and in-depth information about the change request in relation to applicable service targets. You can view the service targets and milestones for the restoration of the unavailability. Service targets and milestones are defined from
within BMC SLM. Escalations can be set up to notify the assignment group prior to acknowledgement or resolution breach times.

From the Change form, you can view service targets defined in BMC SLM. Service targets can be defined in BMC SLM for response time and resolution time. Service targets can be determined by related CIs, product and operational categorization, and many other criteria. The Next Target Date field indicates the next deadline out of all the service targets attached to the change.

For information about managing BMC SLM, see the *BMC Service Level Management User’s Guide*.

### Viewing service targets in BMC Remedy Change Management

You can view service targets that have been attached to change requests. This allows you to see whether the service target has been met, missed, or is in a warning state. You can also create service targets for the Release Management module included with BMC Remedy Change Management. The release management service targets attach to release requests and you can track these service targets using the BMC SLM Status icons and Status Gauge.

**To view service targets related to a change request**

1. Open the change request.

   SLM Status is displayed in the left navigation pane of the Change Request form.

   Table 25 on page 189 shows the icons and explains what they mean.

**Table 25: BMC SLM Status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Status: Not Attached](image) | Status: Not Attached.  
No service target is attached to the incident.  
Click Details or the icon to display the SLM:Integration Dialog form.  
You can also create service targets for the Release Management module included with BMC Remedy Change Management. The release management service targets attach to release requests and you can track these service targets using the BMC SLM Status icons and Status Gauge. |
| ![Status: Attached](image) | Status: Attached.  
Green: The service targets are in compliance.  
Click the icon to display the SLM:Integration Dialog form. |
The colors on the Status Gauge on the SLM:Integration Dialog form show the current status of the selected service targets. Table 26 on page 190 explains the Status Gauge displays.

Table 26: The Status Gauge on the SLM:Integration Dialog form

<table>
<thead>
<tr>
<th>Item</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>The service target is in compliance.</td>
</tr>
<tr>
<td>Yellow</td>
<td>The service target has a warning status.</td>
</tr>
<tr>
<td>Red</td>
<td>The service target has missed its goal.</td>
</tr>
<tr>
<td>Due Date and Time</td>
<td>The goal time within which there must either be an initiation or a completion for the change request otherwise the goal is missed.</td>
</tr>
<tr>
<td>Time Until Due</td>
<td>The amount of time left until the goal is considered missed.</td>
</tr>
<tr>
<td>Time Past Due</td>
<td>The amount of time that has passed since the goal was due.</td>
</tr>
</tbody>
</table>

Table 27 on page 191 describes the information in the SLM:IntegrationDialog form.
Table 27: Information about the SLM:IntegrationDialog form

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case ID</td>
<td>The ID of the change request.</td>
</tr>
<tr>
<td>Details...</td>
<td>Click to see details about the selected service targets.</td>
</tr>
<tr>
<td>Service Target table</td>
<td></td>
</tr>
<tr>
<td>SVT Title</td>
<td>The name of the service target.</td>
</tr>
<tr>
<td>Goal</td>
<td>The type of goal for the service target:</td>
</tr>
<tr>
<td></td>
<td>■ Initiation goal—The change request must be responded to within the time specified</td>
</tr>
<tr>
<td></td>
<td>■ Completion goal—The change request must be resolved within the time specified.</td>
</tr>
<tr>
<td>Hours/Min</td>
<td>The initiation or completion time stipulated in the goal.</td>
</tr>
<tr>
<td>Cost Per Min</td>
<td>The cost per minute for missing the initiation or completion time goal.</td>
</tr>
<tr>
<td>Due Date/Time</td>
<td>The goal time within which there must either be an initiation or a completion for the change request otherwise the goal is missed.</td>
</tr>
<tr>
<td>Progress</td>
<td>The status of the service target:</td>
</tr>
<tr>
<td></td>
<td>■ Attached—The service target has been attached to the change request</td>
</tr>
<tr>
<td></td>
<td>■ Detached—The service target has not been attached to the change request</td>
</tr>
<tr>
<td></td>
<td>■ In Process—Work on the change request is taking place</td>
</tr>
<tr>
<td></td>
<td>■ Pending—Work on the change request is stopped, for example, waiting for a part</td>
</tr>
<tr>
<td></td>
<td>■ Warning—The service target is at risk</td>
</tr>
<tr>
<td></td>
<td>■ Missed or Met—The service target has either missed or met its goal</td>
</tr>
<tr>
<td></td>
<td>■ Invalid—The service target is disabled.</td>
</tr>
<tr>
<td>Milestones for SVT</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>The title of the milestone.</td>
</tr>
<tr>
<td>Execution Time</td>
<td>The time the milestone actions are executed.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the milestone, this is either active or inactive (pending), or Action Performed.</td>
</tr>
</tbody>
</table>
Creating service targets for a change request

If you have BMC Service Level Management (BMC SLM) installed, you can create service targets and relate them to a change request to set goals and track the level of service for the change request. You can view the service target from within BMC Remedy Change Management.

Service targets created with BMC Remedy are internal targets related to Operational Level Agreements (OLAs).

To create service target terms and conditions for a change request

1. Log in to the Service Level Management Console.
2. Select the Service Target tab.
3. Click Create.

The Service Target wizard appears.

4. Enter a title for the service target in the Title field.
5. Optionally, enter a description of the service target in the Description field.
6. From the Applies To list, select Infrastructure Change.
7. In the Goal Type field, select a goal type:
   - **Change Request Initiation** - Work on the change request must be started within the time specified
   - **Change Request Completion** - The change request must be completed within the time specified
8. Click Define next to the Terms and Conditions field to open the Qualification Builder.
9. Enter any criteria that you want to use to build the qualification. All fields are optional.
Company, Region, Site Group, and Site responsible for resolving the change request

Figure 42: Qualification Builder for a change request—Customer tab

10 In the Customer tab, enter criteria in the Requested For, and Operational Level Agreement (OLA) categories.

Select Exact Match if you want the term used in the qualification to be exactly the same as you have selected or typed in the field. If Exact Match is not selected, you can type in partial words to be used in the qualification.

11 In the Classification tab, enter criteria in the Classification, Service Categorization Selection, and Product Categorization Selection categories.

12 In the Assignment tab, enter criteria in the Change Manager and Change Coordinator categories.

13 Click Show Qualification to enter your qualification in the Qualification field.

14 Save your qualification.

An example of a qualification is as follows:

'Priority' = "Medium" AND 'Location Company' = $\text{NULL}$ AND 'Customer Company' = "ABC Company" AND 'Customer Organization' = "SMBU" AND 'Customer Department' = "Research and Development" AND 'Product Cat Tier 1(2)' = "Hardware" AND 'Product Cat Tier 2(2)' = "Inventory" AND 'Product Cat Tier 3(2)' = "Laptop" AND 'Owner Support Company' = $\text{NULL}$
To build a custom qualification

1. Log in to the Service Level Management Console.
2. Select the Service Target tab.
3. Click **Create** to display the Service Target wizard.
4. Fill in the basic information.
5. Click **Define** to display the Qualification Builder for terms and conditions.
6. Select Yes in the Custom Qualification check box.
7. Select Custom Qualification to open the Advanced Qualification Builder.
8. Enter your qualification by typing entries or use the operators, keywords, and fields from the application form.
9. Click **OK** to return to the Qualification Builder, the system enters your Qualification in the Qualification field.
10. Save your qualification.

*Note*

If the service target is related to an agreement with an associated business service CI, an additional qualification is added to your terms and conditions.

Using the Change Calendar

The Change Calendar is a console for managing change and release activities, intended to be used by enterprise CIOs and members of the CAB, usually during a CAB meeting. It provides a graphical view of change requests, release requests, and business events occurring in the organization.

The Change Calendar uses the graphical view to show change requests, release requests, and scheduled business events, similar to how a project management application shows activities and tasks in a Gantt chart, except that the Change Calendar is more dynamic and interactive.

Aided by links to investigative and analysis tools, you can better understand the risk and impact of changes and releases. Because of better planning, you can make more productive decisions about the forward schedule of changes (FSC). The Change Calendar helps you consider the interdependencies and potential conflicts made visible through the Calendar console.
For example, suppose you are installing a new payroll server. When you first open the Change Calendar, you might see the full details of the change requests and business events over a 5-day period, as configured by the application administrator.

Figure 43: Change Calendar

Looking at the day picker calendar, you quickly decide that scheduling a major server installation on Wednesday November 5 (which is a Risk Level 5) would overload already strained resources. Monday November 17 is a condition green day and therefore more promising.

You click the day picker to focus the main calendar with the specified day as the start day. This enables you to look more closely at the day’s scheduled changes or business events. Then you decide if you need to see a more granular view of the data. From the Show menu, you choose to view one day’s worth of data, to see scheduled changes by the hour. The 1-day view enables you to drill down to one-half hour granularity, as shown in Figure 44 on page 196.
You see that no time segments are blocked out for changes. You decide that you can install the new payroll server between 7:00 a.m. and 10:00 a.m., the same time that you are installing other software applications based on your configuration policy.

**Figure 44: Change Calendar—One-day view**

You can select a change request from the calendar and view its essential details (for example, its change ID, its status, and so on). You also can click View Full Details. The request then appears in the Change form. With a few clicks on the Change Calendar, you can quickly move from viewing five days worth of information to viewing a specific change request.

**Tooltip data shown in Change Calendar**

To reduce the clutter on the Consoles, tooltips in the Change Calendar display additional data that is not directly available to users. Point your mouse over the Summary, and the tooltip appears. Tooltips displayed the Change or Release ID, scheduled dates, and so on.
Filtering criteria in the Change Calendar

The Change Calendar shows a graphical representation of change records defined by your search criteria. You can use the search criteria available in this tool to search for any upcoming changes for the week. This information can assist you in the scheduling of change requests.

Of particular interest to the CAB, the Calendar’s primary view is a calendar-like schedule that shows a focused view of the change requests that matched the current filtering criteria, when they are scheduled to begin and end, and related business activities and events.

You can filter the view by selecting criteria for which change requests and business activities to view. You can specify searching for all changes, change records with CI relationships, or for changes filtered by location. By changing these filtering criteria, you can focus on only those items that are of interest. The calendar highlights the aggregate risk assessment for each day. You can drill down from any change request or business activity to see more detailed information about the item.

The Calendar is divided into two areas. The area on the top shows a quick summary of all change records for the days that you are viewing. Each day in the calendar shows the aggregate risk of changes scheduled for that day. The area on the bottom of the Calendar shows those business events that might have an impact on whether the change request can be completed.

To view the Change Calendar

1 Use one of the following methods to open the Change Calendar:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the Change or Release form, choose <strong>Quick Action</strong> =&gt; <strong>View Calendar</strong>.</td>
<td>On the Change or Release form, choose <strong>Quick Links</strong> =&gt; <strong>View Calendar</strong>.</td>
</tr>
</tbody>
</table>
2 Choose whether you want to view Change Requests or Release Requests.

**Figure 46: Filtering requests**

3 From the Show field, select how many days’ worth of requests and business events to show.

You can select the time scale to view a single day, five days, or seven days. Each day is color-coded to indicate the risk associated with carrying out the changes or requests that are scheduled for that day. Only change activities appear in the one-day view.

---

**Note**

The data for all views is gathered by querying requests that have Requested Time, scheduled times, or actual times in the interval. However, the 1-day view only shows requests based on the Scheduled Time only while the 5-day and 7-day views show any request whose Requested Time, Scheduled Time, or Actual Time interval falls in the view duration. Actual time is also factored into the query, even though only scheduled ranges are shown.

4 *(optional)* If you do not want to view business events, click the expand (.FIELD) on the Change Requests bar. The calendar then shows only change requests.

5 Select a request.

A summary of the most important details about the change requests appears at the bottom of the change calendar. Click the View Full Details link to open the request.
6 Click a day in the calendar day picker to select the change requests and business events for a specific day.

**Figure 47: Calendar day picker**

The day picker shows the days of the month in which the currently shown activities occur. You can change the month in which activities appear with controls on the calendar day picker by moving forward or backward a month at a time, or by selecting a day in the month.

Each day is color-coded based on the maximum risk rule” computation of the aggregated change requests scheduled for that day. In this way, you can focus the activity chart time line around (for example, a high risk day to see what activities are scheduled then).

Next to the day picker is a legend that shows what the various bars and the color-coding mean in the change calendar.

**Figure 48: Legend**

7 In the navigation pane, select a filter option for displaying change requests.

For more information, see Viewing change requests on page 200.

8 Select which business events to show.

For more information, see Viewing business events on page 201.

9 *(optional)* Define your own user special defaults.

You can also use other quick links. For more information, see Using Quick Links on page 201.
10 (optional) Click the **Refresh** to refresh the requests and business events shown in the Change Calendar.

## Viewing change requests

The links in the navigation pane enable you to specify which change requests you see in the Change Calendar. When you select a filter option, its label is shown next to the Show field to alert users which search is being shown.

### WARNING

If you do not provide *any* criteria for the CI, Location, or Service CI, then the filter searches for change requests that satisfy the general specified criteria. The Change Calendar shows *all* change requests that have *any* relation to the CI, Location, or Service CI.

<table>
<thead>
<tr>
<th>Filter option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Filter</td>
<td>Lets you view requests by your own search criteria, based on categories such as status or risk level. When you select a search and click the Search button, the results based on your search criteria appear in the Change Calendar.</td>
</tr>
<tr>
<td>Filter By Related CI</td>
<td>Lets you view requests by their related CI. You can define, save, and delete your own search criteria, based on categories such as status, impact, and so on. You can further filter requests by choosing options, such as Operational Categorization (for example, Add) and Assignment (by manager’s name, group, or assignee). Finally, you can include CI criteria in your search (for example, a CI class such as software). When you select a search and click the Search button, the results based on your search criteria appear in the Change Calendar.</td>
</tr>
<tr>
<td>Filter By Location</td>
<td>Lets you include an impact location in your search (for example, by region, site group, or site). <strong>Note:</strong> You can only filter by Location for release requests. You can define, save, and delete your own search criteria, based on categories, such as Change Status, Approval Status, and so on. But you can further filter requests by choosing options, such as Product Categorization (for example, Software) and Assignment (by manager’s name, group, or assignee). When you select a search and click the Search button, the results based on your search criteria appear in the Change Calendar.</td>
</tr>
<tr>
<td>Filter option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service CI Search</td>
<td>Lets you view requests by service CIs. You can define, save, and delete your own search criteria, based on service CIs. Service CIs are in a hierarchical structure as defined by the user company. In searching for change requests by Service CI, you can specify the depth level to search. For example, depth level 2 means that you are searching the specified CI, its children, and its grandchildren (in the hierarchy tree) for all the related change requests. When you select a search and click the Search button, the results based on your search criteria appear in the Change Calendar. For more information about service CIs, see the <em>BMC Remedy Asset Management User’s Guide</em>.</td>
</tr>
</tbody>
</table>

### Viewing business events

The Business Events links in the navigation pane enable you to specify which business events you see in the Change Calendar. Each business event has a level attached to it. Make sure you are comparing the same level of business events. Events can be any level of 0 and above.

**Note**

If the Company field is cleared (every filter has a company field), then all business events of all companies are retrieved. Otherwise, only business events associated with the specified company are retrieved.

<table>
<thead>
<tr>
<th>Global</th>
<th>This setting is especially useful in a multi-tenancy environment. The global flag retrieves business events with Global as company identifier.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ If selected, shows <em>all</em> business events.</td>
</tr>
<tr>
<td></td>
<td>■ If clear, shows only the business events for the company.</td>
</tr>
</tbody>
</table>

| Level  | Retrieves level of business event indicated. If no level is defined (that is, it contains no value), all business events of all levels are retrieved.                                                     |

### Using Quick Links

Quick Links in the navigation pane enables you to select important functions from the Change Calendar.
### Setting time zone preferences for the Change Calendar

If your BMC Remedy Change Management application accesses a BMC Remedy Mid Tier server that is located in a different time zone, the time information that appears in your Change Calendar is not your local time, but is the time where the BMC Remedy Mid Tier server is located.

---

| Set Defaults | Opens the User Defaults dialog box.  
| Your application administrator can define optional defaults for you.  
| The Change or Release tab is displayed based on the calendar selected, Change or Release.  
| You can define Release and Change user settings for displaying change requests and release requests, based on categories, such as status, risk level, company, and so on.  
| You can override the following settings in the General tab:  
|  | **Business Events** — Defines user setting for displaying global business events and their level.  
|  | **Service CI** — Defines the user setting of the depth level shown for service CIs.  
|  | **Duration** — Defines the user setting of duration (for example, 5 days).  
|  | **Print Preferences** — Defines the user setting for page type and orientation when printing.  
| | When you click Save and close and open the Change Calendar, your user defaults are used. |
| New Release Request | Opens the Release form in New mode. For information, see [Initiate milestone - Creating release requests on page 276](#). |
| New Change Request | Opens the Change form in New mode. For information, see [Initiate stage - Creating change requests on page 113](#). |
| New Business Event | Opens the Registration for Shared Time Segment form in New mode. For information, see [Registering time segments on page 157](#). |
| Open Release Console | Opens the Release Console. For information, see [Release Management Console functional areas on page 99](#). |
| Open Change Console | Opens the Change Console. For information, see [Change Management Console functional areas on page 84](#). |
| Reports | Opens the Reporting Console. For information, see “Working with reports” on page 411. |
| Print | Opens the Print Properties dialog box. You can select page type (letter or A4), orientation (portrait or landscape), or supply a title for the printable page. Do not use the single-quote character (’ ) in this string because it triggers a JavaScript error. |
For example, you work in the Pacific time zone and you are assigned a change that should start at 10:00 a.m., local time. However, your BMC Remedy Mid Tier server is in the Eastern time zone (which is three hours ahead of Pacific time), so your Change Calendar shows a scheduled start time of 1:00 p.m.

You can fix this discrepancy by indicating your local time zone in the BMC Remedy AR System user preference record associated with your BMC Remedy AR System login ID.

**To set the time zone in your BMC Remedy AR System user preference record**

   
   a. In BMC Remedy User, click the **Open** icon.
   
   b. In the Object List dialog box, click the Find tab.
   
   c. In the Search What Key Words field, type AR System User Preference, and click **Find**.
   
   d. In the list of forms returned by the search, locate and double-click **AR System User Preference**.
   
   e. Search for your user preference record, and then select it.

2. Click the Locale tab.

3. From the menu beside the Time Zone field, select your time zone.

4. Click **Save**.

**Using the Change Management Dashboard**

The Change Management Dashboard provides flashboards containing key metrics associated with changes occurring in the organization. This dashboard enables the organization to make sure that change-related activities are meeting identified goals.
You must be a member of the CM Dashboard User permission group to view the Change Management Dashboard. You must also purchase a separate BMC Remedy Change Management Dashboard license. To purchase a license, contact your sales representative.

Figure 49: Change Management Dashboard

The Change Management Dashboard uses BMC Remedy Flashboards to provide executives (such as the CIO), the CAB, or change managers important data points and key metrics in a graphic and numeric format. The Change Management Dashboard helps executives and managers who are monitoring changes make sure their organizations are meeting their identified goals. It provides a mechanism for organizational improvement (for example, to identify areas that need improvement).

The Change Management Dashboard presents a set of statistics that provides a snapshot of the state of the Change Management process. You can choose which statistics to view, select criteria for focusing the view on the needed perspective, and specify how far back to show these data. Example statistics are the history of planned and unplanned changes over one of several time ranges, the number of authorized changes over (for example, the last week or month), and the success rate of changes made for the last thirty days.

The Change Management Dashboard helps you understand the trends relating to change configuration management (CCM) and take appropriate action to balance the
flow. The Dashboard enables you to view four different graphical Flashboards with different change request metrics at once. You can filter the data presented by the Flashboards by date to refine the shown information.

You can configure the Change Management Dashboard as needed. For maximum flexibility, you can select various flashboards to appear on the Dashboard screen, along with a time period that applies to all the flashboards shown.

**To use the Change Management Dashboard**

1. On the IT Home page, click the **Change Management Dashboard** link.

2. On the Change Management Dashboard, enter a start time and end time for the Flashboard data to view.

3. In the change statistics area, define how you want the flashboards to appear:
   - **Overall Health** - Choose one of the following settings:

<table>
<thead>
<tr>
<th>Flashboard name</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Success Rate</td>
<td>Successful closed change requests by Status Reason</td>
</tr>
<tr>
<td>Changes by Priority</td>
<td>Open change requests by 'Priority' and 'Categorization Tier 1'</td>
</tr>
<tr>
<td>Changes by Timing/Category</td>
<td>Closed change requests by 'Change Timing' and 'Categorization Tier 1'</td>
</tr>
<tr>
<td>Changes by Timing/Group</td>
<td>Closed change requests by 'Change Timing' and 'Support Group Name'</td>
</tr>
<tr>
<td>Changes Successful</td>
<td>Change requests with Status = Closed &amp; Status Reason = Successful</td>
</tr>
<tr>
<td></td>
<td>grouped by 'Support Group Name' and 'Categorization Tier 1'</td>
</tr>
<tr>
<td>Changes Unsuccessful</td>
<td>Change requests with Status = Closed &amp; Status Reason = Unsuccessful</td>
</tr>
<tr>
<td></td>
<td>grouped by 'Support Group Name' and 'Categorization Tier 1'</td>
</tr>
</tbody>
</table>

- **Financials** - Choose one of the following settings:

<table>
<thead>
<tr>
<th>Flashboard name</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Cost Variance</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Changes by Cost/Category</td>
<td>Average cost of closed changes by Category</td>
</tr>
<tr>
<td>Changes by Cost/Department</td>
<td>Average cost of closed changes by Department</td>
</tr>
</tbody>
</table>

- **Customer Data** - Choose one of the following settings:

<table>
<thead>
<tr>
<th>Flashboard name</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Requests by</td>
<td>Change requests by Organization and Company</td>
</tr>
</tbody>
</table>
### Operational Efficiency - Choose one of the following settings:

<table>
<thead>
<tr>
<th>Flashboard name</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change End Date Variance</td>
<td>Closed change requests by Category/Company versus closed emergency change requests by Category/Company</td>
</tr>
<tr>
<td>Change Start Date Variance</td>
<td>Closed change requests by Group/Company versus closed emergency change requests by Group/Company</td>
</tr>
<tr>
<td>Change Status</td>
<td>Open change requests by change request Status and Support Group</td>
</tr>
<tr>
<td>Changes by Impact</td>
<td>Closed change requests by Impact and Category</td>
</tr>
<tr>
<td>Changes by Performance Rating</td>
<td>Closed change requests by Performance Rating and Group</td>
</tr>
<tr>
<td>Changes Completed</td>
<td>Completed change requests by actual End Date and Category</td>
</tr>
<tr>
<td>Changes Rolled Back</td>
<td>Closed, backed-out change requests by Group and Category</td>
</tr>
</tbody>
</table>

4 *(optional)* Click **Refresh** to refresh the flashboards, including the date criteria (Start Date and End Date) specified, and show the change request data that matches the qualifications.

5 Click **Set Defaults** to open the User View dialog box, where you can save the flashboards which automatically appear when the Change Management Dashboard form opens.

The list for each Flashboard category shows the available Flashboards. In the Duration field, you can select a time period to show data for the last 7, 30, or 90 days.

6 Click **Save**.
Change coordinator role

This section contains information about using the BMC Remedy Change Management application as a change coordinator, and describes how to define, plan, schedule, and track change requests and related tasks.

Implement stage - Working as a change coordinator

At the Implement stage, change coordinators take over responsibility for working on the change request. Change coordinators are support staff members with specialized abilities who handle the details of the change request. Change coordinators frequently exercise lead responsibilities based on factors such as location, skill set, troubleshooting skills, difficulty of the change request, and company (if you are a service provider). In large companies, the change manager would be responsible for the overall change such as scheduling, but the change coordinator would perform the day-to-day management of the change request process, for example, building
and reviewing change plans, managing the change implementer, making sure that the change proceeds in a timely fashion, and so on.

**Figure 50: Implementing change requests**

The responsibilities of a change coordinator include the following tasks:

- Gathering appropriate information based on the type of change being investigated.

- Associating related CIs, incidents, and services to the change request.

- Providing status updates to requesters.

- Reviewing change plans and schedules—Planning activities include scheduling the change request, assessing risk and impact, creating plans, defining and sequencing the tasks needed to accomplish the change request, and scheduling people and resources for each task.

- Reviewing all completed tasks. In the Implement stage, at least one task related to the change request is in progress.

- Conducting post-implementation reviews to validate the results of the change request.

- Determining requester satisfaction with change request.

The change request remains at the Implement stage until all tasks are completed, all required approvals are granted, and reviewers verify that the change was implemented.
For more information about procedures frequently used by change coordinators, see the following links:

- Tracking efforts for a change request on page 217.
- Working with relationships on page 220.

Implementing a change request

This section describes the procedure to implement a change request.

To implement the change request

1. Open the change request.
2. Use the Process Flow Status bar to move the change request to Implement stage.
3. To modify the change request assignments, do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Work Detail tab.</td>
<td>Click the Assignment tab.</td>
</tr>
</tbody>
</table>

For information, see Working with change request assignments on page 211.

4. Click the Relationships tab.

Define the relationship of the change request to other change requests, CIs, LDAP objects, SLIs, and so on. For information, see Working with relationships on page 220.

5. Click the Tasks tab.

a. Create the tasks necessary to implement the change request. For information, see Implement stage - Working with tasks on page 260.

b. Assign the tasks to the appropriate task implementers. For information, see Working with BMC Remedy Change Management as a task implementer on page 341.

c. Reassign tasks as necessary. For information, see Responding to task reassignments as a change coordinator on page 272.
Identifying change requests as rollbacks

If the actions associated with a change request need to be reversed, your support staff and managers can identify the request as needing to be rolled back. This means that impacted systems need to be restored to their previous state before the change request was implemented. The status of a change request must be Implementation In Progress for you to identify it as a rollback.

**Note**

This procedure is a part of a more detailed user story that describes how to resolve a problem investigation with a change rollback.

In the user story, the known error is the result of an incident review request of incident request records associated with a specific CI. The change is initiated by the known error that identifies the problem’s root cause and indicates to the change coordinator that a rollback is required.

For more information about incident request reviews, see the *BMC Remedy Problem Management User’s Guide*. For more information about the use case, see the *BMC Remedy IT Service Management Concepts and Planning Guide*.

**To identify a change request as a rollback**

1. Open the change request.
2. Use the Process Flow Status bar to move the change request to Implement stage.
3. Make sure the Status field is set to Implementation In Progress.
4. Set the Status Reason field to In Rollback.
5. Create a related task to implement the rollback for this change request.
6. Roll back the change request.
7. Use one of the following options to add a work info record to enter information about why you are rolling back the change request:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update the fields on the Work Detail tab.</td>
<td>Update the fields on the Work Info tab.</td>
</tr>
</tbody>
</table>

8. Move the change request to Completed or Closed status.

Changes in value to the Status field are tracked in the audit trail.

9. Click **Save**.
Using the Change Management Console as a change coordinator

The Change Management Console is the primary interface for support staff, especially change coordinators. It provides a dedicated workspace for working on change requests. It provides quick access to the information and procedures that you need daily, so you do not need to open other BMC Remedy ITSM applications. The Change Management Console shows the most important details associated with changes requests, for example, tasks associated with changes, work information, and important broadcasts.

For more information, see Change Management Console functional areas on page 84.

Working with change request assignments

When BMC Remedy Change Management was being configured, the application administrator determined to whom the change request is to be assigned based on a combination of field values, such as the change location, operational categorization, and product categorization. Changes can be assigned to an individual or a support group. For example, all change requests that are categorized as hardware issues might be assigned to the IT Support Hardware group.

There are different roles within the assignment process— the change manager and change coordinator. The classic view has an additional change implementer role. The change manager typically oversees the overall change process, but the change coordinator plans and coordinates the efforts.

Note

This section focuses on change assignment from the perspective of the change coordinator. But there is potentially a great deal of overlap in responsibility between the change manager and the change coordinator.

Responsibilities for change coordinators include both assigning and accepting change requests. You must make sure that the assignment is correct and accept the change request. If you cannot accept or resolve an assigned change request, you or your manager can reassign the change request to another change coordinator. If the change request was categorized incorrectly, you can also reassign it. (For information, see Reassigning change requests on page 219.)

Change requests can be assigned manually or automatically. If an assignment definition has not been done for BMC Remedy Change Management, you must assign the change manually. (For information, see Automatically assigning changes on page 212.)
BMC Remedy Change Management can automatically assign change requests when they are defined. The assignment is based on the change request’s categorization. You can view information about who is assigned to the change request on the Infrastructure Change form. Where you look for this information depends on whether you are using the Best Practice view or the Classic view.

<table>
<thead>
<tr>
<th><strong>Best Practice view</strong></th>
<th><strong>Classic view</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>You can view the Change Coordinator and Change Manager directly from the Infrastructure Change form.</td>
<td>You view the Change Coordinator, Change Manager, and Change Implementer assignments from the Assignment tab.</td>
</tr>
</tbody>
</table>

**Note**

Before you can make any assignments to a Change Manager support group, you must define at least one individual with the Infrastructure Change Manager functional role.

The application administrator configures to whom the change requests are assigned. Assignment is configured based on criteria such as the change request’s categorization. For example, all change requests that are categorized as hardware issues might be assigned to the Support-Hardware group. All change requests that are categorized as software upgrades and originate from California might be assigned to Sonya Software in Santa Clara. The criteria of the change request together with the application administrator’s configuration determines to whom each change request is assigned.

**Automatically assigning changes**

You can automatically assign the change using the Auto Assign option.

<table>
<thead>
<tr>
<th><strong>When using the Best Practice view</strong></th>
<th><strong>When using the Classic view</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>In the Work Detail tab by clicking the auto assign icon 🏢 of the Manager Group field.</td>
<td>In the Assignment tab from the Set Assignment using or Set Implementer using menus.</td>
</tr>
</tbody>
</table>

Assigning the change coordinator using Auto Assign uses the requester’s information, the Change Location information, and the Operational and Product Categorization information about the form to determine an assignment match.

These assignments are based on routing information stored in the CFG:Assignment form. The CFG:Assignment form assigns the groups and then Auto Assign assigns the individual. For more information, see the *BMC Remedy IT Service Management Configuration Guide*. 
**Receiving notifications of change request assignments**

Change coordinators are notified of new change requests, based on their notification method preferences defined in their personal record.

For more information, see *Sending and receiving change notifications* on page 400.

The available notifications follow:

- **Individual Notification** - An individual change coordinator is notified according to the notification method specified in their personal record.
  
  For example, if Bob Backline has a notification method of BMC Remedy Alert, he receives a notification from BMC Remedy Alert for each change request that is assigned to him.

- **Group Notification** - A change manager group is notified according to the notification method specified by each group member’s entry in their personal record.
  
  For example, if a change request is assigned to the Support-Software group, each group member is notified through the notification method specified in their personal record. If Sarah Software has Email specified as the notification method in her personal record, the notification is sent to her by email. If Bob Backline has BMC Remedy Alert specified, he is notified accordingly.

**To receive notification of change assignment by BMC Remedy Alert**

1. Log in to BMC Remedy Alert. You must have support staff member permissions.

   When you or your group receives a notification that you or your group has been assigned to a change request, the information appears in the BMC Remedy Alert window.

2. To evaluate a change, select a change request in the BMC Remedy Alert window.

3. Choose **Alerts => Details**.

   The change request appears in the Change form. For more information, see *Setting application preferences - Change Management* on page 390.

**Viewing assigned changes**

When the system notifies you that a change request was assigned to you or to one of your groups, you can view the request from the Changes table on the Change Management console. You can also view all unassigned change requests.
Select the appropriate option in the Change Management Console based on changes you want to view.

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View changes assigned to you</td>
<td>1 In the Filter By field, choose <strong>Defined Searches =&gt; By Role =&gt; Change Coordinator =&gt; All Changes.</strong></td>
</tr>
<tr>
<td></td>
<td>2 In the Show field, select Assigned To Me. All changes that are assigned to you are displayed in the Assigned Change table.</td>
</tr>
<tr>
<td></td>
<td>3 Click a change request in the table. The assigned group and other important information is displayed in the Change Details and Tasks section.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>To view the complete assignment information, open the change request. In the Best Practice view, assignment details are displayed on the Change form. In the classic view, click the Work Detail tab.</td>
</tr>
<tr>
<td>View changes assigned to your groups</td>
<td>1 In the Show field, select Assigned to My Selected Groups.</td>
</tr>
<tr>
<td></td>
<td>2 Select a group, and then click <strong>OK.</strong></td>
</tr>
<tr>
<td>View all changes assigned to your group</td>
<td>1 In the Show field, select Assigned to All My Groups. All changes that are assigned to you are displayed in the Assigned Change table.</td>
</tr>
</tbody>
</table>

**Assigning change requests**

The Assignment tab displays the details of the current assignment. A change must be assigned to a change coordinator or a Change Management support group. However, the change manager is typically responsible for the overall change process.

**To assign change requests using the Classic view**

1 Open the change request.

2 Click the Assignment tab.

   Certain fields are automatically filled based on the default configuration and requester information in the change request. For example, the Change Manager field already has an assignment.

3 To assign a change coordinator, use one of the following options from the Set Assignment Using field, and then click Set:
- **My Default Group** - Assigns the change to you and your default group.

- **My Group List** - Opens a list of all groups to which you belong. Select the appropriate group from this list.

- **Favorite Groups** - Assigns the change to the typical groups to which your support group assigns requests.

- **Auto Assign** - Automatically assigns the request based on predefined mapping. Use this option if no change coordinator is assigned to the request.

- **Change Manager** - When the Change Manager and the Change Coordinator are the same group or person.

A user must have the Infrastructure Change Coordinator or Infrastructure Change Manager functional role to be a Change Coordinator. Groups that do not have a user with one of these functional roles are not available for selection in the Change Coordinator fields.

4. Save the change request.

   The change manager and the change coordinator are automatically notified of their assignments.

**To assign change requests using the Best Practice view**

1. Open the change request.

   Certain fields are automatically filled based on the default configuration and requester information in the change request. For example, the Change Manager field already has an assignment.

2. To assign a change coordinator, select the appropriate option:

   - **Coordinator Group** - Provides a list of coordinator groups. Select the group of the change coordinator you want to assign the change to.
     
     Groups that have at least one user with the Infrastructure Change Coordinator or Infrastructure Change Manager functional role are listed for selection.

   - **Change Coordinator** - Provides a list of users with the functional role of an Infrastructure Change Coordinator in the selected coordinator group. Select the appropriate change coordinator from this list.

3. To assign a change manager, select the appropriate option:
Manager Group - Provides a list of groups where at least one member has the Infrastructure Change Manager functional role. Select the Change Manager Group to which you want to assign the change.

Change Manager - Provides a list of users with the functional role of an Infrastructure Change Manager in the selected Manager Group. Select the appropriate change manager from this list.

Auto Assign - Automatically assigns the request based on predefined mapping. Use this option by clicking the auto-assign icon if no change coordinator is assigned to the request.

4 Save the change request.

The change manager and the change coordinator are automatically notified of their assignments.

Assigning changes to change implementers

You can assign changes to a change implementer. Assignments are similar for a change coordinator, except when you select Change Coordinator from the Set Implementer using field. Use this option to define the change coordinator as the change implementer.

Note

This section only applies if your are using BMC Remedy Change Management in Classic view. The Change Implementer fields were removed from the Best Practice view, since adding tasks to a change request is a best practice.

When a change request includes tasks, the Change Implementer fields no longer appear on the Assignment tab.

Note

If change implementer fields have been set, for example in a change template that was used, change implementers will be assigned and notified about the change request, but this information will not be displayed in the Best Practice view.

To assign changes to change implementers using the Classic view

1 Open the change request.
2 Click the Assignment tab.

Figure 51: Assigning change implementers (Classic view)

3 To assign a change implementer, use one of the following options in the Set Implementer using field and then click Set:

- **My Default Group** — Assigns the change to you and your default group.
- **My Group List** — Opens a list of all groups to which you belong. Select the appropriate group from this list.
- **Favorite Groups** — Assigns the change to the typical groups to which your support group assigns requests.
- **Auto Assign** — Automatically assigns the request based on predefined mapping.
- **Change Coordinator** — Automatically assigns the change to the change coordinator and updates the change implementer field with the change coordinator.

4 Save the change request.

The change implementer is automatically notified of the assignment.

### Tracking efforts for a change request

When working with assignments, you can record time spent on a change request. The Track Effort log shows a list of all individuals who worked on the change during its life cycle.

*Note*

Entries in the effort log are not system-generated, so you must enter them manually. The list is not in chronological order.
**To track efforts**

1. Open the change request.

2. Choose **Functions => Track Effort**.

3. Fill in the **Select an Assignee** fields.

   This information is required to select the individual for whom the effort log is being generated.

4. Fill in the **Select Effort Classification** fields.

   Select an Assessment Type, Phase, and Area. This information is required to show what kind of effort is being logged, for example, implementation activity.

5. Fill in the **Enter Effort Time Spent** fields.

   Enter the number of hours and minutes you worked on the change. This information records where the time was spent.

   **Note**
   
   As needed, you can adjust the time spent in the Update Assignee Effort Duration section. For information, see **Responding to task reassignments as a change coordinator on page 272**.

6. Click **Add**, and then click **Close**.

**Performing additional functions when tracking efforts**

In addition to creating a track effort log entry, you can perform the functions listed in the following table. All the listed functions are performed from the Change form.

**Note**

You must be the change manager or the change coordinator to modify the effort time.
Table 28: Additional functions when tracking efforts

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the effort log</td>
<td>1  From the change request, choose Functions =&gt;  Track Effort.</td>
</tr>
<tr>
<td></td>
<td>2  Select a record from the table and click View.</td>
</tr>
<tr>
<td></td>
<td>3  Update any of the assessment type information and the time spent.</td>
</tr>
<tr>
<td></td>
<td>4  Click Save.</td>
</tr>
<tr>
<td>Delete the effort log</td>
<td>1  From the change request, choose Functions =&gt;  Track Effort.</td>
</tr>
<tr>
<td></td>
<td>2  Select an entry.</td>
</tr>
<tr>
<td></td>
<td>3  Click delete.</td>
</tr>
<tr>
<td>Update the assignee effort</td>
<td>1  From the change request, choose Functions =&gt;  Track Effort.</td>
</tr>
<tr>
<td>duration</td>
<td>2  Select an entry.</td>
</tr>
<tr>
<td></td>
<td>3  Enter the time spent in hours or minutes.</td>
</tr>
</tbody>
</table>

Reassigning change requests

You or your manager can reassign the change request to another change coordinator.

For more information on reassigning change requests, see Working with change request assignments on page 211.

To reassign a change request yourself

1  Open the change request in the Change form.

2  Use one of the following to select who should be reassigned to the change request.

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the change form select the Coordinator Group and Change Coordinator. On the Work Detail tab select a Manager Group and Change Manager</td>
<td>On the Assignment tab, select to whom to assign the change request.</td>
</tr>
</tbody>
</table>
3 Click Save.

The Change Manager or Change Coordinator is notified of the reassigned change request.

---

**Working with relationships**

Change requests (and release requests) can affect and can be affected by configuration items (CIs) and other types of records (changes, releases, incidents, or problems). By defining these relationships, you can define a more sophisticated overview of the connections and interdependencies between the current request and other service issues being tracked by your system.

*Note*

This information about relationships applies equally to release requests. Where exceptions exist, these are noted.

Change requests can be affected by incidents, problems, and so on. BMC Remedy Change Management enables you to define relationships between change requests and other types of requests if the appropriate application has been installed.

*Note*

The options described in the table below will vary based on the BMC Remedy ITSM applications installed on the server.

<table>
<thead>
<tr>
<th>Request type related to change request</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other change requests</td>
<td>When you work with a change request, you can define related requests that address similar issues. For example, a set of related requests can result from many change requests sent to the service desk by one requester. A set of related requests can also result from a single request that encompasses several other requests. You can create a series of dependent change requests, where one must be completed before another request can be started, for example, a change request to upgrade Microsoft Outlook on the email server that has a Dependent relationship to a change request to upgrade the operating system. For more information, see Creating related change requests on page 242 and Relating change requests on page 242.</td>
</tr>
<tr>
<td>Configuration items</td>
<td>When you work with a change request, you can view a related configuration item (CI). For example, you might be working with a desktop system that consists of a laptop, mouse, keyboard, and docking station. The CI has information about the specific type of these CIs. For more information, see Working with related configuration items on page 246.</td>
</tr>
<tr>
<td>Unavailability of configuration items</td>
<td>When you work on a change request that requires a configuration item that would be unavailable when in use for the change request, you can view a related CI Unavailability. For more information, see Creating CI unavailability on page 253.</td>
</tr>
</tbody>
</table>
## Request type related to change request

<table>
<thead>
<tr>
<th>Request type related to change request</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP objects</td>
<td>When you work with a change request, you can view related LDAP objects. For example, you might want to relate a change request to an LDAP server where all the permission rights are stored to enable seamless authentication with Policy Manager. For more information, see Performing additional functions with relationships on page 248.</td>
</tr>
<tr>
<td>Release</td>
<td>When you work with a change request, you can view or create release requests. Releases can be related to a change request (in the Relationships tab, or contain the change request in the Release manifest. For example, you might want to create a release request and include the change in the Release manifest. For more information, see Working with release manifests on page 323.</td>
</tr>
<tr>
<td>Software library items</td>
<td>When you work with a change request, you can view related software library items (SLI), for example, different versions of Microsoft Office along with their license contracts. For more information, see Performing additional functions with relationships on page 248.</td>
</tr>
<tr>
<td>Asset configuration</td>
<td>When you work with a change request, you might need to work with a related asset configuration. For example, if you are working on a change request involving a monitor, relate the change to the monitor. You might also want to temporarily assign another monitor to the requester because work is being done on the original monitor. In this case, you can relate the change request to both monitor asset records. To perform this procedure, BMC Remedy Asset Management must be installed and integrated.</td>
</tr>
<tr>
<td>Incidents and problems</td>
<td>When you work with a change request, you might need to relate incidents and problems. If a change request for a server upgrade results in connection problems for the people affected by the change, for example, you can relate their incident to the server upgrade change request as you open the cases. This relationship can provide helpful information to the support staff working on resolving the incident. To perform this procedure, BMC Remedy Incident Management must be installed and integrated. For more information, see Performing additional functions with related change requests on page 245. For problem and known error investigation, BMC Remedy Problem Management must be installed.</td>
</tr>
<tr>
<td>Projects</td>
<td>A change request can be a part of a larger project. This relationship provides information about the project to which the change is related. To view this option, BMC IT Business Management Suite must be installed and integrated. Currently, you cannot relate a change request to a Project from the Change form.</td>
</tr>
</tbody>
</table>

For more information about relationships and request types, see “Related request types for BMC Remedy Change Management and Release Management” on page 222.
Related request types for BMC Remedy Change Management and Release Management

The Relationships tab shows the relationships between the current change request to CIs and to other modules inside BMC Remedy Change Management.

You use request types to define these relationships. The following table displays a list of request types to which you can relate changes (or releases) and their available actions, along with their start and end dates. The list varies depending on the other BMC Remedy ITSM applications you have installed with BMC Remedy Change Management.

Note
The Start date and End date values are not displayed in the Best Practice view.

Table 29: Related request types to Change and Release Management modules

<table>
<thead>
<tr>
<th>Request type</th>
<th>Actions</th>
<th>Relationship type</th>
<th>Start date</th>
<th>End date</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Unavailability (Asset Management)</td>
<td>■ Search—Opens the CI Unavailability Relationship Search form to search for an unavailable CI, and then relate it to the release.</td>
<td>Related to</td>
<td>■ Scheduled Start Date</td>
<td>■ Scheduled End Date</td>
<td>See Creating CI unavailability on page 253.</td>
</tr>
<tr>
<td></td>
<td>■ View—Opens the CI that is related to the release.</td>
<td></td>
<td>■ Actual Start Date</td>
<td>■ Actual End Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Remove—Removes the CI from the relationship with the release; it does not delete the CI.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request type</td>
<td>Actions</td>
<td>Relationship type</td>
<td>Start date</td>
<td>End date</td>
<td>More information</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>■ Search—Opens the CI Relationships Search form to search for a CI, and then relate it to the change or release.</td>
<td>■ Related to</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>See Working with related configuration items on page 246.</td>
</tr>
<tr>
<td></td>
<td>■ View—Opens the CI that is related to the change or release.</td>
<td>■ Upgrades</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Remove—Removes the CI from the relationship with the change or release; it does not delete the CI.</td>
<td>■ Installs</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Repairs</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Removes</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Impacts</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Moves</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Changes</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Note: For more information about the relationship types, see &quot;Related request types for BMC Remedy Change Management and Release Management&quot; on page 222</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project (If BMC Remedy IT Business Management is installed)</td>
<td>View—Opens the Project summary form that displays details of the Project to which the change is related.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request type</td>
<td>Actions</td>
<td>Relationship type</td>
<td>Start date</td>
<td>End date</td>
<td>More information</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
<td>-------------------</td>
<td>------------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td>Incident (If BMC Remedy Incident Management is installed)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>See Performing additional functions with relationships on page 248.</td>
</tr>
<tr>
<td>■ Search—Opens the Incident Relationship Search form to search for an incident, and then relate it to the change or release.</td>
<td>■ Related to</td>
<td>Reported Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>■ Create—Opens the Incident form in New mode.</td>
<td>■ Caused</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>■ View—Opens the incident that is related to the change or release.</td>
<td>■ Corrects</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>■ Remove—Removes the incident from the relationship with the change or release; it does not delete the incident.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request type</td>
<td>Actions</td>
<td>Relationship type</td>
<td>Start date</td>
<td>End date</td>
<td>More information</td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
<td>-------------------</td>
<td>------------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td>Infrastructure Change</td>
<td>▪ Search— Opens the Change Relationship Search form to search for a change, and then relate it to the change or release.</td>
<td>▪ Dependent ▪ Related to</td>
<td>▪ Scheduled Start Date</td>
<td>▪ Scheduled End Date</td>
<td>See Creating related change requests on page 242.</td>
</tr>
<tr>
<td></td>
<td>▪ Create— Opens the Change form in New mode.</td>
<td></td>
<td>▪ Actual Start Date</td>
<td>▪ Actual End Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ View— Opens the change that is related to the change or release.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Remove— Removes the change from the relationship with the change or release; it does not delete the change.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request type</td>
<td>Actions</td>
<td>Relationship type</td>
<td>Start date</td>
<td>End date</td>
<td>More information</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
<td>-------------------</td>
<td>------------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td>Known Error (if BMC Remedy Problem Management is installed)</td>
<td>■ Search— Opens the Known Error/Solution Search form to search for a known error, and then relate it to the change or release. ■ Create— Opens the Known Error form in New mode. ■ View— Opens the known error that is related to the change or release. ■ Remove— Removes the known error from the relationship with the change or release; it does not delete the known error.</td>
<td>■ Related to ■ Initiated by</td>
<td>■ Problem Reported On ■ Corrective Action Determined</td>
<td>■ Workaround Determined On ■ Infrastructe Chg Initiated</td>
<td>See Performing additional functions with relationships on page 248.</td>
</tr>
<tr>
<td>Request type</td>
<td>Actions</td>
<td>Relationship type</td>
<td>Start date</td>
<td>End date</td>
<td>More information</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>--------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>LDAP Object</td>
<td>■ Search—Opens the LDAP Search form to search for an LDAP item, and then relate it to the change or release.</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>See <a href="#">Performing additional functions with relationships</a> on page 248.</td>
</tr>
<tr>
<td></td>
<td>■ View—Opens the LDAP item that is related to the change or release.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Remove—Removes the LDAP item from the relationship with the change or release; it does not delete the LDAP item.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request type</td>
<td>Actions</td>
<td>Relationship type</td>
<td>Start date</td>
<td>End date</td>
<td>More information</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>------------</td>
<td>----------</td>
<td>------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Problem Investigation (Problem Management) | ■ Search—Opens the Problem Relationship Search form to search for a problem, and then relate it to the change or release.  
■ Create—Opens the Problem Investigation form in New mode.  
■ View—Opens the problem that is related to the change or release.  
■ Remove—Removes the problem from the relationship with the change or release; it does not delete the problem. | Related to         | Problem Reported On | Workaround Determined On | Solution Created | See Performing additional functions with relationships on page 248. |
<table>
<thead>
<tr>
<th>Request type</th>
<th>Actions</th>
<th>Relationship type</th>
<th>Start date</th>
<th>End date</th>
<th>More information</th>
</tr>
</thead>
</table>
| Release      | ■ Search— Opens the Release Relationship Search form to search for a release request, and then relate it to the change or release.  
■ Create— Opens the Release form in New mode.  
■ View— Opens the release request that is related to the change or release.  
■ Remove— Removes the release request from the relationship with the change or release; it does not delete the change or release. | ■ Related to  
■ Member of | ■ Scheduled Start Date  
■ Deployment Start Date | ■ Scheduled End Date  
■ Deployment End Date | See Searching for request types and establishing the relationship type on page 333. |
<table>
<thead>
<tr>
<th>Request type</th>
<th>Actions</th>
<th>Relationship type</th>
<th>Start date</th>
<th>End date</th>
<th>More information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Library Item</td>
<td>■ Search—Opens the Software Library Item Search form to search for an SLI, and then relate it to the change or release.</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>See Performing additional functions with relationships on page 248.</td>
</tr>
<tr>
<td></td>
<td>■ View—Opens the SLI that is related to the change or release.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Remove—Removes the SLI from the relationship with the change or release; it does not delete the SLI.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Configuration Item relationship types

When you work with a change request, you can view a related configuration item (CI). This section lists the relationship types available when defining a relationship between a Configuration Item and a Change Request.

When defining a relationship between a Configuration Item and a Change Request, the following options are available:

- **Related to** - Relates the item or request to the Change Request
- **Upgrades** - Upgrades the item or items as part of the Change Request process
- **Repairs** - Repairs the items or items as part of the Change Request process
- **Impacts** - Impacts the item that as part of the Change Request process
- **Moves** - Moves an item from one location to another location as part of the Change Request process
- **Installs** - Installs the item as part of the Change Request process
- **Removes** - Removes an item from the location as part the Change Request process
- **Changes** - Changes items as part of the Change Request process

These options are for information purpose which can be used while reporting. You have the option to use them based on the organizational requirements and processes.

### Defining relationships

Use the following procedure to define a relationship.

**To define a relationship when using the Best Practice view**

1. Open the change request
2. In the Quick Action area, click the arrow beside *Create Relationship to*.
3. From the menu, select the type of record to which you want to relate the current record.
4. In the Search field of the dialog box that opens, type a search string. For example, if you are creating a relationship to an incident request about a printer that regularly goes off-line, you might type *printer off line*. Try to supply as much information as possible in each type of search to reduce the overall number of records returned by the search.

   **Note**
   
The type of search dialog box that appears depends on the type of record you chose from the menu.

The search scans multiple fields in each record looking for a match, and returns a list of records that contain any of the words - printer, off, or line in one of the scanned fields.
If, after using a more specific search string, the search returns too many records, consider using the advanced search. To do this, click Use Advanced Search, which opens a form in search mode that is relevant to the type of relationship you are making.

The keyword search is available only when BMC Remedy Knowledge Management is installed with BMC Remedy IT Service Management. If BMC Remedy Knowledge Management is not installed, the Advanced Search is displayed. If the Advanced Search is displayed, in the search window for the request type, enter information about the search criteria tabs, and then click Search.

The Alternate Data Set field defines the dataset will be used to search for a CI. For more information about datasets, see the BMC Remedy Asset Management User Guide.

5 From the search results table, select the specific record to which you want to create the relationship.

6 From the Relationship Type list at the bottom of the search dialog box, select the type of relationship you want to create.

7 Clicking Relate to create the relationship.

The specific list for Select a Relationship Type depends on the type of relationship you are creating. For example, if you are creating a relationship with another change request record, the list includes Related to, if you are creating a relationship with an incident request record, the list includes Related to, Caused, and Corrects. If you are creating a relationship with a known error, there are two relate buttons: Initiated by and Related to, and so on.

Additional buttons might be displayed depending on the type of relationship you are creating. For example, if you are creating a relationship with another incident request record, only the Relate button is displayed. If you are creating a relationship with a known error, there are two relate buttons: Relate With Solution and Relate Without Solution, and so on.

8 Close the search dialog.
To define relationships when using the Classic view

1. Open the change request from which to define the relationship, and then click the Relationships tab.

   The Relationships tab shows the record types that you can relate to the change.

2. (optional) In the Alternate Data Set field, select a data set to relate with CIs.

   For more information, see Relating CIs to alternate data sets on page 251.

3. From the Request Type list at the bottom of the Relationships tab, select the type of record to which to relate the current record.

   You can relate a change to any of the options listed in the Request Type field, for example, Infrastructure Change. For specific instructions on CIs, see Relating configuration items to change requests on page 247.

4. Click Search to search for a request type or Create to create a new request. For more information on these options, see the Related request types to Change and Release Management modules table.

   If you create a new change request, the request is automatically related to the change request when you save it.

5. In the Search field of the dialog box that opens, type a search string. For example, if you are creating a relationship to an incident request about a printer that regularly goes off-line, you might type printer off line. Try to supply as much information as possible in each type of search to reduce the overall number of records returned by the search.

   **Note**
   The type of search dialog box that appears depends on the type of record you chose from the menu.

   The search scans multiple fields in each record looking for a match, and returns a list of records that contain any of the words - printer, off, or line in one of the scanned fields.

   **Note**
   If, after using a more specific search string, the search returns too many records, consider using the advanced search. To do this, click Use Advanced Search, which opens a form in search mode that is relevant to the type of relationship you are making.

   The keyword search is available only when BMC Remedy Knowledge Management is installed with BMC Remedy IT Service Management.
Remedy Knowledge Management is not installed, the Advanced Search is displayed. If the Advanced Search is displayed, in the search window for the request type, enter information about the search criteria tabs, and then click Search.

6 From the search results table, select the change request with which to define the relationship.

7 From the Relationship Type list at the bottom of the search dialog box, select the type of relationship to define.

8 Click Relate, and then click OK.

---

**Note**
The specific list for Select a Relationship Type depends on the type of relationship you are creating. For example, if you are creating a relationship with another change request record, the list includes Related to, if you are creating a relationship with an incident request record, the list includes Related to, Caused, and Corrects. If you are creating a relationship with a known error, there are two relate buttons: Initiated by and Related to, and so on.

---

**Note**
Additional buttons might be displayed depending on the type of relationship you are creating. For example, if you are creating a relationship with another incident request record, only the Relate button is displayed. If you are creating a relationship with a known error, there are two relate buttons: Relate With Solution and Relate Without Solution, and so on.

9 Click OK.

10 Close the search window.

The related request types and relationship types appear in the Relationships table. To refresh the table, click **Refresh** from the right-click menu.

# Using Quick Actions on relationships

The Quick Actions menu on the Relationships Tab enables you to perform advanced actions on relationships. Not all actions are available with all request types. This table shows the relationship between request types and the available actions you can perform on them.
### Table 30: Matrix of request types and quick actions

<table>
<thead>
<tr>
<th>Request type</th>
<th>Relationship quick action</th>
</tr>
</thead>
</table>
| CI Unavailability        | ■ Broadcast CI Unavailability  
                          | ■ Get Related Relationships  
                          | ■ Modify Relationship Type  |
| Configuration Item       | ■ Create New CI Unavailability  
                          | ■ Explore CI              
                          | ■ Get CI Impact/Urgency    
                          | ■ Get CI Product Categorization  
                          | ■ Get Impacted Areas        
                          | ■ Get Related Relationships 
                          | ■ Modify Relationship Type  
                          | ■ Show Related Services     |
| Project                  | None                                                            |
| Incident                 | ■ Get Related Relationships  
                          | ■ Modify Relationship Type  |
| Infrastructure Change    | ■ Get Related Relationships  |
| Known Error              | ■ Get Related Relationships  
                          | ■ Modify Relationship Type  |
| LDAP Object              | None                                                            |
| Problem Investigation    | ■ Get Related Relationships  
                          | ■ Modify Relationship Type  |
To use quick actions

1. Select the entry from the Relationships table.

2. From the Quick Actions menu, select an action.

For example, you can copy relationships from a CI already related to the release request. This table lists all the quick actions you can use.

Table 31: Effect of using Relationship Actions

<table>
<thead>
<tr>
<th>Relationship action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explore CI</td>
<td>Opens the graphical BMC Atrium Explorer that shows the selected CI’s relationship to other CIs.</td>
</tr>
<tr>
<td>Create New CI Unavailability</td>
<td>Creates a new CI Unavailability record for the selected CI.</td>
</tr>
<tr>
<td>Note: This option is available only if BMC Remedy Asset Management is installed. For more information, see:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To create CI unavailability where other CI unavailability already exists on page 255</td>
</tr>
<tr>
<td></td>
<td>To create CI unavailability from CIs associated with a request on page 256</td>
</tr>
<tr>
<td>Get CI Impact/Urgency</td>
<td>Sets the current release request’s Impact and Urgency to the corresponding values of the selected CI.</td>
</tr>
<tr>
<td>Get CI Product Categorization</td>
<td>Sets the current release request’s Product Categorization to that defined in the selected CI.</td>
</tr>
<tr>
<td>Get Related Relationships</td>
<td>Copies the relationships of the selected record to the release request’s relationships. For more information, see Copying relationships on page 240.</td>
</tr>
<tr>
<td>Modify Relationship Type</td>
<td>Modifies the relationship type and enter a new description for the related item.</td>
</tr>
</tbody>
</table>

3. Click Execute.
Viewing the impact of CIs on change requests

You can relate CIs to change requests, based on a simulated impact analysis generated by the Atrium Impact Simulator tool. Additional workflow in BMC Remedy Change Management lets you use Atrium Impact Simulator functionality to predict how a change to the availability of a CI affects other CIs and services. For example, you could run a simulation in Atrium Impact Simulator to learn what devices and applications in the network are affected if you take a specific server offline due to scheduled maintenance or lease returns.

Atrium Impact Simulator is transparently integrated into other BMC applications as an integral part of their workflow. From BMC Remedy Change Management, Atrium Impact Simulator exposes only the features required for the user, simplifying the user experience.

For additional information, see Atrium Impact Simulator analysis for change requests on page 134.

**Note**
The Impact Analysis functionality is not available on the Relationships tab of the Release form.

To view impact of CIs on change requests

1. Open the change request, and then click the Relationships tab.

2. Relate at least one CI to the request.

   You can layer multiple requests for different types of CIs and add to the impacted list. You can use any Relationship Type except Impacts.

3. In the Relationships tab, click **Impact Analysis**.
The Atrium Impact Simulator opens.

**Figure 52: Atrium Impact Simulator**

4 Click Simulate Impact to run the simulation.

In the Simulation Progress dialog box, you can click the Cancel button to stop a long running simulation (if needed).

5 Click the Results in Table tab.

A list of impacted CIs are listed and also the number of results is displayed in the header bar.

6 To relate the results to the change request, you can perform the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the Relate column to Yes or No</td>
<td>By default, the change results are defaulted to Yes for relate. Using the column relate, you can individual toggle the action to No or Yes for granular control. These can be set as a group, using Execute options.</td>
</tr>
</tbody>
</table>

Running an impact simulation does not relate the results automatically to the change record. You must click Execute to select the results that should be related.
<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Only Services (click to toggle)</td>
<td>Lists only impacted service CIs in the view. This action has no effect on relating.</td>
</tr>
<tr>
<td>Show All Results (click to toggle)</td>
<td>Lists all impacted CIs in the view. This action has no effect on relating.</td>
</tr>
<tr>
<td>Pick list and Execute button</td>
<td>These options modify the relate options. They provide a quick way to select groups of CIs to relate or unrelate. You can select from the following options:</td>
</tr>
<tr>
<td></td>
<td>■ Relate All — Relates all CIs and services from the change request.</td>
</tr>
<tr>
<td></td>
<td>■ Unrelate All — Unrelates all CIs and services from the change request.</td>
</tr>
<tr>
<td></td>
<td>■ Relate All Services — Relates only services to the change request.</td>
</tr>
<tr>
<td></td>
<td>■ Unrelate All Services — Unrelates only services from the change request.</td>
</tr>
<tr>
<td></td>
<td>■ Relate Selected — Based on the CIs or services you pick, relates them to the change request.</td>
</tr>
<tr>
<td></td>
<td>■ Unrelate Selected — Based on the CIs or services you pick, unrelates them from the change request.</td>
</tr>
<tr>
<td>Click Report</td>
<td>Runs a report that exports all the fields in the simulation. This report can export all fields that are in the new .csv file or any subset of them. The report file, which is attached to the change request, provides a history that can be referenced in the future.</td>
</tr>
<tr>
<td>Click Cancel</td>
<td>Exits the window without make any changes.</td>
</tr>
<tr>
<td>Click Save</td>
<td>Creates the CI relationships between the change request and the selected CIs. The CIs are now displayed in the Relationships tab. Work information is created for the change request, along with a simulation .csv file attached.</td>
</tr>
</tbody>
</table>

Click Close to create the CI relationships between the change request and the selected CIs.

The CIs are now displayed in the Relationships tab. Work information is created for the change request, along with a simulation .csv file attached.
Copying relationships

When you define a relationship between the current change and another change, the other change request might also have one or more changes related to it. On the Relationships tab opened from the Copy Related Relationships form, you can see the related change’s other relationships. If you determine that any of these other relationships need to be related to the current change, you can define the relationship from this form.

By doing this, you can more thoroughly document the change relationships.

To copy relationships

1. Open the change request, and then click the Relationships tab.
2. Select a change related to the current change.
3. From the Quick Actions list, select Get Related Relationships, and then click Execute.

The Copy Related Relationships form appears, containing a table of all other records related to the record you selected in Step 2 on page 143.
4. From the table of related items, select the other items to relate to the current change.

   **Note**
   To see a detailed description of an item in the table, select it, and then click View. Use this feature to help determine whether to relate the other item to the current change.

5. In the Relationship Type field, select the type of relationship to define, and then click Select.

   **Note**
   The contents of the Relationship Type list depends on the type of related item you are using to define the relationship.

The newly created relationship appears in the Relationships table. For more information, see Performing additional functions with relationships on page 248.
Viewing relationships

You can limit which relationships shown with the current change record. You can also limit the list of associated relationships by selecting Show Related <option>, for example, to see only Known Errors.

To view relationships

1. Open the change request, and then click the Relationships tab.
2. Select the entry from the Relationships table.
3. To view a specific request type, choose it from the Show Related field.

The list varies depending on the other applications you have installed with BMC Remedy Change Management.

<table>
<thead>
<tr>
<th>Relationship</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Shows all related assets, change requests, incidents, CIs, and so on (if you have the corresponding application installed).</td>
</tr>
<tr>
<td>CI Unavailability</td>
<td>Shows the related CI unavailability tied to the change entry. This option is enabled only if BMC Remedy Asset Management is installed.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Shows the related CIs.</td>
</tr>
<tr>
<td>Incident</td>
<td>Shows the related incidents. This option is enabled only if BMC Remedy Incident Management is installed.</td>
</tr>
<tr>
<td>Infrastructure Change</td>
<td>Shows the related change records.</td>
</tr>
<tr>
<td>Known Error</td>
<td>Shows the related known errors. This option is enabled only if you have BMC Remedy Problem Management is installed.</td>
</tr>
<tr>
<td>LDAP Object</td>
<td>Shows the related LDAP objects.</td>
</tr>
<tr>
<td>Problem Investigation</td>
<td>Shows the related problems. This option is enabled only if you BMC Remedy Problem Management is installed.</td>
</tr>
<tr>
<td>Project</td>
<td>Shows related projects.</td>
</tr>
<tr>
<td>Release</td>
<td>Shows the related release objects.</td>
</tr>
<tr>
<td>Software Library Item</td>
<td>Shows the related software library items, that is, the location where the master copy of the software program and its version are stored.</td>
</tr>
</tbody>
</table>

The related items appear in the table.

4. Click the icon.

You can now view the details of the related item.
For example, if you select an incident relationship and click the 🗳 icon, the Incident Request form opens, showing information about the Incident.

---

**Note**

Double-click a relationship entry to open the associated form. You then can modify the record, depending on your configuration.

---

For relationships external to BMC Remedy Change Management (such as an incident or a problem), you must have the required view permissions for the BMC Remedy ITSM application to view the record details.

---

### Creating related change requests

When you work with a change request, you might need to define a related change request. For example, you might need to define related change requests that address similar problems. A set of related change requests can result from many changes needed by one requester at the same time.

**To define a change request related to another change request, with no dependency**

1. Open the change request, and then click the Relationships tab.
2. Select the entry from the Relationships table.
3. From the Quick Actions list, select **Create Related Request => Infrastructure Change**.

   In the Change form, fill in the details on the Change form as described in Initiate stage - Creating change requests on page 113.

4. Click **Save**.
5. Return to the original change request using the breadcrumb bar.
6. Save the original change request.

---

### Relating change requests

When you work with a change request, you might also need to relate a change request to it. Relating change requests enables the support staff to work with multiple change requests for the same requester at once. With related change
requests, you can optionally designate if the current change request exists in a dependent relationship to a change request.

**To relate a change request to another change request**

1. Open the change request, and then click the Relationships tab.
2. Select the entry from the Relationships table.
3. In the Request Type field, select Infrastructure Change, and then click **Search**.
4. In the Change Relationship Search form, use the various tabs to choose the appropriate search criteria.
5. To use more specific search criteria, click the Advanced Search tab, enter the appropriate search criteria, and then click **Search**.
6. In the Change Results table, select the item to relate.
7. In the Relationship Type field, select how to relate the current request to the selected change request.

   The options are:

   - **Related To** — Indicates the two changes are related to each other.

   - **Dependent** — Indicates the current change request depends on the original change. Dependent changes can be assigned sequence numbers to specify the sequence in which the dependent change requests should be completed. For more information about dependencies, see the next procedure, **Assigning sequence numbers to dependent change requests on page 243**.

8. Click **Relate**, and then click **OK**.

   If you create a Dependent relationship, the sequence appears in the Relationships table.

9. Save the change request.

**Assigning sequence numbers to dependent change requests**

When you create change requests with relationship as dependent, you should specify the sequence in which change requests are to be completed. When you specify a sequence for the dependent change requests, you must complete a change request with the sequence number 0 before you can start a change request with the sequence number 1.
In the following example, you have two related change requests—the change request to update the I/O device software has Dependent relationships to two other change requests.

**Note**

You cannot assign sequence numbers to release requests. To add sequence numbers to tasks, see Assigning a sequence number to task groups and tasks on page 268.

**To define a dependent change request**

1. Open the change request to upgrade the operating system, and then click the Relationships tab.

2. Select the Dependent change request from the Relationships table.
   
   The default sequence number for the dependent change request is 0.

3. Click View.

4. In the dependent change request, do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Relationships tab.</td>
<td>Click the Classification tab.</td>
</tr>
</tbody>
</table>

5. In the Sequence field, enter a number (for example, 1).
   
   The sequence number indicates the order in which the dependent change request must be completed relative to the original change request.

6. If necessary, add any additional information about the Change form to finish relating the change request.

7. Save your work, and then close the change request.
   
   You return to the original change request.

8. To view the updated sequence number, refresh the table.
   
   The record now shows a sequence of 1. The sequence number indicates the order in which you must complete the current request relative to the dependent request. In this example, you must now complete the change request (sequence 1) to
remove the old software before you can start work on installing the new software (sequence 2).

**Figure 53: Related change requests with sequence numbers (Classic view)**

9. Save the change request.

**Performing additional functions with related change requests**

You can perform the additional functions with related change requests that are listed in the following table.
## Working with relationships

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View change dependencies</td>
<td>1. Open the change request in the Change form, and then click the Relationships tab.</td>
</tr>
<tr>
<td></td>
<td>2. In the Show Related field, select Infrastructure Change. A list of change requests appears in the table. Changes with a dependent relationship to the current request are shown as Dependent under the Relationship Type column. The table shows the status of each request and enables you to monitor the progress of the change request implementation.</td>
</tr>
<tr>
<td></td>
<td>3. To view a request, select it, and then click View.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Remove a related change request</th>
<th>1. Open the change request in the Change form, and then click the Related Items tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Select the request to unrelate, and then click Remove Relationship.</td>
</tr>
<tr>
<td></td>
<td>3. Save the change request.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This procedure removes the change request from the relationship with another change request. It does not delete any change requests.</td>
</tr>
</tbody>
</table>

### Working with related configuration items

When you work with a change request or a task, you might need to work with related CIs. For example, if you are working on a change request to upgrade memory for a department, you work with the asset records for the department members, configuration information for desktop systems, and information about the memory in inventory.

For more information about CIs, see Managing configuration items on page 453.

### Working with configuration items related to change requests

You can do the following when working with configuration items related to change requests:

- View configuration items related to a change request
- Relate configuration items to change requests
- Define new configuration items to relate to change requests
- Unrelate configuration items from change requests

**Viewing configuration items related to change requests**

You can view the configuration information from within BMC Remedy Change Management in the Relationships tab of the Change form. Select the configuration item from the Show Related list, select the configuration item, and then click View. The Asset Management Configuration Information form appears, showing details of the configuration.

**Note**
You cannot define a new configuration item on the Relationships tab. Use the Advanced Functions => Manage CIs on the Change Management console to define new CIs. For more information, see Managing configuration items on page 453.

**Relating configuration items to change requests**

The following section provides detailed instructions about searching for configuration items and relating them to change requests.

For more information, see Defining relationships on page 231.

**To relate configuration items to change requests**

1. Open a change request, and then click the Relationships tab.
2. From the Request Type field, select Configuration Item, and then click Search.
3. On the CI Relationships Search form, complete the search criteria tabs with the relevant information, and then click Search.
   
   Matching results appear in the CIs table.
4. In the Relationship Type field, select the type to relate with the change request, for example, Installs.
   
   For more information on relationship types, see Configuration Item relationship types on page 230.
5. Click Relate.
   
   The original change request and the related configuration item appear in the Relationships tab.
When you relate a CI to a change, the CI’s Impacted Areas can be automatically copied into the change’s Impacted Areas, based on the Relationship Type. This allows for impact analysis within the change record and makes sure that Change Approvers can be generated based on any Impacted Area Approval mappings related to moves, upgrades, impact, or repairs. In the SYS:Association Types form, administrators can define whether a particular Relationship Type copies the CI’s Impacted Area to the change.

Performing additional functions with relationships

You can perform the additional functions with relationships that are listed in the following table.

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify a relationship</td>
<td>1. On the Relationships tab of the Change form, select the change with the relationship to modify.</td>
</tr>
<tr>
<td></td>
<td>2. From the Quick Actions menu, choose Modify Relationship Type, and then click <strong>Execute</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Modify the Relationship Type or Relationship Description, and then click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Remove a relationship</td>
<td>1. On the Relationships tab of the Change form, select the change with the relationship to remove.</td>
</tr>
<tr>
<td></td>
<td>2. Click <strong>Remove</strong>.</td>
</tr>
<tr>
<td>Copy relationships to a CI that is related to the change</td>
<td>1. On the Relationships tab of the Change form, select the corresponding CI relationship entry from the Relationships table</td>
</tr>
<tr>
<td></td>
<td>2. From the Quick Actions menu, choose Get Related Relationships, and then click <strong>Execute</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. On the Relationships for Configuration Item dialog box, select the item to relate to the current change. Select a Relationship Type, and then click <strong>Select</strong>.</td>
</tr>
<tr>
<td>Function</td>
<td>Action</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unrelate a CI from a change request</td>
<td>1. In the Show Related field on the Relationships tab of the Change form, select Configuration Item.</td>
</tr>
<tr>
<td></td>
<td>2. Select the configuration item to unrelate, and then click <strong>Remove</strong>.</td>
</tr>
<tr>
<td>Relate a change request to an LDAP object</td>
<td>When you work with a change request, you must define a related LDAP object. For example, to enable seamless authentication with Policy Manager you might want to relate a change request to an LDAP server where the permission rights are stored.</td>
</tr>
<tr>
<td></td>
<td>1. On the Relationships tab of the Change form, select the entry to relate to an LDAP object.</td>
</tr>
<tr>
<td></td>
<td>2. In the Request Type field, select LDAP Objects, and then <strong>Search</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. From the search results, select the LDAP object to relate to the change request, and then click <strong>Relate</strong>.</td>
</tr>
<tr>
<td></td>
<td>The change request and the related LDAP item appear on the Relationships tab.</td>
</tr>
<tr>
<td>Relate a change request to an software library item (SLI)</td>
<td>When you work with a change request, you might need to define a related software library item. For example, you might need to view related software library items (SLIs), for example, different versions of Microsoft Office along with their license contracts. SLIs are also used by Policy Manager to determine the location of software to deploy.</td>
</tr>
<tr>
<td></td>
<td>1. On the Relationships tab of the Change form, select the entry to relate to an SLI.</td>
</tr>
<tr>
<td></td>
<td>2. In the Request Type field, select Software Library Item, and then <strong>Search</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. From the search results, select the Software Library Item to relate to the change request, and then click <strong>Relate</strong>.</td>
</tr>
<tr>
<td></td>
<td>The change request and the related SLI appear on the Relationships tab. For more information, see the <em>BMC Remedy Asset Management User’s Guide</em>.</td>
</tr>
</tbody>
</table>
### Working with relationships

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
</table>
| Define an incident related to a change request | 1. On the Relationships tab of the Change form, select the entry for which to define an incident.  
2. In the Request Type field, select Incident, and then click **Create**.  
3. On the Incident form, define the incident. For instructions, see the *BMC Remedy Incident Management User’s Guide*.  
4. Save the incident and the change request.  
5. To see the incident, refresh the Related Items table.  
   **Note:** To perform this function, BMC Remedy Incident Management must be installed. |
| Relate an incident to a change request | 1. On the Relationships tab of the Change form, select the entry to relate to change request  
2. In the Request Type field, select Incident, and then **Search**.  
3. From the search results, select the incident to relate to the change request.  
4. Select the option for how to relate the incident to the change request, and then click **Relate**.  
   **Note:** To perform this function, BMC Remedy Incident Management must be installed. |
| Unrelate an incident from a change request | 1. On the Relationships tab of the Change form, select the entry to relate to change request  
2. In the Show Related field, select Incident.  
3. Select the incident to unrelate, and then click **Remove**.  
4. Save the change request.  
   **Note:** To perform this function, BMC Remedy Incident Management must be installed. |
Relating CIs to alternate data sets

When you open the Change form, different data sets are available when relating CIs to a change request:

- Personal Preference Change Data Set (CDS) — When you open the Change form, the personal preference change data set is loaded as a global setting from your application preference settings. If this setting is blank, the production data set is loaded from the AST:AppSettings form.

For more information, see Setting application preferences - Change Management on page 390.

- Production Data Set (PDS) — If there is no CDS, the PDS is loaded as the global setting. The PDS value is taken from the data set field on the AST:AppSettings form.

- Alternate Data Set (ADS) — Field on Change form on the Relationships tab that enables you to select a different data set other than the CDS or PDS.

**Note**

For more information about datasets, see the section on Changing datasets in the BMC Remedy Asset Management User Guide.

You must understand the following restrictions if you use an alternate data set when relating CIs:

<table>
<thead>
<tr>
<th>Configuration items</th>
<th>Alternate Data Set field</th>
<th>Data set preference</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>If there are no CIs related to the change...</td>
<td>Empty</td>
<td>CDS</td>
<td>You can select the ADS as needed. After you start working on the change request, the setting of the ADS is the data set that you selected last.</td>
</tr>
</tbody>
</table>
| If there are no CIs related to the change... | Empty | PDS | PDS is used.  
**Note:** An empty Alternate Data Set field is equivalent to using the PDS. |
| If CIs are related to the change... | Selected | Not applicable | Alternate Data Set field is locked. If you relates a CI with the ADS, you **must** save the change to save the ADS.  
**Note:** There is no database rollback on the relationships. |
| If all related CIs are removed... | Editable | Whatever the last value is | When all related CIs are removed, the Alternate Data Set field becomes editable. If you clear the Alternate Data Set field when it is editable, the data set is PDS. |

**Note**

The CDS is the default value, and is used only if ADS is set to CDS when you relate a CI. If you choose the PDS, you must clear the Alternate Data Set field.
Note

When the status of the change reaches Closed, the change is locked for everyone except the Change Master. Only the Change Master can make modifications to a change request in the Closed status, including adding and removing relationships. For the Change Master, the Alternate Data Set field behaves the same way as when the relationship is not locked.

To relate CIs from alternate data sets

1. In the Relationships tab, choose a data set from the Alternate Data Set list, for example, BMC Asset.

   Depending on the applications installed, you might see the following options:
   - BMC Asset
   - BMC Configuration Import
   - BMC Sample Dataset
   - BMC.ASSET.SANDBOX

2. Relate CIs from the alternate data set as needed.

   The CI Relationships Search dialog box enables you to search for and relate CIs from the alternate data set. After you select a CI from the alternate data set, the Alternate Data Set is locked.

   Figure 54: Alternate data set locked

3. To unlock the data set, remove all the CIs.

   The Alternate Data Set field is unlocked.
4 Select another data set as needed.

5 To return to the PDS, click Clear.

Creating CI unavailability

CI Unavailability entries track down time of an outage against a CI. For example, CI unavailability can be an outage due to scheduled maintenance, usually through a scheduled change. Also, CI unavailability can occur due to an unexpected circumstance, usually related to an incident.

**WARNING**

You can define CI Unavailability entries only if BMC Remedy Asset Management is installed.

There are two ways to define CI Unavailability entries for a related CI:

- Directly—By clicking the Relate with Unavailability button from the CI Relationships Search form, when you are creating the relationship with the CI.

- Indirectly—By creating the unavailability after the CI has been associated with the change. For more information, see Defining new CI unavailability for a record—alternative method on page 256.

When you save the CI Unavailability entry, the CI Unavailability relationship entry is generated. A CI Unavailability relationship entry then appears on the Relationships tab.

**Note**

CI Unavailability cannot be tracked directly against CI Components. The Relate with Unavailability button does not appear on the CI Relationships Search form when you are searching for CIs from a release request.

Relating unavailable CIs and changes

Typically, change requests occur because a CI needs to be upgraded (such as an operating system) or needs repair (such as a server). Using BMC Remedy Change Management, you can relate unavailable CIs (also known as outage records) to their related change request. By relating an unavailable CI record to a change request, you can track its history, and the costs related to changes to the CI.

**To relate an unavailable CI to a change request**

1 Open a change request, and then click the Relationships tab.
If unavailable CIs are related to the change request, they appear in the Relationships table.

2 From the Request Type list, select CI Unavailability, and then click Search.

3 In the CI Unavailability Search form, enter search parameters to filter the CI relationships shown, and then click Search.

The quick search buttons enable you to easily filter CI unavailability with different criteria:

- All unavailability
- All scheduled unavailability
- All unscheduled unavailability

4 Select an unavailable record from the list.

5 From the Relationship Type list, select Related to, and then click Relate.

The following actions occur:

- Messages alert you that the CI has been automatically related to the change.
- The CI Relationships Search form closes.
- The unavailable CI and its related CI record appear in the Relationships table.

6 If needed, you can broadcast the CI unavailability.

For more information, see Performing additional functions with CI unavailability on page 259.

**To relate a change request to a CI with unavailability**

1 Open a change request, and then click Relationships tab.

   The Relationships tab shows the requests that you can relate to the change.

2 From the Request Type field, select Configuration Item, and then click Search.

3 On the CI Relationships Search form, complete the search criteria tabs with the relevant information, and then click Search.

4 In the Relationship Type field, select the type to relate with the change request, for example, Related to.
5 (optional) Click Explore CI to view a CI and its relationship in the BMC Atrium Explorer.

6 Click Relate with Unavailability.

If the CI has open unavailability entries created against it, the CI Unavailability Exist dialog box appears.

7 Enter the unavailability settings (for example, Scheduled Full and the scheduled start and end dates), and then click Save.

For information about filling out this dialog box, see To create CI unavailability where other CI unavailability already exists on page 255.

8 Close the CI Relationships Search dialog box.

The CI Unavailability request type appears in the Relationships table.

To create CI unavailability where other CI unavailability already exists

1 Select the associated Configuration Item from the Relationships table.

2 From the Quick Actions menu, select Create New CI Unavailability, and then click Execute.

3 Perform one of the following procedures.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the CI has open unavailability entries created against it, the Existing Configuration Item Unavailability dialog box appears.</td>
<td>Do one of the following actions:</td>
</tr>
<tr>
<td>■ Click Create New to define an unavailability entry. You are then prompted to define the configuration item unavailability, for example, unscheduled full unavailability type, start and end dates, and so on.</td>
<td></td>
</tr>
<tr>
<td>■ Select an entry from the table, and then click Relate to Current Request to relate the change directly against the CI unavailability entry. You are then prompted to specify the relationship type between the current request and the selected CI unavailability.</td>
<td></td>
</tr>
</tbody>
</table>
If the CI does not have any unavailable CI entries, the Configuration Item Unavailability dialog box appears.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Select the unavailability type that best describes the down time (for example, Scheduled Full).</td>
</tr>
<tr>
<td></td>
<td>2. Enter the appropriate Scheduled Start and Schedule End dates.</td>
</tr>
<tr>
<td></td>
<td>3. Enter remaining information, as needed.</td>
</tr>
<tr>
<td></td>
<td>4. Click Save.</td>
</tr>
</tbody>
</table>

For more information about filling out the Configuration Item Unavailability dialog box, see To create CI unavailability where other CI unavailability already exists on page 255.

4. Save the request.

### Defining new CI unavailability for a record—alternative method

You can also define CI unavailability entries after the CI has been associated with the change request (or release request).

**Note**

You can perform these steps only if BMC Remedy Asset Management is installed.

#### To create CI unavailability from CIs associated with a request

1. Select the associated CI from the Relationships table.

2. From the Quick Actions menu, select Create New CI Unavailability, and then click **Execute**.

   In the Configuration Item Unavailability form the Unavailability Class defaults to Change. Here you enter specific details, for example, unscheduled full unavailability type, the actual start date, or the assignment status.

3. Select the unavailability type that best describes the down time.

   The options are:

   - **Scheduled Full** — Creates high priority.
   - **Scheduled Partial** — Creates medium priority.
   - **Unscheduled Full** — Creates critical priority.
- **Unscheduled Partial**—Creates high priority.

  **Note**
  After you select the unavailability class and type, the Priority field is filled based on a configurable CI Unavailability Prioritization mapping.

4  *(optional)* Modify the description identifying the reason why this unavailability is being defined.

5  Enter the appropriate Scheduled Start and Schedule End dates.

After you enter the dates into these fields, the system automatically calculates the Estimated Duration.

  **Note**
  When a Scheduled Start Date is entered without an Actual Start Date, the Unavailability Status is automatically set to Scheduled.

6  Enter the Actual Start and End dates, as needed.

The system automatically calculates the Actual Duration, based on the actual dates.

  **Note**
  When an Actual Start Date is entered without an Actual End Date, the Unavailability Status is automatically set to Current Unavailability. The Unavailability Status is automatically set to Restored when the Actual End date is filled in. After the Actual End Date is set, you can modify it, but not blank it out.

7  Select where the assignment is set from.

The Assignment is set from field determines where the assignment is based.

- **Configuration Item**—Assigns automatically the CI Unavailability entry if an assignment record has been defined for unavailability from within the Configuration Item Contact relationship.

  **Note**
  This type of assignment can be configured to be locked or open. Locked means that the system selects the Assignment Group from the Configuration Item Contact relationship, and then locks the fields so that they cannot be re-assigned or manually overridden. Open means that the system selects the Assignment Group from the Configuration Item Contact Association and then enables you to select another assignment method.
Cross Referenced Request—Assigns the CI Unavailability entry when the CI Unavailability is generated from either an Infrastructure Change or an Incident. This setting keeps the CI Unavailability assignment synchronized with either the Change or Incident record assignment.

Manually—Lets you assign the CI Unavailability entry manually to any group defined within the application.

Setting the Assignment Status to Completed marks the CI Unavailability record as closed.

Automated Routing—Assigns the CI Unavailability entry automatically to a support group if you do not assign a support group from the People tab. Automated Routing is configured using the CFG:Assignment configuration form.

For more information about configuring BMC Remedy ITSM, see the BMC Remedy IT Service Management Configuration Guide.

8 If you selected Manual assignment, set the assignment company, organization, group, and assignee.

The individual or group assigned to this unavailability record must set the status to Completed after recording the actual start and end times.

9 Set the Assignment Status to Assigned.

Note

The Assignment Status governs whether the CI Unavailability entry is considered Open or Closed. Setting the Assignment Status to Completed marks the CI Unavailability entry Closed.

10 (optional) Click Set From Change Schedule to retrieve the request’s Scheduled Start and End dates and times.

You can use this button to fill the Schedule Start and End date and times on the CI Unavailability record. This feature is available only for CI Unavailability records that were generated from a change request (not release requests).

11 (optional) Click the CI Status Information tab to change the status of the CI, for example, In Repair.

12 (optional) Click the Relationships tab to see possible relationships against the unavailability that might exist, for example, relationships to incidents, changes, or problems. You can also define relationships to these respective modules.

13 (optional) Click the Financials tab to define cost entries against the unavailability. This enables you to track costs associated to the down time.
Note
You must save the CI Unavailability record before you can define Relationships and Financials.

14 (optional) Click the References tab to see the record identification numbers for any incidents or changes that might have created the unavailability entry.

15 (optional) Click the SLM tab to see the service targets and milestones for the restoration of the unavailability. Service targets and milestones are defined from within BMC Service Level Management. Escalations can defined to notify the assignment group prior to acknowledgement or resolution breach times.

16 Click Save to define the new CI unavailability for the record.

Performing additional functions with CI unavailability

You can perform the additional functions with CI unavailability that are listed in the following table.

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify CI unavailability</td>
<td>1 On the Relationships tab of the Change form, select the unavailability entry to modify, and then click View.</td>
</tr>
<tr>
<td></td>
<td>2 On the Configuration Item Unavailability form, modify the information as needed, and then click Save.</td>
</tr>
<tr>
<td></td>
<td>3 To create a financial cost for the unavailability, click Add on the Financials tab of the Configuration Item. On the Costs dialog box, enter required information as needed, and then click Save.</td>
</tr>
<tr>
<td></td>
<td>Note: The CI unavailability entry represents the entry as seen within the CI Unavailability form. The CI unavailability entry that appears on the Relationships tab represents the relationship between the Unavailability and the Change.</td>
</tr>
<tr>
<td>Modify outage information</td>
<td>1 From the Change form, choose Functions =&gt; Outage List.</td>
</tr>
<tr>
<td></td>
<td>2 On the CI Unavailability form, modify the information as needed, and click Save.</td>
</tr>
<tr>
<td></td>
<td>For more information, see the BMC Remedy Asset Management User’s Guide.</td>
</tr>
<tr>
<td>Function</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete CI unavailability</td>
<td>1  On the Relationships tab of the Change form, select the unavailability entry to delete.</td>
</tr>
<tr>
<td></td>
<td>2  Click Remove.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Deleting a CI Unavailability entry also deletes all related relationships and cost entries against the unavailability. The CI Unavailability is deleted if the cross-referenced ID is the change ID.</td>
</tr>
<tr>
<td>Broadcast CI unavailability</td>
<td>1  On the Relationships tab of the Change form, select the unavailability entry to broadcast.</td>
</tr>
<tr>
<td></td>
<td>2  From the Quick Actions menu, select Broadcast CI Unavailability, and then click <strong>Execute</strong>.</td>
</tr>
<tr>
<td></td>
<td>3  On the New/Modify Broadcasts dialog box, complete the required fields and any other information, and then click <strong>Save</strong>.</td>
</tr>
<tr>
<td></td>
<td>The View Access field is used to make the broadcast available on the web (if your Broadcast form is web-enabled and the View Access is set to Public).</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: You must have the Broadcast Submitter functional role to broadcast the current change.</td>
</tr>
</tbody>
</table>

**Implement stage - Working with tasks**

In the Implement stage of the request, the change coordinator (or change manager) reviews all the tasks that are needed to complete the change request. Generally, change requests are divided into smaller units, called tasks. They are then assigned to task implementers who complete the tasks. When you plan a change request, determine whether you can divide it into separate tasks.

**Note**

For more information on task implementers, see Task implementer role on page 341. If you create a change request and then do not save it before you close it, the tasks you created do not exist because there is no parent change request.

The Tasks tab shows the tasks that must be performed to complete the change. You can use task groups to manage changes with many tasks, each having its own
schedule, task implementer, and plan. For less complex changes, tasks are optional. A single change can have an any number of tasks.

Figure 55: Creating and assigning tasks

After a task is assigned to a support group or an individual, the assignee receives notifications to perform the various task activities based on the change process.

**Note**

For less complex changes, tasks are optional. If no tasks are created, the change is assigned to a Change Implementer. The Change Implementer field is applicable only when using the Classic view.

**Task Management System overview**

In the Task Management System integration with BMC Remedy Change Management, which is installed and integrated as part of the application set, all tasks belonging to a change request or a release request are related to one another through their association with the parent change request or release request. You use BMC Remedy Change Management to set dependencies among the tasks associated with a change request or a release request. You can also set dependencies among change requests and among release requests.
Relation of task statuses to change statuses

Tasks, similar to change requests, go through many status transitions as they progress. The status in which a task is generated depends on the status of the parent change request.
This section is an example of the flow changes, approval, task groups, and tasks follow with the out of the box configuration:

**Figure 56: Overview of change and task statuses with approval phases**

<table>
<thead>
<tr>
<th>Change States</th>
<th>Approval Phases</th>
<th>Task Group States</th>
<th>Task States</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Request for Authorization</td>
<td>Review</td>
<td>Staged</td>
</tr>
<tr>
<td></td>
<td>Request for Change</td>
<td>Review</td>
<td>Staged</td>
</tr>
<tr>
<td></td>
<td>Planning in Progress</td>
<td>Business Approval</td>
<td>Staged</td>
</tr>
<tr>
<td></td>
<td>Scheduled for Review</td>
<td>Implementation Approval</td>
<td>Staged</td>
</tr>
<tr>
<td></td>
<td>Scheduled for Approval</td>
<td>Implementation Approval</td>
<td>Staged</td>
</tr>
<tr>
<td></td>
<td>Scheduled</td>
<td>Work in Progress</td>
<td>Closed</td>
</tr>
<tr>
<td></td>
<td>Implementation in Progress</td>
<td>Work in Progress</td>
<td>Closed</td>
</tr>
<tr>
<td></td>
<td>Completed (Final Review Required)</td>
<td>Work in Progress</td>
<td>Closed</td>
</tr>
<tr>
<td></td>
<td>Completed (Final Review Complete)</td>
<td>Close Down</td>
<td>Closed</td>
</tr>
<tr>
<td></td>
<td>Cancelled</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. A change request starts in the Draft status. Any related task groups or tasks are in Staged status.
• If a change request is cancelled, the task groups and tasks associated with the change are also cancelled.

• If a task group is cancelled, its tasks are also cancelled.

If a request is moved from Cancelled to Draft (Rescheduled Notification), the change manager or change coordinator is notified. The change requester is notified of the rescheduled change.

2 The change request moves into the Request For Authorization status and the approval group or approvers are notified that the change request requires approval for the Review phase. Any task groups or tasks are in the Staged status. The Status Reason field is updated to Staging in Progress.

3 The change manager or change coordinator is notified when the change request is moved into Request For Change status. The change manager or change coordinator are also notified when the request is moved from Cancelled to Request for Change (Rescheduled Notification).

4 The approval group or approvers are notified that the change request requires approval for the Business Approval phase.

5 All people assigned to the change are notified when the change request is ready for planning. For taskless changes only, the change implementer is notified. When the status reason of all the tasks is Staging Complete, the change moves to the Schedule For Review status.

6 Task implementers are notified that the task group or tasks are set to Staged.

7 The change manager or change coordinator is notified when the change request is scheduled for review.

8 The approval group or approvers are notified that the change request requires approval for the Implementation Approval phase.

9 All people assigned to the change are notified when the change request has been scheduled as a change with no impact. For taskless changes only, the change implementer is notified. Tasks can be set to the Assigned status.

10 When change request is moved into the Implementation In Progress status, the task group is set to Work in Progress and the first task is set to Pending or Assigned. The task implementers are notified to start working on tasks. They set the task to Work in Progress when work begins. Task implementers can now update the task information, and start implementing the task.

11 After last task is set to Closed, the task group is set to Closed. The change manager, change coordinator, and change requester are notified that the change
request is completed. Workflow enters required information into the Actual Start Date, Actual End Date, and Performance Rating fields.

12 The approval group or approvers are notified that the change request requires approval for the Close Down phase.

13 The change manager or change coordinator is notified when the final review is completed.

14 If change request is cancelled, the requester is notified.

Viewing task groups and tasks

To view your assigned tasks and task groups click the Show Tasks Details link in the Change Details And Tasks section of the BMC Remedy Change Management Console. Tasks are prefixed with TAS, and task groups with TGR. You can also view tasks and task groups related to a change request on the Tasks tab of the Change form.

Note
You can click View Flow to see a read-only view of the task flow in the task group. For more information about using the View Flow button, see Using CCM tasks on page 347.

To view task groups and tasks

1 In the Assigned Tasks table on the BMC Remedy Change Management Console, or from within the Tasks tab of a change request, select the task group or the task to view.

2 Click View.

3 Modify the task details as needed.

4 Save your work.

Relating ad hoc tasks to change requests

You can relate an ad hoc task to the change request. The status of these tasks can be Staged, Assigned, Pending, Work in Progress, or Closed. You can manually set the assignment for any task. Finally, if you close the task, you must select whether you are canceling the task or completing it as a success or failure.
To relate an ad hoc task to a change request

1. Open the change request, and then click the Tasks tab.

2. In the Request Type field, select Ad hoc, and then click Relate.

   The Task form appears with certain fields in the form filled with data from the change request.

   You can click the Open link next to the Request ID field to open the parent change request.

3. Fill in the following required fields:

   - **Name** — Enter a descriptive name of the task.

   - **Summary** — Enter a brief description of the task.

   The Type field is set by default to Manual when you create an ad hoc task.

4. In the General tab, fill in information about the company.

   The Company field defaults to the contents of the Change Location field in the Change form. Your task can be assigned to a different department or company.

5. On the Requester tab, enter information about the person defining the task (Requester) and the intended target of the task (Requested For).

   Some information is filled by default from the Requested By information of the change request.

6. In the Classification tab, fill in information about the product and operational categorizations.

7. In the Assignment/Dates tab, fill in the following fields to assign the task:

   - **Assignee Group** — Optionally, select a task implementer group from the list.

   - **Assignee** — Optionally, select a task implementer from the list.

   The assignment engine automatically assigns the task when the task is generated. You can override this if needed by manually assigned the task.

---

**Note**

If you manually assign a task, the assignee is immediately notified when the task is staged. If the assignment engine assigns the task, the task is staged but the notification is not sent to the assignee until the task is activated.
For more information about assignment configuration, see the BMC Remedy IT Service Management Configuration Guide.

- **Scheduled Start Date**—Optionally, enter an estimated start date.

- **Scheduled End Date**—Optionally, enter an estimated end date.

You might want to set the Start Date and End Date to be different from the dates of the parent change request.

8 In the Relationships tab, search for and then relate configuration items, LDAP objects, and software library items that are needed with this task.

Additionally, you can execute any quick actions like Update Attributes, Explore CI or get Related Relationships for the task.

9 When you finish creating the task, click **Save**.

10 To specify if you want to notify the assignee or not, reopen the task and in the Assignment tab select the appropriate option from the Notify Assignee field.

**Relating predefined task group or task templates to a change request**

You can relate a predefined task or task group template to the change request. The Calbro Services sample data includes best practice task group and task templates that you can use.

*Best practice*

In addition, special templates were created for the integration with BMC Configuration Automation for Clients (previously known as BMC Configuration Management). Other templates might have been added by your application administrator.

**To add predefined task group and task templates to a change**

1 Open the change request.

2 Click the Tasks tab.

3 Select Task Group Template or Task Template from the Request Type field, and then click **Relate**.

All template types for all categories are listed in the Select Template dialog box.
4 (optional) You can filter the list by selecting the type or category, or both, of the template. To filter the list:

a  Select the type of template:
   ■ With task group templates, select Standard or Sequencing.
   ■ With task templates, select Manual, Automatic, or ALL.

b (optional) From the Category list, select which application the task belongs to, for example, Change Management System.

   The available task groups or tasks for that selection appear in the list. The categorization of the change request determines which list items appear.

5 (optional) Click View to see more details about the task group or task template.

6 If a relevant task set appears on the list to include with the change request, select it, and then click Relate.

7 Define a numerical sequence of the tasks, as described in Assigning a sequence number to task groups and tasks on page 268.

8 When you finish adding templates, save the change request.

Assigning a sequence number to task groups and tasks

The task management subsystem enforces the dependencies between tasks. These relate to any Sequence order you might have specified in the Change form.

For more information, see Assigning sequence numbers to dependent change requests on page 243.

When you include task group templates, task templates, or ad hoc tasks in a change request, they are automatically assigned a sequence number in the order in which you add them to the change request. More than one task can have the same sequence number; tasks with the same sequence number are considered peers. Peer tasks can be completed in any order among themselves.

Tasks must be completed sequentially. When the change request’s status is set to Scheduled, the task with sequence number 1 is activated and its status is set to Assigned. When the last task is completed, the change request is closed.
To renumber a task group or task, you can use the arrow buttons next to the Tasks and Task Groups table on the Tasks tab of the Change Request. Tasks with lower sequence numbers, for example 1, must be completed before those with higher numbers, for example, 2, 3, or 4.

**Adding work information to a task**

You can add work information to each task included in the change request. The work information for each task appears in the Work Info of Selected Task table on the Change form.

**To add work information to a task**

1. Open the task and then click the Work Info tab.
2. Modify the work information type, if needed.
3. From the Source list, select the source of this information.
   Information sources can include, for example, email, system assignment, or the web.
4. Enter details of your work information record in the Date, Summary, and Work Info Notes fields.
5. To add attachments, right-click in the attachment table, and then select **Add**.
6. From the Locked list, select Yes or No to lock the log.
7. Select the view access:
   - Internal — If you want only users within your organization to see the entry.
   - External — If you want everyone with access to the system to see the entry.
8. When you finish updating, click **Save**.
   Your entry is added to the task’s work history. The Show field enables you to filter specific work entries based on the type of activity shown in the table.
9. To see a report of the activities you performed against this task, click **Report**.
10. To see all work information history entries, click **View**.
Performing additional service request functions

In addition to creating a service request, you can perform the functions listed in the following table. All the listed functions are performed from the Requester Console.

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify a task</td>
<td>1 On the Tasks tab of the Change form, select the tasks to modify, and then click View.</td>
</tr>
<tr>
<td></td>
<td>2 Modify the task details.</td>
</tr>
<tr>
<td></td>
<td>3 Click Save.</td>
</tr>
<tr>
<td>Assign a task</td>
<td>1 On the Tasks tab of the Change form, select a parent task or child task that is related to the change request, and then click View.</td>
</tr>
<tr>
<td></td>
<td>2 Select the Assignment tab, select the group or person to work on the task, and then click Save.</td>
</tr>
<tr>
<td></td>
<td>The implementer for that task is notified of the task assignment.</td>
</tr>
<tr>
<td>Assign all tasks in a change requests</td>
<td>1 Open the change request in the Change form.</td>
</tr>
<tr>
<td></td>
<td>2 Set the Status field to Scheduled.</td>
</tr>
<tr>
<td></td>
<td>The change request is set to Scheduled and the status of the first task is set to Assigned.</td>
</tr>
<tr>
<td>Plan the time for tasks</td>
<td>1 Open the task, and then click the Dates tab.</td>
</tr>
<tr>
<td></td>
<td>2 In the Time Segment Action field, select a time segment option, and then click Save.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Registering time segments on page 157.</td>
</tr>
<tr>
<td>Function</td>
<td>Action</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Automatically track the time spent working on tasks (using the Start Clock and Stop Clock buttons) | 1 Open the task.  
2 Click the Assignment tab on the Task form.  
3 Click Start Time, and then click **Save**.  
4 When you finish working on the task, click **Stop Clock**, and then click **Save**.  
You can use the start and stop clock buttons as many times as needed. Each successive time, the new time is added to the value in the Total Time Spent field. The time is automatically calculated, based on when you click the buttons.  
1 Click the Assignment tab on the Task form.  
2 Click **Effort Log**.  
3 Enter information into the effort log, and then click **Add to Effort Log**. |
| Track manually the time spent working on tasks                           | 1 Open the task.  
2 Click the Assignment tab on the Task form.  
3 Enter a number of hours or minutes in the Time Spent fields, and then click **Save**.  
The time you entered is added to the value in the Total Time Hours and Minutes fields.  
4 Click the Assignment tab on the Task form.  
5 Click **Effort Log**.  
6 Enter information into the effort log, and then click **Add to Effort Log**. |
| Cancel a task                                                            | 1 Open the change request in the Change form.  
2 Click the Tasks tab.  
3 Select a task, and then click **Cancel**.  
The status of the task is set to Closed.  
**Note**: If the task has related CIs, you can update any CI costs that are affected by this cancellation. See **Working with related configuration items on page 246**. |
Responding to task reassignments as a change coordinator

As a change coordinator, you might need to assign new assignees to tasks associated with your change. Task reassignment is performed manually, directly on the Task form.

**To respond to task reassignment requests as change coordinator**

1. In the change request, from the Tasks tab, open the task you want to reassign.
2. Click the Assignment tab.
3. After reviewing the task, reassign the request as needed.

   If you decide to reassign the task:
   - In the Assignee field, select a new staff member. The task is assigned to this new staff member.
   - In the Notify Assignee field, select Yes.
   - Update the work history.

   **Note**

   If you reject the assignment request, set Notify Assignee to Yes and update the work history.

4. Click **Save**.

When the task is reassigned, the previous and new assignees are automatically notified of the changed assignment.

**Tracking the time spent working on change requests**

You can track the time spent working on a change request after it has been fully assigned. The Support Company, Support Organization, Support Group, and Change Coordinator must be set before you can use the Start Clock and Stop Clock buttons.

There are three ways to track the time spent working on a request:
To track the time spent on a change request using the Start Clock and Stop Clock buttons

1. Open the change request and do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Date/System tab.</td>
<td>Click the Assignment tab.</td>
</tr>
</tbody>
</table>

2. Click **Start Clock**.

   The current date and time are appear in the read-only Start Time field.

3. To close the Change form while working on the request, make sure to save the request first.

4. To stop tracking the time, click the **Stop Clock** button. You must repeat steps 1 and 2 first if you closed the Change form.

5. Update the assignment log, as needed, and then click **Save**.

   You can use the start and stop clock buttons as many times as you like. Each successive time, the new time is added to the value already in the Total Time Spent field.

To manually track the time spent on a change request

1. Open the change request and do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Date/System tab.</td>
<td>Click the Assignment tab.</td>
</tr>
</tbody>
</table>

2. In the editable Time Spent field, enter the number of minutes.

3. Enter information in the effort log, using the Update Assignment Log button, and then click **Save**.
The time you entered is added to the value in the Total Time Spent field.
Release coordinator role

This section describes how release coordinators can use the Release Management application to monitor issues pertaining to the daily aspects of Release Management activities and how they can help their staff meet their commitments to the organizations they support.

Working as a release coordinator

The release coordinator in ITIL terminology is typically a member of the support staff who is responsible for the following release tasks:

Table 32: Release coordinator responsibilities

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manages all aspects of the end-to-end release process</td>
<td>Makes sure the build and test environment team and the release team are coordinated. Establishes final release configuration, builds the final release delivery, and tests the final delivery before independent testing.</td>
</tr>
<tr>
<td>Creates releases, change requests, and activities</td>
<td>Creates release manifest that consists of change requests and activities, and reviews the RFCs if they have been passed on from BMC Remedy Change Management. Deals with release, distribution, and installation of packaged software.</td>
</tr>
<tr>
<td>Submits the release request for approval</td>
<td>Whether a release request requires approval is determined by your organization’s business rules. The application administrator configures the approval process to determine which approval phases are available for the release request.</td>
</tr>
<tr>
<td>Plans and schedules the release</td>
<td>Organizes and facilitates the CAB meetings; schedules the release request. Determines the impact by assessing the different kinds of risks. Splits the requirements of releases into logical groups that can be handled efficiently by change coordinators. Prepares a business case for a new release when additional funding is needed for its implementation. Schedules people and resources to implement each task.</td>
</tr>
<tr>
<td>Initiates the implementation of releases.</td>
<td>Decides on corrective actions as needed. Estimates the costs of the release request. Coordinates release acceptance, rollout planning, release communications, preparations and training activities, and distribution and installation of releases. Provides management information about Release Management quality and operations.</td>
</tr>
</tbody>
</table>
Responsibility | Explanation
--- | ---
Closes release requests | A release request is resolved when all work for the release is completed. Organizes and conducts post-implementation meetings to collect improvement suggestions for future releases.

The release coordinator is usually responsible for addressing general, day-to-day issues from a personnel and customer satisfaction standpoint.

The release coordinator requires the following permissions and functional roles:

- Release Coordinator functional role is required to be assigned as the Release Coordinator for individual releases.
- Membership in your company’s support group is required to create release templates for that group.
- Release User permission is required for access to release and manifest records.
- Release Config permission to setup and modify the Release Module configuration forms.

### Using the Release Management Console

The Release Management Console provides a dedicated workspace for managing release requests. This console is designed for release coordinators who deal with Release Management daily and do not want to view other BMC Remedy ITSM applications. It provides quick access to the information you need and to the procedures that you perform most often.

Various functions are available in the navigation pane of the Release Management Console. They provide you with quick ways to go to different areas in Release Management and to perform other functions.

For more information, see Release Management Console functional areas on page 99.

### Initiate milestone - Creating release requests

Releases start at the Initiate milestone of the release request lifecycle. Release Management enables any user with Release User permissions to enter release requests into the system. But it is typically release coordinators who create release requests.
Creating a release request at the initiate milestone—Best Practice view

The section describes how to create a release request at the Initiate stage when using the Best Practice view of Release Management.
To create a release request at the Initiate milestone

1 Review the RFCs to make sure you understand their requirements.

This is a manual step you should perform before you open Release Management. You should understand the scheduled start and end dates, the CIs involved, the manifests necessary to complete the release, the CAB approvers, and so on.

**Best practice**
You should enter information into Release Management as soon as it is available to you. You can always revise it at later milestones.

2 On the Release Management Console, click **Create** to open the Release form.

The Release ID field is automatically filled with an ID number for the release request.

In the Initiate stage, the release request initially appears in Draft status. The release request has not yet been submitted to the Release Management process.

3 Use the following fields to specify the release coordinator:

   **Coordinator Group**
   
   Specify the group of people with the Release Coordinator functional role. This list is populated with groups that have at least one user with a Release Coordinator functional role.

   **Coordinator**
   
   Specify the user responsible for the release. The list is populated with people with the Release Coordinator functional role and who are included in the Coordinator Group selected.

4 From the **Service** field, select the business service configuration item (CI) that relates to the release request that you are creating.

   The **Service** field relates business service configuration items (CIs) to the release request at the time it is created. Business service CIs are related either to the customer directly or to the customer’s company, organization, or department.
The business service CI is not a physical CI (such as a printer or a router); it is a logical CI. In this context, a logical CI is a business service that can be provided from one business, or organization within a business, to another. Service CIs can include customer support, employee provisioning, web farms, storage, and so on. When business service CIs are created and made available on the Service field menu, they are related either to a customer directly or to the customer's company, organization, or department. If you need to have a new business service CI added to the Service field menu, you must notify a system administrator with Asset Administrator privileges.

5 (optional) Select a template to complete part of the release request.

Release templates are especially useful in any release request that follows well-defined methods for specific and repeated requirements. Release templates do more than simply fill out fields for you; they can also include CIs and manifests to the release request. For more information, see Selecting release templates on page 448.

The template is attached to the release request.

Note
If you start to enter fields in the release request and then select a release template, the release template overwrites any field values that are already present in the release request. Any relationships or manifests included with the release request are not overwritten. Any additional manifests from the template are added as peers, and additional relationships (for example, CIs) are included with the release request.

6 Complete the following fields:

Summary

Provide a brief description of the release.

Target Date

The target date is the date by when the release must be completed, according to the applicable service level target. Alternatively, the target date can be a date that is agreed to on an ad hoc basis, per release.

Business Justification

Specify the business requirement for the request. Select an option based on the policies defined by your company.

You have the following options:
- Corporate Strategic
- Business Unit Strategic
- Maintenance
- Defect
- Upgrade
- Enhancement
- Customer Commitment
- Sarbanes-Oxley

**Impact**

Specify the extent to which the release affects the business. The default value is 4-Minor/Localized. Impact is often directly related to the extent to which the service has degraded from agreed service levels. Impact can be measured by the number of people affected, the criticality of the system affected, and the loss of revenue as a result of the service degradation or disruption.

**Urgency**

Specify a value that indicates the importance of the release request, and reflects how quickly a release must be implemented, or the time available to reduce the impact of the release on the business. The default value is **Low**.

Use the following factors to determine Impact and Urgency:

- Number of customers affected by associated Releases
- Duration and scope of the service disruption
- Availability of a solution or workaround
- The type of service being disrupted, usually based on the CI involved
- Awareness of the future impact on the business

**Priority**

*(Optional)* Specify the importance that you (as support staff) assign to the release request.
Priority indicates the relative order in which to address the releases. It is influenced by considerations of risk and resource availability, but is primarily driven by the combination of Urgency and Impact. The default value is Low.

7 Select the Risk Level to indicate the relative risk associated with the release.

The default risk level is Level 1, which is the lowest level. The highest risk level is Level 5. The Risk Level is used as a criterion to determine required approvals.

**Note**
For more information about how to configure or modify the Impact, Urgency, and Priority data so that it is set automatically, see the *BMC IT Service Management Configuration Guide*.

8 Select the Release Type for the release request.

You use this field to further categorize the releases that are released into the IT infrastructure.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>All components of the release are built, tested and deployed together. You typically use the Full release type if you want to make sure that the release or version of your application, plus the necessary CI components to run the application, are all linked throughout the entire process.</td>
</tr>
<tr>
<td>Delta</td>
<td>Includes only incremental releases and only those components or CIs that need to be included in this release. You typically use the Delta release type if your application was moving from version 1.0.00 to 1.1.00.</td>
</tr>
<tr>
<td>Package</td>
<td>All individual Full and Delta releases are grouped together and form a packaged release. You typically use the Package release type if you combine several minor and major updates together.</td>
</tr>
<tr>
<td>Backlog</td>
<td>Method to identify and review multiple changes, incidents, and problems that are candidates to target to implement in a release. The Backlog release type is a grouping mechanism that the CAB uses as their candidates to review for future releases.</td>
</tr>
</tbody>
</table>

**Note**
Do not manually set the Milestone, Status, and Status Reason fields in the Release form. When you use the Process Flow Status bar the release request to the next milestone, the value in the Status field automatically changes, based on the options you select from the Status bar menus.

9 Click **Save** to create the release request.

This is the minimum information needed to create the release.
Creating a release request at the initiate milestone—Classic view

The section describes how to create a release request at the Initiate stage when using the Classic view of Release Management.

To create a release request at the Initiate milestone

1. Review the RFCs to make sure you understand their requirements.

   This is a manual step you should perform before you open Release Management. You should understand the scheduled start and end dates, the CIs involved, the manifests necessary to complete the release, the CAB approvers, and so on.

   **Best practice**

   You should enter information into Release Management as soon as it is available to you. You can always revise it at later milestones.

2. On the Release Management Console, click Create.

   The Release form appears with the Request ID field automatically filled with an ID number for the release request.

   The release request initially appears in Draft status. To enable the release request from Draft status to be moved to its next status, enter information into the required fields.

3. (optional) Use a release template to fill out the contents of the release request.

   **Best practice**

   Release templates are especially useful in any release request that follows well-defined methods for specific and repeated requirements. Release templates do more than simply fill out fields for you; they can also include CIs and manifests with the release request. For more information, see Selecting release templates on page 448.

4. The Requested By fields are auto-populated with the details of the user who creates the release. If this user is not associated to a support group, the Support Company is set to the Location Company of the user. If this user is associated to a support group, the Support Company, Support Organization, and Support Group is set to the user's default Support Group.

   You can modify the Requested By fields if required. The Support Company list is modified based on profile of the user selected in the Requested By field. For users who are support staff the list includes only Support Group companies only for

Initiate milestone - Creating release requests
that user and for non-support staff the list includes all valid companies listed under Location Company.

5 In the Summary field, enter a brief description of the release.

6 In the Notes field, enter a more complete description of the release.

7 From the Service field, select a business service CI.

Selecting a business service CI automatically performs the following actions:

- Populates the Product Categorization of the release request based on the categorization of the business service CI. You can modify the Product Categorization values later.

- Relates the business service CI to the release request as a Related to” association type when the release is submitted. After it is established, you cannot remove the association created between the release request and the business service CI from the Relationships tab. However, you can select another service from the Service field when the release request is in Modify mode.

8 Select the Deployment type for the release request.

You can use this field to further categorize the releases that are released into the IT infrastructure.

<table>
<thead>
<tr>
<th>Phased</th>
<th>Stage the deployment of the release to a part of the user base. The operation is repeated for subsequent parts of the user base through a scheduled rollout plan, for example, the release coordinator identifies a set of changes that must be done at the same time, for example, all changes for Building 1 at Phase 1, all changes for Building 2 at Phase 2, and so on. You typically use phased deployments when new services are introduced into a store environment in manageable phases (such as retail organizations).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Phased</td>
<td>All changes or activities deployed all at the same time in one operation with no restrictions, for example, a company-wide rollout of new servers. You typically use non-phased deployments when introducing an application change, and consistency of service across the organization is important. <strong>Note:</strong> ITIL Service Transition Version 3 describes non-phased deployment as the Big Bang” method.</td>
</tr>
</tbody>
</table>

Do not manually set the Milestone, Status, and Status Reason fields in the Release form.

When you use the Process Flow Status bar the release request to the next milestone, the value in the Status field automatically changes, based on the options you select from the Status bar menus.
9 Select the Release Type for the release request.

You use this field to further categorize the releases that are released into the IT infrastructure.

<table>
<thead>
<tr>
<th>Release Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>All components of the release are built, tested and deployed together. You typically use the Full release type if you want to make sure that the release or version of your application, plus the necessary CI components to run the application, are all linked throughout the entire process.</td>
</tr>
<tr>
<td>Delta</td>
<td>Includes only incremental changes and only those components or CIs that need to be included in this release. You typically use the Delta release type if your application was moving from version 1.0.00 to 1.1.00.</td>
</tr>
<tr>
<td>Package</td>
<td>All individual Full and Delta releases are grouped together and form a packaged release. You typically use the Package release type if you combine several minor and major updates together.</td>
</tr>
<tr>
<td>Backlog</td>
<td>Method to identify and review multiple changes, incidents, and problems that are candidates to target to implement in a release. The Backlog release type is a grouping mechanism that the CAB uses as their candidates to review for future releases.</td>
</tr>
</tbody>
</table>

10 Select Impact to reflect the extent to which the release affects the business.

The default value is 4-Minor/Localized. Impact is often directly related to the extent to which the service has degraded from agreed service levels. Impact can be measured by the number of people affected, the criticality of the system affected, and the loss of revenue as a result of the service degradation or disruption.

11 Select the Urgency to indicate the importance the requester assigns to the release request.

Urgency reflects how quickly a release must be implemented, or the time available to reduce the impact of the release on the business. The default value of the Urgency field is 4-Low.

The following factors can be used to determine Impact and Urgency:

- Number of customers affected by associated releases
- Duration and scope of the service disruption
- Availability of a solution or work-around
- The type of service being disrupted, usually based on the CI involved
- Awareness of the future impact on the business
12 *(optional)* To override the priority, select a new Priority to identify the importance you (as support staff) assign to the release request.

Priority indicates the relative order in which releases should be addressed, for example, Medium. The priority of the request is automatically calculated for you, based on the Urgency and the Impact values that you specify. These values are configured in the Release Prioritization form. But you can override the calculation by selecting a different value, for example, High or Critical.

---

**Note**

For more information about how to configure or modify the Impact, Urgency, and Priority data so that it is set automatically, see the *BMC IT Service Management Configuration Guide*.

---

13 Select the Risk Level to indicate the relative risk associated with the release, from 5 (highest risk) to 1 (lowest risk).

The default value is Risk Level 1. The Risk Level is used as a criterion to determine required approvals.

14 Click Rollup to accumulate the risk level from the related change requests (displayed on the Manifest tab).

The highest Risk Level of all the related change requests is used when rolling up the Risk Level. The risk rollup is not performed automatically. You can override the risk rollup with a different value.

15 Modify information as needed in the required fields on the General tab, for example, Company, First Name, and Last Name.

This information is auto-filled, based on your login. The Company is the organization or group that the release request is assigned to.

---

**Tip**

If you type a letter or name into any of the fields with a (+) sign and press Enter, the field is auto-filled. If multiple choices exist, a selection list or dialog box appears, to help you enter a name. Otherwise, you are prompted if no such letter or person exists in the system.

16 *(optional)* Modify information in the required Release Location Company field.

The Release Location Company field is especially important in a multi-tenancy environment. In this field, you can specify the company, department, or other group that controls access to the release request.

17 Click the Assignment tab.
Make sure the release is properly assigned. You can manually reassign it to another release coordinator.

a Select an assignment method (for example, Auto Assign), and then click Set.

b Review the Support Company, Support Organization, and Support Group Name (if this information is not already supplied).

c Select the release coordinator to whom to reassign the request.

For more information, see Working with release request assignments on page 316.

18 Click Save to create the release request.

This is the minimum information needed to create the release. You should include additional information as it is available to you.

19 (optional) If you need to suspend work temporarily on the release request, use the Process Status Flow area to move the release request to Pending status.

**Figure 58: Moving release request into a different status**

Select Enter Pending and an appropriate status reason (for example, Manager Intervention) from the Process Flow Status menu. When you are ready to continue work on the release request, select Resume from the Process Flow Status menu.

The Status field is updated automatically during the Process Flow for other options. For more information, see Performing additional functions from the Process Flow Status bar on page 299.

**Specifying the business justification**

At the Initiate milestone, the release coordinator prepares a business case to justify the release, for example, compliance with Sarbanes-Oxley requirements or fixing a defect in a mission-critical server.
Release coordinators specify the business justification of the release to initiate the implementation of the release and to decide on corrective actions (if needed). If there is not enough funding to implement the release, you should create a contingency plan if an adjusted business case for the release can still get the necessary approvals. If you cannot get your business case approved, you must inform the requesters of the release that the business case for the release has been rejected.

**Figure 59: Release form—Classification information**

![Classification information](image)

**To specify the business justification**

1. Open the release request.
2. Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter this information in the Business Justification field on the Release form.</td>
<td>Click the Classification tab. The Classification tab is used to describe the business justification of the release (for example, Maintenance) and show which products and services are affected by the release.</td>
</tr>
</tbody>
</table>
3. Select a Business Justification to indicate the business reason for implementing the release request.
Business justification information is important when the request goes through the approval process. You use this information to make sure funding is available to implement the release.

4 Categorize the release request by filling in the categorization fields.

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Links =&gt; Categorizations</strong> in the left frame of the Release form.</td>
<td>Add this information to the Classification tab.</td>
</tr>
</tbody>
</table>

The application automatically assigns the release request to the submitter if they have the functional role of a Release Coordinator when the request is saved. Assignments are determined by the rules configured by the application administrator.

5 To create or relate other items to the release request, click the Relationships tab.

You can create and relate release requests to your current release request before it is saved. You can also create and relate configuration items, change requests, and so on, to the release request.

**Note**

If you close the new release request before saving, any new items you created as a relationship or a manifest, still exist. There is no relationship between these new items and the release request since the release request was not created.

6 Click **Save**.

Depending on the settings configured by your application administrator, you might see the Release form in Modify mode. You might also have to open the Release form in Search mode and query for your request.

**Creating a manifest**

When you are in the Initiate milestone, you should create a release manifest. A manifest functions like a packing list or an invoice—it describes the schedule and provides an overview of the contents of a particular release. Here you split the requirements of the release into logical groups of change requests and activities that can be handled efficiently by change coordinators and activity assignees.

**Note**

You can create change requests and activities during all milestones, except Close Down.
You can relate a change request to the release; or you can create an ad hoc change request and activity to add to the release. When adding multiple manifests, you can define the order in which they need to be executed.

In a release, the Manifest tab defines the contents of a release at a particular milestone. You create the associations between a release and the various release activities or change requests that are necessary to implement and close it.

Finally, collision detection is automatically run when you save the release. It runs only on new change requests that you have added to the release.

For more information, see Detecting CI collisions between change requests on page 176 and Working with release manifests on page 323.

**To create a manifest**

1. Click the Manifest tab in the Release form.

   The Manifest tab shows the release activities and changes related to the release.

   **Figure 61: Release form—Manifest tab**

2. From the Request Type list at the bottom of the Manifest tab, select Infrastructure Change or Activity.

   **Note**

   The contents of the search form depend on the type of application object you chose in the Request Type list.
<table>
<thead>
<tr>
<th>Request Type</th>
<th>Action</th>
<th>For more information</th>
</tr>
</thead>
</table>
| Infrastructure Change | ■ Search—Opens the Change Relationship Search form. You use this form to search for change requests, and then establish a Consists of” relationship change to the release.  
■ Create—Opens the Change form in New mode.  
■ View—Opens the change that is related to the release.  
■ Remove—Removes the change from the relationship with the release; it does not delete the change. | Relating change requests on page 242            |
| Activity          | ■ Create—Opens the Activity form in New mode.  
■ View—Opens the activity that is related to the release.  
■ Remove—Removes the activity from the relationship with the release; it does not delete the activity. | Creating activities - basic steps on page 326 |

3 Add the activity or change to the release manifest.

The Manifest Attributes dialog box appears. This dialog is displayed whenever you relate a change or activity to a release manifest. You can specify the milestone and the phase in which the change or activity should be grouped.

**Figure 62: Manifest Attributes dialog box**

4 Specify the milestone and phase for the activity or change, for example, Deployment and Phase 1.

5 Click **Apply**, and then close the Manifest Attributes dialog box.
6 The original release request is displayed. Click **Refresh** to view the related request types appear in the Changes and Activities table.

7 Click the up or down arrows next to Refresh, to change the order of items that have been added to the release manifest.

The manifest items are grouped in the Order column, for example, 0, 1, 2, and so on and must be executed in the defined order.

8 Click **Rollup** next to the Risk Level field to accumulate the risk level, cost, and time from the related change requests and activities (displayed on the Manifest tab).

The highest Risk Level of all the related change requests is used when rolling up the Risk Level. The risk rollup is not performed automatically. The release user can override the risk rollup with a different value.

**Note**
If you need to add change requests or activities at other milestone, you can click Rollup as needed on demand.

Rollup also rolls up the following information from the changes in the release manifest.

- **Budget Cost and Actual Cost**—Rolls up financial data from change requests and activities into the release. You can see costs under **Links => Financials** when using the Best Practice view and on the Financials tab of the Release form when using the Classic view.

- **Time**—Rolls up time spent (in minutes) from change requests and activities to the Release form. You can see time spent on the Date/System tab when using the Best Practice view and the Assignment tab of the Release form.

9 Save your work.

**Detecting CI collisions between change requests**

The Collision Detection tool (under Advanced Functions in the left navigation pane) determines if there are other change requests scheduled to work on the same CI during the same scheduled time, and helps you manage and resolve these potentially harmful conflicting change requests. For Release Management, Collision Detection is run against the changes in the release manifest, not the changes related to the release in the Relationships tab. Collision Detection does not apply to release activities in the release manifest.
**Note**

The Collision Detection tool works with Release Management a little bit differently than with BMC Remedy Change Management. The Collision Detection link does not turn red when a collision is detected. Also, you fix collisions in the Manifest tab of the release form.

**Figure 63: CI collisions detected with change requests**

It consists of two sections:

- The Exclude Collision State section at the top lets you exclude (or include) change requests that have already run through Collision Detection. The following collision states are detected:

<table>
<thead>
<tr>
<th>Collision state values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None Found</td>
<td>The change request has been checked for collisions and none were found (green). When running Collision Detection from a release, changes with no scheduled start or end dates will have a collision state of None Found. <strong>Note:</strong> Used primarily with Release Management.</td>
</tr>
<tr>
<td>Detected</td>
<td>Collision detected for the listed CI (red).</td>
</tr>
<tr>
<td>Ignored</td>
<td>You ignore the collision (purple).</td>
</tr>
<tr>
<td>Investigating</td>
<td>You are investigating the collision (orange).</td>
</tr>
<tr>
<td>Resolved</td>
<td>You have taken action on the collision (blue).</td>
</tr>
<tr>
<td>(clear)</td>
<td>Collision detection has not been run against this change request. <strong>Note:</strong> Used primarily with Release Management.</td>
</tr>
</tbody>
</table>
Collision state values | Description
---|---
N/A | Used only for Activities in the manifest table. Collision Detection does not apply to Activities.

- The Change Requests with Identified Collisions section at the bottom identifies the current CI collisions for the change request. It lists the CI affected, the change request ID, the scheduled start and end dates, and the ID and Scheduled Start and End dates of the change request causing the conflict.

The first time you run the Collision Detection tool, it shows you by design only the current collisions in the release manifest. If you open the Collision Detection tool a second time and maintain the default settings (all Exclude Collision State fields selected), only new collisions are shown. Previously detected collisions that need corrective action are not listed. To see all CI collisions that need corrective action, you must clear the Exclude Collision State fields and then click the Identify Collisions button, as shown in Figure 38 on page 176.

**To detect CI collisions between change requests**

1. Open the request.

2. Click the Tasks tab on the change form or the Manifest tab on the release form, and then add change requests to the request.

   You must add at least one change request to the request before running Collision Detection.

3. Choose Advanced => Collision Detection.

   The Collision Detection dialog box appears (Figure 38 on page 176). In the Include Collision State section, you now must choose to exclude or include the collision states (for example, Detected) the next time you run the tool. For example, if Detected is selected, then any records that were previously flagged as Detected are excluded from collision detection the next time the tool is run. If you clear Detected, then these records are again run through collision detection.

4. Select or clear collision states as needed, and then click Identify Collisions.

5. Close the Collision Detection tool when you finish.

6. Click the Tasks tab in the change form or the Manifest tab in the release form.

   The table displays the collision state of each change request that is included in the request.

7. Use the drop-down menu in the Collision column to update the collision state.
New changes that you add to the request appear in black until you run Collision Detection.

8 To fix the CI collision:
   a Change the collision state from Detected to Resolved.
   b Save and close the request.
      Collision states are not saved to the database until you save the request.
   c Click View to open the change request.
   d Run Collision Detection from the change request to determine which CIs are causing the collision.
   e Click the Dates tab of the change request.
   f Enter a new Scheduled Start Date and End Date that avoids the CI collision.
   g Save and close the change request.
   h Run the Collision Detection tool one more time in the request to make sure that no other collisions are detected.
      Make sure all the Exclude Collision States are cleared before you click Identify Collisions.
   i Save and close the Collision Detection tool.
9 Save the request.
   Collision states are not saved to the database until you click Save.

**Scheduling releases**

For the Initiate milestone, in the Release form, use the Dates tab in the Classic view or the Dates/System tab in the Best Practice view to add the scheduled start and end dates for the release. These dates can also be revised for the Planning milestone. During deployment, you also use this tab to track actual and deployment start and end dates for the release.

The following information describes each of these date fields on the Release form:
Requested Availability Date

For the Planning milestone, provide the date and time when the release should be available.

Scheduled Start Date

For the Initiate milestone, use this field to specify the date and time at which the release implementation is scheduled to start (the moment at which the release is planned to be set to the status "Work in Progress").

Actual Start Date

For the Deployment milestone, provide the date for when work started on the release.

Deployment Start Date

For the Deployment milestone, provide the date when the release starts to be deployed to the IT infrastructure.

Completed Date

This field is read-only and is automatically set to the current date and time when the status of the release is set to "Completed."}

Scheduled End Date

For the Initiate milestone, use this field to specify the date and time at which the release implementation is scheduled to be completed (the moment at which the release is planned to be set to the status "Closed").

Actual End Date

For the Deployment milestone, provide the date for when work ended for the release.

Deployment End Date

For the Deployment milestone, provide the date when the release finishes deploying to the IT infrastructure.
You can use the Schedule Assist tool to identify possible conflicts associated with releases. You can search for windows of opportunity that your release request can be scheduled around. The Schedule Assist tool helps you search for available deployment times for the release request based on global business events and CI availability.

When you create a release request that modifies a CI—for example, you must upgrade a server—you can schedule a time segment for the CI that shows it is unavailable to the rest of the support staff. If another member of the support staff wants that CI to be available, they should schedule their own release in a different time segment. You can perform the tasks listed in the following table.

**Note**

The following processes are essentially the same for BMC Remedy Change Management and Release Management, with one exception for the Schedule Assist tool. The Release form shows you the CIs related to the changes in the release manifest. In BMC Remedy Change Management, you see the CIs that are directly related to the change.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register unique business events for releases</td>
<td>1 In the navigation pane of the Release form, choose Advanced Time Segments Business Event.</td>
<td>For more information, see:</td>
</tr>
<tr>
<td></td>
<td>2 On the Search Business Event/Location Definition dialog box, click New.</td>
<td>■ Registering time segments on page 157</td>
</tr>
<tr>
<td></td>
<td>3 On the Business Event/Location Definition dialog box, define a unique time segment for the business event or categorization.</td>
<td>■ Registering unique business events and operational categorizations on page 158</td>
</tr>
<tr>
<td></td>
<td>4 Click Save.</td>
<td>■ Understanding server time, time zones, and time segments on page 169</td>
</tr>
<tr>
<td></td>
<td>5 Click Add to create a time segment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 In the Description field on the Business Time Segment dialog box, enter a description for the time segment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7 In the Availability field, select Available or Unavailable.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 In the Level field, select a level of 10 or higher.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 In the Duration Type field, select One time (which generates a single occurrence of the time segment) or Recurring (which cannot span multiple days, but must be scheduled within a 24-hour period).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 Enter the starting and ending dates and times for the duration of the time segment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 Click Save, and then click Finish.</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
<td>Explanation</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Registering CI time segments for releases</td>
<td>1 In the navigation pane of the Release form, choose Advanced =&gt; Time Segments =&gt; Configuration Item (CI).</td>
<td>For more information, see:</td>
</tr>
<tr>
<td></td>
<td>2 In the CI Advanced Search form, enter the information necessary to search for a CI and then click Search.</td>
<td>■ Registering time segments on page 157</td>
</tr>
<tr>
<td></td>
<td>3 Select a CI from the search results.</td>
<td>■ Registering time segments for CIs - Creating a blackout schedule on page 164</td>
</tr>
<tr>
<td></td>
<td>4 Click Explore CI to view a CI and its relationship in a tree structure.</td>
<td>■ Understanding server time, time zones, and time segments on page 169</td>
</tr>
<tr>
<td></td>
<td>5 Select the CI.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 In the Registration for Shared Time Segment dialog box, click Add.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7 In the Description field on the Business Time Segment dialog box, enter a description for the time segment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 In the Availability field, select Available or Unavailable.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 In the Level field, select a level of 10 or higher.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 In the Duration Type field, select One time (which generates a single occurrence of the time segment) or Recurring (which cannot span multiple days, but must be scheduled within a 24-hour period). If you select Recurring, you must specify the recurrence.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 Enter the starting and ending dates and times for the duration of the time segment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12 Click Save to associate the time segment to the CI, and then click Finish.</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
<td>Explanation</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Schedule Assist to search for available times</td>
<td>1. Open the release request.</td>
<td>For more information, see Using Schedule Assist to search for available times on page 170</td>
</tr>
<tr>
<td></td>
<td>2. Click the Dates tab.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Click the <strong>Schedule Assist</strong> icon.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Define any time segments needed for the CIs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5. Click <strong>Find Next Available Time</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6. Click <strong>Schedule Time Segment</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7. On the Associate Time Segment to CIs dialog box, use the following steps to associate CIs to time segments.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8. Select the CI to associate the time segment to.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9. Enter a description of the time segment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10. Click <strong>Create Time Segment</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11. Click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12. Enter the scheduled start date and end date.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>13. Click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>14. Save the change request.</td>
<td></td>
</tr>
</tbody>
</table>

**Performing additional functions from the Process Flow Status bar**

You can perform the following functions from the Process Flow Status bar.

**Table 33: Additional functions from the Process Flow Status bar**

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to next milestone</td>
<td>In the Process Flow Status bar, click the arrow and choose <strong>Action =&gt; Next</strong>. The next status or milestone appears.</td>
</tr>
<tr>
<td>Function</td>
<td>Action</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Enter pending status         | 1. In the Process Flow Status bar, click the arrow and choose **Action => Enter Pending**.  
                               | 2. Select appropriate status reason (for example, Manager Intervention).  
                               | 3. Select Resume from the Process Flow Status bar when you are ready to continue work on the release request. |
| Return to earlier milestone  | 1. In the Process Flow Status bar, click the arrow and choose **Back**.  
                               | 2. Select the milestone you want to return to, for example, Initiate.    |
| Create new change request    | 1. In the Process Flow Status bar, click the arrow and choose **Action => Create a New Change**.  
                               | 2. Enter required information to complete the change request.            | 3. Save your work.                                                      |
| Create new activity          | 1. In the Process Flow Status bar, click the arrow and choose **Action => Create a New Activity**.  
                               | 2. Enter required information to complete the activity.                  | 3. Save your work.                                                      |
| Cancel release request       | 1. In the Process Flow Status bar, click the arrow and choose **Action => Cancel**.  
                               | 2. Select appropriate status reason, for example, Resources Not Available. Release moves to Close Down milestone. |
| Approve release request at an approval phase | At the approval phase of the release request, click the arrow and choose **Approve**. The next status or milestone appears. |
| Reject release request at an approval phase | 1. At the approval phase of the release request, click the arrow.  
                                            | 2. Choose **Reject => rejection reason** (for example, Business Case Rejected).  
<pre><code>                                        | 3. The release request moves to Rejected status.                        |
</code></pre>
<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
</table>
| Cancel release request at an approval phase   | 1  At the approval phase of the release request, click the arrow.  
2  Choose **Cancel** => **cancel reason** (for example, No Longer Required).  
3  The release request moves to Rejected status.                                      |
| Find application help                         | In the Process Flow Status bar, click the arrow and choose **Action** => **Help**.  
Release Management help appears (if it is installed).                                   |

**Recording release activities**

You might need to modify a release request with work history entries that you add during its life cycle, in order to document activities performed or information gathered. For example, you can track a release request’s progress in the work history by recording the steps that you took to implement it.

Use the Work Details tab when using the Best Practice view and the Work Info tab when using the Classic view to add work information about activities performed for the current release request. For example, you can track a release request’s progress by recording the steps that you took to implement it in the work history.

The request should still follow the stages in the recommended life cycle of a release request, as described in **Milestones in the release request lifecycle on page 60**. The Process Flow Status bar directs you with messages if there are fields that must be filled in when you move to a new milestone.

You might want to add work information about the following activities:

- **General Information** — Notes about the record, for example, you might want to add a note that a particular CI was deployed, and include the date.

- **Planning** — Notes about a plan to implement a global release throughout your organization.

- **Implementation** — Installation and backout procedures for the release.

- **Costing and Charging** — Additional information about the cost of the current CI, incident, change, or so on. For example, you might want to add a note that the cost of maintaining a CI was split between two cost centers, or that the cost to implement a release came under budget.
Recording the release activities

Use the following procedure to add work information about activities performed for the current release request.

**To add or modify work information to a release request when using the Best Practice view**

1. Open the release request.

2. To add new work information, under the Add Work Info details section on the Work Detail tab, enter the following information:
   - **Notes** - Enter the details of your work information record in this field.
   - **Attachment** - Click to add any attachments related to the work information.

3. Click More Details to select the work information type and add any additional attachments.
   - From the Work Info Type list, select the type of work information to add.
   - In the Attachment fields, add any additional attachments required for the work information. You can add up to three files.

4. When you finish updating the release request, under Add Work Info click Save.
   The Save operation adds your entry to the work history.

5. To view or update the entries in the work information, select the work info record and click View. Under the Edit Work Info section:
   - Update the required fields.
   - To delete an attachment, click delete icon for that attachment.
   - Click Save.

6. To view a report of selected activities you performed against this request, select the records from the work info table and click Report.

7. To view the history of when and by whom each of the work information was added click History.

8. Click Save.
To add or modify work information to a release request when using the Classic view

1. Open the release request and click the Work Info tab.

2. From the Work Info Type list, select the type of work information to add.

3. From the Source list, select the source of this information.

   Information sources can include, for example, email, system assignment, or the Web.

4. Enter the details of your work information record in the Summary and Details fields.

5. To add an attachment to the record, right-click in the attachment table and select Add from the menu that appears. With browsers, click the Add button.

6. From the Locked list, select Yes or No to lock the log.

   **WARNING**
   
   If you select Yes you cannot modify the work log after you save the record.

7. From the View Access list, select Internal or Public.

   - **Internal** — If you want only users within your organization to see the entry.
   
   - **Public** — If you want everyone with access to the system to see the entry, including requesters.

8. When you have finished updating the release request, click **Save**.

   The Save operation adds your entry to the work history. The Show field allows you to filter out specific work entries based on the type of activity that appear in the table.

9. To see a report of the activities you performed against this release, click **Report**.

10. To see all entries for work information history, click **View**.

    You can view but not modify the work info records if they are locked.

   **Note**

   When you return to the Release Management Console, you might need to refresh the Release Information table to display all the modified records.

11. Click **Save**.
Modifying release requests - Moving the release forward

As you track and supervise a release request, you move it from one milestone to another (for example, from Initiate to Planning). When you choose different milestones, messages alert you if you need to complete more fields in the request.

**Note**
A request should follow the milestones in the recommended lifecycle of a release request, as described in Milestones in the release request lifecycle on page 60. Manually setting the status values can disrupt the lifecycle in which you enter information about and resolve the release request.

To modify release requests

1. Open the release request.
2. On the Release form, make the appropriate changes.
3. *(optional)* Add manifests to the release request.
   
   For more information, see Creating a manifest on page 288.
4. *(optional)* Modify the release request assignments.
   
   For more information, see Working with release request assignments on page 316.
5. *(optional)* Relate a CI or some other object to the release request.
   
   For more information, see Working with release relationships on page 330.
6. *(optional)* Modify the start and end dates of the release request.
   
   For more information, see Planning milestone - Planning and scheduling the release request on page 305.
7. Save your work.
8. Use the Process Flow Status bar to move the release request forward to the Initiation Approval phase.

**Figure 65: Moving release request to next approval phase**

For more information, see Performing additional functions from the Process Flow Status bar on page 299.
Note
Out-of-the-box, release requests must be approved before they move to the Planning milestone. For more information, see Working with BMC Remedy Change Management as an approver on page 355 and Approval processes provided out-of-the-box on page 357.

9 After the release request is approved, use the Process Flow Status bar to move the release request forward to the Initiation Registered status.

10 Use the Process Flow Status bar to move the release request forward to the Planning Approval phase.

The release must be approved before it can move forward. For more information, see Planning milestone - Planning and scheduling the release request on page 305.

Planning milestone - Planning and scheduling the release request

After a release request is approved at the Planning Approval phase, the release coordinator must plan the details associated with the release.

Figure 66: Planning the release request

Plan for the following important details:

- Set the release request’s status to Planning, and review the planned dates.
- Estimate the time the project will take.
- Estimate any applicable downtime associated with the release.
Register an available or unavailable time segment to perform the release.

Assess the risks and impact of the release request.

Specify the business justification for the release (if this was not already done when the release request was created).

Create your plans.

Calculate the costs associated with the release request.

Submit the release request for approval.

Approvers require this information to be able to decide whether to approve or reject the release request.

**To plan and schedule the release request**

1. Open the release request at the Planning In Progress status.

2. Open the Change Calendar.

   **Figure 67: Change Calendar—Viewing release requests**

   ![Change Calendar](image)

   a. Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Quick Action =&gt; View Calendar.</td>
<td>Choose Quick Links =&gt; View Calendar.</td>
</tr>
</tbody>
</table>
b Select how many days’ worth of requests and business events to show.

c Select Release Requests to view release requests in the calendar.

d Select the requests and business events for a specific day.

e Close the Change Calendar when you are finished.

For more information, see Using the Change Calendar on page 194.

3 Register available or unavailable time segments for your business event, operational categorization, or CI.

For more information, see Using Schedule Assist to search for available times on page 170.

4 Click the Dates/System tab in the Best Practice view or Dates tab in the Classic view.

When planning a release request, you use this tab to track the scheduled, actual, and deployment start and end dates of releases.
5 Revise the start and end dates as needed.

6 Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review the Business Justification field on the Release form.</td>
<td>Click the Classification tab, and then review the Business Justification.</td>
</tr>
</tbody>
</table>

For more information, see Specifying the business justification on page 286.

7 (optional) Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Links =&gt; Financials.</td>
<td>Click the Financials tab.</td>
</tr>
</tbody>
</table>

You can calculate the costs associated with the change request. For more information, see Close Down milestone - Completing release requests on page 312.

8 Save your work.

9 Use the Process Status Flow area to move the release request from the Planning In Progress status to the Build Approval phase.

The release must be approved before it can move forward. For more information, see Build milestone - Building a controlled environment for the release on page 308.

### Build milestone - Building a controlled environment for the release

After a release request is approved at the Build Approval phase, you must work the release through the Build milestone. This milestone assembles the CIs that are needed to create the release package in a controlled IT environment before it goes into service. You also add change requests and activities to the release.
At most companies, the Build milestone is interchangeable with the Test milestone. The Build and Test milestones are typically iterative processes. Release candidates are built, tested, and frequently kicked back so that they can be fixed. During the Build milestone, you complete change requests and activities to build and test the release package. You then find you must add additional change requests and activities to fix bugs, add additional functionality to the release, and so on.

**Note**

For release coordinators, the Build milestone is mostly a manual stage to verify that the Build process is successful. You should use the Release form to update information, revise your plans, add additional change requests and activities, and so on.

**To build the release**

1. Open the release request at the Build In Progress status.

2. On the Dates tab in the Classic view or the Dates/System tab in the Best Practice view, revise the start and end dates as needed.

3. On the Manifest tab, add changes or activities to the release as needed.

4. Click **Rollup** to accumulate the risk level, costs, and time spent from the related change requests (displayed on the Manifest tab).

5. Save your changes.

6. Use the Process Status Flow area to move the release request from the Build In Progress status to the Test Approval phase.

The release must be approved before it can move forward. For more information, see Test milestone - Testing the release on page 310.
Test milestone - Testing the release

After a release request is approved at the Test Approval phase, you should test it at the Test milestone, before you can release it. Testers can be business staff, users, or other IT staff. They verify the release; then you can roll it out.

**Figure 69: Release request at the Test milestone**

For release coordinators, the Test milestone is mostly a manual stage to verify that the service work is successful in a controlled environment. You should use the Release form to update information, revise your plans, add additional change requests and activities, and so on. At most companies, the Test milestone is interchangeable with the Build milestone.

**To test the release**

1. Open the release request at the Test In Progress status.
2. Revise the start and end dates as needed.
3. Add changes or activities to the release as needed.
4. Click **Rollup** to accumulate the risk level, costs, and time spent from the related change requests (displayed on the Manifest tab).
5. Save your changes.
6. Use the Process Status Flow area to move the release request from the Test In Progress status to the Deployment Approval phase.
The release must be approved before it can move forward. For more information, see Deployment milestone - Rolling out the release to the business on page 311.

Deployment milestone - Rolling out the release to the business

After a release request is approved at the Deployment Approval phase, the release is rolled out to the business at the Deployment milestone. You deploy the release to the IT infrastructure according to the prepared plan at the scheduled start date (for example, over a long holiday weekend). You must distribute hardware and software to the installation site. Task implementers must follow a prepared script of tasks and activities to complete the installation.

The Deployment milestone can require approvals to make sure the release does not need to be rolled back.

Figure 70: Rolling out the release at the Deployment milestone

To deploy the release to the business

1. Open the release request at the Deployment In Progress status.

2. On the Dates tab in the Classic view or the Dates/System tab in the Best Practice view, revise the deployment start and end dates if needed.

   You use these date fields to specify when the release is deployed to the IT infrastructure. These dates are usually different than the Scheduled Start and End Dates, which is typically a longer process.

3. On the Manifest tab, review the status of the change requests and activities that are included in the release manifest.
4 (optional) Use the Schedule Assist tool to search for available deployment times for the release request.

The Schedule Assist tool identifies possible conflicts associated with releases and windows of opportunity that your release request can be scheduled around. These deployment dates are based on global business events and CI availability. (For more information, see Specifying the business justification on page 286.)

5 Click Rollup to accumulate the risk level, costs, and time spent from the related change requests (displayed on the Manifest tab).

6 Save your work.

7 When all the change requests and activities reach Closed status, use the Process Status Flow area to move the release request from the Deployment In Progress status to the Close Down Approval phase.

The release must be approved before it can move forward. For more information, see Close Down milestone - Completing release requests on page 312.

**Close Down milestone - Completing release requests**

After the release request is approved at the Close Down Approval phase, you cannot close the release request until all tasks are closed, due to success, cancellation, or failure. When all the tasks related to a release request are closed, the requester and the release coordinator are notified that the release is resolved.

**Figure 71: Release request at the Close Down milestone**

The Close Down milestone provides the opportunity for reviewers to conduct post-implementation reviews (sometimes called post-mortems) to offer feedback on the effectiveness of the release, and record metrics for deployment to make sure the
release met its service targets. After IT and the business unit (BU) have completed
the review, no further changes or activities are performed on this release.

When the requester has verified that the release request was resolved satisfactorily,
the release request can be set to Closed. If the requester does not close the release
request within the allowed response time of it being resolved, the release request is
closed automatically after a specified period of time. The Status Reason for the
release request indicates that the release was automatically closed.

The allowed response time depends on how the application administrator
configured the Release Management application. The default is 15 days.

If the requester is not satisfied with the release request, the requester can reopen the
release request.

The release coordinator is notified that the release request is reopened, and must
respond to the release request.

A release request is moved to the Close Down milestone when it is cancelled.

**To close down the release**

1. Open the release request at the Close Down In Progress status.
2. Revise the start and end dates as needed.
3. Add changes or activities to the release as needed.
4. Click **Rollup** to accumulate the risk level, costs, and time spent from the related
change requests (displayed on the Manifest tab).
5. Save your changes.
6. Click **Next** in the Process Flow Status bar to move the release request forward.

**To cancel a release**

Once the release moves into the Planning milestone it can be cancelled. Cancelling a
release will close the release record and move it to the Close Down milestone. All
changes and activities created or related to the release must either be Completed,
cancelled or Closed to cancel the release request.

1. Open the release request.
2. For the current milestone, select **Cancel => Reason**.

Reason can have the following values:
■ No Longer Required  
■ Funding Not Available  
■ To Be Re-Scheduled  
■ Resources Not Available

If all related Changes and Activities defined in the Manifest tab are either Completed, Cancelled or Closed, the status of the release request is changed to Cancelled, with the status reason as the reason selected and the release request is moved to the Close Down milestone.

### Monitoring the progress of a release request

As a release request is being worked on, you can follow its progress by viewing the information by one of the following methods:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>On the Work Detail tab, select the Work Info from the table and then click <strong>View</strong>.</td>
<td>1 Click the Work Info tab on the Release form.</td>
</tr>
<tr>
<td></td>
<td>2 Select the Work Info from the table and then click <strong>View</strong>.</td>
</tr>
</tbody>
</table>

For example, during its Deployment milestone, you can follow the progress of the tasks as they are being completed.

**To view the progress of a release request when using the Best Practice view**

1. Open the release request.

   The release request form displays details about the release assignments, target date, status, next approval phase, potential risks, and whether the release request has been escalated.

2. View progress details of the release request by clicking the appropriate tab:
**Tab** | **Description**
---|---
**Work Detail** | ■ View information about each step in the process in the work information history area.  
■ Review the current stage in the approval process for the release request, including the next approval phase.  
*Note:* The Work Detail tab is displayed when you open the Release form.

**Manifest** | View and create associations to activities and change requests.

**Relationships** | View and create associations between releases and other application objects (example - incidents, known errors, changes, problem investigations, software library items, LDAP objects, CI unavailability and configuration items, and other releases).

**Date/System** | View the planned dates, information related to who and when the release request was submitted and by who and when the release request was last modified.

**SLM** | Review the agreed-upon service targets for the request. This tab is visible only if the BMC Service Level Management application is installed.

3 View additional details by clicking the appropriate links:

**Link** | **Description**
---|---
**Links => Categorization** | View the timing of the release request and its categorizations.

**Links => Financials** | View information relating to cost types, total costs, and the total costs in a specific currency.

4 Close the Release form.

**To view the progress of a release request when using the Classic view**

1 Open the release request.

   The top part of the release request provides information about the status, next approval phase, potential risks, and whether it is escalated.

2 View progress details of the release request by clicking the appropriate tab:

**Tab** | **Description**
---|---
**General** | View who requested the release request and who is assigned to the request. When the release request was created, it was automatically assigned to the appropriate support staff group or person.

**Classification** | View the timing of the release request and its categorizations.
Working with release request assignments

One responsibility for release coordinators is creating the release request assignments. They can be assigned manually or automatically. If an assignment definition has not been created for the Release Management application, you must assign the release manually.

For information on assigning the release manually, see Automatically assigning releases on page 318.

The release assignee is then notified of release request assignments by email, pager, or BMC Remedy Alert. Assigned release requests can also be listed in the Release Information table in the console.

Release requests are assigned automatically on creation by the Release Management application. The assignment is based on the release request’s categorization. The Assignment tab displays information about people assigned to a release as the Release Coordinator.

The time spent resolving activities or change requests is automatically rolled up into the release. Separate Time Spent (Classic view) and Time Information fields display

---

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Info</td>
<td>View information about each step in the process written in the work information history area.</td>
</tr>
<tr>
<td>Manifest</td>
<td>View and create associations to activities and change requests.</td>
</tr>
<tr>
<td>Assignments</td>
<td>View who is assigned to the release request as the release coordinator.</td>
</tr>
<tr>
<td>Relationships</td>
<td>View or create associations between releases and other application objects (example - incidents, known errors, changes, problem investigations, software library items, LDAP objects, CI unavailability and configuration items, and other releases).</td>
</tr>
<tr>
<td>Approvers</td>
<td>Review the current stage in the approval process for the release request, including the next approval phase.</td>
</tr>
<tr>
<td>SLM</td>
<td>Review the agreed-upon service targets for the request. This tab is visible only if the BMC Service Level Management application is installed.</td>
</tr>
<tr>
<td>Financials</td>
<td>View information relating to cost types, total costs, and the total costs in a specific currency.</td>
</tr>
<tr>
<td>Dates</td>
<td>View the planned dates.</td>
</tr>
</tbody>
</table>

3 Close the Release form.
the total time spent (in minutes) for the activities and the change requests related to the release.

**Figure 72: Assigning releases and tracking time spent**

Note

You must define at least one individual with the Release Coordinator functional role before you can make any assignments to a Release Coordinator support group.

During configuration, the application administrator determines to whom the release requests are assigned. This decision is based on criteria such as the release request’s categorization. For example, all release requests that are categorized as hardware issues might be assigned to the Support-Hardware group. All release requests that are categorized as software upgrades and originate from California might be assigned to Sonya Software in Santa Clara. The criteria of the release request together with the application administrator’s configuration determines to whom each release is assigned.

The release coordinator must make sure that the assignment is correct and accept the release request. If the assignment is not correct, the release coordinator can reassign the request.
Automatically assigning releases

You can automatically assign the release using the Auto Assign option from the Set Assignment using menus. Assigning the release coordinator using Auto Assign uses the requester’s information, the Release Location information, and the Operational and Product Categorization information about the form to determine an assignment match.

These assignments are based on routing information stored in CFG:Assignment form. The CFG:Assignment form assigns the groups and then Auto Assign assigns the individual. For more information, see the *BMC Remedy IT Service Management Configuration Guide*.

Reassigning release requests

If you cannot work on an assigned release request, you can reassign it to another release coordinator in the Best Practice view. You can ask your coordinator to reassign the release request.

If the release request was categorized incorrectly, it can also be reassigned.

**Note**

You must set a notification rule and define a milestone for it to enable the notification workflow. For more information on setting notification rules, see the *BMC Remedy IT Service Management Configuration Guide*.

To reassign a release request when using the Best Practice view

1. Open the release request.
2. On the Release form, select the Release Coordinator to whom the release request is to be assigned.
3. Click Save.

   The release coordinator is notified of the reassigned release request.

To reassign a release request when using the Classic view

1. Open the release request.
2. Click the Assignment tab.
3. Select the Release Coordinator to whom to assign the release request.
4 Click Save.

The release coordinator is notified of the reassigned release request.

**Working with release reassignment requests**

Release coordinators are responsible for responding to reassignment requests. When a release coordinator reassigns a release request to another coordinator, the person is notified. Upon reviewing the release, the coordinator can reassign the release to another qualified release coordinator.

**To respond to release reassignment requests**

1 Open the Overview Console or the Release Management Console.

   All reassignment requests appear in the table along with other release requests. BMC recommends regularly monitoring your assigned work to keep track of any release requests reassigned to you.

2 Select the appropriate release request.

3 Click View.

   After reviewing the release request, you can manually reassign the release coordinator.

4 To deny the reassignment request, you must reassign it to another release coordinator. To reassign the release request, do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Release Coordinator on the Release form.</td>
<td>1 Click the Assignment tab.</td>
</tr>
<tr>
<td></td>
<td>2 Select the Release Coordinator to whom to reassign the request.</td>
</tr>
<tr>
<td></td>
<td>3 Select an assignment method (for example, Auto Assign), and then click Set.</td>
</tr>
</tbody>
</table>

5 Click Save.

If you reassign the release request, the new assignee is automatically notified of the changed assignment.

For more information, see Assigning release requests on page 322.
Tracking efforts for a release record

The Effort log displays a list of all individuals who have worked on the release during its life cycle.

*Note*
Entries in the effort log are not system-generated, so you must enter them manually. The list is not in chronological order.

**To track efforts**

1. Open the release request.
2. Choose Functions => Track Effort.
3. Fill in the Select an Assignee fields.
   This information is required to select the individual for whom the effort log is being created.
4. Fill in the Select Effort Classification fields.
   This information is required to show what kind of effort is being logged, for example, actual implementation activity.
5. Fill in the Enter Effort Time Spent fields.
   This information records where the time was spent.

   *Note*
   As needed, you can adjust the time spent in the Update Assignee Effort Duration section. For information, see Performing additional release request functions on page 320.

6. Click Add, and then click Close.

**Performing additional release request functions**

In addition to creating a release request, you can perform the functions listed in the following table.
Table 34: Additional release request functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the effort log</td>
<td>From the release request, choose <strong>Functions =&gt; Track Effort</strong>. Update any of the assessment type information and the time spent, and then click Save. <strong>Note:</strong> You must be the release coordinator to modify the effort time.</td>
</tr>
<tr>
<td>Delete the effort log</td>
<td>From the release request, choose <strong>Functions =&gt; Track Effort</strong>. Select an entry and then click delete. <strong>Note:</strong> You must be the release coordinator to modify the effort time.</td>
</tr>
<tr>
<td>Update assignee effort duration</td>
<td>From the release request, choose <strong>Functions =&gt; Track Effort</strong>. Select an entry and then enter the time spent in hours or minutes. <strong>Note:</strong> You must be the release coordinator to modify the effort time.</td>
</tr>
</tbody>
</table>

Receiving notifications of release request assignments

Release coordinators are notified of new release requests based on their notification method preferences defined in their personal record.

The available notifications follow:

- **Individual Notification** — A release coordinator is notified according to the notification method specified in their personal record.
  
  For example, if Bob Backline has a notification method of BMC Remedy Alert, he receives a notification from BMC Remedy Alert for each release request that is assigned to him.

- **Group Notification** — A release coordinator group is notified according to the notification method specified by each group member’s entry in their personal record.
  
  For example, if a release request is assigned to the Support-Software group, each group member is notified through the notification method specified in their personal record. If Sarah Software has Email specified as the notification method in her personal record, the notification is sent to her by email. If Bob Backline has BMC Remedy Alert specified, he is notified accordingly.

**To receive release assignment notification by BMC Remedy Alert**

1. Log in to BMC Remedy Alert as a Support staff member.

   When you or your group receives a notification that you or your group has been assigned to a release request, the information appears in the BMC Remedy Alert window.

2. To evaluate a release, select the release request listed in the BMC Remedy Alert window.
3 Choose **Alerts => Details**.

The release request appears in the Release form. For more information, see Setting application preferences - Release Management on page 440.

**Assigning release requests**

The release coordinator is typically responsible for the overall release process.

**To assign release requests using the Best Practice view**

1. Open the release request.

   Certain fields are automatically filled based on the default configuration and requester information in the release request. For example, the Release Coordinator field already has an assignment.

2. To assign a release coordinator, select the appropriate option:

   - **Coordinator Group** - Provides a list of coordinator groups. Select the group of the release coordinator you want to assign the release to. Groups that have at least one user with the Release Coordinator functional role are listed for selection.

   - **Release Coordinator** - Provides a list of users with the functional role of a Release Coordinator in the selected coordinator group. Select the appropriate release coordinator from this list.

3. Save the release request.

   The release coordinator is automatically notified of the assignment.

**To assign release requests when using the Classic view**

1. Open the release request.

2. Click the Assignment tab.

   Based on the default configuration and requester information in the release request, certain fields are already filled. For example, the Release Coordinator field already has an assignment.

3. To assign a release coordinator if none is assigned, select Auto Assign from the Set Assignment Using field and then click **Set**.
To assign a release coordinator, use one of the following options and then click Set:

- **My Default Group** — Assigns the release to you and your default group.
- **My Group List** — Opens a list of all groups to which you belong. Select the appropriate group from this list.
- **Favorite Groups** — Assigns the release to the typical groups to which your support group assigns requests.
- **Auto Assign** — Automatically assigns the request based on predefined mapping.
- **Release Coordinator** — Assigns the release to you.

To be eligible as the release coordinator, a user must have the Release Coordinator functional role. Groups that do not have a user with one of these roles are not available for selection in the Release Coordinator field.

5 Save the release request.

The release coordinator is automatically notified of the assignment.

### Working with release manifests

In the Manifests tab, you can perform the additional functions with related release requests that are listed in the following table.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>View the selected item in the Changes and Activities table. Opens the application object form.</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes the relationship with the release.</td>
</tr>
<tr>
<td>Search</td>
<td>Opens the Search dialog box for the specified Request Type.</td>
</tr>
<tr>
<td>Create</td>
<td>Opens a window allowing you to create the specified Request Type. You can create an Activity or an Infrastructure Change. For more information:</td>
</tr>
<tr>
<td></td>
<td>- Managing release activities on page 325</td>
</tr>
<tr>
<td></td>
<td>- Creating related change requests on page 242</td>
</tr>
<tr>
<td>Request Type</td>
<td>Displays list of all the available application objects that can be related to a release.</td>
</tr>
<tr>
<td>Show Milestone</td>
<td>Filters list by selected milestone, for example, Deploy.</td>
</tr>
<tr>
<td>Show Related</td>
<td>Filters list of all the available application objects that are related to a release.</td>
</tr>
</tbody>
</table>
Using Quick Actions on changes and activities

The Quick Actions menu on the Manifests Tab enables you to perform advanced actions on changes and activities. Not all actions are available with all request types. This table shows the relationship between request types and the available actions you can perform on them.

Table 35: Matrix of request types and quick actions

<table>
<thead>
<tr>
<th>Request type</th>
<th>Relationship quick action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Update Attributes</td>
</tr>
<tr>
<td>Infrastructure Change</td>
<td>- Get Related Relationships</td>
</tr>
<tr>
<td></td>
<td>- Update Attributes</td>
</tr>
</tbody>
</table>

To use quick actions

1. Select the entry from the Relationships table.

2. From the Quick Actions menu, select an action.

   For example, you can copy relationships from a CI already related to the release request. This table lists all the quick actions you can use.

Table 36: Effect of using Relationship Actions

<table>
<thead>
<tr>
<th>Relationship action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Attributes</td>
<td>Opens Manifest Attributes dialog box for updating milestone attributes for the relationship.</td>
</tr>
<tr>
<td>Get Related Relationships</td>
<td>Copies the relationships of the selected record to the release request’s relationships. For more information, see Copying relationships on page 240.</td>
</tr>
</tbody>
</table>

3. Click Execute.
Performing other functions with related release requests

In the Manifests tab, you can perform the additional functions with related release requests that are listed in the following table.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>View the selected item in the Changes and Activities table. Opens the application object form.</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes the relationship with the release.</td>
</tr>
<tr>
<td>Search</td>
<td>Opens the Search dialog box for the specified Request Type.</td>
</tr>
<tr>
<td>Create</td>
<td>Opens a window allowing you to create the specified Request Type. You can create an Activity or an Infrastructure Change. For more information:</td>
</tr>
<tr>
<td></td>
<td>■ Managing release activities on page 325</td>
</tr>
<tr>
<td></td>
<td>■ Creating related change requests on page 242</td>
</tr>
<tr>
<td>Request Type</td>
<td>Displays list of all the available application objects that can be related to a release.</td>
</tr>
<tr>
<td>Show Milestone</td>
<td>Filters list by selected milestone, for example, Deploy.</td>
</tr>
<tr>
<td>Show Related</td>
<td>Filters list of all the available application objects that are related to a release.</td>
</tr>
<tr>
<td>Quick Actions</td>
<td>Performs advanced actions on relationships.</td>
</tr>
<tr>
<td>Execute</td>
<td>Executes selected Quick Action.</td>
</tr>
</tbody>
</table>

Managing release activities

Release Management module provides the capability of creating and assigning specific units of work called activities. Activities have their own lifecycle with a series of status transitions, for example, Draft, Assigned, and so on. You can also establish a sequence of tasks in your activities. Activities are useful when you need to create a structured sequence of tasks that you must complete to fulfill the release, but these tasks should not be classified as a change request.

For example, imagine you must release a new version of the Calbro marketing application. One of the work items that must be completed in the release cycle is training users on the new marketing application. Because training is not a change request that the Change Management team would complete, you decide instead that training should be an activity that is assigned, tracked, and completed using the Activity form.

Release Management comes bundled with the Activity form, which provides basic facilities for assignment, status, work info, and task management.
Management integration with the Activity form lets you create any generic activity that you need to track.

**Figure 73: Activity form**

You use the Activity form to add a set of activities to a release request. You can track release states and requester information, relate and assign tasks, and enter work log information.

**Note**

For more information about the activity assignee role, see *Working with activities as an activity assignee* on page 375.

### Creating activities - basic steps

The following section describes the basic steps for creating an activity.

**To create a new activity—basic steps**

1. Perform one of the following actions:

   - In the Initiate milestone of the Process Flow Status bar, click the arrow and choose **Action => Create a New Activity**.
- On the Release Management Console, click **Create** (above the Change Requests and Activities table).

- On the Manifest tab of the Release form, choose the Activity request type and then click **Create**.

The Activity form is displayed. The tabs you see vary according to which other applications are installed, for example, BMC SLM.

The activity initially appears in Draft status. To enable the activity from Draft status to be moved to its next status, enter information into the following **required** fields.

2. *(optional)* Use an activity template to fill out the contents of the activity.

   Activity templates are especially useful in any activity that follows well-defined methods for specific and repeated requirements. Activity templates do more than simply fill out fields for you; they can also include tasks with the activity. For more information, see Selecting activity templates on page 450.

3. In the Summary field, enter a brief description of the activity.

4. In the Detailed Description field, enter a more complete description of the activity.

5. Select the Priority to identify the importance you (as support staff) assign to the activity.

   Priority indicates the relative order in which activities should be addressed. It is influenced by considerations of risk and resource availability. The default value of the Priority field is Low.

6. In the Requester tab, enter the person creating the activity (Requested By).

   When creating an activity, the Requested By information is populated automatically with the people and group information of the person logged in. In Search mode, these fields are blank.

   To modify this information, you can click in the Last Name field, enter partial information you might know about the individual you are looking for, and then press ENTER.

   From the People Search dialog box that appears, select the appropriate user record, and then click Select. The other fields in the Requested By section are filled in with information from the user’s People form record.

7. Enter the location information for the activity.
The Location Information is populated automatically with the company information of the person logged in.

8 Complete Assignment information about the activity.

For information, see Creating activity assignments on page 328.

9 (optional) Define work information about the activity.

For information, see Entering work information on page 381.

10 (optional) Create tasks associated with the activity.

For information, see Creating activity task groups and tasks on page 383.

11 (optional) Complete financial information associated with the activity.

For information, see Planning financial information for activities on page 385.

12 (optional) Plan the activity’s dates.

For information, see Planning dates on page 386.

13 Click Save.

Creating activity assignments

Your responsibility as a release coordinator is to properly assign the activity. If an assignment definition has not been created for the activity, you must assign the activity manually. Otherwise, the best practice is to use the assignment rules already configured for you by your Release Management administrator.

The activity assignee is then notified of activity assignments by email, pager, or BMC Remedy Alert. Assigned activities can also be listed in the Assigned Work Orders table in the console.

Activity assignment is based on the activity’s categorization. The Assignment tab displays information about people assigned to an activity as the Request Manager or Request Assignee.

Note
You must define at least one individual with the Request Manager functional role before you can make any assignments to a Support Group.
During configuration, the administrator determines to whom the activities are assigned. This decision is based on criteria such as the activity’s categorization. For example, all activities that are categorized as hardware issues might be assigned to the Support-Hardware group. All activities that are categorized as software upgrades and originate from California might be assigned to Sonya Software in Santa Clara. The criteria of the activity together with the application administrator’s configuration determines to whom each activity is assigned.

The assignee must make sure that the assignment is correct and accept the activity. If the assignment is not correct, the request manager can reassign the request.

These assignments are based on routing information stored in the Assignment Configuration form. This form assigns the groups and then Auto Assign assigns the individual. For more information, see the *BMC Remedy IT Service Management Configuration Guide*.

**Assigning activities**

A activity *must* be assigned to a Support Group. However, a specific request manager is typically responsible for the overall activity process.

**To assign activities**

1. Open the activity.
2. Click the Assignment tab.

   ![Figure 74: Activity form—Assignment tab](image)

   Based on the default configuration and requester information in the activity, certain fields might already be filled.

3. To assign a request manager or assignee, make selections from the Activity Assignee field.
If needed, you can click **Clear** to remove information from Activity Assignee field.

4 Enter the time spent resolving the activity.

5 Save the activity.

The activity assignee is automatically notified of his assignment.

---

## Working with release relationships

You can use the Relationships tab to create associations between releases and other application objects, for example, CI unavailability, configuration items, incidents, infrastructure changes, known errors, LDAP objects, problem investigations, other releases, and software library items. Relating application objects (such as CIs) to the release request lets you identify items that the Release Coordinator plans to address in the release.

**Note**

For more information, see Working with relationships on page 220. The information about relationships in the context of change requests applies equally to release requests. Where exceptions exist, these are noted.

**Figure 75: Release form—Relationships tab**

The relations in a release request are informational only, and are not required to be part of any milestone of the release request. In addition, the application objects do not have to be Completed or Closed for this release to be Closed.

---

## Defining release relationships

You use request types to define these relationships. The Related request types to BMC Remedy Change Management and Release Management modules table
displays a list of request types to which you can relate releases and their available actions, along with their start and end dates. The list varies depending on the other BMC Remedy ITSM applications you have installed with BMC Remedy Change Management.

To view a list of request types to which you can relate releases and their available actions, along with their start and end dates, see “Related request types for BMC Remedy Change Management and Release Management” on page 222.

**To define a relationship when using the Best Practice view**

1. Open the release request record.

2. In the Quick Action area, click the arrow beside **Create Relationship to**.

3. From the menu, select the type of record to you want to relate the current record to.

4. In the Search field of the dialog box that opens, type a search string. For example, if you are creating a relationship to an incident request about a printer that regularly goes off-line, you might type **printer off line**.

   The search scans multiple fields in each record looking for a match, and returns a list of records that contain the phrase "printer off line" in one of the scanned fields. For a list of the fields that are scanned during a search, see "Fields scanned," which follows.

   **Note**
   The type of search dialog box that appears depends on the type of record you chose from the menu.

   **Tip**
   Try to supply as much information as possible in each type of search to reduce the overall number of records returned by the search. If, after using a more specific search string, the search returns too many records, consider using the advanced search. To do this, click **Use Advanced Search**, which opens a form in search mode that is relevant to the type of relationship you are making.

5. From the search results table, select the specific record to which you want to create the relationship.

6. From the **Relationship Type** list at the bottom of the search dialog box, select the type of relationship you want to create.

7. Create the relationship by clicking **Relate**.
The specific list for Select a Relationship Type depends on the type of relationship you are creating. For example, if you are creating a relationship with a change request record, the list includes Related to, if you are creating a relationship with an incident request record, the list includes Related to, Caused, and Corrects. If you are creating a relationship with a known error, there are two relate buttons: Initiated by and Related to, and so on.

8 Close the search dialog.

To define release relationships when using the Classic view

1 Open the release request from which to define the relationship, and then click the Relationships tab.

The Relationships tab shows the record types that you can relate to the release.

Note
The Relationships tab appears in New and Modify mode, but does not in Search mode.

2 From the Request Type list at the bottom of the Relationships tab, select the type of application object to which to relate the current release request.

You can relate a release to any of the options listed in the Request Type field, for example, Infrastructure Change.

3 Add the release type to the release.

You can perform the following functions with related release requests.

<table>
<thead>
<tr>
<th>GUI item</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search button</td>
<td>Opens the Search dialog box for the specified Request Type. For information, see Searching for request types and establishing the relationship type on page 333.</td>
</tr>
<tr>
<td>Create button</td>
<td>Opens a window allowing you to create the specified Request Type. Note: The Create button is disabled for Configuration Item, CI Unavailability, Software Library Item, or LDAP Objects.</td>
</tr>
<tr>
<td>Request Type menu</td>
<td>Displays list of all the available application objects that can be related to a release.</td>
</tr>
<tr>
<td>View button</td>
<td>View the selected item in the Relationship table. Opens the application object form.</td>
</tr>
</tbody>
</table>
### GUI item | Action
--- | ---
Remove button | Deletes the relationship with the release. **Note:** You can delete items from this release request if you later decide that they will not be addressed. You should remove the relationships **before** the release request is closed.
Show Related menu | Filters list of all the available application objects that are related to a release.
Quick Actions menu | Performs advanced actions on relationships. For more information, see Using Quick Actions on relationships on page 234.
Execute button | Executes selected Quick Action.

The original release request and the related request types appear in the Relationships table. To refresh the table right-click in the table and select Refresh All in Table.

4 Save your changes.

### Searching for request types and establishing the relationship type

You can search for a request type (for example, Release or Infrastructure Change) and then establish a relationship (for example, Related to) to the release.

To search for releases to relate to the current release, use the following criteria:

#### Table 37: Release relationship searches

<table>
<thead>
<tr>
<th>Search type</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Search</td>
<td>Release ID, Summary, Status, Status Reason, Impact, Urgency, Risk Level, Milestone, Release Type, Priority, and Deployment Type fields.</td>
</tr>
<tr>
<td></td>
<td>You can also perform advanced searches.</td>
</tr>
<tr>
<td>Categorization Search</td>
<td>Product and Operational Categorization fields.</td>
</tr>
<tr>
<td>Date and Location</td>
<td>Release Location and Release Dates fields.</td>
</tr>
</tbody>
</table>

#### To search for request types and establish the relationship type

1 Open the release request from which to define the relationship, and then click the Relationships tab.

---

4 Save your changes.
2. From the Request Type list at the bottom of the Relationships tab, select the type of application object to which to relate the current release request.

3. In the search window for the request type, complete the search criteria tabs with the relevant query information (for example, the Deployment Type), and then click **Search**.

The search form appears.

---

**Note**

The contents of the search form depend on the type of application object you chose in the Request Type list.

---

**Figure 76: Release Relationship Search form**

Supply as much information as possible in the search dialog box to reduce the overall number of records returned by the search. Matching results appear in a search results table.

4. From the search results table, select the release request with which to create the relationship.

5. From the Relationship Type list at the bottom of the search dialog box, select the type of relationship to create (for example, Related to).
6 Click **Relate**, and then click **OK** to close the confirmation dialog box.

The search window closes automatically. The original release request and the related request types appear in the Relationships table. To refresh the table, right-click in the table and select **Refresh All in Table**.

### Using Quick Actions on relationships

The Quick Actions menu on the Relationships Tab enables you to perform advanced actions on relationships. Not all actions are available with all request types. This table shows the relationship between request types and the available actions you can perform on them.

#### Table 38: Matrix of request types and quick actions

<table>
<thead>
<tr>
<th>Request type</th>
<th>Relationship quick action</th>
</tr>
</thead>
</table>
| CI Unavailability  | • Broadcast CI Unavailability  
|                    | • Get Related Relationships  
|                    | • Modify Relationship Type |
| Configuration Item | • Create New CI Unavailability  
|                    | • Explore CI  
|                    | • Get CI Impact/Urgency  
|                    | • Get CI Product Categorization  
|                    | • Get Impacted Areas  
|                    | • Get Related Relationships  
|                    | • Modify Relationship Type  
|                    | • Show Related Services |
| Project            | None                                                            |
| Incident           | • Get Related Relationships  
|                    | • Modify Relationship Type |
To use quick actions

1. Select the entry from the Relationships table.

2. From the Quick Actions menu, select an action.

For example, you can copy relationships from a CI already related to the release request. This table lists all the quick actions you can use.

Table 39: Effect of using Relationship Actions

<table>
<thead>
<tr>
<th>Relationship action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explore CI</td>
<td>Opens the graphical BMC Atrium Explorer that shows the selected CI’s relationship to other CIs.</td>
</tr>
<tr>
<td>Create New CI Unavailability</td>
<td>Creates a new CI Unavailability record for the selected CI.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option is available only if BMC Remedy Asset Management is installed. For more information, see:</td>
</tr>
<tr>
<td></td>
<td>- To create CI unavailability where other CI unavailability already exists on page 255</td>
</tr>
<tr>
<td></td>
<td>- To create CI unavailability from CIs associated with a request on page 256</td>
</tr>
</tbody>
</table>
### Relationship action

<table>
<thead>
<tr>
<th>Relationship action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get CI Impact/Urgency</td>
<td>Sets the current release request’s Impact and Urgency to the corresponding values of the selected CI.</td>
</tr>
<tr>
<td>Get CI Product Categorization</td>
<td>Sets the current release request’s Product Categorization to that defined in the selected CI.</td>
</tr>
<tr>
<td>Get Related Relationships</td>
<td>Copies the relationships of the selected record to the release request’s relationships. For more information, see Copying relationships on page 240.</td>
</tr>
<tr>
<td>Modify Relationship Type</td>
<td>Modifies the relationship type and enter a new description for the related item.</td>
</tr>
</tbody>
</table>

3 Click **Execute**.

### Rolling up costs - Working with financial information

Risk, time, and costs (actual and budget) from activities and change requests that are related to the release manifest are rolled up on the Financials tab.

- For activities, only the time spent, and the actual and budget costs, are rolled up to the release.
- For change requests, in addition to time spent and costs, the highest Risk Level is also rolled up to the release.

**To roll up costs**

1 Open the release request.

2 Do one of the following:
When using the Best Practice view

Click Links => Financials.

When using the Classic view

Click the Financials tab.

Figure 77: Release form—Financials tab

Based on the changes and activities displayed in the release manifest, the Release Costs table shows the costs associated with the release, and rolled-up costs from the related activities or change requests.

For more information, see Working with release manifests on page 323.

3 Click Add to attach costs to the release.

Note

If you attach a cost entry to the release you are working on, the Release Costs table does not list a related request ID.

4 Filter the release costs by selecting from the Cost Category field.

The default (the Cost Category field is cleared) displays all entries.

Otherwise, select Infrastructure Change, Release, or Activity to display costs associated with those entries.

5 Filter the release costs by selecting from the Show field.

All Cost Types (the default value) displays all release and rolled-up costs.

6 (optional) Click View to view the costs associated with the release, or click Delete to remove them.

Note

You can only delete Release costs from the Financials page of the Release form.
Understanding the approval process

After a release is planned and built, the release request is set to a status of Scheduled for Review. The release coordinator has the opportunity to review plans, schedules, and so on, before moving the release to the Implementation Approval phase.

Figure 78: Release form— Approvers tab

The read-only Current Approval Phase field shows what approval phase the release is in during its life cycle. For more information, see Approval processes provided out-of-the-box on page 357 and Change request status transitions on page 481.

Approving or rejecting release requests

When an approval is required to move the release request to the next status, the Process Status Flow area prompts you to approve, cancel, or reject the approval. If configured, the release request cannot be moved to the next status unless the approval is received.

When a release requires an approval, its approvers are notified. Notifications are sent according to the method specified in the approver’s record in the People form.

When you have finished planning the release request, and have supplied all the information that the approvers require to review the release request, you can submit the release request to the approval process.

Note
For more information, see Change Management approver role on page 355.
Performing additional functions with related change requests

You can perform the additional functions with related change requests that are listed in the following table.

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View change dependencies</td>
<td>1. Open the change request in the Change form, and then click the Relationships tab.</td>
</tr>
<tr>
<td></td>
<td>2. In the Show Related field, select Infrastructure Change. A list of change requests appears in the table. Changes with a dependent relationship to the current request are shown as Dependent under the Relationship Type column. The table shows the status of each request and enables you to monitor the progress of the change request implementation.</td>
</tr>
<tr>
<td></td>
<td>3. To view a request, select it, and then click <strong>View</strong>.</td>
</tr>
<tr>
<td>Remove a related change request</td>
<td>1. Open the change request in the Change form, and then click the Related Items tab.</td>
</tr>
<tr>
<td></td>
<td>2. Select the request to unrelate, and then click <strong>Remove Relationship</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Save the change request.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This procedure removes the change request from the relationship with another change request. It does not delete any change requests.</td>
</tr>
</tbody>
</table>
Task implementer role

This section contains information about using the BMC Remedy Change Management application as a task implementer to manage and fulfill your task assignments.

Working with BMC Remedy Change Management as a task implementer

When tasks are added to a change request the change can be implemented using the tasks implementers. In the Classic view, the Change Implementer fields are hidden. Task implementers are the people or groups responsible for the tasks related to a change request. Change requests typically start in the Draft status and any related task groups or tasks are in Staged status. When the change request status is set to Scheduled, the following takes place:

- If there is a task group, the first task group in the list is activated, and its status is set to Work In Progress. The status of the first task in the task group is set to Assigned.

- If there is no task group, the first task in the list is activated and its status is set to Assigned.
The task implementers are then notified of tasks assigned to them by email, BMC Remedy Alert, or pager.

**Figure 79: Implementing tasks in a change request**

After tasks are assigned, task implementers can start work on their tasks when the change request reaches the Implement stage. They log their progress as they complete each task. When all the tasks related to a change request are either closed or cancelled, the change is set to Complete and the requester and manager are notified that the change is resolved.

The change approver requires Change User permission to access change request and task records.

For a helpful overview of the entire process, see the following items:

- Relation of task statuses to change statuses on page 262
- Using CCM tasks on page 347

**Note**

For more information about configuring and administering the Task Management System, see the *BMC Remedy Task Management System Administrator’s Guide*. 
Implement stage - Working on task assignments

Following the recommended life cycle of a change request, the status of a task should be in Scheduled before you accept the task. You cannot start working on a task until the change request reaches the Implement stage.

You receive notification of assigned tasks by BMC Remedy Alert, email, and so on. You can also use the Overview Console or the Change Management Console to view all tasks assigned to you. The table list includes a column that shows the assignee of the task. Tasks are identified by the TAS prefix. To access the Change Management Console, the task implementer must have Infrastructure Change Master, Infrastructure Change User, Infrastructure Change Submit, or (at a minimum) Infrastructure Change Viewer permissions.

**Note**
Tasks do not support functional roles; they have their own permission model. BMC Remedy Change Management maps its groups into the relevant task computed groups for access. For this reason, users with Infrastructure Change Viewer permission cannot update the task assigned to them from the parent change request. To work on a task with Infrastructure Change Viewer permission, you must also be assigned a functional role (for example, Infrastructure Change Coordinator) and you must open the task from the Change Management console.

Following the recommended lifecycle of a change request, the task must be in Scheduled status before you accept the task. For more information, see User roles in the change request lifecycle on page 36.

Receiving notification of task assignment by BMC Remedy Alert

You can receive notification of assigned tasks by BMC Remedy Alert.

**To receive notification of task assignment by BMC Remedy Alert**

1. Log in to BMC Remedy Alert. You must be a Support staff member.

   When you or your group receive a notification that you or your group have been assigned to a task, the information appears in BMC Remedy Alert.

2. To evaluate a task, select the task listed in the BMC Remedy Alert window, and then choose **Alerts => Details**.
Working on assigned tasks

When change request reaches the Implement stage you can start working on the task assigned to you. When a change request is set to Scheduled and a task is not assigned, the task status is set to Pending. If the task is assigned, its status is set to Work in Progress.

*Note*

When the change is in Planning in Progress, all the tasks have a status of Staged and a status reason of Staging In Progress. When all the tasks’ status reasons have become Staging Complete, the change moves from Planning in Progress to Scheduled For Approval.

**To work on tasks assigned to you**

1. Open the Change Management Console.

2. From the View By, select Personal.

3. Click the Show Tasks Details link in the Change Details and Tasks section to view the Task table.

4. In the Assigned Tasks table, select the task to accept, and then click View.

   Tasks are identified by the prefix of TAS.

   On the Task Management screen, you can click Open next to the Request ID field to open the parent change request.

5. If you are ready to begin working on the task - that is, if the Status Field of the change request is set to Scheduled - set the Status field to Work in Progress.

   This is an important step, because the task then moves into Work in Progress status. In addition, different escalations occur based on the task’s status. If the task is still in the Scheduled status while you are working on it, an inaccurate escalation can occur.

6. Click the Assignment tab.

7. Enter the time spent.

   When you are ready to start working on the task, you can use the start and stop clock or the effort log to keep track of how much time you spent.

8. Click the Work Info tab, and then enter the progress you have made on the task.
Optionally, you can add relevant information to the Task Plans field to describe how you intend to complete the task.

9 Click Save.

If this is the first task to be moved to Work in Progress status, the following changes are automatically made to the change request:

- The entire change request’s status is also moved to Implementation in Progress. This includes all tasks included in the change request. The change manager is notified of the changed status, and the requester is notified when the status of the change is set to Scheduled.

- In the Task Dates region of the Change form, the Start Date field is filled with the date and time at which the task was saved.

For additional responsibilities (for example, closing a task), see Performing additional task functions on page 345.

## Performing additional task functions

In addition to accepting assigned tasks, you can perform the functions listed in the following table.

**Table 40: Additional task functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reassign a task</td>
<td>1  To view a list of tasks, click the Show Tasks Details link.</td>
</tr>
<tr>
<td></td>
<td>2  In the Assigned Tasks table on the Change Management Console, select the task to reassign, and then click View.</td>
</tr>
<tr>
<td></td>
<td>3  On the Assignment tab, choose the group or person to assign the task to in the Assignee Group or Assignee fields.</td>
</tr>
<tr>
<td></td>
<td>4  Make sure the Notify Assignee field is set to Yes, and then click Save. Until the new implementer accepts the task assignment, you are assigned to the task and have responsibility for it.</td>
</tr>
<tr>
<td>Function</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View assigned tasks assigned to you</td>
<td>1 On the Open the Change Management Console, select Personal from View By.</td>
</tr>
<tr>
<td></td>
<td>2 To view a list of tasks, click the <strong>Show Tasks Details</strong> link.</td>
</tr>
<tr>
<td></td>
<td>3 To view the details of a task, select it, and then click <strong>View</strong>.</td>
</tr>
<tr>
<td>View assigned tasks assigned to your group</td>
<td>1 On the Open the Change Management Console, select <strong>View By =&gt; Selected Groups</strong>.</td>
</tr>
<tr>
<td></td>
<td>2 On the My Group Selection dialog box, select the option under View Group, and then click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>3 To view a list of tasks, click the <strong>Show Tasks Details</strong> link. The open tasks assigned to your group appear in the Assigned Tasks table.</td>
</tr>
<tr>
<td></td>
<td>4 To view the details of a task, select it, and then click <strong>View</strong>.</td>
</tr>
<tr>
<td>Modify a task</td>
<td>1 To view a list of tasks, click the <strong>Show Tasks Details</strong> link.</td>
</tr>
<tr>
<td></td>
<td>2 In the Assigned Tasks table on the Change Management Console, select the task to modify, and then click <strong>View</strong>.</td>
</tr>
<tr>
<td></td>
<td>3 On the Task Management form, update the fields.</td>
</tr>
<tr>
<td></td>
<td>4 Click the Work Info tab.</td>
</tr>
<tr>
<td></td>
<td>5 Define a work info history entry for the task, and then click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Function</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Close a task             | 1. To view a list of tasks, click the **Show Tasks Details** link.  
2. In the Assigned Tasks table on the Change Management Console, select the task to close, and then click **View**.  
3. Click the Assignment tab, and then update the time you spent on the task.  
4. Click the Work Info tab, and then define an entry in the Work Info History field.  
5. At the top of the Task form, set the Status field to Closed.  
6. Select a status reason to describe how the task was closed, and then click **Save**.  
   **Note:** After a task is closed, it cannot be reopened.                                                                                       |
| Add financial information to a task. | 1. To view a list of tasks, click the **Show Tasks Details** link.  
2. In the Assigned Tasks table on the Change Management Console, select a task, and then click **View**.  
3. Click the Financials tab, and then enter the budgeted estimated total time in hours.  
4. When you finish the task, enter the actual total time.  
5. Enter your calculation unit type, for example, flat rate.  
6. Save the change request. All this information is calculated and rolled up into the change request.  
When you are assigned a task, you can contribute financial information for the task. However, you can only calculate charges for the change inside the change request.  |

**Using CCM tasks**

BMC Remedy Change Management comes installed with the predefined task and task group templates that you can use as shipped for deploying or installing software and verifying task completion. This section describes how you can launch Configuration Change Management (CCM) tasks at run time from a change request.
For more information, see Best practice CCM task templates and templates on page 353.

Figure 80: Using tasks inside a parent object (Best Practice view)

Figure 81: Using tasks inside a parent object (Classic view)
To use CCM tasks to install software and verify compliance

1 Open BMC Remedy Change Management and then create a change request.

   Although you can add tasks or task groups to a change during any status, they can only be worked on during the Implement status.

2 Use the process flow accelerators to advance through the states of your change request until you reach the Implement status.

3 Click the Tasks tab.

4 From the Request Type list, select Task Group Template, and then click Relate.

5 In the Select Template dialog box, select a task group, for example, Automatic Verification and then click Relate.

   This example task group comes for use as shipped for deploying software and verifying task completion. The task group is then added to the change request.

6 (optional) Click View Flow to see a read-only view of the task flow in the task group.

   Figure 82: Task Flow Viewer

   The Task Flow Viewer uses color codes to illustrate the different stages of the tasks. For example, a blue stage indicates that its status is Closed, and a yellow stage shows its status is Staged. The Viewer also shows you the flow between tasks.
You can also perform the following functions in the Task Flow Viewer.

- Zoom in to focus the view.
- Zoom out to expand the view
- Click the pan buttons to move the flow around.

7 Select the task to work on, and then click View.

8 On the Tasks form, click the Relationships tab.

9 Search for a Software Library Item.
   
   On the Software Library Item Search dialog box, the SLI is the software that is being deployed. The SLI contains the location of the software. The SLI location can be either a physical repository (Fred’s top drawer) or electronic (a folder on your network).

10 Perform a search for an SLI and then click Relate.

11 On the Relationship Attributes dialog box, define the relationship attribute, for example, SOURCE.

12 Define the action attribute, for example, INSTALL, and then click Apply.
   
   The SLI is added to the change request.

13 Search for a Configuration Item.
   
   On the CI Relationships Search dialog box, CIs are the systems where the software is deployed.

14 Search for a CI, and then click Relate.

15 Define the relationship attribute, for example, TARGET.

16 Define the action attribute, for example, INSTALL.

17 Click Apply.
   
   The CI is added to the change request.
When the SLI and the CI are related to the task, the relationships are carried over to the change. If a task implementer wants to select SLIs or CIs related to the change, use the Get Related Relationships quick action on the Relationships tab on the Task form. A similar quick action on the Task tab of the Change form to enable the change to relate SLIs or CIs to a task related to the change entry.

18 Click the General tab, and then click **Launch**.

**Figure 83: Policy Manager**

If you have deployed the integrated CCM solution with seamless authentication, the task implementer can launch the task from BMC Remedy Change Management or BMC Configuration Automation for Clients without having to retype your user ID and password.

19 After you have performed the policy changes in the Policy Manager tool, click **Save**.

20 Close the Policy Manager window to return to the Task form.

21 *(optional)* Review the Work Info about the task.

The work information for the task is updated with the changes performed by the task.
a Click the Work Info tab.

b In the Work Info History area, select the Policy Manager entry and then click View.

c After you view the information, close the Work Info dialog box.

d Click Report to view an ASCII-format report of the task changes.

   The report lists the software installed, if the policy was successful, and so on.

22 In the Status field, set the task status to Closed.

   The status reason automatically is set to Success. You can select a different status reason, for example, Failed or Cancelled.

23 After you have made all your modifications, save and close the task.

24 On the Change form, refresh the children of the task group table.

   The status of the first task is marked as Closed and the status of the second task is now Waiting.

25 Open the second task:

   a Select the Check Compliance task and then click View.

   b On the Task form, click Details to view the target and package compliance.

   c Verify the compliance in Policy Manager.

   d Close the Viewer to return to the Task form.

26 In the Status field, set the task status to Closed.

   You can view the work information for the task as needed. The task record is updated with the changes performed by the task.

27 After you have made all your modifications, save and close the task.

28 In the Change form, refresh the children of the task group and the task and task groups tables.

   All tasks and the task group are marked as Closed.

29 Click Save.
Best practice CCM task templates and templates

BMC Remedy Change Management ships with the following predefined best practice” task group and task templates that you can use for installing or deploying software and verifying task completion. These templates were specially created for the integration with BMC Configuration Automation for Clients (previously known as BMC Configuration Management).

**Best practice**

### Table 41: CMM task templates and templates

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create and Modify Policy with Closed Loop Verification | Task group that includes the following tasks:  
  - Create and Modify Policy  
  - Closed Loop Verification (automatically)  
  You use this task group template when creating or modifying a BMC CM based policy. This template automatically performs a closed-loop verification to make sure that the task was executed properly. |
| Closed Loop Verification (automatic)          | Automatic task that calls BMC Configuration Management Policy Manager to set up compliance parameters for Closed Loop Verification. It verifies the task automatically against compliance status.                                   |
| Create and Modify Policy                      | Manual task that defines or modifies a policy using Policy Manager. It uses the Relationships feature to add the CI and SLI to the task.                                                                     |
| Deploy Package                                | Manual task that deploys a package using BMC Configuration Management Deployment Manager. It adds the CI and SLI using the Relationships feature on task. Verification of a Deployment Manager task is based on the exit status of the Deployment Manager job. |
| Execute Remote Command                        | Manual task that executes a remote command using BMC Configuration Management Deployment Manager. Verification of a Deployment Manager task is based on the exit status of the Deployment Manager job. |
| Execute Remote Script                         | Manual task that executes a remote script using BMC Configuration Management Deployment Manager. Use the Task Attachments table to define the remote scripts. Verification of a Deployment Manager task is based on the exit status of the Deployment Manager job. |
| Verify Target Status                          | Manual task for manually verifying the status of a target against BMC Configuration Management. Use this task to verify that a specified target is in compliance with the policies to which the target has been assigned. |
Change Management approver role

This section describes the Change Management approver role. The approver uses the approval feature to review, approve, or reject change requests, and to ask for more information about them.

Working with BMC Remedy Change Management as an approver

BMC Remedy Change Management integrates fully with the BMC Remedy Approval Server for business, technical, and financial approvals.

An approver must:

■ Be defined in the ITSM Foundational People form

■ Be assigned an appropriate application permissions. For example, Infrastructure Change Viewer is sufficient for a user who only needs to approve a request through the Approval Central.

■ Have a BMC Remedy Action Request System Read license.

■ Have the functional role of Infrastructure Change Approver

Additionally, the server must have the appropriate BMC Remedy ITSM application license.

Note

The BMC Remedy Change Management application ships with defined approval processes. Most companies should not have to define additional approval processes. However, you can use the Approval Process Configuration form to define additional approval processes for your company. For more information, see Approval processes provided out-of-the-box on page 357.
In BMC Remedy Change Management, application administrators can define an approval process in which a series of people must review and approve a proposed change request or release request. Only after all approvals are granted can the change request or release request be moved to the next status.

A change request goes through several phases as it progresses through its lifecycle. Approvers are responsible for reviewing their assigned change requests, and for approving or rejecting them. Approvers are configured by the application administrator and are responsible for change requests with a specific categorization and location. The application administrator also determines which types of change requests need approval, and what type of approval process they require.

As the change request moves from one status to another, the default workflow on the change request queries the approval server to find out which approval process to use, and then executes it. For example, when a change request moves from the Draft status into the Review phase (shown in Figure 84 on page 356), the Approval Server checks the Review approval process. If the application administrator mapped an approver to the Review process, the change request must be approved before it moves to the next stage. Also, the Class and Timing Reason fields are locked by workflow. You cannot make modifications to the values set in these fields until the change request is approved and it moves to the next status in its lifecycle.

The Approve option is enabled in the Process Flow bar when a change request is sent for Approval.

Figure 84: Change request going through Review Approval in the Review & Authorize stage

The Approve option enabled in the Process Flow bar when a change request is sent for Approval.

Figure 85: Approval option enabled
When the user clicks the approve option the change request is approved and it moves to the next status in its lifecycle. In case of an auto-approval (no approver is assigned), the change form is refreshed to show the updated Change status after approval.

Note

The Approve option is displayed to all users, even if the user is not an approver for that change request. If a user, who not an approver for that change request clicks the approve option the following error message is displayed: You are not currently defined as an alternate for any user and you are not on the Approvers list for this approval. (ARERR 45802).

The change manager or change coordinator controls the overall progression of a change request, and can perform approvals at several points in the change life cycle. For change requests in the Request for Change status with no approvers, the change manager and the change coordinator can move the change forward to Planning In Progress, cancel it, or send it back to the requester by assigning it a status of Draft.

After a change is planned and built, the change request is set to a status of Scheduled for Review. Once again, the change manager or change coordinator has the opportunity to review change plans, schedules, and so on, before moving the change to the Implementation Approval phase.

The following people perform the approval process:

<table>
<thead>
<tr>
<th>Approver</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application administrator</td>
<td>Selects the approval process, and if necessary, modifies the approval rules. Configures the approval mappings. For more information, see the BMC Remedy IT Service Management Configuration Guide.</td>
</tr>
<tr>
<td>Change manager (or change coordinator)</td>
<td>Monitors the approval process to make sure that it proceeds as expected. The change manager also determines which types of change requests need approval, and in some cases, selects the approvers.</td>
</tr>
<tr>
<td>Change approvers</td>
<td>Review the change request and approve or reject it. If approvers need more information about a change request, they can request it. Their signature is put on hold while they are waiting for the information and the status is set to More Information.</td>
</tr>
<tr>
<td>Requester</td>
<td>Checks the status of the change request and follows the approval process throughout its cycle.</td>
</tr>
</tbody>
</table>

Approval processes provided out-of-the-box

BMC Remedy Change Management ships with default approval processes designed out-of-the-box for global use. These best practice approval processes are already
defined for you by default. These processes specify which status occurs next if a request is approved or rejected, or if no approvers are defined.

### Table 42: Preconfigured approval processes for BMC Remedy Change Management

<table>
<thead>
<tr>
<th>Approval Process (phase)</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review</td>
<td>In the Initiate stage, the out-of-the-box behavior for change requests is that when their Status moves out of Draft status into Request For Authorization status, the Review approval phase starts.</td>
</tr>
<tr>
<td></td>
<td>■ If the change request is approved, the request moves to the Business Approval phase and its Status becomes Request For Change.</td>
</tr>
<tr>
<td></td>
<td>■ If the change request is rejected, its Status changes to Rejected.</td>
</tr>
<tr>
<td></td>
<td>■ If there are no approvers defined for the request (that is, if no approvers are mapped to the Review approval phase), its Status changes to Request For Change and requires the change manager or the change coordinator to move the request forward.</td>
</tr>
<tr>
<td></td>
<td>■ If the Class of the change is Latent, it moves to the Completed status.</td>
</tr>
<tr>
<td>Business Approval - No Impact</td>
<td>The Change Ad Hoc approval process is used in the No Impact Business Approval phase with the Change Manager login as the first approver. By default, this Ad Hoc approval process applies only to changes with a Class setting of No Impact. No approver mapping is required to be configured for this phase.</td>
</tr>
<tr>
<td></td>
<td>When the change moves through the process flow and Change Manager approves the change in the Business Approval - No Impact phase, it then moves to the Scheduled status. You use this process for pre-approved No Impact changes where the change is automatically scheduled after the approval phase is satisfied.</td>
</tr>
<tr>
<td></td>
<td>■ If the change is approved, it moves to the Scheduled status.</td>
</tr>
<tr>
<td></td>
<td>■ If the request is cancelled, it moves to the Cancelled status.</td>
</tr>
<tr>
<td></td>
<td>■ If the request is rejected, its status changes to Rejected.</td>
</tr>
<tr>
<td>Approval Process (phase)</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Business Approval</strong></td>
<td>The Review &amp; Authorize stage focuses on risk assessment and impact analysis. The Business Approval Phase starts when the change request is placed in Request for Change status. The Business Approval phase requires that the business case for the change be approved before it can move forward.</td>
</tr>
<tr>
<td></td>
<td>■ If the change is approved, it moves to the Planning in Progress status.</td>
</tr>
<tr>
<td></td>
<td>■ If no approvers are mapped to the Business Approval phase, the change moves to the Planning in Progress status and requires the change manager or change coordinator to move the change forward.</td>
</tr>
<tr>
<td></td>
<td>■ If the request is cancelled, it moves to the Cancelled status.</td>
</tr>
<tr>
<td><strong>Implementation Approval</strong></td>
<td>In the Plan &amp; Schedule stage, the out-of-the-box behavior for change requests is that the Implementation Approval phase starts when their Status moves into Scheduled For Approval status. At this phase, the system notifies you that the change must be approved before it can be implemented.</td>
</tr>
<tr>
<td></td>
<td>■ If the change request is approved, its Status becomes Scheduled.</td>
</tr>
<tr>
<td></td>
<td>■ If there are no approvers defined for the change (that is, if no approvers are mapped to the Implementation approval phase), its Status changes to Scheduled.</td>
</tr>
<tr>
<td></td>
<td>■ If the change request is rejected, its Status changes to Rejected.</td>
</tr>
<tr>
<td><strong>Close Down Approval</strong></td>
<td>In the Implement stage, the out-of-the-box behavior for change requests is that the Close Down approval phase starts when their Status moves into Completed status (with a status reason of Final Review Required). At this phase, the system notifies you that the request must be approved before it can be closed down.</td>
</tr>
<tr>
<td></td>
<td>■ If the change request is approved, its Status Reason becomes Final Review Complete. You can then move the request to the Closed stage.</td>
</tr>
<tr>
<td></td>
<td>■ If the change request is rejected, its Status changes to Rejected.</td>
</tr>
<tr>
<td></td>
<td>■ If there are no approvers defined for the change (that is, if no approvers are mapped to the Close Down approval phase), its Status is Completed. You can then move the request to the Closed stage.</td>
</tr>
<tr>
<td></td>
<td>■ Approval Administrators can globally approve or reject the change request. This may be required if approvers are not available or the CAB makes a decision the requires an urgent approval or rejection of a change request. If the change is globally approved or rejected, the approval status is changed to Closed.</td>
</tr>
</tbody>
</table>
The read-only Next or Current Approval Phase field displays what approval phase the change is in during its life cycle. The Approvers tab also displays the following important information:

- Approval status
- Signatures of groups and individuals who must approve the change request
- Alternate approvers

Approvals can be generated automatically, based on information captured on the change request. They can also be generated manually on an ad hoc basis.

**Figure 86: Change form—Approvers tab**

If needed, the application administrator can configure the change request approval workflow according to your organization’s business model. This determines which change requests require approval and what kind of approval process they undergo.

Release Management also is installed with default approval processes designed out-of-the-box for global use.
### Table 43: Preconfigured approval processes for Release Management

<table>
<thead>
<tr>
<th>Approval Process (phase)</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Initiate                 | The Initiate phase starts when the release request is placed in Initiation Approval status.  
  ■ If the release request is approved, the request moves to the Registered status.  
  ■ If the release request is rejected, its Status changes to Rejected.  
  ■ If there are no approvers defined for the request (that is, if no approvers are mapped to the Initiate approval phase), its Status changes to Registered and requires the release coordinator to move the request forward. |
| Planning                 | The Planning phase starts when the release request is placed in Planning Approval status.  
  ■ If the release request is approved, it moves to the In Progress status.  
  ■ If no approvers are mapped to the Planning phase, the release request moves to the In Progress status and requires the release coordinator to move the request forward.  
  ■ If the request is rejected, it moves to the Rejected status. |
| Build                    | The Build phase starts when the release request is placed in Build Approval status.  
  ■ If the release request is approved, it moves to the In Progress status.  
  ■ If no approvers are mapped to the Build phase, the release request moves to the In Progress status and requires the release coordinator to move the request forward.  
  ■ If the request is rejected, it moves to the Rejected status. |
| Test                     | The Test phase starts when the release request is placed in Test Approval status.  
  ■ If the release request is approved, it moves to the In Progress status.  
  ■ If no approvers are mapped to the Test phase, the release request moves to the In Progress status and requires the release coordinator to move the request forward.  
  ■ If the request is rejected, it moves to the Rejected status. |
<table>
<thead>
<tr>
<th>Approval Process (phase)</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Deployment              | The Deployment phase starts when the release request is placed in Deployment Approval status.  
- If the release request is approved, it moves to the In Progress status.  
- If no approvers are mapped to the Deployment phase, the release request moves to the In Progress status and requires the release coordinator to move the request forward.  
- If the request is rejected, it moves to the Rejected status. |
| Close Down              | The Close Down phase starts when the release request is placed in Close Down Approval status.  
- If the release request is approved, it moves to the Completed status.  
- If no approvers are mapped to the Close Down phase, the release request moves to the Completed status.  
- If the request is rejected, it moves to the Rejected status. |

**Note**
You can view the included approval phases on the Status Flow tab of the Approval Process Configuration form. For information about configuring approvals as an administrator for BMC Remedy Change Management, see the BMC Remedy IT Service Management Configuration Guide. For information about working with the BMC Remedy Approval Server as an administrator, see the BMC Remedy Approval Server Guide.

---

### Approving changes using Approval Central

You can use BMC AR System Approval Central to approve change requests. This is especially important if the Approve functionality in the Process Flow Status bar is not available under your current access permission for the change request. Not all approvers have access to the BMC Remedy Change Management application through their home pages, yet still have the role to approve change requests before they can move forward.

**Note**
To access approvals using the Process Flow Status bar you must have appropriate permissions to modify a change request. For more information on roles and permissions, see the BMC IT Service Management Configuration Guide.
To approve changes using Approval Central

1. Log in to the AR System server as the approver in BMC Remedy User or browser.

2. Open Approval Central.

   **Figure 87: Using Approval Central to approve change requests**

   Approval Central displays all pending change requests that are assigned to you. If there are many requests, you can filter them by using the fields in the Search Criteria area.

   **Note**
   
   Click the Source ID to view details of the change request.

3. Approve, reject, hold, reassign, or view the change request.

   After you approve the change request, it no longer is displayed in the Approval Requests table.

   **Note**
   
   If approvers need more information about a change request, they can view the request details and add a question in the approval activity log. Their signature is on hold while they are waiting for the information and the status is set to More Information.
Multiple approvers and multiple approval levels

There can be more than one level of approval, and there can be several approvers on each level. At least one approver on each level must approve the change request before it can be reviewed by the next level of approvers. Approvers can review the actions of previous approvers by viewing their comments and the approval audit trail. Release Management module also

Note

- This information is also applicable for the Release Management module.
- You can configure the approval process to have one or all approvers on each level approve the change request before the change can be reviewed by the next level of approvers. Modify the If Multiple Approvers setting to configure this option. For information about modifying the If Multiple Approvers setting, see the BMC Remedy ITSM Configuration Guide.

The application administrator can also configure the change management chain (parent-child) approval process. If the change is configured for the management chain approval process, the requester’s manager is notified.

If the change is approved by all approvers, the approval process is complete and the change moves to the next status. If the change is rejected by any approver, the change is stopped. The change manager or change coordinator can then cancel the change or update it and resubmit it for approval.

Approving the change request can complete the approval or trigger the next step in the approval process. If there are several levels of approvers, your approval can send the approval request to the next approver or if you deny the request the approval process is completed, regardless of whether more approvers are defined. An approval signature cannot be modified after the request has been rejected, and the approval process is finished. If the change request is to be implemented, the change manager must first restart the approval process.

Approving changes using the Process Flow Status bar

When a change request reaches an approval phase, the Process Flow Status bar prompts you to approve, cancel, or reject the approval. You must have appropriate permissions to modify a change request to access approvals using the Process Flow Status bar. For more information on roles and permissions, see the BMC IT Service Management Configuration Guide.
To approve the change request, the required approvers must click the accelerator, and then approve, cancel, or reject the change request before it can then move to the next status. For more information, see Approval processes provided out-of-the-box on page 357.

You cannot move the change request to the next status unless you first receive an approval. The change remains in the approval phase and will not move to the stage until it is approved.

When a change requires an approval, its approvers are notified. Notifications are sent according to the method specified in the approver’s record in the People form.

If you need more information about a change request, approvers can request that information.

To use the Process Flow Status bar to approve change requests

1. Open the change request.

2. Use the Process Flow Status bar to move the change request to an approval phase.

3. Click the accelerator in the Process Flow Status bar, and then approve, cancel, or reject the change request.

   **Note**
   As a change manager or a change coordinator, you can perform these actions for Normal requests if you are the approver, or if you are an alternate approver.

4. Click the Approvers tab to view the current approval status or any other approval signatures required to approve the change request.
From the Approvers tab, the following options in the Show menu enable you to filter the approval signature entries on the table, for example, Hold or Approved. No action is taken without refreshing the table contents.

5 Save your work.

- If the change is configured for the change level approval process, all approvers on the first level are notified that they must review the request.

- If the change is configured for the change management chain (parent-child) approval process, the requester’s manager is notified.

The signature of the last approver completes the approval process, and automatically moves the change request to the next status.

### Handling approvals for emergency change requests

Depending on how the application administrator has configured the application, change requests that have been designated as emergencies can be allowed to bypass the approval process even if they normally require approval. In this scenario, the emergency change request is not held up waiting for approvals.

For more information, see Creating emergency change requests on page 133.

These are possible configurations:

- The application administrator can configure emergency change requests to bypass the normal change states and approval process. To configure a new approval process for emergency changes, the application administrator must create a new approval process for your company. As a result, when a change manager or change coordinator creates a change and selects Emergency in the Timing field, the new approval process phase is then used. For more information, see the BMC Remedy IT Service Management Configuration Guide.

- The change manager or the change coordinator can choose to add approvers to the process. The Approval Status field is set to Approval Required.
  - If the change manager assigns approvers, the approval process proceeds as usual.
  - If the change manager does not assign approvers, the Approval Status is set to Approved, and the change request can be implemented.

- If the change request is designated as an emergency and your organization uses the Change Management Chain approval process, the manager of the Requested
For user (in the Requester tab) is the first approver in the management chain. If the Requested For fields are empty, the emergency approval process is bypassed. Change managers can add more approvers if appropriate. They cannot delete approvers.

Resubmitting a rejected change request

If an approver rejects a proposed change request, the approval process is stopped. The Approval Status is set to Rejected. You can resubmit the request for approval.

To resubmit a rejected change request

1. Open the change request.

2. Click the accelerator in the Process Flow Status area and then select Restart. The change request returns to the approval process phase it was in when it was rejected, for example, Review.

   **Note**
   
   When an approver rejects a request, all signature lines associated with the request are closed. If this request is restarted, any ad hoc approver assigned to the request will have to be added again.

3. Do one of the following:

   **When using the Best Practice view** | **When using the Classic view**
   --- | ---
   Click the Work Details tab and explain in the Notes field why you are resubmitting the request for approval. | Click the Work Info tab and explain in the Details field why you are resubmitting the request for approval.

4. Save your changes.

Adding approvers

You can create additional approvers on an ad hoc basis. The following rules apply:

- You can add Support Groups or Individuals as approvers.
- Group approval requests are sent only to group members with the Infrastructure Change Approver role.
If an individual approver is needed, only people defined within the People form can be chosen as approvers.

**Note**
The ability to add someone as an approver is restricted, based on the permissions of the user adding an approver. If the person adding signatures cannot see the person based on row-level access, they cannot add them as an approver. But anyone with a record in the People form can become an approver if the assigner has access to that information.

There are slight differences between ad hoc approvals and the typical approval processes configured by the application administrator.

- If you add an ad hoc approver (Bob Baxter) and an approver mapping does not exist, the approval server immediately generates an approval signature for the ad hoc approver and Bob is notified that he must approve the change request. The change request cannot move past the next approval phase until Bob (the ad hoc approver) approves the request.

- If you add an ad hoc approver (Bob Baxter) at the Draft status and an approver mapping already exists (Mary Mann for the Review phase), the approval server immediately generates an approval signature for the ad hoc approver and Bob is notified that he must approve the change request. The change request cannot move past the next approval phase until both Bob (the ad hoc approver) and Mary (the mapped approver) approve the request.

- If the request is already at the Review phase and you add an ad hoc approver where an approver mapping already exists (Mary Mann), the approval server generates two approval signatures—one for Bob (the ad hoc approver) and one for Mary (the mapped approver). Also, Bob is notified that he must approve the change request. The change request cannot move past the next approval phase until both Bob (the ad hoc approver) and Mary (the mapped approver) approve the request.

For more information about the relationship between approver mappings and approval process configuration records, see the *BMC Remedy IT Service Management Configuration Guide*.

**Adding additional approvers**

This section describes the procedure to create additional approvers on an ad hoc basis for a change request.

**To add approvers**

1. Open the change request.
2 Advance through the states of your change request until you reach an approval stage.

3 Click the Approvers tab.

The Approvers table shows the list of approvers generated for the change request. Their signature is required for approval. You might need to refresh the table to see the lists. The list contains the following information:

- Approval Status — Indicates status of work on the change.
- Approvers — Indicates the names of the approvers.
- Name — Indicates either the individual’s full name or the support group name.
- Alternate Signature — Appears when someone other than the original signature owner has approved or rejected the change.

4 Click Add.

5 On the Add Approver dialog box, select an individual, or a group to add.

6 Enter the name of one or more individuals or groups.

7 (optional) To search for an individual, enter a name or initial in the Full Name+ field, and press ENTER.

8 Click Save.

You might have to refresh the table field to see all approvers.

9 Click Save.

The approver is notified that they must review the change request.

**Adding alternate approvers**

Sometimes an approver might be unavailable because of a scheduled vacation or business event. For that period of time, the approver should designate an alternate approver because change requests still require approval.

From the People form, you can set up one or more people to approve change requests that are pending your approval, for example, to add the change manager or change coordinator as an alternate approver.
**Note**
You can only configure alternate approvers for yourself.

**To add alternate approvers for people**

1. Open the People form.
2. Search for yourself.
3. Select your record, then click the Alternate Approvers tab.
4. Click **Update Alternate Approvers**.
   The Alternate Approvers form appears.
5. To locate the alternate approver, click **Search**.
6. In the People Search form, select the alternate approver, then click **Select**.
7. Select the start date and the end date.
8. In the Notify Alternate field, select whether to notify the alternate approver.
9. In the Covering field, select whether this will be an alternate for all approvals or only for a specific process.
10. If you selected Specific Process in the Covering field, select the applicable process in the Process field.
11. Click **Add**.

**Acting as an alternate approver**

If you are acting as an alternate approver of a change request, you have the same signature authority as the approver for whom you are serving. Your authority as an alternate approver exists for a specific time period, and for the designated approval process or processes.

**To act as an alternate approver**

1. Open the Approval Console.
2 From the Action Menu, click **Search My Approvals**.

*Figure 89: Entering information to act as an alternate approver*

<table>
<thead>
<tr>
<th>Approval Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Acting As</td>
</tr>
<tr>
<td>User</td>
</tr>
</tbody>
</table>

3 In the Acting As field, select Alternate.

4 In the User field, type the name of the user for whom you are acting as the alternate.

   You must enter that user’s exact AR System login name.

5 Select the approval process.

6 Verify that the Approval Status field is set to Pending.

7 Click **Search**.

   The Approval Requests table is populated with the pending requests for the user for whom you are acting as alternate, instead of your own pending requests.

**Viewing and remove non-approver notifications**

You can view or remove notifications for non-approver associated with a change.

**To view notifications**

1 Open the change request.

2 Advance through the states of your change request until you reach an approval stage.

3 Click the Approvers tab.

4 Click **View Notifications**.
The Non-Approver Notifications dialog box appears.

Figure 90: Non-Approver Notifications dialog box

5 To delete a non-approver notification:

a In the Status field, select Pending (default) or Notified.

Figure 90 on page 372 shows that a notification has been sent to a user about an approval for the Business Approval phase of a change request.

b Select the notification to remove and click Delete.

A warning appears, verifying that you want to delete the selected notification.

c Click Yes to delete the selected notification.

The notification is removed from the table.

6 Close the Non-Approver Notifications dialog box when you are finished.

Adding non-approval notifications

The change manager can notify additional individuals or groups that are not approvers about the approval. These notifications are non-approval notifications.
To add non-approver notifications

1. Open the change request.

2. Advance through the states of your change request until you reach an approval stage.

3. Click the Approvers tab.

4. Click View Notifications.

The Non-Approver Notifications dialog box appears. You can select the type of notification you want to add. The options are:

- Individual

- Group

5. To add an individual:

   a. Select Individual in the Notification For field.

   Figure 91: Adding an individual notification

   b. Enter the individual’s first or last name.

   You can enter a last name (or partial last name) and then press RETURN to bring up the People Search form.
c Click Add to create the notification.

The individual’s name, approval phase for the notification, and its status appears in the table.

6 To add a group:

a Select Group in the Notification For field.

Figure 92: Adding a group notification

b Specify the support company, organization, and group name.

c Click Add to create the notification.

The group name, approval phase, and its status (for example, Pending) appears in the table.

7 Use the Status field to toggle between viewing Pending and Notified notifications.

8 Delete the notifications, if needed.

9 Close the Non-Approver Notifications dialog box when you are finished.
Activity assignee role

This section describes how activity assignees can use the Release Management application and the Activity form to work on activity actions.

Working with activities as an activity assignee

Release Management provides the capability to assign specific units of work known as activities. When work in a release must be tracked in a lifecycle with specific status transitions, but does not require the complexity of a change request (for example, approvals), you can use an activity instead. For example, a new payroll application requires that your user base receives proper documentation and training. Since this requirement is not a change request that needs to be completed by the Change Management team, the release coordinator creates it as an Activity using the Activity form, and then assigns it to an activity assignee.

Note
Activities do not typically involve changes to the IT infrastructure.

The activity assignee is typically a member of the support staff and is responsible for planning the activity, for example, adding scheduled start and end dates; adding work information to the activity, for example, attaching a training schedule; creating and assigning tasks, for example, the Payroll staff to create training materials, the HR staff to train the users; and adding financial information, for example, budgeted and actual costs. For more information, see Activities on page 376.

The activity assignee requires the following User permissions:

- Release User permission grants general access to the Release Management Console. You can open, query, submit and modify release requests. Release Viewer permission grants access to the Release Management, but you can only open and query release requests.

- Activity User permission grants general access to the Activity form. The activity assignee will be permitted to query and modify activity requests.
Using the Release Management Console

The Release Management Console provides a dedicated workspace for managing release requests. This console is designed for release coordinators who deal with Release Management daily and do not want to view other BMC Remedy ITSM applications. It provides quick access to the information you need and to the procedures that you perform most often.

Various functions are available in the navigation pane of the Release Management Console. They provide you with quick ways to go to different areas in Release Management and to perform other functions.

For more information, see Release Management Console functional areas on page 99.

Activities

The Release Management module provides the capability of creating and assigning specific units of work called activities. Activities have their own lifecycle with a series of status transitions, for example, Assigned, In Progress, and so on. You can also establish a sequence of tasks in your activities. Activities are useful when you need to create a structured sequence of tasks that you must complete to fulfill the release, but these tasks should not be classified as a change request.

For example, you must release a new version of the Calbro payroll application. One of the work items that must be completed in the release cycle is training users on the new payroll application. Because training is not a change request that the Change Management team would complete, you decide instead that training should be an activity that is assigned, tracked, and completed using the Activity form.
The following sections provide detailed procedures on working with activities and related tasks in the Activity form.

Figure 93: Activity form

You use the Activity form to add a set of activities to a release request. You can track release states and requester information, relate and assign tasks, and enter work log information. For more information, see Activity form functional areas on page 109.

Working on activities

This section describes the procedure to start working on activities defined for a release.

To work on activities

1. Log in to the Release Management console.
2. Select the activity from the Change Requests and Activities table.
3. Click View.

   On the activity form, enter information in each of the tabs described in the following steps to move the activity forward.

4. Click the Assignment tab to review the assignment.
If necessary, you can reassign the activity. For more information, see Accepting activity assignments on page 379.

5 Click the Work Info tab to enter work information about the activity.

You can track the activity’s progress by recording the steps you took to implement it in the work history or attach a detailed Training Plan. For more information, see Entering work information on page 381.

6 Click the Tasks tab to add tasks to the activity.

Tasks allow you to provide more granularity to the Activity if needed. You can assign specific tasks to specific task implementers. For example, if there are multiple people that need to train users in multiple locations, you can want to assign work to them using tasks.

You can create activities with related tasks at each release milestone. Tasks have their own independent lifecycle and continue on their own path. You might decide to complete the training materials tasks during the Planning milestone, but complete training tasks during Deployment.

For more information, see Creating activity task groups and tasks on page 383.

7 Click the Financials tab to add budget and actual costs of the activity.

As you work the activities, you can add the costs associated to each activity in each activity record that is part of the Release Request. The release activity can be in any status except Closed or Completed. For more information, see Planning financial information for activities on page 385.

8 Click the Dates tab to add start and end dates.

When you start working on an activity, you should enter the Scheduled Start Date and Scheduled End Date. For more information, see Planning dates on page 386.

9 If there is no need to update information, move the status to In Progress and save your work.

- If you need to temporarily stop work on the activity, you can move the activity to the Pending status.

- If you must cancel the activity, you can move it to the Cancelled status. This is a terminal status for the activity. All open tasks are marked as Closed.
Accepting activity assignments

One responsibility for activity assignees is accepting the activities assigned to them. If an assignment definition has not been created for the activity, you must assign the activity manually. Otherwise, the best practice is to use the assignment rules already configured for you by your Release Management administrator.

The activity assignee is then notified of activity assignments by email, pager, or BMC Remedy Alert. Assigned activities can also be listed in the Assigned Work Orders table in the Release Management Console.

Activity assignment is based on the activity’s categorization. The Assignment tab displays information about people assigned to an activity as the Request Manager. The assignee must make sure that the assignment is correct and accept the activity. If the assignment is not correct, the request manager can reassign the request.

These assignments are based on routing information stored in the Assignment Configuration form. This form assigns the groups, and then Auto Assign assigns the individual. For more information, see the BMC Remedy IT Service Management Configuration Guide.

Reviewing activity assignments

A activity must be assigned to a Support Group. However, a specific request assignee is typically responsible for the overall activity process.

To review activity assignments

1. Open the activity.
2. Click the Assignment tab.

Figure 94: Activity form—Assignment tab
Based on the default configuration and requester information in the activity, certain fields might already be filled.

3 To assign an activity assignee, make selections from the menu options.

If needed, you can click Clear to remove information from the Activity Assignee fields.

4 Enter the time spent resolving the activity.

5 Save the activity.

The request assignee are automatically notified of their assignments.

**Receiving notifications of activity assignments**

Request assignees are notified of new activities based on their notification method preferences defined in their personal record. In addition, when an activity moves into a new status, for example, Completed, the activity executes workflow that triggers notifications. Based on your group or role, you might receive notifications during various activity states. For more information about notification preferences, see the *BMC Remedy IT Service Management Configuration Guide*.

The available notifications follow:

- Individual Notification—An individual assignee is notified according to the notification method specified in their personal record.
  
  For example, if Bob Backline has a notification method of BMC Remedy Alert, he receives a notification from BMC Remedy Alert for each activity that is assigned to him.

- Group Notification—A support group is notified according to the notification method specified by each group member’s entry in their personal record.
  
  For example, if an activity is assigned to the Support-Software group, each group member is notified through the notification method specified in their personal record. If Sarah Software has Email specified as the notification method in her personal record, the notification is sent to her by email. If Bob Backline has BMC Remedy Alert specified, he is notified accordingly.

**To receive notification of activity assignment by BMC Remedy Alert**

1 Log in to BMC Remedy Alert.
When you or your group receives a notification that you or your group has been assigned to an activity, the information is displayed in the BMC Remedy Alert window.

2 To evaluate your assignment, select the activity listed in the BMC Remedy Alert window.

3 Choose Alerts => Details.

The activity is displayed in the Activity form.

Reassigning activities

If you cannot accept or resolve an assigned activity, you can reassign the activity to another assignee, or you can ask your manager to reassign the activity.

If the activity was categorized incorrectly, it can also be reassigned.

To reassign an activity yourself

1 Open the activity so that it is displayed in the Activity form.

2 In the Assignment tab, select the manager or assignee to whom you want to assign the activity.

3 Click Save.

The manager or assignee is notified of the reassigned activity.

Entering work information

You sometimes need to modify the activity with work history entries that you can create during its life cycle to document activities performed or information gathered. You use the Work Info tab to add work information regarding tasks performed on the current activity. For example, you can track an activity’s progress by recording the steps you took to implement it in the work history, or you can attach a detailed training plan as part of your overall release strategy.

As you track and supervise an activity, you move it from one status to another, for example, from Assigned to In Progress. The activity should follow the stages in the
recommended life cycle. If you have simple activities or activities that are already underway, you might see that the status is set to Pending or some other status.

**Figure 95: Activity form—Work Info tab**

You can categorize work information about the activity (for example, General Information).

## Modifying an activity

To enter work information related to an activity you must modify the activity. This section describes the procedure to modify activities to enter details of the work information.

### To modify an activity

1. On the Release Management Console, select the activity from the Change Requests and Activities table, and click View.

   The activity is displayed in the Activity form.

2. Make the appropriate changes.

3. Click the Work Info tab and take the following steps:

   a. From the Work Info Type list, select the type of work information you want to add.

   b. From the Source list, select the source of this information.

   Information sources can include, for example, email, system assignment, or the Web.
c Enter the details of your work information record in the Summary and Details fields.

d To add an attachment to the record, right-click in the attachment table and select Add from the menu that appears. With browsers, click the Add button.

e From the Locked list, select Yes or No to lock the log.

---

**WARNING**

You cannot modify the work log after you save it.

f From the View Access list, select Internal or Public.

- **Internal**—If you want only users within your organization to see the entry.
- **Public**—If you want everyone with access to the system to see the entry, including requesters.

4 When you have finished updating the activity, click **Save**.

The Save operation adds your entry to the work history. The Show field allows you to filter out specific work entries based on the type of activity displayed in the table.

5 To see a report of the activities you performed against this activity, click **Report**.

6 To display all entries for work information history, click **View**.

---

**Note**

When you return to the Release Management Console, you might need to refresh the Change Requests and Activities table to display all the modified records.

7 Save your changes.

---

**Creating activity task groups and tasks**

When you plan an activity, determine whether you can divide it into separate tasks, especially if you need to add more granularity to the activity. Tasks are the individual components of an activity, and can be assigned to specific assignees who complete the tasks.

When you add an activity, by default, the Requested By and Location information fields on the Activity form are populated with information of the user creating the activity.
Tip
When you are creating tasks for an activity, you must complete the Company, First Name and Last Name fields under Requester Information, Company fields under Location information and the Summary field on the activity form before you include the tasks.

The Tasks tab displays the tasks that are required to be performed to complete the activity. You can use task groups to manage an activity with many tasks, each having its own schedule, task assignee, and plan. For less complex activities, tasks are optional. Tasks are created and modified within the activity and are stored separately within the Tasks form. A single activity can have an unlimited number of tasks.

After a task is assigned to a support group or an individual, the assignee receives notifications to perform the various task activities when the activity reaches the Assigned status. The task dates are also displayed on the Dates tab.

Tasks, like activities, go through many status transitions as they progress. The status in which a task is created depends upon the status of the parent activity.

Your assigned tasks and task groups are listed in the Tasks and Task Groups table on the Activity form. Tasks are prefixed with TAS and task groups with TGR.

You can also view tasks and task groups related to an activity from within the Tasks tab of the Activity form.

Figure 96: Activity form—Tasks tab

Note
You can click the View Flow button to see a read-only view of the task flow in the task group. For more information about using the View Flow button, see Using CCM tasks on page 347.

Adding task groups and tasks to activities follows the same steps as change requests. For more information, see Implement stage - Working with tasks on page 260.
Planning financial information for activities

The Financials tab allow you to enter the Budget and Actual costs for the activity. These fields are optional.

To plan financial activities for activities

1. Open the activity.

2. Click the Financials tab.

   Figure 97: Activity form—Financials tab

3. In the Budget Cost area, click Add to include an estimated cost for the activity.

   This field is read-only. You typically enter this information at the Plan stage of a release.

4. In the Costs dialog box, enter the relevant information in the following required fields:
   - **Cost Center Code** — Identifies the code name for the business unit or organization within the company that is charged for servicing the activity. The default cost center is the business unit to which release coordinator belongs, but you can modify this.
     When you select the cost center code, the Company and Cost Center Name fields show the values attached to the cost center code.
   - **Cost Category** — This field is automatically filled according to the application you are working in.
   - **Related Cost** — Enter the rate. You select the Currency from the list. Your administrator sets the available currencies.
5 Save your changes in the Costs dialog box.

Click **View** to modify the budget costs. For information about using other fields on this dialog box, see **Working with costs on page 183**.

6 In the Actual Cost area, click **Add** to include the final cost for the activity.

7 Save the activity.

---

**Planning dates**

You should enter the Scheduled Start Date and Scheduled End Date for the activity. The Dates tab in the Activity form includes various fields where you can enter scheduling information, for example, the actual start date of the activity.

**To plan dates for activities**

1 Open the activity.

2 Click the Dates tab.

**Figure 98: Activity form—Dates tab**

![Activity form—Dates tab](image)

Scheduled tasks are displayed on the Dates tab.

3 In the Activity Dates area, fill in the following fields to assign the activity:

- **Scheduled Start Date**—Optionally, enter an estimated start date.

- **Scheduled End Date**—Optionally, enter an estimated end date.
You should set the Start Date and End Date to be different from the dates of the parent release.

4 Save the activity.

Closing the activity

In the final stage of the activity, the activity assignee reviews all the implemented tasks to make sure that each objective was met. An activity cannot be closed until all tasks are closed.

To close the activity

1 Open the activity.

2 Click the Dates tab, and enter the actual start date and end date.

3 Moves the activity to the Completed status.

4 After everything is verified using your company’s criteria, move the status of the activity to Closed.
Closing the activity
Supplemental Change Management tasks

This section contains descriptions of supplemental tasks that you might also perform if you work with the Overview console or the BMC Remedy Change Management application.

Setting application preferences and options

When you click **Functions => Application Preferences**, you can view and edit the settings that affect the default appearance of the main application console. Depending on which applications you have installed, you can also view their preferences and options.

When an application opens, you can determine:

- Default console view.
- Forms that appear.
- Search criteria defaults.
- What happens after you save a request.
- What appears in the Overview Console.
- The Data Set Name that is selected when the form opens.
- Statistics.

**Note**

For the changes to take effect, close the application console and reopen it. The preferences you set are applicable until they are modified.
Setting application preferences - Change Management

You can set preferences to:

- Set defaults for the consoles.
- Determine the action that occurs after you save an Change Request form.
- Determine which console appears by default when you open BMC Remedy IT Service Management.

To set application preferences for Change Management

1. From the Change Management console, click **Functions => Application Preferences**.
2. On the Application Preferences dialog box, click the Change Management tab.

The following table describes the settings available on the form.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences for</td>
<td>This is a read-only field that identifies the user.</td>
</tr>
<tr>
<td>Default Home Page</td>
<td>Select the console that you want to appear as your home page when you log into the BMC Remedy Action Request System (BMC Remedy AR System) server. For example, if you want the Change Management console to appear, select <strong>Change Management Console</strong>. The default value is IT Home Page.</td>
</tr>
<tr>
<td>Company</td>
<td>Select the company that you want to appear in the Company field of the Change Management console by default.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show</td>
<td>The default console view, with the search criteria, controls which change requests appear in the Assigned Work area. You can temporarily change this setting from the navigation pane of the console. The following list shows you the available selections:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Submitted By Me</strong> - Shows all change request that you submitted.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Assigned To Me</strong> - Displays change requests assigned to you.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Assigned To My Selected Groups</strong> - Prompts you to select any support groups to which you belong. You can select to display all change requests assigned to your group, or change requests assigned to your group that are not yet assigned to an individual.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Assigned To All My Groups</strong> - Displays change requests assigned to all your support groups. You can choose to display all change requests, or change requests that are not yet assigned to an individual.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are a new user, you must select the preference for the View Broadcast link to function correctly.</td>
</tr>
<tr>
<td>Confirm on Submit</td>
<td>Choose whether to display a confirmation message when you submit a new change record.</td>
</tr>
<tr>
<td>Console Page&gt;On Form Open</td>
<td>■ <strong>Data Set Name</strong> - Choose a personal preference data set, for example, BMC Asset. For more information about how this data set is used, see Relating CIs to alternate data sets on page 251.</td>
</tr>
<tr>
<td>Form</td>
<td>■ <strong>After New Save</strong> - This setting controls the action after you click Save on the Change form. The following list shows the available selections:</td>
</tr>
<tr>
<td></td>
<td>— <strong>New Request After Submit</strong> - Opens the Change form in New mode ready for you to record a new change.</td>
</tr>
<tr>
<td></td>
<td>— <strong>Modify Request After Submit</strong> - Leaves the Change form open and changes the mode from New to Modify.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Tab Views</strong> - You can choose whether to show the following panels:</td>
</tr>
<tr>
<td></td>
<td>— Show Approvers</td>
</tr>
<tr>
<td></td>
<td>— Show Financials                                                                <strong>Note:</strong> These preferences apply only when you are using the Classic view.</td>
</tr>
<tr>
<td>Overview Console</td>
<td>You can choose whether to show change records based on the status and user role on the Overview console.</td>
</tr>
</tbody>
</table>
3 To select task related options, on the Application Preferences dialog box click the Task Management tab.

The following table describes the settings available on the form.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Console Page</td>
<td>■ <strong>Show Task</strong> - Choose Yes to show tasks.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Task Status</strong> - Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>— All Tasks - Shows all tasks irrelevant of their status.</td>
</tr>
<tr>
<td></td>
<td>— All Open Tasks - Displays all tasks that are not in the Closed status.</td>
</tr>
<tr>
<td></td>
<td>— All Closed Tasks - Displays all tasks with the status of Closed.</td>
</tr>
</tbody>
</table>

4 Click **Save**.

**Setting the BMC Remedy Change Management view**

BMC Remedy Change Management is configured by your application administrator. For information about customizing your options to help you quickly process change requests, see *BMC Remedy ITSM Configuration Guide*. The following procedure provides information about setting the view.

**To set the view**

1 From the Applications menu, choose **Application Administrator => Application Administrator Console**.

2 From the Application Administration Console, click the Custom Configuration tab.

3 On the Custom Configuration tab, choose **Foundation => Advanced Options => View Selection Framework - Deploy View**, and then click **Open**.

4 In the navigation pane on the left side of the form, select the application name (**Remedy Change Management**) and the role (**Change Classic View User** for Classic view, **Change Best Practice View User** for Best Practice view) and **Virtualization Administrator** for the VLM view, if applicable.

5 To deploy the view to a company, perform the following steps:
a On the Company Mapping tab, select the company to which you are mapping the view.

b If necessary, change the sorting order number.

The sorting order is used when a support group or an individual belongs to more than one company. A company with a lower sort order value takes precedence over a company with a higher sort order value.

6 To deploy the view to a support group, perform the following steps:

a On the Support Group Mapping tab, select the company and organization to which the support group belongs.

b From the Support Group list, select the support group.

c If necessary, change the sorting order number.

The sorting order is used when a support group or an individual belongs to more than one company. A company with a lower sort order value takes precedence over a company with a higher sort order value.

Note
If you need to change the sort order after you save the deployment, you must first delete the deployment by using the Remove button, and then re-create the deployment with the new sort order number.

7 To deploy the view to an individual, perform the following steps:

a On the Individual Mapping tab, select the company, organization, and support group to which the individual belongs.

b From the People list, select the individual to whom you are mapping the view.

8 To save the deployment, click Add.

9 Close the form and then have the affected users log back in to the application.

Viewing your profile

You can view and modify your personal profile. When you click My Profile, the People (Search) form appears.

In this form, you can:
- Update company information such as organization, business, and home address, and so on.

- View permissions.

For detailed information about the People form, see the *BMC Remedy IT Service Management Configuration Guide*.

**To modify your profile**

1. To open your profile, from the navigation pane in the application console, choose **Functions => My Profile**.

2. On the People form, update the information at the top of the form, or click the tab corresponding to the area in which you want to change the profile information.

   Make your changes by selecting from the various lists that are available.

**Updating assignment availability**

Your assignment availability status indicates whether you are available to accept work assignments. If your status is yes, you are available. If your status is no, you are not available.

You can quickly update your status using the My Profile function.

**Note**

If you have management level permissions, you can also update the status of the people in the support group that you manage.

**To update assignment availability**

1. To open your profile, from the navigation pane in the Release Management Console, choose **Functions => My Profile**.

2. From the Assignment Availability menu, choose the status you want.

3. Click **Save**.

**Working with records**

This section discusses some of the common functions related to record handling.
**WARNING**

For the purpose of data integrity, BMC does not recommend deleting change requests. Deleting a change request does not delete the underlying related data, such as approvals, tasks, relationships, and any other dependencies.

---

**Searching all records**

The following procedure describes how to search all changes. Use this type of search when you are looking for a change that is not associated with your ID or your group’s ID, or anytime you search all changes.

**To search all records**

1. From the navigation pane in the Change Management console, choose **Functions => Search Change**.

   The Change (search) form appears that with which you can perform the search. The search form is similar to the Change form.

   It contains the same tabs and the same fields. You can use any of the tabs and fields in the form to specify your search criteria.

2. Use the tabs and fields to build your search condition.

   To reduce the number of records found by the search, enter as much information into the form as you can.

3. When you finish entering your search criteria, click **Search**.

   When the search finishes, the search results table lists all the records that match the search criteria.

4. Scroll through the table to find the specific record you want.

5. When you find the record, double-click it to open it.

**Printing records**

You can print a copy of a record to keep for filing purposes or to share with someone who does not have access to the application.
To print a record

1. Open the record you want to print.

2. Click Print at the bottom of the form to open the Business Objects Report Preview dialog box, then go to Step 3 on page 349.

   The Business Objects Report Preview dialog box appears, enabling you to view the record before you print it.

3. Click the Print icon on the menu bar at the top of the dialog box.

   When the print confirmation dialog box appears, click the Print icon to send the record to your local printer.

4. Close the Business Objects dialog box.

Modifying records

After you generate a record, you can modify or update the information it contains.

To modify a record

1. Open the record that you want to modify.

2. Click the field, tab, or link in the navigation pane that contains or takes you to the information you want to update.

3. Make the appropriate changes.

4. Click Save.

Working with requester records

When you define change and release requests, or monitor them, you frequently work with requester information. For example, you might need to search for a requester in the database. If the requester does not exist, you must define a new requester. Or, you might need to change requester information.

The People form contains all user records. You can access this form in different ways:

- Select People on the Application Administration Console.
Select My Profile on the Overview Console, the Change Management Console, or the Release Management Console. You then can see your own user record.

Click in the Last Name field, enter partial information about the individual you are looking for, and then press ENTER.

Information stored here is used to automatically fill in requester information fields on many forms. For more information, see the BMC Remedy IT Service Management Configuration Guide.

Creating a requester record

While defining a new change request, release request, or task, you might find that the requester does not have a record in the database. If this is the case, you must define a record for the requester. You can do this while you are defining the request or task.

To define a requester record

1. From the IT Home page, click Application Administration Console.
2. Select the appropriate company from the Company field.
3. Click Create next to People.
4. On the People form, complete all the required fields:
   - **First Name** — Enter the requester’s first name.
   - **Last Name** — Enter the requester’s last name.
   - **Client Type** — Select Operating Company, Customer, or Vendor.
   - **Profile Status** — Set the Status to Enabled (or other option, as needed).
   - **Client Sensitivity** — Select Standard or Sensitive.
   - **VIP** — Select Yes or No to indicate the person’s appropriate status.
   - **Support Staff** — Select Yes or No to indicate if the requester is a support staff member.
   - **Site** — Select a Site location.
- **Company**—Select access data for one company but not another, based on the companies to which the person is assigned. The Company field controls access when configuring people.

- **Business**—Enter a business phone number. Also enter an email address.

5. Optionally, complete the remaining fields, including fields on the other tabs.

6. Click **Save**.

---

### Using Reminders

Reminders enable you to define notes for yourself and others. You can send them by email or through BMC Remedy Alert, and you can specify when they are sent.

You can define generic reminders, or you can define reminders that are associated with a specific change request or task. For example, you can send yourself a note about a specific change request to remind yourself to follow up on it.

Whether you access reminders from the console or from within a change request determines which reminders you are able to view:

- When you open the Reminders dialog box from the console, you can view all reminders that you have created.

- When you open reminders from within a change request, you can view reminders associated with that request. This includes not only your reminders but also those created by other users of the application.

You can modify or delete only the reminders that you have created.

---

### Creating and viewing reminders

You can set reminders to send notes to yourself and others.

**To view and create reminders**

1. On the Change Management console select **Functions => Reminders**.

   The Show Reminders tab displays a list of reminders that you can filter using the options in the Show Reminder drop down.

2. Select the Create Reminder tab to create a new reminder.
3 Enter information in the fields as appropriate.

Notify

Select the type of notification.

The options are:

- Individual—Select this option to notify a user.
- Group—Select this option to notify a group.

**Note**

If you select the **Group** option, all the people who belong to the support group and have the Infrastructure Change Approver functional role are set up as approvers. By default, only one approver in the group must sign off on the approval before it can move to the next status.

Recipient

Enter the name of the user or group and press **Enter**.

AR login

If you select **Individual**, this field appears. The login ID of the user is automatically included when you select the user.

Time

Select the calendar icon to select the date and time for when the reminder needs to be set. By default, the time is set to an hour ahead of the current time.

Subject

Specify a subject for the reminder.

Message

Enter a brief message related to the reminder.

4 Click **Save**.

A confirmation message with details of the notifier and time of the reminder is displayed.
Modifying and deleting reminders

If you open the Reminders dialog box from the BMC Remedy Change Management Console, all reminders that you created are shown. If you open the Reminders dialog box from within a change request, only the reminders associated with that request are shown.

To modify or delete reminders

1. In the BMC Remedy Change Management Console, or from within a change request, choose Functions => Reminders.

2. In the Show Reminders field on the Reminders dialog box, select the set of reminders to view. The choices are All, Pending, and Sent.

3. Select a reminder, and then click View.

4. On the Reminder Details dialog box, make your changes to the reminder, and then click Save.

5. To delete a reminder, select it, and then click Delete.

Sending and receiving change notifications

When a change request moves into a new status, for example, Completed, the application generates notifications. Based on your group or role, you might receive notifications during various change statuses.

For more information, see Reassigning change requests on page 219. For more information about notification preferences, see the BMC Remedy IT Service Management Configuration Guide.

For more detailed information about notifications, see the BMC Remedy IT Service Management 7.6.xx Notification Engine Guide.

Notifications by groups

The following table lists the change events that trigger notifications and the change management groups they are sent to.
Table 44: Change statuses when notifications are sent to groups

<table>
<thead>
<tr>
<th>Current status</th>
<th>Coordinator group</th>
<th>Support group</th>
<th>Change Implementer group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request for authorization</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request for Change</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Planning in Progress</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Scheduled For Review</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Scheduled For Approval</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Implementation in Progress</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completed</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pending</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rejected</td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Cancelled</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notifications by roles

The following table lists the change statuses that trigger notifications and the change management roles they are sent to.

Table 45: Change statuses when notifications are sent to roles

<table>
<thead>
<tr>
<th>Current Status</th>
<th>Change coordinator</th>
<th>Change manager</th>
<th>Requested by</th>
<th>Requested for</th>
<th>Change implementer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Request for authorization</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request for Change</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planning in Progress</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Scheduled For Review</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduled For Approval</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Broadcasting messages

This feature enables you to send messages to your entire organization, selected groups within the organization, and to external customers. You can use this feature to send messages about work in progress, system status, planned work, and so on. You can also use this feature to view messages that were broadcast to you from other groups in your organization.

Broadcasts are filtered by the logged-in user’s company, based on the following criteria:

- Broadcasts that are defined for the logged in user’s company
- If the logged-in user’s company cannot be determined, only Global broadcasts appear.
- Only broadcasts defined for the Global company appear to guest users, whose company cannot be determined.

You can also broadcast the unavailability of CIs from the Relationships tab. For information, see Performing additional functions with CI unavailability on page 259.
Managing broadcasts

While viewing broadcasts, you can modify the message, define a new broadcast message, and under some circumstances (when viewing the message from the current record) relate the broadcast message to the current record.

To manage broadcasts

1. From the BMC Remedy Change Management console or the application console click View Broadcast.

   If there are pending broadcasts that you have not viewed, this link will display as New Broadcast.

2. To view a broadcast, select the message to view from the Broadcast table and then click View.

   The View Broadcast dialog displays details of the selected broadcast.

   To view another message, close the current broadcast, select another message from the Broadcast table and click View.

3. If the broadcast table contains many messages, limit the number of messages using the Broadcast Search Criteria tab. For more information, see “Limiting the number of messages” on page 403.

4. Click Modify to update the broadcast message.

   You must belong to the authorized authoring group for the selected broadcast and have the functional role of a Broadcast Submitter to modify the broadcast. For more details on modifying broadcasts, see “Creating broadcast messages” on page 404.

   **Note**

   Authorized authoring groups are defined on the Authoring Groups tab of the New/Modify Broadcasts dialog.

Limiting the number of messages

When viewing broadcast messages from the current record, you can limit the number of messages that appear in the Broadcast table. Click the Broadcast Search Criteria tab and define a set of criteria that filters out messages.
To limit the number of messages

1. Click the Broadcast Search Criteria tab, and then complete the fields in the tab.

   To return the smallest number of broadcast messages, complete as many of the fields as possible.

2. When you finish specifying the search criteria, click Search.

Creating broadcast messages

This section describes how to define a broadcast message. To define a broadcast, you must have the Broadcast Submitter functional role.

To define a broadcast message

1. You can open the New/Modify Broadcasts dialog box from two locations, as follows:

   - To broadcast a change, from the navigation pane of the change record, choose Functions => Broadcast Change. If you define a broadcast from a change or release, a relationship is generated between the broadcast and the change or release.

   - To broadcast generic information, from the BMC Remedy Change Management Console, click Create, which appears below the Broadcast table. If you define a broadcast from the main console, it is not related to a specific record.

     **Note**

     To broadcast a release, select the given options in the release record or console. For a release broadcast, the Broadcast originated from and Broadcast originated from ID fields are pre-populated because a relationship between a release and broadcast has been associated.

2. Enter information in the required fields.

   Required fields appear in bold on the Broadcast Details tab.

   - **Company**—Select the company where this broadcast will be sent. Only users with access to this company see the broadcast. To send the broadcast to everyone, select Global from the Company list.

     The Company field is mandatory. To specify a specific part of the company, fill in the other location fields. For example, you can specify the site, organization, or department.
- **Subject** — A short description of what the broadcast is about.

- **Broadcast Message** — The text of your message.

- **Broadcast Type** — Select a broadcast type from the list.

- **Broadcast Start Date** and **Broadcast End Date** — To start the broadcast now, click in the Broadcast Start Date field, and then press Enter. To select a date from the calendar, click the Browse button next to the field. Select a date from the calendar on which to start the broadcast and the date to end it. You can also specify times of the day using the Time feature at the bottom of the calendar.

- **Broadcast Originated From** — This is automatically filled in. The contents depend on where you are creating the broadcast. If you broadcast from an investigation, the value is set to Problem Investigation.

- **Broadcast Originated From ID** — When you define a broadcast from within a record, this field is automatically filled in. If you define a broadcast from the main console, the field is unavailable.

- **View Access** — To make the broadcast visible only to members of your organization, select Internal. To make the broadcast visible from the Requester console, select Public.

- **Notify** — Select Yes to broadcast notification automatically sent to an individual or group.

  If you select Yes, an Email button and the Notify Support area appears.

  Use the Manual Email button to manually send an email about the broadcast. On the Email System form, enter the recipient’s email address in the Internet Email field, and then click Send Email Now.

  Use the Notify Support area to indicate which group to notify of the broadcast. You must complete all three fields, Support Company, Support Organization, and Support Group. The notification is sent at the time and on the date specified in the Broadcast Start Date field.

- **Priority** — Select a priority level for the broadcast. The choices are Low, Medium, and High.

  3 To add an attachment to the Broadcast, right-click inside the table and select Add from the menu.

    In the Add Attachment dialog box, click Open to attach the indicated file. Only one attachment is allowed for each broadcast.

  4 If you want members of another group to be able to modify the message, follow these steps:

    a Click the Authoring Groups tab, and then click Manage Authoring Groups.
b On the Authoring Group dialog box, select the group to have authoring rights, and then click Add.

5 Click Save.

Sending pages and email messages

In BMC Remedy Change Management, you can send messages to individuals by email. You can page an individual or member of an on-call group.

Sending email

You can send messages about the current record using the BMC Remedy Change Management email system.

To send an email message

1 Open the change or release from which to send the email.

2 From the left navigation pane, choose Functions => Email System.

3 On the Email System dialog box, indicate the recipient by selecting either:

   ■ Current Contact—When you open the Email System form, if there is a current contact assigned to the record, the contact’s name and contact information appears in the table and is the default recipient.

   ■ Current Assignee—To select the current assignee, click Select Current Assignee. The current assignee’s name and contact information appears in the table.

4 To select another recipient, complete the following steps:

   a Complete the fields in the People Search Criteria area, and then click Search.

   b Select the recipient’s name in the search results table. If you need help deciding which is the correct name in the list, click View to see more information about an individual.

5 Complete the email information fields as described in the following list:
- **Internet Email** — Type the recipient’s email address.
  To find this information, select the person’s name from the search results list, and then click View. The Internet Email field is on the General tab of the People form.

- **Email Subject Line** — The subject line contains the request ID number. You can type over or add to this information.

- **Email Message Body** — Type the message text here. A series of buttons, to the right of the Email Message Body field, enable you to automatically insert text from the record into the message text.

  **Note**

  If one or more of these buttons is unavailable, the corresponding field in the record contains no information.

- **Email Attachment** — To attach a single file to the email message, right-click inside the Email Attachment table, and then click Add. On the Add Attachment dialog box, select the file to attach, and then click Open.

6. Click **Send Email Now**.

### Paging a person or on-call group

You can page individuals or the on-call member of a group about the current record using the BMC Remedy Change Management paging system feature.

**To page a person or an on-call group**

1. Open the change from which to send the page.

2. From the navigation pane on the left side of the form, choose **Functions => Paging System**.

3. On The Paging System dialog box, select either:
   - **Page By Person** — To page an individual.
   - **Page By On-Call Group** — To page the on-call member of a specified group.

4. Complete the fields in the Search Criteria area, and then click **Search**.

5. Select the recipient’s name in the search results table, and then click **Select**.
If you are sending a page to a person instead of an on-call group, and need help finding the correct person, click **View**.

6. Complete the fields in the Paging Information area, as follows, and then click **Send Page Now**.

- **Pager Service Provider** — Select the recipient’s pager service provider.
  
  If you are sending a page to a person, you can find this information by selecting the person’s name from the search results list, and then clicking **View**. On the People form, click the Notifications tab to see the Pager Service Provider field.

  **Note**
  
  If you need more information about the service provider, click the button with the globe icon beside the field. This opens a link that takes you to the service provider’s website.

- **Pager Type** — This field is automatically filled.

- **Pager Number** — This field is automatically filled with the pager’s telephone number, when possible. If the pager number is unavailable to the system, you must enter the pager number manually.

- **Pager Email** — If the pager has an email address, type it here. If you are sending the page to a person, this information is available on the Notifications tab.

- **Manual Pager Number** — If the pager’s telephone number is not available automatically from the paging system, type the pager’s telephone number here.

- **Alphanumeric Pager Message** or **Numeric Pager Message** — Type your message in this field. Only one of these fields is enabled, depending on the recipient’s type of pager.

### Searching for records

From the Change Management console or Release Management console, you can search for records.

To do this, you can run a series of predefined searches, run a one-time custom search using the Search form, or create and save your own custom searches using advanced qualifications.
Using custom searches

A custom search looks through all the records that meet your search criteria, regardless of their associations to people or groups. You run this type of search by using the Search Problem link in the Navigation pane.

Use this type of search when you are looking for a record not associated with your ID or your group’s ID, or any time you need to search all records.

**To use a custom search**

1. From the Navigation pane, choose **Functions => Search Release** (or Search Change).

   A form appears that enables you to perform the search. The form is laid out in a similar way to the Change form or Release form, and contains the same tabs and fields. You can use any of the tabs and fields in the form to specify your search criteria.

2. Using the tabs and fields, build your search condition.

   To reduce the number of records found by the search, enter as much information into the form as you can.

3. When you finish entering your search criteria, click Search.

   When the search finishes, the search results list contains all the records that match the search criteria.

4. Scroll through the list to find the specific record you want.

Manage My Searches - Creating a custom search with advanced qualifications

In the Manage My Searches area in the left navigation pane, you can define and save a custom search. Custom searches using advanced qualifications allow you to create searches with very specific search criteria, which you can save for reuse. After you save the custom search, it appears in the My Searches node of the Defined Searches list.

**Note**

The My Searches node only appears after a custom search is defined.
To define a custom search

1. In the Defined Searches section of the Navigation pane, click Manage My Searches.

2. In the Type field, select the type of record you want to search for.

3. In the Search Name field, type a name for the search.

4. Click Build Search Qualification to open the Advanced Qualification Builder dialog box, and then define the search qualification.

5. From the Keywords or Fields selection boxes, select the keywords or record fields on which you want to search.

   To insert operators (+, =, >, <, and so on), click the appropriate operator button. Do not forget to place literal values between double quotation marks. For example, to search for a problem investigation with a priority of high, you would construct the following search:

   'Priority' = "High"

6. Click Select to close the Advanced Qualification Builder, and then click Save.

7. Close the Manage My Searches dialog box.

   The search appears in the Defined Searches list, under the My Searches node.

   **Note**

   The My Searches node only appears when a custom search is defined.
**Editing or deleting custom searches**

If you want the power of a custom search with advanced qualifications, but do not want to save the search, you can delete it.

**To edit or delete the custom search**

1. Open the Manage My Searches dialog box as described in the preceding procedure.
2. From the list of searches, select the search you need to modify or delete.
3. Perform one of the actions described in the following table.

<table>
<thead>
<tr>
<th>To modify the search</th>
<th>To delete the search</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Edit the search as required.</td>
<td>1. Click Delete.</td>
</tr>
<tr>
<td>2. Click Save.</td>
<td>2. Click Close.</td>
</tr>
<tr>
<td>3. Click Close.</td>
<td></td>
</tr>
</tbody>
</table>

**Working with reports**

BMC Remedy ITSM provides a variety of predefined reports to give you quick and easy access to information about your system. Use the Report console to generate these reports. If the predefined reports return more information than you need, you can manage the scope of the report using qualifications. From the Applications menu, choose **Quick Links => AR System Report Console** to view customized reports.

This release of BMC Remedy ITSM integrates the Crystal reports from version 7.6.00 and Web reports from version 7.6.01. On the web interface, a number of reports are available in the Web format. Additional Crystal reports are available only if users have a valid Crystal license and have chosen to install them for the web at the time of installation.

**Note**

Customer Support can only provide limited assistance if you modify predefined reports and have a reporting problem. In addition, there is no guarantee that BMC Customer Support can solve problems that result from these modifications. The standard reports included with the BMC Remedy ITSM application are designed to be used without modification.
If your database does not support the Not Equal To argument in this format: "!="; the content of your reports can be affected. Reports that have additional qualifications that filter out Group By fields (for example, ‘Department’ != "Engineering") also filter out the specified conditions and records that have Group By fields set to Unspecified or Null. Check with your system administrator to determine whether your database supports this form of the Not Equal To argument.

**Generating a report**

Use this procedure to generate a standard report without qualifications by using the BMC Remedy web console.

For information about generating reports with qualifications, see Using qualifications to generate a report on page 413 or Using qualifications to generate a report on page 413.

**To generate a report by using the Remedy web console**

1. In the navigation pane on the application console, choose **Functions => Reports**.

2. On the Reporting console, select one of the options under **Show**:

   - **All Reports**: Displays all available reports
   - **Created by me**: Displays reports that you created

3. Under **Category**, select `applicationName => reportCategory => reportName`.

   A list of available reports is displayed. Reports are organized by category, some of which contain subcategories. The reports that you see vary according to which applications are installed.

4. Select the report that you want to run.

5. Click **Run**.

   If you select a report that requires additional parameters, you are prompted to enter the required parameters. For example, if the selected report requires a date range, the date range field appears.

6. Enter the required parameters, and click **OK**.
If the report displayed is a web report, you can specify the following additional options:

- **Toggle Table of Contents**
  - Display the table of contents for the current report

- **Export Report**
  - Export the report to a file of the specified format
  - To export the report, select one of the following formats from the Export Format list:
    - Excel
    - PostScript
    - PDF
    - Word
    - PowerPoint
  - Select the appropriate page options, and click **OK**.

- **Print Report**
  - Print the report to HTML or PDF format

### Using qualifications to generate a report

You can manage the scope of a report by adding qualifications to the criteria that the report engine uses to generate the report content. You can tell the report to search only certain specified fields for particular values, or you can build advanced qualifications by using field names, keywords, and operators.

This procedure describes how to generate basic qualifications by using the **Show Additional Filter** option. To generate a report by using advanced qualifications, see Using advanced qualifications to generate a report on page 415.

#### To use qualifications to generate a report

1. From the navigation pane in the application console, choose **Functions => Reports**.

2. On the Reporting console, select one of the options under **Show**:
All Reports Displays all available reports

Created by me Displays reports that you created

3 Under **Category**, select `applicationName => reportCategory => reportName`.

A list of available reports is displayed. Reports are organized by category, some of which contain subcategories. The reports that you see vary according to which applications are installed.

4 Select the **Show Additional Filter** option.

Along with a list of available fields, two sections are displayed—the simple query builder and the advanced query builder. You use the simple query builder to quickly construct a simple query. Alternatively, advanced users can use the advanced query builder to build the query by using BMC Remedy AR System query syntax.

For additional information about the BMC Remedy AR System Reporting console, see the *BMC Remedy Mid Tier Guide*.

5 Select a field name from the **Available Fields** list, and click **Add** next to the simple query builder.

---

**Note**

Click the button to remove a qualification.

---

6 Click the down arrow next to the field name listed in the qualification box, and select the appropriate operator.

7 Enter or select a value for the field in the right column.

---

**Example**

If you want to enter the qualification **Cost Center = 001**, select the Cost Center field, click the down arrow next to the field and select `=`, and then enter 001 in the right column.

---

8 Repeat steps 5 through 7 for each field that you want to include in the report.

9 When you finish defining your additional qualifications, click **Run**.

10 If the report displayed is a web report, you can specify the following additional options:
Using advanced qualifications to generate a report

You can manage the scope of a report by adding qualifications to the criteria that the report engine uses to generate the report content. You can tell the report to search only specified fields for particular values, or you can build advanced qualifications by using field names, keywords, and operators.

To generate a report by using advanced qualifications

1. From the Navigation pane in the application console, choose **Functions => Reports**.

2. On the Reporting Console, select one of the options under **Show**:
   - All Reports: Displays all available reports
   - Created by me: Displays reports that you created

3. Under **Category**, select `applicationName => reportCategory => reportName`. 

---

Chapter 11  Supplemental Change Management tasks  415
A list of available reports is displayed. Reports are organized by category, some of which contain subcategories. The reports that you see vary according to which applications are installed.

4 Select the **Show Additional Filter** option.

Along with a list of available fields, two sections are displayed—the simple query builder and the advanced query builder. You use the simple query builder to quickly construct a simple query. Alternatively, advanced users can use the advanced query builder to build the query by using BMC Remedy AR System query syntax.

For additional information about the BMC Remedy AR System Reporting console, see the *BMC Remedy Mid Tier Guide*.

5 Select a field name from the **Available Fields** list, and click **Add** next to the advanced query builder. Use the BMC Remedy AR System query syntax to build your qualification.

6 Construct your qualification by using the various operators provided by the qualification builder.

7 Repeat steps 5 and 6 for each field that you want to include in the report.

   **Note**

   Select the qualification and press Delete to remove a qualification.

8 When you finish defining your advanced qualification, click **Run** to view the updated report.

**BMC Remedy Change Management predefined reports**

This section lists the predefined Web reports and Crystal Reports available for BMC Remedy Change Management. It provides a brief description of each report and shows you where to find it.

You first select the type of report that you want to run. The report type pulls information from the appropriate BMC Remedy ITSM application form. After you select a report type, you select the individual report that you want to run.

Table 46 on page 417 describes the predefined Web reports and Table 47 on page 417 describes the predefined Crystal Reports included, organized by the type of report.
### Table 46: Web reports—names and descriptions

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change =&gt; Change Requests =&gt; Change Manager and Scheduled Start Date</td>
<td>Shows all change requests grouped by the change manager and scheduled start date</td>
</tr>
<tr>
<td>Changes By Manager and Scheduled Start Date</td>
<td>Shows all change requests grouped by the change manager and scheduled start date</td>
</tr>
<tr>
<td>Change =&gt; Configuration Item =&gt; Changes Scheduled by Configuration Item</td>
<td>Shows all scheduled change requests grouped by CI</td>
</tr>
<tr>
<td>Changes Scheduled by Configuration Item</td>
<td>Shows all scheduled change requests grouped by CI</td>
</tr>
<tr>
<td>Change =&gt; Risk =&gt; Change Risk Report by Scheduled Start Date</td>
<td>Shows all change requests grouped according to their Risk Level and Planned Start Dates</td>
</tr>
<tr>
<td>Change Risk Report by Scheduled Start Date</td>
<td>Shows all change requests grouped according to their Risk Level and Planned Start Dates</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Changes with related Problem records</td>
<td>Shows all the change requests that are related to a Problem record</td>
</tr>
<tr>
<td>Changes that have a Problem record associated with them</td>
<td>Shows all the change requests that are related to a Problem record</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Changes with related Incident records</td>
<td>Shows all the change requests that are related to an Incident record</td>
</tr>
<tr>
<td>Changes that have an Incident record associated with them</td>
<td>Shows all the change requests that are related to an Incident record</td>
</tr>
</tbody>
</table>

### Table 47: Crystal Reports—names and descriptions

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change =&gt; Calendar =&gt; Changes By Calendar Date Range</td>
<td>Shows all change requests grouped within a specified range of dates</td>
</tr>
<tr>
<td>Changes By Calendar Date Range</td>
<td>Shows all change requests grouped within a specified range of dates</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Backed Out Change Request</td>
<td>Shows all backed-out change requests</td>
</tr>
<tr>
<td>Backed Out Change Request</td>
<td>Shows all backed-out change requests</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Change Manager</td>
<td>Shows all change requests grouped by the change manager</td>
</tr>
<tr>
<td>Changes By Change Manager</td>
<td>Shows all change requests grouped by the change manager</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Change Type</td>
<td>Shows all change requests grouped by change type</td>
</tr>
<tr>
<td>Changes By Type</td>
<td>Shows all change requests grouped by change type</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Changes By Assignee and Scheduled Start Date</td>
<td>Shows all change requests grouped by the change coordinator and scheduled start date</td>
</tr>
<tr>
<td>Changes By Assignee and Scheduled Start Date</td>
<td>Shows all change requests grouped by the change coordinator and scheduled start date</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Changes By Business Justification</td>
<td>Shows all change requests grouped by the change business justification</td>
</tr>
<tr>
<td>Changes By Business Justification</td>
<td>Shows all change requests grouped by the change business justification</td>
</tr>
<tr>
<td>Change =&gt; Change Requests =&gt; Changes By Change Coordinator</td>
<td>Shows all change requests grouped by the change coordinator</td>
</tr>
<tr>
<td>Changes By Change Coordinator</td>
<td>Shows all change requests grouped by the change coordinator</td>
</tr>
<tr>
<td>Report name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Changes By Change Coordinator</td>
<td>Shows all change requests grouped by their change coordinator</td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Changes By Status</strong></td>
<td></td>
</tr>
<tr>
<td>Changes By Status</td>
<td>Shows all change requests grouped by status</td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Location And Scheduled Start Date</strong></td>
<td>Shows all change requests grouped by their change location and sorted by the scheduled start date</td>
</tr>
<tr>
<td>Changes By Location and Scheduled Start Date</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Location And Status</strong></td>
<td>Shows all change requests grouped by their change location and sorted by the change status.</td>
</tr>
<tr>
<td>Changes By Location and Status</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Operational Categorization</strong></td>
<td>Shows all change requests grouped by operational categorization</td>
</tr>
<tr>
<td>Changes By Operational Categorization</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Related Changes</strong></td>
<td>Shows all change requests that are related to other change requests, grouped by the parent change request</td>
</tr>
<tr>
<td>Changes with Related Changes</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Requester</strong></td>
<td>Shows all change requests grouped by requester information and support company information</td>
</tr>
<tr>
<td>Changes By Requester and Status</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Status Reason</strong></td>
<td>Shows all change requests grouped by status reason</td>
</tr>
<tr>
<td>Changes By Status Reason</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Class</strong></td>
<td>Shows all change requests grouped by the change Class, previously termed as change timing</td>
</tr>
<tr>
<td>Changes By Class</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Configuration Item</strong></td>
<td>Shows all virtual machines with a decommission date proposed for the selected date range</td>
</tr>
<tr>
<td>Virtual Machines by Decommission Date</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Service Requests</strong></td>
<td>You must have BMC Remedy Service Request Management installed to view Service Request related reports.</td>
</tr>
<tr>
<td>Requests for Virtual Machines</td>
<td>Shows all service requests for virtual machines.</td>
</tr>
<tr>
<td>Decommission Requests for Virtual Machines</td>
<td>Shows all decommissioned requests for virtual machines</td>
</tr>
<tr>
<td>Extension Requests for Virtual Machines</td>
<td>Shows all requests for virtual machine extensions</td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Approvals</strong></td>
<td></td>
</tr>
<tr>
<td>Report name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Requests By Approval Status</td>
<td>Shows all change requests grouped by approval status</td>
</tr>
<tr>
<td>Change Approvals By Virtual Machines</td>
<td>Shows all change requests related to virtual machines along with the last approval status of the change</td>
</tr>
<tr>
<td><strong>Change =&gt; Change Requests =&gt; Approval Status</strong></td>
<td></td>
</tr>
<tr>
<td>Virtual Machines Requests by Approvals</td>
<td>Shows all service requests for virtual machines grouped by approval status</td>
</tr>
<tr>
<td><strong>Note:</strong> You must have BMC Remedy Service Request Management installed to view this report.</td>
<td></td>
</tr>
<tr>
<td><strong>Change =&gt; Configuration Item =&gt; Open Change Requests by Configuration Item</strong></td>
<td></td>
</tr>
<tr>
<td>Open Changes Requests By Configuration Item</td>
<td>Shows all change requests related to CIs and grouped by CIs</td>
</tr>
<tr>
<td><strong>Change =&gt; Configuration Item =&gt; Configuration Item Scheduled Changes</strong></td>
<td></td>
</tr>
<tr>
<td>Changes Scheduled by Virtual Machine</td>
<td>Shows all change requests related to virtual machines with status Scheduled and a start date</td>
</tr>
<tr>
<td><strong>Change =&gt; Configuration Item =&gt; Status</strong></td>
<td></td>
</tr>
<tr>
<td>Open Change Requests for Virtual Machines</td>
<td>Shows all open change requests related to virtual machines for which the status is not Completed, Cancelled or Draft</td>
</tr>
<tr>
<td><strong>Change =&gt; Costs =&gt; Cost Categories/Types</strong></td>
<td></td>
</tr>
<tr>
<td>Change Cost Categories - Actual Cost</td>
<td>Shows the actual costs incurred for the change requests</td>
</tr>
<tr>
<td>Change Cost Categories - Budgeted Costs</td>
<td>Shows the budgeted costs incurred by the change requests</td>
</tr>
<tr>
<td>Virtual Machine Costs</td>
<td>Displays costs incurred for the VM. The costs include cost for change for the VM and VM costs.</td>
</tr>
<tr>
<td><strong>Change =&gt; Costs =&gt; Cost Summary/Year-Quarter</strong></td>
<td></td>
</tr>
<tr>
<td>Cost Summary/Year-Quarter by Change Location - Actual Cost</td>
<td>Cross-tab report that provides the actual costs incurred by the change location</td>
</tr>
<tr>
<td>Cost Summary/Year-Quarter by Change Location - Budgeted Cost</td>
<td>Cross-tab report that provides the budgeted costs by the change location</td>
</tr>
<tr>
<td>Cost Summary/Year-Quarter by Operational Categorization - Actual Cost</td>
<td>Cross-tab report that provides the actual costs incurred by the change operational categorization</td>
</tr>
<tr>
<td>Cost Summary/Year-Quarter by Operational Categorization - Budgeted Cost</td>
<td>Cross-tab report that provides the budgeted costs incurred by the change operational categorization</td>
</tr>
<tr>
<td>Virtual Machine Costs by Quarter</td>
<td>Cross-tab report that provides the quarterly costs incurred for the VM. The costs include cost of the change for the virtual machine and the actual virtual machine costs.</td>
</tr>
<tr>
<td>Report name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change =&gt; Impact =&gt; Change Impact Report by Planned Start Date</td>
<td>Shows all change requests grouped according to their Impact, Urgency, and Planned Start Dates</td>
</tr>
<tr>
<td>Change Impact Report by Planned Start Date</td>
<td></td>
</tr>
<tr>
<td>Changes and Tasks by Status</td>
<td>Shows all tasks related to change requests sorted by task status</td>
</tr>
</tbody>
</table>

Using the Change Management KPI flashboards

The KPI flashboards use graphs to show how well various change management business processes are performing against the Change Management key performance indicators (KPIs). If installed, you can also view the Change Management KPIs from BMC SMPM.

For a list and a description of the Change Management KPIs, see “Change Management KPIs” on page 421.

**Tip**
The BMC SMPM defines a key performance indicator as, A vital and measurable result to track the efficiency, effectiveness, and predictability of a process.”

The KPI flashboard component collects the data according to the selected customer company. Each KPI flashboard contains two graphs that present the following types of information:

- Relevant historical data — Use this graph for trending purposes. The most recent historical data displayed in the graph is collected from the previous month. Historical data goes back to a maximum of one year.

  **Note**
  Historical data only appears in a graph when that historical data exists in the database. Typically, new or recent installations, or upgrades, of BMC Remedy Incident Management might not have historical data available.

- Current, or real time data — Use this graph to see what is happening with the business process now. In most cases, the displayed real time data is collected from the first day of the current month to today’s date.

You can also view the individual change request records that are reported by the real time dashboard graph. For example, you can view all of the change request records
that are reported by the Change Backlog KPI flashboard. For information about how to do this, see Viewing and displaying data from the KPI flashboards on page 424.

**Note**
KPI flashboards are available only for version 7.6.00 (and later) of the BMC Remedy ITSM applications. If you are running a mixed environment, that is, if you are running some BMC Remedy ITSM applications at version level 7.5.01 (or earlier), you see flashboards with only the version 7.6.00 (or later) applications.

## Change Management KPIs

This section contains a list and a description of the Change Management key performance indicators.

### Table 48: BMC Remedy Change Management KPIs

<table>
<thead>
<tr>
<th>KPI title</th>
<th>Description of graph content</th>
<th>Frequency of data collection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Successful changes</td>
<td>This graph displays:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- The number of closed change requests with the Status Reason field set to &quot;Successful&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- The total number of closed change requests</td>
<td>Monthly</td>
</tr>
<tr>
<td>Standard changes</td>
<td>This graph displays:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- The number of completed change requests with class &quot;Standard&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- The total number of completed change requests</td>
<td>Monthly</td>
</tr>
<tr>
<td>Emergency changes</td>
<td>This graph displays the number of completed changes with the Timing field set to &quot;Emergency&quot;.</td>
<td>Monthly</td>
</tr>
<tr>
<td>Time to plan</td>
<td>This graph displays the average time taken for the Status field to be set to Scheduled for Review from the moment a change is registered.</td>
<td>Monthly</td>
</tr>
<tr>
<td>Time to Approve</td>
<td>This graph displays the average time taken for the Status field to be set to Scheduled from Scheduled for Approval.</td>
<td>Monthly</td>
</tr>
<tr>
<td>Backlog of Changes</td>
<td>This graph displays the number of change requests with Change Type field set to &quot;Change&quot; for which the Status field is not yet set to &quot;Completed&quot;.</td>
<td>Daily</td>
</tr>
</tbody>
</table>
Change Management KPI flashboards variables

KPI flashboards use variables to fetch the data that is used to create the dashboard graphs for the selected company. In most cases, you can control what data appears in the graph by choosing to hide or display one or more of the active variables.

See “Viewing and displaying data from the KPI flashboards” on page 424 for information about how to hide or display variables.

Table 49 on page 422 lists the Change Management KPI graph types, the active variable names, and the meaning of the information provided. This will help you to understand the effects of choosing to hide or display a specific variable.

Table 49: KPI flashboards variables

<table>
<thead>
<tr>
<th>Graph type</th>
<th>Variable name</th>
<th>Data displayed by the variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Successful Changes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Historical</td>
<td>CHG:CHG:SuccessfulChangesHistory</td>
<td>Changes that were closed successfully for the last year (if the data exists), for the selected company.</td>
</tr>
<tr>
<td></td>
<td>CHG:CHG:SuccessfulChangesHistoryC0</td>
<td>Total number of changes that were closed for the last year (if the data exists), for the selected company.</td>
</tr>
<tr>
<td>Real time</td>
<td>CHG:CHG:SuccessfulChanges</td>
<td>Changes that were closed successfully for the month.</td>
</tr>
<tr>
<td></td>
<td>CHG:CHG:SuccessfulChanges_C0</td>
<td>Changes that were closed unsuccessfully for the month.</td>
</tr>
<tr>
<td>Standard Changes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Historical</td>
<td>CHG:CHG:StandardChangesHistory</td>
<td>Changes that were completed successfully with class &quot;Standard&quot; for the last year (if the data exists), for the selected company.</td>
</tr>
<tr>
<td></td>
<td>CHG:CHG:StandardChangesHistoryC0</td>
<td>Total number of changes that were completed for the last year (if the data exists), for the selected company.</td>
</tr>
<tr>
<td>Real time</td>
<td>CHG:CHG:StandardChanges</td>
<td>Changes that were completed successfully with class &quot;Standard&quot; for the month.</td>
</tr>
<tr>
<td></td>
<td>CHG:CHG:StandardChanges_C0</td>
<td>Changes that were completed successfully with class not equal to &quot;Standard&quot; for the month.</td>
</tr>
<tr>
<td>Emergency Changes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Historical</td>
<td>CHG:CHG:EmergencyChangesHistory</td>
<td>Completed emergency changes for the past year (if data exists), for the selected company.</td>
</tr>
<tr>
<td>Graph type</td>
<td>Variable name</td>
<td>Data displayed by the variable</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Real time</td>
<td>CHG:CHG:EmergencyChanges</td>
<td>Completed emergency changes for the current month for the selected company.</td>
</tr>
<tr>
<td>Time to approve</td>
<td>CHG:CHG:TimetoapproveHistory</td>
<td>Time taken to approve the changes during the past year (if data exists), for the selected company.</td>
</tr>
<tr>
<td>Real time</td>
<td>CHG:CHG:Timetoapprove</td>
<td>Time taken to approve the changes for the current month for the selected company.</td>
</tr>
<tr>
<td>Time to plan</td>
<td>CHG:CHG:TimetoplanHistory</td>
<td>Time taken to plan the changes for the past year (if data exists), for the selected company.</td>
</tr>
<tr>
<td>Real time</td>
<td>CHG:CHG:Timetoplan</td>
<td>Time taken to plan the changes for the current month, for the selected company.</td>
</tr>
<tr>
<td>Backlog of Changes</td>
<td>CHG:CHG:BacklogofchangesHistory</td>
<td>Completed change requests for the past year (if data exists), for the selected company.</td>
</tr>
<tr>
<td>Real time</td>
<td>CHG:CHG:Backlogofchanges</td>
<td>Completed change requests for the current month, for the selected company.</td>
</tr>
</tbody>
</table>

### Opening the KPI flashboards from the BMC Remedy Change Management console

Use this procedure when you need to open the KPI flashboards to view the information that they contain.

**To open the KPI flashboards**

1. Choose **Functions => KPIs**. This option is accessible only to Change Managers.
2. From the Company list select the customer company for which you want to view KPI flashboards.
3. From the Navigation pane, choose **Process KPIs => KPIflashboardLink**.

*KPIflashboardLink* is the link to the specific KPI flashboard that you want to see.
Viewing and displaying data from the KPI flashboards

After the KPI dashboard opens, there are controls on the dashboard that help you view and display the data. The actions you can perform and the procedures that you use to perform them are described under KPI dashboard actions and procedures.

See, Table 50 on page 424.

Tip
Click the triangle beside the Key Performance Indicator text to open and close this area of the Navigation pane.

Note
Not all of the KPI dashboards support all of these procedures.

Table 50: KPI dashboard actions and procedures

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>View specific records used to create the real time KPI dashboard data</td>
<td>1  Click anywhere inside the real time graph.</td>
</tr>
<tr>
<td><strong>Note:</strong> Use this procedure, for example, to view all of the change request records with the Status Reason field set to &quot;Successful&quot;. This does not work on the historical data graph.</td>
<td>2  In the search results list, select the record you want to view.</td>
</tr>
<tr>
<td>Zoom a graph</td>
<td>1  Click the arrow in the lower left corner of the graph to expand the bottom control panel.</td>
</tr>
<tr>
<td><strong>Note:</strong> Use the zoom feature to enlarge a section of the graph. You can also use full screen mode to enlarge the entire graph as described by “View a graph in full screen mode” which appears later in this table.</td>
<td>2  Click the magnifying glass icon, then follow the onscreen instructions.</td>
</tr>
<tr>
<td>Hide or display the graph legend</td>
<td>1  Click the arrow in the lower left corner of the graph to expand the bottom control panel.</td>
</tr>
<tr>
<td><strong>Note:</strong> The default setting is to show the graph legend. The legend provides information about how to interpret the graph. Not all graphs have a legend.</td>
<td>2  Deselect or select the Show Legend check box to either hide or display the legend.</td>
</tr>
<tr>
<td>Change the graph style</td>
<td>1  Click the arrow in the lower left corner of the graph to expand the bottom control panel.</td>
</tr>
<tr>
<td><strong>Note:</strong> There are a number of different graph styles from which you can choose. For example, you can select to display the KPI data in a line graph, a bar graph, a stacked bar graph, an area chart, and so on. Not all graphs support all graph styles.</td>
<td>2  Click the double-arrow button, then select the graph style you want.</td>
</tr>
</tbody>
</table>
### Action
Change the graph titles
**Note:** You can customize the title text that appears on the graphs to suit your organization’s needs. For example, you can change the titles of the X and Y axis.

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In the upper right corner of the graph, click the Titles icon.</td>
</tr>
<tr>
<td>2 Change the label text appropriately to your organization’s needs.</td>
</tr>
<tr>
<td>3 Click <strong>Apply</strong> when you finish updating the text.</td>
</tr>
</tbody>
</table>

### Action
Hide or display active variables
**Note:** KPI flashboards use active variables to fetch the data that is used to populate the graphs. If you choose to hide a variable, then the part of the graph that uses the variable is hidden. This gives you the ability to further customize the KPI flashboards appearance. *Not all graphs have active variables that you can turn on or off.*

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In the upper right corner of the graph, click the Titles icon.</td>
</tr>
<tr>
<td>2 Select or deselect the active variables that you want to display or hide.</td>
</tr>
</tbody>
</table>

### Action
View a graph in full screen mode
**Note:** You can display the selected graph across the entire screen for better visibility. *Not all graphs display in full screen mode.*

<table>
<thead>
<tr>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In the upper right corner of the graph, click the Full Screen icon.</td>
</tr>
<tr>
<td>2 When you finish viewing the graph in full screen mode, press ESC to restore regular display mode.</td>
</tr>
</tbody>
</table>

---

## Using the Change Management ROI flashboard

The Change Management ROI flashboard shows the cost of failed changes (per month). The flashboard shows the baseline costs that would have been incurred if BMC Remedy IT Service Management Suite was not implemented as compared to the actual costs that were incurred. This information is displayed in a pair of graphs on the Cost of Failed Changes flashboard.

**Note**

In some cases, if the relative difference between the numbers reported in each graph is great enough, the smaller graph might not appear on the flashboard. However, a number representing the value of the smaller graph is always seen.

The information displayed in these graphs helps you to determine the return on investment (ROI) that your organization achieves from the BMC Remedy ITSM implementation.

ROI flashboards are available on the ROI console for other BMC Remedy ITSM applications. For more information about those flashboards, refer to either the **BMC**
The ROI data is collected by the ROI flashboard component according to:

- the customer company you select in the ROI console.
- the date range you specify in the ROI console.
- a set of parameters that are configured by a ROI admin.

See the BMC Remedy IT Service Management Configuration Guide for information about configuring the ROI flashboard parameters. See Configured parameters on page 427 for descriptions of what the configured parameters mean.

Opening the ROI flashboards

This section describes the procedure to open the KPI flashboards from the BMC Remedy AR System IT Home page.

To open the ROI flashboards

1. In the Navigation pane of the BMC Remedy AR System IT Home page, click the ROI Console link.

2. From the Navigation pane, choose ROI Console.

3. From the lists at the top of the ROI console, select the following parameters:
   - Company — The client company for which you want to create a comparison.
■ Start Date—The start date of the period for which the graph is created. The year of the start date must be 2000 or later.

■ End Date—The end date of the period for which the graph is created.

**Note**
The companies that you see in the Company list are controlled by your access level. The Effort Input, Effort Estimate, Baseline Effort, and Cost fields are completed automatically by the application and are configurable by the system administrator.

4 In the ROI Navigation pane, choose **Change Management => Cost of Failed Changes**.

**Note**
If other BMC Remedy ITSM applications are installed, you will also see links to those ROI flashboards in the Navigation pane.

## Configured parameters

The following list describes the ROI parameters that are configured by the ROI admin:

■ **Cost (per hour)**—The estimated per hour cost of change used by your organization for creating projections.

■ **Effort Input**—Can be one of the following:
  
  – **Specify Effort Estimate**—If selected, this parameter represents the estimated number of hours to complete a change request. This parameter is used to specify a estimate that is different from the one specified in the Baseline Effort field.

  – **Use Baseline Effort**—If selected, the flashboard uses the same value for Effort Input that is specified for Baseline Cost Calculations.

■ **Effort Estimate (in hours)**—The actual value of the Specify Effort Estimate parameter, if that parameter is configured.

■ **Baseline Cost Calculation**—If you selected the Use Baseline Effort option as Effort Input, the flashboard uses the values specified here. You will see the following values:

  – **Effort (in hours)**—The estimate average number of hours required to handle change requests, expressed in hours.
— Unsuccessful Changes (per month) — The number of changes that were expected to be unsuccessful.

**Viewing and displaying data**

After the Cost of Failed Changes flashboard opens, there are controls on the flashboard that help you view and display the data. The actions that you can perform and the procedures that you use to perform them are the same as those described for the KPI flashboards under KPI flashboard actions and procedures.

See, Viewing and displaying data from the KPI flashboards on page 424.

**Active variables**

The ROI flashboards use active variables to fetch the data that is used to create the graphs. You can control the appearance of the graph by choosing to hide or display an active variable.

See for information about how to hide or display active variables.

Table 51 on page 428 lists the Cost of Failed Changes active variable names and the meaning of the information they provide.

**Table 51: Cost of Failed Changes active variables**

<table>
<thead>
<tr>
<th>Active variable name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effort Input selected is Specify Effort Estimate</td>
<td></td>
</tr>
<tr>
<td>ROI:Costoffailedchanges_Baseline</td>
<td>Projected costs. Value selected from Configuration form.</td>
</tr>
<tr>
<td>ROI:Costoffailedchanges_Actual</td>
<td>Actual cost. Value selected from Change form and the configurations. Actual effort (Effort estimate) are used for calculations.</td>
</tr>
<tr>
<td>Effort Input selected is Use Baseline Effort</td>
<td></td>
</tr>
<tr>
<td>ROI:Costoffailedchanges_Baseline</td>
<td>Baseline costs. Value selected from Configuration form.</td>
</tr>
<tr>
<td>ROI:Costoffailedchanges_Usingbaselinecost</td>
<td>Actual cost. Values selected from Change form and the configurations. Baseline efforts (efforts (in hour)) are used for calculations.</td>
</tr>
</tbody>
</table>
Selecting change templates

The Change Template function enables you to select any templates for your support group. Use change templates to quickly and efficiently create standard change requests with a minimum of mouse clicks and key strokes. Change templates are useful in any change request that follows well-defined methods for specific and repeated requirements—for example, Installs, Moves, and Add Changes (IMAC). Change templates are most helpful to new and occasional BMC Remedy Change Management users.

To select templates

1. Create or open a change request.

2. Do one of the following:

<table>
<thead>
<tr>
<th>When using the Best Practice view</th>
<th>When using the Classic view</th>
</tr>
</thead>
<tbody>
<tr>
<td>To attach a change template click the template field on the change form.</td>
<td>To attach a change template click Quick Links =&gt; Select Template on the left navigation pane.</td>
</tr>
</tbody>
</table>

**Note**
The change template can be applied in the Draft state, that is, while creating the change request. You can select a template only once for each change request.

3. On the Change Template Selection dialog box, click View to examine the contents of a change template.

   The template appears in read-only mode. Viewing a template enables you to see its relationship, its task and task group templates, and other important features.

   **Note**
   You cannot create, modify, or delete change templates in the BMC Remedy Change Management application; you can only view them. You must use the Application Administration Console to create, modify, or delete change templates. Besides change managers, users with Infrastructure Change Master and Change Config permissions can create, modify, and delete change templates. Any member of your support group can modify change templates for that group. For more information, see the BMC Remedy IT Service Management Configuration Guide.

4. Select a template and click OK.

   The contents of the template are applied to the change request. The change template overwrites any field values that are already present in the change request. Any relationships or tasks included with the change request are not
overwritten. Any additional tasks from the template are added as peers, and additional relationships (for example, CIs) are included with the change request.

Assignments defined in the template overwrite the assignments defined for the change. For example, when the user create a new change request, the Change coordinator group and Change coordinator fields are auto-populated with the user's details, if the user is a change coordinator. After selecting a template for this change request, if the template defines a change coordinator group, but no change coordinator, the change coordinator group is modified to the group specified in the template and the change coordinator is set to null since no value is defined in the template.

**Associating custom process flows to a change template**

You can create and modify custom process flows, which determine the change lifecycle. You must associate the custom process flow with the appropriate change template or templates. Then when the change coordinator selects the template on the change request form, the custom process flow applies to the change request.

**To associate a custom process flow with a change template**

1. From the Application Administration Console, click the Custom Configuration tab.
2. From the Application Settings list, choose Change Management => Template => Template, and then click Open.
3. Either search for and open an existing change template, or create a new change template.
4. Click the Process Flow tab.
5. In the Change Process Flow field, select the custom process flow.
   - The Status Transition field displays a textual representation of the status flow transitions.
6. Click Save.
Copying change requests

The Copy Change function is available on the Change form only when it is in Modify mode. This function enables you to copy a request into a new change request. When using the copy function, you have options to include different sections of the original change request, for example, Requested For Customer, Impacted Areas, CI/Component Relationships, Related Changes, or Work Info with attachments.

The following fields are filled with information from the change from which you are copying: Summary, Change Timing, Class, Timing Reason, Impact, Urgency, Priority, Risk Level, Lead Time, Environment, Reason For Change, and Notes. You can change the information in these fields to reflect the new change. You are also presented with different sections of the change that you can copy.

To copy a change request

1. From the left navigation pane on the Change form, choose Functions => Copy Change.

2. On the Copy Infrastructure Change dialog box, click the sections to include in the new request.

   Note
   If you select Copy Tasks, you will be prompted to enter additional information. For more details, see Copying tasks from another change request on page 432

3. Make any modifications to the new request you are creating (for example, changing its priority or timing).

4. Click Start Copy.

   The copy function can take several minutes to process.

   After the change is copied, the Change form opens in New mode with the newly copied change information in a Draft status. You now can modify and submit the new request.

5. If you select the Copy Related Changes option, Related Infrastructure Change Requests with a Dependent relationship type will be converted to Related To relationships.

   To keep the dependent relationship, in the Relationship tab, search for the dependent change request, make a new dependent relationship and delete the Related To relationship that were copied.

6. Save the new copy of the request.
Copying tasks from another change request

The Copy Change function enables you to copy a request into a new change request. When using the copy function, you have the option to copy the tasks associated with the original change request.

To copy tasks from another change request

1. From the left navigation pane on the Change form, choose **Functions => Copy Change**.

2. On the Copy Infrastructure Change dialog box, select **Copy Tasks**.

3. (optional) On the Copy Tasks dialog box, specify a value in the **Summary** field.

   If you specify a summary value, the **Summary** field of all the new copied tasks uses this value. Otherwise, the **Summary** field of all the new copied tasks uses the values of the source tasks.

4. On the Copy Tasks dialog box, select the related task information that you want to copy, and then click **OK**.

Depending on the options that you select, the following information is copied to the new change request:

<table>
<thead>
<tr>
<th>Option</th>
<th>Copied information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Information with Attachments</td>
<td>The following information from the General tab related to Task Location and the Task Attachments, except Command field:</td>
</tr>
<tr>
<td></td>
<td>■ Company</td>
</tr>
<tr>
<td></td>
<td>■ Region</td>
</tr>
<tr>
<td></td>
<td>■ Site Group</td>
</tr>
<tr>
<td></td>
<td>■ Site</td>
</tr>
<tr>
<td></td>
<td>■ Address</td>
</tr>
<tr>
<td></td>
<td>■ All related attachments</td>
</tr>
<tr>
<td>Option</td>
<td>Copied information</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requester Information</td>
<td>The following information from the Requester tab:</td>
</tr>
<tr>
<td></td>
<td>■ Requester Company</td>
</tr>
<tr>
<td></td>
<td>■ First Name</td>
</tr>
<tr>
<td></td>
<td>■ Middle Name</td>
</tr>
<tr>
<td></td>
<td>■ Last Name</td>
</tr>
<tr>
<td></td>
<td>■ Phone Number</td>
</tr>
<tr>
<td></td>
<td>■ Organization</td>
</tr>
<tr>
<td></td>
<td>■ Department</td>
</tr>
<tr>
<td></td>
<td>■ Support Organization</td>
</tr>
<tr>
<td></td>
<td>■ Support Group Name</td>
</tr>
<tr>
<td>Work Info with Attachments</td>
<td>All information on the Work Info tab including any attachments</td>
</tr>
<tr>
<td>Relationships</td>
<td>All information from the Relationships tab</td>
</tr>
<tr>
<td>Dates</td>
<td>The following information from the Dates tab is copied:</td>
</tr>
<tr>
<td></td>
<td>■ Schedule start date</td>
</tr>
<tr>
<td></td>
<td>■ Schedule end date</td>
</tr>
<tr>
<td>Financials</td>
<td>The following information from the Financials tab:</td>
</tr>
<tr>
<td></td>
<td>■ Calculation Unit type</td>
</tr>
<tr>
<td></td>
<td>■ Budget Estimated Total Time</td>
</tr>
</tbody>
</table>

5 Click **Start Copy**.

**Note**

It can take several minutes for the copy process to be completed.

All tasks and child tasks related to the task are copied. After the change is copied, the Change form opens in New mode with the newly copied change information in a Draft status. Any tasks that are copied are in Staged status. You now can modify and submit the new request.
6 Save the new copy of the request.

**Note**
A copied change request is not automatically submitted.

---

### Using phases with change requests

Version 7.5.01 of BMC Remedy Change Management introduced a feature that allowed you to complete tasks during any phase of a change request, not just the Implementation phase as in earlier versions of BMC Remedy Change Management. The following table describes when the Phase field is visible or hidden on the Change form.

#### Table 52: Phase field hidden or visible on Change form

<table>
<thead>
<tr>
<th>Change request created using change template?</th>
<th>Phase Management enabled in Change Rules?</th>
<th>Phase Management enabled on change template?</th>
<th>Phase field hidden or visible on Change form</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Disabled</td>
<td>Not applicable</td>
<td>Hidden</td>
</tr>
<tr>
<td>No</td>
<td>Enabled</td>
<td>Not applicable</td>
<td>Visible</td>
</tr>
<tr>
<td>Yes</td>
<td>Disabled</td>
<td>No</td>
<td>Hidden</td>
</tr>
<tr>
<td>Yes</td>
<td>Disabled</td>
<td>Yes</td>
<td>Visible</td>
</tr>
<tr>
<td>Yes</td>
<td>Enabled</td>
<td>No</td>
<td>Hidden</td>
</tr>
<tr>
<td>Yes</td>
<td>Enabled</td>
<td>Yes</td>
<td>Visible</td>
</tr>
</tbody>
</table>

For more information about creating change requests and working with tasks, see *Initiate stage - Creating change requests on page 113.*

**To use phases with change requests**

1. Create or open a change request.

2. Enter the required information.

3. Click the Tasks tab.

---
If Phase Management has been enabled, the Phase field appears on the Change form.

**Figure 99: Selecting phases in a change request**

4. From the Phase field, choose a phase.

5. Relate an ad hoc task, task template, or task group template to the change request.

6. Assign a task implementer to the task.

   After you select a phase and relate your tasks, the Related Templates table shows only tasks included with that phase.

7. Repeat step 4 through step 6 until you finish all the phases and all the tasks to include in the change request.

8. Save the change request.

9. Use the Process Flow Status bar to move the change request through the change management lifecycle.

   Tasks remain in Staged status until they are ready to be worked on. When you enter a stage in the lifecycle that includes tasks, the status of those tasks is set to Assigned. The task implementers are then notified (by email, BMC Remedy Alert, or pager) of tasks assigned to them.

10. Open the tasks defined for the stage and complete them.
**Using BMC Remedy Change Management with other applications**

You can access additional functionality from BMC Remedy Change Management (for example, manage inventory locations).

**Managing inventory locations**

If you have Asset Admin permissions, you can use the Manage Inventory dialog box to view inventory locations, relocate configuration items (CIs), and reserve and use CIs and bulk inventory items. For more information, see the *BMC Remedy Asset Management User’s Guide*.

**Viewing inventory locations**

You can view the location of all your CIs from the Manage Inventory dialog box.

**To view inventory locations**

1. In the BMC Remedy Change Management Console, choose **Advanced => Manage Inventory**.
2. On the Manage Inventory dialog box, enter your search criteria, and click **Search**.
3. Select a CI or bulk inventory item from the table, and then click **View Location**.

**Relocating CIs**

You can relocate CIs or bulk inventory items from one location to another.
To relocate CIs

1. In the BMC Remedy Change Management Console, choose Advanced => Manage Inventory.

2. On the Manage Inventory dialog box, select the CI or bulk inventory item to relocate, and click Relocate CIs.

3. From the Location list on the Search Inventory Locations dialog box, select the location where to relocate the CI, and then click Search.

4. Select the location where to relocate your CI.

5. In the Quantity field, enter the number of CIs to relocate, and then click Relocate.

Reserving and using inventory

You can reserve and use the CIs and bulk inventory items that are in inventory.

To reserve and use inventory

1. In the BMC Remedy Change Management Console, choose Advanced => Manage Inventory.

2. On the Manage Inventory dialog box, select the CI or bulk inventory item to reserve and use.

3. Click in the Transaction Qty column and enter the number of CIs or bulk inventory items to use.

Figure 100: Transaction Qty column

4. Click Reserve/Use Inventory.

5. The number of CIs or bulk inventory items in the Qty in Stock column is reduced by the number reserved and used.
Using the Configuration Manager

If the integration between BMC Remedy Change Management and BMC Configuration Automation for Clients is configured, you can open BMC Configuration Manager from the Change Management Console.

For more information, see Change and Configuration Management (CCM) on page 493.

To use the Configuration Manager

1. From the Change Management Console (log on as a Change Manager), choose Advanced => Configuration Manager.

The BMC Configuration Management console appears. This console provides a foundation on which BMC Configuration Management browser-based applications, such as Report Center and Policy Manager, run. It provides the browser-based interface, or console, through which you use the applications. It also enables you to configure system settings, which apply to all browser-based applications.

Figure 101: BMC Configuration Management Console

2. Configure the system settings through the console, as needed.

For more information, see the BMC Configuration Management Infrastructure Administrator’s Guide.
Supplemental Release Management tasks

This section contains descriptions of supplemental tasks that you might also perform when you work with Release Management.

Setting application preferences and options

When you click **Functions => Application Preferences**, you can view and edit the settings that affect the default appearance of the main application console. Depending on which applications you have installed, you can also view their preferences and options.

When an application opens, you can determine:

- Default console view.
- Forms that appear.
- Search criteria defaults.
- What happens after you save a request.
- What appears in the Overview Console.
- The Data Set Name that is selected when the form opens.
- Statistics.

**Note**

For the changes to take effect, close the application console and reopen it. The preferences you set are applicable until they are modified.
Setting application preferences - Release Management

You can specify which form appears when you create a new request or start a search.

To set application preferences for Release Management

1. From the Release Management Console, click Application Preferences.

2. On the Application Preferences dialog box, click the Release Management tab.

The following table describes the settings available on the form.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences for</td>
<td>This is a read-only field that identifies the user.</td>
</tr>
<tr>
<td>Default Home Page</td>
<td>Select the console that you want to appear as your home page when you log into the BMC Remedy Action Request System (BMC Remedy AR System) server. For example, if you want the Release Management console to appear, select Release Management Console. The default value is IT Home Page.</td>
</tr>
<tr>
<td>Company</td>
<td>Select the company that you want to appear in the Company field of the Release Management console by default.</td>
</tr>
</tbody>
</table>
| Show                        | The default console view, with the search criteria, controls which release requests appear in the Assigned Work area. You can temporarily change this setting from the navigation pane of the console. The following list shows you the available selections:  
  - **Submitted By Me** - Shows all release request that you submitted.  
  - **Assigned To Me** - Displays release requests assigned to you.  
  - **Assigned To My Selected Groups** - Prompts you to select any support groups to which you belong. You can select to display all release requests assigned to your group, or release requests assigned to your group that are not yet assigned to an individual.  
  - **Assigned To All My Groups** - Displays release requests assigned to all your support groups. You can choose to display all release requests, or release requests that are not yet assigned to an individual.  
  **Note:** If you are a new user, you must select the preference for the View Broadcast link to function correctly. |
| Confirm On Submit           | Choose whether to display a confirmation message when you submit a new release record.                                                       |
| Console Page>On Form Open   | **Data Set Name** - Choose a personal preference data set, for example, BMC Asset. For more information about how this data set is used, see Relating CIs to alternate data sets on page 251. |
### Setting Description

#### Form

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>After New Save</strong></td>
<td>This setting controls the action after you click Save on the Release form. The following list shows the available selections:</td>
</tr>
<tr>
<td></td>
<td>- <strong>New Request After Submit</strong> - Opens the Release form in New mode ready for you to record a new release.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Modify Request After Submit</strong> - Leaves the Release form open and changes the mode from New to Modify.</td>
</tr>
<tr>
<td><strong>Tab Views</strong></td>
<td>You can choose whether to show the following panels:</td>
</tr>
<tr>
<td></td>
<td>- Show Approvers</td>
</tr>
<tr>
<td></td>
<td>- Show Financials</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> These preferences apply only when you are using the Classic view.</td>
</tr>
</tbody>
</table>

#### Overview Console

You can choose whether to show release records and activities based on the status on the Overview console.

3. To select task related options, on the Application Preferences dialog box click the Task Management tab.

The following table describes the settings available on the form.

#### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Console Page</strong></td>
<td><strong>Show Task</strong> - Choose Yes to show tasks.</td>
</tr>
<tr>
<td></td>
<td><strong>Task Status</strong> - Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- All Tasks - Shows all tasks irrelevant of their status.</td>
</tr>
<tr>
<td></td>
<td>- All Open Tasks - Displays all tasks that are not in the Closed status.</td>
</tr>
<tr>
<td></td>
<td>- All Closed Tasks - Displays all tasks with the status of Closed.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
Setting the Release Management view

Release Management is configured by your application administrator. For detailed information about customizing your options to help you quickly process release requests, see BMC Remedy ITSM Configuration Guide. The following procedure provides information about setting the view.

To set the view

1. From the Applications menu, choose Application Administrator => Application Administrator Console.

2. From the Application Administration Console, click the Custom Configuration tab.

3. On the Custom Configuration tab, choose Foundation => Advanced Options => View Selection Framework - Deploy View, and then click Open.

4. In the navigation pane on the left side of the form, select the application name (Remedy Release Management) and the role (Release Classic View User for Classic view and Release Best Practice View User for Best Practice view).

5. To deploy the view to a company, perform the following steps:
   a. On the Company Mapping tab, select the company to which you are mapping the view.
   b. If necessary, change the sorting order number.
      The sorting order is used when a support group or an individual belongs to more than one company. A company with a lower sort order value takes precedence over a company with a higher sort order value.

6. To deploy the view to a support group, perform the following steps:
   a. On the Support Group Mapping tab, select the company and organization to which the support group belongs.
   b. From the Support Group list, select the support group.
   c. If necessary, change the sorting order number.
      The sorting order is used when a support group or an individual belongs to more than one company. A company with a lower sort order value takes precedence over a company with a higher sort order value.
If you need to change the sort order after you save the deployment, you must first delete the deployment by using the **Remove** button, and then re-create the deployment with the new sort order number.

7 To deploy the view to an individual, perform the following steps:

   a. On the Individual Mapping tab, select the company, organization, and support group to which the individual belongs.

   b. From the **People** list, select the individual to whom you are mapping the view.

8 To save the deployment, click **Add**.

9 Close the form and then have the affected users log back in to the application.

### Sending release or activity notifications

When a release request moves into a new Milestone and Status, for example, Deployment In Progress, Release Management generates notifications. Based on your assignee group or role (release coordinator or requester), you might receive notifications during various status transitions.

Release notifications are data-driven and easily configured. The following notifications are enabled out-of-the-box. Your administrator might have created additional notification rules.

<table>
<thead>
<tr>
<th>Milestone</th>
<th>Status</th>
<th>Release Coordinator</th>
<th>Assignee Group</th>
<th>Requester</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate</td>
<td>Draft</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Deployment</td>
<td>Deployment Approval</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Deployment</td>
<td>In Progress</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Deployment</td>
<td>Cancelled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Activities work the same way, except that no out-of-the-box notifications are enabled. Your administrator can easily configure a rule in which, for example, the activity assignee is notified when the Status of the activity is set to Draft.

For more information, see **Receiving notifications of release request assignments** on page 321. For more information about notification rules, see the **BMC Remedy IT Service Management Configuration Guide**.
Release Management predefined reports

This section lists the predefined Web reports and Crystal Reports available for Release Management that are designed to help support staff managers monitor activities related to their service desk. It provides a brief description of each report and shows you where to find it.

The activities of most release coordinators center around release request analysis, for example, determining the length of time spent on release requests, types of releases requested, and frequently repeated tasks. Release Management reports to give you quick and easy access to information about your system.

To access the Reporting Console, in the navigation pane on the Release Management console, choose Functions => Reports. You first select the type of report that you want to run. The report type pulls information from the appropriate BMC Remedy ITSM application form. After you select a report type, you select the individual report that you want to run.

Table 46 on page 417 describes the predefined Web reports and Table 47 on page 417 describes the predefined Crystal Reports included, organized by the type of report.

Table 54: Web reports—names and descriptions

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release =&gt; Configuration Item =&gt; Configuration Item Scheduled Releases</td>
<td>Shows all scheduled release requests grouped by CI</td>
</tr>
<tr>
<td>Release =&gt; Risk =&gt; Release Risk And Impact By Scheduled Start Date</td>
<td>Shows all releases with details of Risk and Impact, grouped by their scheduled start date</td>
</tr>
<tr>
<td>Release =&gt; Release Requests =&gt; Problem Records</td>
<td>Shows all problems related to the release</td>
</tr>
<tr>
<td>Release =&gt; Costs =&gt; Cost Summary/Year-Quarter by Service - Actual Cost</td>
<td>Cross-tab report that provides the actual costs by the Service CI</td>
</tr>
<tr>
<td>Release =&gt; Configuration Item =&gt; Service Scheduled Releases</td>
<td>Shows all releases scheduled by Service CI, grouped by Service CI Name</td>
</tr>
</tbody>
</table>
### Table 55: Crystal reports-names and descriptions

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release =&gt; Calendar =&gt; Releases By Calendar Date Range</td>
<td>Shows all release requests grouped within a specified range of dates</td>
</tr>
<tr>
<td>Releases By Calendar Date Range</td>
<td>Shows all release requests grouped within a specified range of dates</td>
</tr>
<tr>
<td>Release =&gt; Costs =&gt; Cost Summary/Year-Quarter by Location - Actual Cost</td>
<td>Cross-tab report that provides the actual costs incurred by the request location</td>
</tr>
<tr>
<td>Cost Summary/Year-Quarter By Location- Actual Costs</td>
<td>Cross-tab report that provides the actual costs incurred by the request location</td>
</tr>
<tr>
<td>Release =&gt; Release Requests =&gt; Activities</td>
<td>Shows all releases, grouped by Status and Date</td>
</tr>
<tr>
<td>Activities By Status and Dates</td>
<td>Shows all releases, grouped by Status and Date</td>
</tr>
<tr>
<td>Releases With Activities and Tasks</td>
<td>Shows all activities and tasks associated with releases</td>
</tr>
<tr>
<td>Release =&gt; Release Requests =&gt; Approvals</td>
<td>Shows all release requests that have been approved, grouped by their approval status</td>
</tr>
<tr>
<td>Release Approvals By Approval Status</td>
<td>Shows all release requests that have been approved, grouped by their approval status</td>
</tr>
<tr>
<td>Release =&gt; Release Requests =&gt; Change Requests</td>
<td>Shows all change requests associated with the release</td>
</tr>
<tr>
<td>Releases with Related Changes</td>
<td>Shows all change requests associated with the release</td>
</tr>
<tr>
<td>Release =&gt; Release Requests =&gt; Incident Records</td>
<td>Shows all incidents related to the release</td>
</tr>
<tr>
<td>Releases with Related Incidents</td>
<td>Shows all incidents related to the release</td>
</tr>
<tr>
<td>Release =&gt; Release Requests =&gt; Releases with Manifest Information</td>
<td>Shows all activities and changes related to releases</td>
</tr>
<tr>
<td>Releases with Manifest Information</td>
<td>Shows all activities and changes related to releases</td>
</tr>
<tr>
<td>Release =&gt; Release Requests =&gt; Unsuccessful</td>
<td>Shows all unsuccessful releases</td>
</tr>
<tr>
<td>Unsuccessful Releases</td>
<td>Shows all unsuccessful releases</td>
</tr>
</tbody>
</table>

For detailed information on generating reports, see Generating a report on page 412.

## Managing SLM service targets

If you have BMC Service Level Management (BMC SLM) installed, the Release form shows both overview and in-depth information about the release request in relation to applicable service targets. You can view the service targets and milestones for the restoration of the unavailability. Service targets and milestones are defined from within BMC SLM. Escalations can be set up to notify the assignment group prior to acknowledgment or resolution breach times.

From the Release form, you can view service targets defined in BMC SLM. Service targets can be defined in BMC SLM for response time and resolution time. Service
targets can be determined by related CIs, product and operational categorization, and many other criteria. The Next Target Date field indicates the next deadline out of all the service targets attached to the change.

For more information, see Using BMC Service Level Management with BMC Remedy Change Management on page 188.

Working with release request approvals

Certain release requests must pass through an approval process before they can be deployed. Approvals can be defined for each milestone of the release request from Initiate to Close Down.

The read-only Approval Phase field shows what approval phase the release is in during its life cycle.

The application administrators configure the approval processes. The process owner determines the approvals based on the policies of the business. They determine which release requests require approval, what kind of approval process the release requests must undergo, and who the approvers are. Support staff and management can add more approvers to the list.

Viewing release requests awaiting approval

Release coordinators submit the requests for approval and monitor the approval process.

Approvers are notified when a release request requires their approval. After reviewing the release request, they can approve it or reject it.

As an approver, you are required to review release requests for approval. You review release requests and provide approval through the Release Management application or the Approval Central.

To view the release requests awaiting approval from the Approval Central, click Pending Approvals under the Approval Tasks list of the Approval Central.

To view release requests awaiting approval from the Release Management console

1. In the Release Management console, from the Show list, select All.

2. From the Filter By list, select By Status > All Open Approvals.
The Releases table shows the release requests waiting approval.

3 Select the release request to review, and then click View.

The approver can approve or reject the release request from the Release Request form, or request further information.

**Approving or rejecting release requests**

When an approval is required to move the release request to the next status, the Process Status Flow area prompts you to approve, cancel, or reject the approval. If configured, the release request cannot be moved to the next status unless the approval is received.

When a release requires an approval, its approvers are notified. Notifications are sent according to the method specified in the approver’s record in the People form.

When you have finished planning the release request, and have supplied all the information that the approvers require to review the release request, you can submit the release request to the approval process.

*Note*
For more information, see Change Management approver role on page 355.

**Performing additional approval functions**

In addition to approving or rejecting approvals, you can perform the functions listed in the following table.
Table 56: Additional approval functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resubmit a rejected release request</td>
<td>If an approver rejects a request, the approval process is stopped. You can resubmit the request for approval.</td>
</tr>
<tr>
<td></td>
<td>1. Open the request record.</td>
</tr>
<tr>
<td></td>
<td>2. From the process flow bar, at the stage the request was rejected, select <strong>Restart</strong>.</td>
</tr>
<tr>
<td></td>
<td>The request status is set to Pending Approval for the stage at which it was cancelled.</td>
</tr>
<tr>
<td></td>
<td>3. When approving the request after it was restarted, users can enter details for restarting the request in the Work Info.</td>
</tr>
<tr>
<td></td>
<td>When using the Best Practice view: On the Work Detail tab, select the Work Info and click <strong>View</strong>. When using the Classic view, click the Work Info tab.</td>
</tr>
</tbody>
</table>

Selecting release templates

The Release Template function allows you to select any templates that can be made available for your support group. You use release templates to quickly and efficiently create *standard* releases with a minimum of mouse clicks and keyboard entry. Release templates are useful in any release request that follows well-defined methods for specific and repeated requirements, for example, Installs, Moves, Add Changes (IMAC). New and occasional users to Release Management should find release templates very helpful.

**To select release templates**

1. Create or open a release request.

2. Do one of the following:
When using the Best Practice view

1. Click the magnifying glass icon next to the template field on the release form.
2. Select the support group from the Viewing Templates for Support Group.
3. Select the desired template from the list displayed.

When using the Classic view

To attach a release template click **Quick Links => Select Template** on the left navigation pane.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can apply a release template to a release request in any status before Approval and as long as the request is not waiting any approval. You can select a release template only once for each release request.</td>
</tr>
</tbody>
</table>

3. On the Release Template Selection dialog box, click **View** to examine the contents of a release template.

The template appears in read-only mode. Viewing a template lets you see its relationship, its task and task group templates, and other important features.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot create, modify, or delete release templates in the Release Management application; you can only view them. You must use the Application Administration Console to create, modify, or delete release templates instead. Any member of your support group with Release Master permissions can modify release templates for that group. For more information, see the <strong>BMC Remedy IT Service Management Configuration Guide</strong>.</td>
</tr>
</tbody>
</table>

4. Select a template and click **OK**.

The contents of the template are applied to the release request. The release template overwrites any field values that are already present in the release request. If the release request already includes relationships or manifests, these are not overwritten. Any additional manifests from the template are added as peers, and additional relationships, for example, CIs, are included with the release request.
Selecting activity templates

The Activity Template function allows you to select any templates that can be made available for your support group. Activity templates are useful in any activity that follows well-defined methods for specific and repeated requirements.

To select activity templates

1. Create or open an activity.

2. From the navigation pane on the left side of the form, choose Quick Links => Select Template.

3. On the Activity Template Selection dialog box, click View to examine the contents of an activity template.

   The template appears in read-only mode. Viewing a template lets you see its relationship, its task and task group templates, and other important features.

   **Note**

   You cannot create, modify, or delete activity templates in the Release Management application; you can only view them. You must use the Application Administration Console to create, modify, or delete activity templates instead. Any member of your support group with Release Coordinator permissions can modify activity templates for that group. For more information, see the BMC Remedy IT Service Management Configuration Guide.

4. Select a template and click OK.

   The contents of the template are applied to the activity. The activity template overwrites any field values that are already present in the activity. If the activity already includes tasks, these are not overwritten. Any additional tasks from the template are added as peers.

Using the Release Management KPI flashboards

The KPI flashboards use graphs to show how well various release management business processes are performing against the Release Management key performance indicators (KPIs). If installed, you can also view the Release Management KPIs from BMC SMPM.
For a list and a description of the Release Management KPIs, see “Release Management KPIs” on page 451.

*Tip*

The BMC SMPM defines a key performance indicator as: A vital and measurable result to track the efficiency, effectiveness, and predictability of a process.”

The KPI data is collected from a variety of application forms by the underlying KPI flashboard component according to the customer company selected at the top of the KPI tab. Each KPI flashboard contains two graphs that present the following types of information:

- Relevant historical data, which you can use for trending purposes.
- Current data collected at regularly scheduled times, depending on the specific KPI you are viewing.

**Release Management KPIs**

This section contains a list and a description of the Release Management key performance indicators.

**Table 57: BMC Remedy Release Management KPIs**

<table>
<thead>
<tr>
<th>KPI title</th>
<th>Description of graph content</th>
<th>Frequency of data collection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Successful Releases</td>
<td>This graph displays the number of closed releases with the Status Reason field set to “Successful”, compared to the total number of closed releases.</td>
<td>Monthly</td>
</tr>
<tr>
<td>Backlog of Releases</td>
<td>This graph displays the number of releases that do not yet have their Status field set to “Completed” or higher.</td>
<td>Daily</td>
</tr>
</tbody>
</table>

**Release Management KPI flashboard variables**

KPI flashboards use variables to fetch the data that is used to create the flashboard graphs for the selected company. In most cases, you can control what data appears in the graph by choosing to hide or display one or more of the active variables.

See “Table 50” on page 424 for information about how to hide or display variables.
Table 58 on page 452 lists the Release Management KPI graph types, the active variable names, and the meaning of the information provided. This will help you to understand the effects of choosing to hide or display a specific variable.

### Table 58: Release Management KPI flashboards variables

<table>
<thead>
<tr>
<th>Graph type</th>
<th>Variable name</th>
<th>Data displayed by the variable</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Successful Releases</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Historical</td>
<td>RMS:RMS:SuccessfulReleaseHistory</td>
<td>Releases that were closed successfully for the last year (if the data exists), for the selected company.</td>
</tr>
<tr>
<td></td>
<td>RMS:RMS:SuccessfulReleaseHistoryC0</td>
<td>Releases that were closed unsuccessfully for the last year (if the data exists), for the selected company.</td>
</tr>
<tr>
<td>Real time</td>
<td>RMS:RMS:SuccessfulReleases</td>
<td>Releases that were closed successfully for the month (if the data exists), for the selected company.</td>
</tr>
<tr>
<td></td>
<td>RMS:RMS:SuccessfulReleases_C0</td>
<td>Releases that were closed unsuccessfully for the month (if the data exists), for the selected company.</td>
</tr>
<tr>
<td><strong>Backlog of Releases</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Historical</td>
<td>RMS:RMS:BacklogofReleasesHistory</td>
<td>Completed release requests for the last year (if the data exists), for the selected company.</td>
</tr>
<tr>
<td>Real time</td>
<td>RMS:RMS:BacklogofReleases</td>
<td>Completed release requests as of date (if the data exists), for the selected company.</td>
</tr>
</tbody>
</table>

### Viewing and displaying data

After the Cost of Failed Changes flashboard opens, there are controls on the flashboard that help you view and display the data. The actions that you can perform and the procedures that you use to perform them are the same as those described for the KPI flashboards under KPI flashboard actions and procedures.

See, Viewing and displaying data from the KPI flashboards on page 424.
Managing configuration items

Overview - Configuration items

You can define a new Configuration item (CI), search for CIs, and update records within BMC Remedy Change Management. When creating a CI name, follow a consistent naming convention. According to ITIL guidelines, use identifiers that are short, but meaningful. For hardware, do not use identifiers that are based on supplier device names. For example, the name might include an indicator of the CI’s function (such as Workstation” or Monitor”) followed by a numeric code, such as MONITOR100.

Note

When creating CIs in BMC Remedy Change Management, if BMC Remedy Asset Management is not installed on your server, the data is always taken from the AST:AppSettings form. For more information, see Relating CIs to alternate data sets on page 251.

A configuration item (CI) is any component of an infrastructure.

Some CI types are virtual, while others are physical. The Service CI type is an example of a virtual CI. In this context, a service can be provided from one business or organization within a business to another. Service CIs can include customer support, employee provisioning, web farms, storage, and so on.

Other CI types are physical and include hardware and software.

You can use the information in CIs to determine if a change to a CI or the IT infrastructure must be made. To record information against CIs, such as CI unavailability, or to relate a change request to a CI, the CI must be recorded in the BMC Remedy Atrium CMDB. If you do not have BMC Remedy Asset Management, then BMC Remedy Change Management provides limited ability to manage CIs and inventory.
Creating a CI

To create a CI, you must have Asset Admin permission. If you have Asset User permission and you are modifying a CI, your administrator must open the appropriate CI, and then relate your support group to the CI.

There are many different types of CIs that you can create. While the general procedure for creating each CI type is similar, only the specific fields on the CI form change depending on the CI type.

This section provides several examples of how to create CIs.

To create a Service CI

Note

Step 1 on page 454 to Step 5 on page 344 creates the service CI. Step 6 on page 210 to Step 14 on page 456 relates the service CI to a company. This is necessary to ensure the service CI appears in the Service field menu on the Classification tab, when relating the incident request to a company.

1. From the Navigation pane of the Change Management console, choose Advanced Functions => Manage CIs.

2. From the CI Type list, select Logical Entity => Business Service and then click Create.

3. On the Business System form, type the CI name and description.

Best practice

When creating a CI name, BMC recommends that you follow a consistent naming convention. According to ITIL guidelines, identifiers should be short but meaningful. For example, Payroll” or Network.” The name can be followed by a numeric code, such as NETWORK100.
4 Complete the optional fields that appear on the form in a way that is appropriate for the service you are creating.

Table 59: Optional fields when creating a Service CI

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI ID</td>
<td>A customer specified identifier. You can use this to augment the CI Name.</td>
</tr>
<tr>
<td>Company</td>
<td>The company that owns the service.</td>
</tr>
<tr>
<td>Impact, Urgency, and Priority</td>
<td>Used to determine service levels when assigning support.</td>
</tr>
<tr>
<td>Supported</td>
<td>Indicates whether the service currently is supported.</td>
</tr>
<tr>
<td>System Role</td>
<td>A description of the role the service fulfills in the organization.</td>
</tr>
<tr>
<td>Additional Information</td>
<td>A place to record any additional information about the service.</td>
</tr>
<tr>
<td>Users Affected</td>
<td>The number of users who use this service.</td>
</tr>
</tbody>
</table>

5 Click **Save**.

**Note**
Depending on how your application is configured, after you click Save to create a Service CI, the Service CI form might be redisplayed in a Modify window.

**Note**
The People tab referred to in the following procedure does not appear on the Business Service form until you create and save the CI. The Relationships tab, Outage tab, and Impact tab also appear after you save the new CI. If the People tab does not appear after you click Save, then search for and open the CI record as described in *To reassign a change request yourself on page 219*, and then continue with *Step 6 on page 210*.

6 Open the People tab and click **Add**.

7 From the Type list select People Organization and then click **OK**.

8 From the Company list in the Organization Search window, select the company to which you are relating the service and then click **Search**.

**Note**
If you are relating the service to the entire company, then skip *Step 9 on page 210*.

9 If you need to relate the service either to an organization within the company or to a department within the organization, select the organization and, if necessary, the department from the Organization and Department lists.
- **Organization**—If you choose Organization, the service is related to the specified organization within the specified company.

- **Department**—If you choose Department, the service is related to the specified department within the specified organization.

10 From the Choose a Relationship Level list, select how much of the company will be related to this service.

For example, if you are relating the service to the entire company, then select Company. If you specified department in the preceding step, then select Department, and so on.

11 Click **Select**.

12 From the Role list in the Asset Person Role window, select Used By and click **OK**.

13 Click **OK** to dismiss the confirmation note.

14 Click **Save** and then click **Close**.

**To create a computer system CI**

1 From the Navigation pane of the Change Management console, choose **Advanced Functions => Manage CIs**.

2 From the CI Type list of the CI Type dialog box, select **System => Computer System**.

3 Click Create.

4 In the CI Name field of the Computer System form, type a name for the CI.

   **Best practice**

   When creating a CI name, BMC recommends that you follow a consistent naming convention. According to ITIL guidelines, identifiers should be short but meaningful, and for hardware they should not be based on supplier device names. For example, the name can include an indicator of the CI’s function (such as Workstation” or Monitor”) followed by a numeric code, such as MONITOR100.

5 In the CI ID field, type a unique alphanumeric value for the CI.

6 Select the company to which this CI belongs.

7 From the Primary Capability and Capability lists, select the roles this CI performs in your company’s topology.
8 Select a status from the Status list. The default value is Ordered. You can select one of the following options.

**Table 60: Computer system CI status options**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordered</td>
<td>The CI was ordered from the supplier.</td>
</tr>
<tr>
<td>Received</td>
<td>The CI was received in shipping.</td>
</tr>
<tr>
<td>Being Assembled</td>
<td>The CI is being assembled.</td>
</tr>
<tr>
<td>Deployed</td>
<td>The CI was installed.</td>
</tr>
<tr>
<td>In Repair</td>
<td>The CI is down for maintenance.</td>
</tr>
<tr>
<td>Down</td>
<td>The CI is down, but not yet in maintenance.</td>
</tr>
<tr>
<td>End of Life</td>
<td>The CI is no longer being deployed.</td>
</tr>
<tr>
<td>Transferred</td>
<td>The CI was transferred to another place.</td>
</tr>
<tr>
<td>Delete</td>
<td>The CI is marked for deletion. You must be a member of the APP-Management or APP-Administrator group to mark a CI for deletion.</td>
</tr>
<tr>
<td>In Inventory</td>
<td>The CI is in inventory but not yet deployed. When you select this status, you are prompted to select the inventory place.</td>
</tr>
<tr>
<td>On Loan</td>
<td>The CI is on loan to another location.</td>
</tr>
<tr>
<td>Disposed</td>
<td>The CI is no longer available and was disposed of.</td>
</tr>
<tr>
<td>Reserved</td>
<td>The CI was reserved and taken out of inventory.</td>
</tr>
<tr>
<td>Return to Vendor</td>
<td>The CI must be returned to the vendor as damaged or unwanted.</td>
</tr>
</tbody>
</table>

9 Specify whether the CI is supported by selecting Yes or No from the Supported list.

10 Select what impact or urgency this CI will have if it goes down.

11 In the Users Affected field, specify the number of people who use this CI or are affected if it goes down.

12 Complete the other fields in this area.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag Number</td>
<td>The CI tag number. This is the number usually placed on the product by a member of your IT department to track the CI.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>The CI serial number.</td>
</tr>
</tbody>
</table>
13 Click the General tab.

14 Categorize your CI using the lists and fields in the Product Categorization area.

15 Specify the place of the CI using the lists and fields in the Location area.

16 Enter the dates of the CI in the lifecycle area.

17 Click the Specifications tab.

18 Add more information about the CI.

19 Click Save.

**To create a bulk inventory CI**

*Note*

Bulk inventory items are not tracked by an separate record for each item. Instead, bulk items are tracked by quantities of an item type. For example, cables used to connect desktop computers to the network do not require individual records but rather, one record for a bulk quantity of the specific cable type.

1 From the Navigation pane of the Change Management console, choose **Advanced Functions => Manage CIs**.

2 From the CI Type list of the Manage CI Information dialog box, select **Bulk Inventory => Bulk Inventory**, and click **Create**.

3 In the Bulk Inventory form, complete the following required fields.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Name</td>
<td>Enter the name of the bulk inventory item, for example, Microsoft Windows XP.</td>
</tr>
<tr>
<td>Tier 1, Tier 2, and Tier 3</td>
<td>Categorize the item.</td>
</tr>
<tr>
<td>Received Quantity</td>
<td>Enter the number of items received.</td>
</tr>
</tbody>
</table>

4 Click **Save**.
To create an inventory location CI

*Note*
You can use inventory location CIs to indicate where bulk inventory and other CIs are located.

1. From the Navigation pane of the console, choose **Functions => Manage CIs**.
2. From the Type list of the Manage CI Information dialog box, select **System => Inventory Location**, and click **Create**.
3. In the CI Name field of the Inventory Location form, enter the location name.
4. Complete the optional fields.
5. Click **Save**.

Searching for CIs from the Change Management console

Use the following procedure to search for CI records from the Change Management console. Use this procedure any time you need to open a CI record to see details about it, or to modify it.

**To search for CIs from the Change Management console**

1. From the Navigation pane of the console, choose **Functions => Manage CIs**.
2. From the CI Type list on the Manage CI Information window, select the type of CI and click **Search**.
3. On the search form provide information about the CI and click **Search**. Click **Search** without entering any information in the form to search for all available CIs.
4. Select the CI from the search results displayed on the top of the page. Details of the selected CI are displayed in the CI form.
Inventory management

You can use the Manage Inventory function to track bulk inventory items and other CIs that are available for deployment.

Before you can track inventory, you must:

- Create bulk inventory CIs, or other CIs to be tracked as inventory. For information about how to do this, see “To create a bulk inventory CI” on page 458 or “To set the view” on page 392.

- Create inventory location CIs. For information about how to do this, see “To create an inventory location CI” on page 459.

- For bulk inventory, specify the received quantity and the inventory locations. For information about how to do this, see To enter requester information using the Best Practice view on page 124.

- For non-bulk inventory CIs, set the inventory status to In Inventory, and select a location. For information about how to do this, see To place non-bulk CIs in inventory on page 461.

Placing bulk CIs in inventory

To place bulk CIs in inventory, you must specify the location or locations for them.

**Tip**

If you do not see a location, make sure that the CI has a CI type of inventory location, and not physical location. For information about creating inventory locations, see To create an inventory location CI on page 459.

**To place bulk CIs in inventory**

1. Open a bulk CI, as described in To reassign a change request yourself on page 219.

2. On the Inventory Location tab, click Add.

3. In the Search Inventory Locations dialog box, specify the search criteria and click Search.

4. Select a location, and click Relate.

5. In the message about the relationship, click OK.
6 If the inventory is stored in multiple locations, for each location, repeat Step 4 on page 460 and Step 5 on page 218.

7 Click **Close**.

   On the Bulk Inventory form, the Inventory Location tab lists each of the related locations.

8 Click in the Quantity Per Location field for a location, and type the quantity in that location.

9 Continue to enter the quantity for each location, until all the quantity in stock for the bulk CI is accounted for.

10 Click **Save**.

   After items are in inventory, you can use the Manage Inventory function to:

   - view
   - relocate
   - reserve and use CIs and bulk inventory items

**Placing non-bulk CIs in inventory**

You can place non-bulk CIs that you want to manage in inventory by changing the status of the CI to In Inventory, and then designating a location for that CI.

**To place non-bulk CIs in inventory**

1 Open a CI, as described in To reassign a change request yourself on page 219.

2 From the Status list, select In Inventory.

3 Click **OK** in the confirmation message that appears.

4 In the Search Inventory Locations dialog box, from the Location list, select a location, make sure other values are correct, and click **Search**.

5 Select a location and click **Return**.
Managing inventory tasks

This section describes how to perform inventory management tasks that you most commonly use.

To search for CIs from the console

1. From the Navigation pane of the console, choose Advanced Functions => Manage CIs.

2. From the CI Type list on the Manage CI Information window, select the type of CI and click Search.

3. On the search form provide information about the CI and click Search. Click Search without entering any information in the form to search for all available CIs.

4. Select the CI from the search results displayed on the top of the page. Details of the selected CI are displayed in the CI form.

To view inventory locations

1. From the Navigation pane of console, choose Advanced Functions => Manage Inventory.

2. Enter your search criteria in the Manage Inventory dialog box, and click Search. Results matching your search criteria appear in the table.

3. Select a CI or bulk inventory item from the table, and click View Location.

4. View the CIs in the inventory listed in the Inventory Location form.

5. Click Close.

To relocate CIs

1. From the Navigation pane of the console, choose Advanced Functions => Manage Inventory.

2. Search for inventory in the current location using the Manage Inventory dialog box.

3. Select the CI or bulk inventory item you want to relocate, and click Relocate CIs.

4. For the location where you want to relocate the CI, specify search criteria, and click Search in the Search Inventory Locations dialog box.
5 Select the location where you want to relocate your CI.

6 In the Quantity field, enter the number of CIs you want to relocate.

7 Click **Relocate**.

**To reserve and use inventory**

1 From the Navigation pane of console, choose Advanced **Advanced Functions** => **Manage Inventory**.

2 From the CI Type menu in the Manage Inventory dialog box, select the CI or bulk inventory item you want to reserve and use.

3 Click **Search**.

4 Click in the Transaction Qty column and enter the number of assets or bulk inventory items you want to use.

*Figure 102: Manage Inventory dialog box with transaction quantity*

5 Click **Reserve/Use Inventory**.

The number of CIs or bulk inventory items in the Qty in Stock column is reduced by the number reserved and used.
Working with the Overview console

The information in this section is for people who fulfill one or more of the following support roles:

- problem coordinators
- service desk analysts
- specialists
- group coordinators
- on-duty managers

Use the Overview console if you must respond to, manage, or track individual or group work assignments from a variety of sources. For example: if your company runs the full BMC Remedy ITSM suite, either you or the group you manage might receive work assignments from BMC Remedy Incident Management, BMC Remedy Problem Management, and BMC Remedy Change Management. From the Overview console, you can quickly get information about all your work assignments and perform the procedures that you use most often.

As you work with the forms and dialog boxes associated with this console, you might see a plus sign (+) included in a field label. You can type part of the information next to these fields and press ENTER. If an exact match is located, the program automatically completes the field. If a selection list appears, double-click the item you want to put in the field. Using auto-fill fields and lists is faster, more consistent, and more accurate than typing the information.

Functional areas

This section illustrates the functional areas of the Overview console and describes what you can do in each of the functional areas.
Table 61: Overview console functional areas

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview Console header</td>
<td></td>
</tr>
<tr>
<td>Search</td>
<td>The Global search feature lets you search across multiple forms for records that match a key term.</td>
</tr>
</tbody>
</table>
## Functional areas

<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| **Show Company**        | This area contains the following fields: Show and Company. These fields combine to provide a way that you can filter the change records in the console table.  
The Show field provides a filter by which you can manage the contents of the Console List table. The choices are:  
  - **All** — Shows all records  
  - **Submitted By Me**— Shows all records submitted by you.  
  - **Assigned To Me**— Shows all records assigned to you.  
  - **Assigned To My Selected Groups**— Asks you to select one of the groups to which you belong, and then displays the records assigned to that group.  
  - **Assigned To All My Groups**— Displays the records assigned to all of the support groups to which you belong.  
The Company field restricts the criteria that you choose in the Show field for the selected company. This helps you manage the number of records returned by the Show field. |
| **Refresh**             | Refreshes the data in the tables.                                                                                                     |
| **Navigation pane**     | **View Broadcast, or New Broadcast**  
  Opens the broadcast dialog box, from where you can view, create, modify, and delete broadcasts.  
  When there are unread broadcast messages, this area displays a message: New Broadcasts, followed by the number of new messages. When there are new broadcast messages, the area also turns red.  
  **Note:** If you open the Overview console with no new broadcast messages, but the View Broadcast link is red, open the Application Preferences dialog box and make sure that a Console View preference has been selected.  
  See Broadcasting messages on page 402 for more information about broadcasting messages. |
| **Functions**           | Use the links in this area to do the following actions:  
  - **Select Status Values**— See only those records in a certain state, which you specify from the Select Status Values dialog box. See Selecting status values on page 469.  
  - **My Profile**— Set your profile. See Viewing your profile on page 393.  
  - **Application Preferences**— Set your program preferences and options. This function is also available from the application console. |
<p>| <strong>IT Home Page</strong>        | Use this link to open the IT Home Page.                                                                                               |
| <strong>ROI Console</strong>         | Use this link to open the Return on Investment (ROI) console.                                                                        |</p>
<table>
<thead>
<tr>
<th>Functional area</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMDB</td>
<td>Use this link to open the BMC Atrium CMDB.</td>
</tr>
</tbody>
</table>

**Console List panel**

<table>
<thead>
<tr>
<th>View</th>
<th>Displays a form containing detailed information about the selected record in the Console List table.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>Creates a new record.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays a report of the record contents that can be printed.</td>
</tr>
<tr>
<td>Search for Ticket</td>
<td>Opens a dialog box from which you can select the type of ticket you are searching for. After you select the type of record from the menu, click the Select button to open a search form specific to the type of ticket you are searching for. <strong>Note:</strong> To see activity records and CI unavailability records, you must search for those tickets, because these records are not displayed in the Console List table.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Using Preferences, you can control the appearance of the Console List table. For example, you can add or remove a column.</td>
</tr>
</tbody>
</table>

**Console List table**

The Console List table lists different types of requests. The types of requests that you can choose from depend on the applications that are installed.

A specific prefix identifies each type of request:

- **CRQ** — Identifies change requests. To view and define change requests, BMC Remedy Change Management must be installed.

- **RLM** — Identifies release requests. To view and define release requests, BMC Remedy Change Management must be installed.

- **TAS** — Identifies tasks.

- **SDB** — Identifies solution database entries. To view and define solution entries, BMC Remedy Service Desk must be installed.

- **INC** — Identifies incidents. To view and define incidents, Service Desk must be installed.

- **PBI** — Identifies problems. To view and define problems, Service Desk must be installed.
- **PKE**—Identifies known errors. To view and define known errors, Service Desk must be installed.

- **PR**—Identifies purchase requisitions. To view and define purchase requisitions, BMC Remedy Asset Management must be installed.

You can also change the table’s contents by using the Show and Company filters at the top of the console:

**Show**—Shows records that either are assigned to you or to your support groups.

- Submitted By Me - All change requests created by you.
- All - All change requests, regardless of who created them.
- Assigned To Me - All change requests assigned to you.
- Assigned To My Selected Group - All change requests assigned to a specific support group of which you are a member. If you select this, you are prompted to select the support group.
- Assigned To All My Groups - All change requests assigned to all of the support groups of which you are a member.

**Company**—Shows records that are created for the selected company.

If there are more entries than the system can show in the table, use the arrow keys at the right top corner of the table to scroll through the table.

## Selecting status values

You can use the Select Status Values dialog box to filter the requests that appear in the Overview console based on their status.

### To select status values

1. From the Navigation pane, choose **Functions => Select Status Values**.

2. In the Select Status Values dialog box, select the status values for each category from the lists, then click **OK** to close the dialog box.

3. If the Assigned Work table does not refresh with the filtered records, click **Refresh** to reload the table’s contents.
Working with the Requester console

The Requester console enables users to quickly submit changes and incidents to BMC Remedy Change Management and BMC Remedy Incident Management.

*Note*
If you have BMC Service Request Management installed, the Requester console is replaced by BMC Service Request Management. For information about BMC Service Request Management, see *BMC Service Request Management User’s Guide*.

Requester role

User’s of the Requester Console are usually employees who need assistance from the IT support staff. The user or requester is typically an employee in the organization who must have a change implemented or an incident resolved. But any member of your organization can be a requester.

However, the user might not be an employee. Non-employees can also be requesters, since non-registered users can also submit service requests.

Traditionally, after a requester made a telephone call to a central help desk, a support staff member logged the request. BMC Remedy Incident Management and BMC Remedy Change Management provide user self-provisioning. Using the Requester console, requesters can submit, track, and (in some cases) resolve their own requests, and, as a result, improve the overall efficiency. BMC Remedy Change Management and BMC Remedy Incident Management are preconfigured to work with the Requester console. However, an organization can set an option to make the Requester console unavailable.

The Requester console is the primary interface for requesters to define and view their requests. From the Requester console, you can define a request that is submitted to BMC Remedy Change Management and BMC Remedy Incident Management. You can also view requests and respond to a survey after the request has been resolved.
Figure 104 on page 472 illustrates the key areas on the Requester console.

**Figure 104: Requester console key areas**

---

**Requester console users**

The following user permissions can be used for accessing the Requester console to submit service requests:

- **Request Master** – This user is responsible for troubleshooting service requests. The request master can view requests submitted by other users and view the details of a record in the Service Request form. This user is more of an administrator, than a support user.

- **Registered User** – This user has a record in the People form, and the user’s AR login information is in the Login/Access Details tab of the People form or in the AR System User form.

- **Unknown User** – All other users are considered to be unknown users even if the user has a record in the People form. If a user’s login information is not in the People form, the user is considered a unknown user.
For unknown users who do not have an AR System login to be able to access the Requester console, the AR System server Allow Guest User option must be selected. The Allow Guest User option is unavailable in multi-tenancy mode (for more information about multi-tenancy, see the BMC Remedy IT Service Management Guide to Multi-Tenancy). Also, the AR Submitter locked mode option must be selected for users with a read-only license to respond to surveys. A default People record with a valid AR System login must be defined in the application for use by unknown users. For more information, see the BMC Remedy IT Service Management Configuration Guide.

If a user meets any of the following conditions, the user type is unknown user:

- The user has an entry in the People form and in the AR System User form, but does not have an AR System Login ID in the People form.
- The user has an entry in the People form, but does not have an entry in the AR System User form or an AR System Login ID in the People form. This type of user is also an AR System Guest User.
- The user does not have an entry in the People form, but has an entry in the AR System User form.
- The user does not have an entry in the People form or in the AR System User form. This type of user is also an AR System Guest User.

Some other factors that control allowing unknown users access to the Requester console follow:

- Unknown users are not allowed access if the multi-tenancy option is selected. Multi-tenancy restricts access of data from different companies or business units.
- In addition to setting the Tenancy Mode to Single-Tenancy, the Allow Unknown Users option must be set to Yes and login information added. The console is the entry point for users to define, view, update, or cancel service requests.

**Working with service requests**

This section describes working with service requests.
Defining a service request

BMC recommends the New Request wizard as a simplified method of submitting service requests. You can also define service requests from the Change and Incident Request forms.

To define a service request

1. From the Requester console, click **Create a New Request**.

   ![New Request wizard](image)

   Figure 105: New Request wizard

   Pay careful attention to the following items for the Requester section:

   - If you are a registered user, the fields in the Requester section are filled from your People record. You can edit only the Phone and Email fields.
   - If you are an unknown user, the First Name and Last Name fields are filled with your login information. The Company is filled with the company name. Unknown users must enter information in the Phone and Email fields.

2. Complete the required fields, as shown in bold with an asterisk.

   a. Select a definition from the Summary list that you have defined.

      If the list does not contain the specific request to log, you need to create the summary definition. For more information about creating summary definitions, see the *BMC Remedy IT Service Management Configuration Guide*. 

Working with service requests

474  
*BMC Remedy Change Management User Guide*
Note
If BMC Remedy BMC Remedy Change Management and BMC Remedy Incident Management is installed, entering a summary or ad hoc request generates an incident request. If only BMC Remedy Change Management is installed, a change request is generated.

If you select a summary definition that is an incident request, related solution database entries appear in the Possible Solutions table. If BMC Remedy Problem Management is not installed, possible solutions do not appear for manually entered summaries.

If there is a solution database entry that might be valid, click the entry, and then click View. Review the solution entry. If the solution resolves your request, click Use Solution.

If you choose a matching solution, the solution entry is related your request and the request is resolved automatically.

b Select an Urgency level for your request.

c If you do not have a record in the People form, enter your company, first name and last name.

3 (Optional) Click Add Attachment to enter request work information. You can include a note or an attachment.

4 Complete the optional fields:

- **Date Required**—Enter a date by when you require that this request to be completed.

  **Note**
  If a change request is created for the service request, the date is populated as the Requested Date on the Date/System tab of the Change request.

- **Phone**—Enter or edit your phone number.

- **Email**—Enter or edit your email address.

5 Click **Save**.

The request appears in the My Requests table.
Service request state changes

For changes and incidents, the My Requests table console lists the status of its underlying service request. Users are notified by email when a service request undergoes a status change, for example, when a service request is moved from In Progress to Completed or a change request reaches the Completed state.

Performing other service request functions

In addition to defining a service request, you can perform the functions listed in the following table. All the listed functions are performed from the Requester console.

Table 62: Additional service request functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
</table>
| Filter your service requests          | Click the appropriate link from the View Requests section, located in the Navigation pane, and then select Open or All.  
**Note:** Open is the default view. To change the default view, select another sort option, and then click **Save As Default View**. |
| View a service request                | From the My Requests table, select the service request, and then click **View**. Only the requests that the logged in user has submitted appear in the My Requests table. Change requests are prefixed with CRQ and Incident requests are prefixed by INC. |
| Add work information                  | From the My Requests table, select the service request, and then click **View**. Click the Add Work Info link in the Console Functions section of the Navigation pane.  
You can add:  
- A summary of the work log in the Summary field.  
- Additional information in the Notes field.  
- An attachment. You can add only one attachment for each work information entry. To add multiple attachments, add multiple work information entries. |
| Search for a request by request ID    | In the General Functions area of the Navigation pane, click Search by Request ID, and then enter the complete Request ID or the numeric part of the ID.                                                                 |
| Print a service request               | From the My Requests table, select the service request, and then click **Print**. Review the report, and then click the Print icon on the toolbar.  
**Note:** If you are having problems printing from BMC Remedy User, choose **Tools => Options in BMC Remedy User**. On the Advanced tab of the Options dialog box, make sure the ODBC Use Underscores option is selected. |
<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel a service request</td>
<td>From the My Requests table, select the service request, and then click <strong>Cancel</strong>. The Status changes to Cancelled. You can only cancel a service request that is open.</td>
</tr>
<tr>
<td>Reopen a request</td>
<td>From the My Requests table, select the service request, and then click <strong>Reopen</strong>. The Status changes to New, Staged, or In Progress. You can only reopen service requests that are completed or rejected.</td>
</tr>
<tr>
<td>Complete a survey</td>
<td>From the General Functions are of the Navigation pane, click <strong>View Survey</strong>, select a survey, and then click <strong>Respond</strong>. Type your responses to the questions, and then click <strong>Save</strong>. After your service request is completed, you are notified through email to respond to a survey. To enable surveys, they must defined for your company and the option must be selected.</td>
</tr>
<tr>
<td>View broadcast messages</td>
<td>View the broadcasts by clicking the Broadcast link in the Navigation pane. <strong>Note:</strong> If there are new broadcasts, the label on the link changes to New Broadcast, and the color of the link changes from gray to red. To view more details, select a broadcast entry, and then click <strong>View</strong>. Broadcasts are filtered by the logged-in user’s company. If the logged-in user’s company cannot be determined, only Global broadcasts appear. Only Public” messages are shown to the requesters.</td>
</tr>
</tbody>
</table>

**Troubleshooting service requests with errors**

If the service request cannot be completed because of an error from BMC Remedy Change Management or BMC Remedy Incident Management, you can view which service requests contain errors and review the event log to troubleshoot the service request. If the error is the result of integration or other configuration issues, you can also see the *BMC Remedy IT Service Management Configuration Guide* for information to help you troubleshoot the problem.

**Note**

To see service requests with errors, you need Command Event Master permissions in addition to Requester console Master permissions.
To view requests with errors

1. From the Navigation pane of the Requester console, choose **Request Errors => View Requests with Errors**.

Figure 106: Service Request form—entries containing errors

2. Click the Change/Incident Data tab.

3. Click **Reset Error** to restart the service request.

Users can now continue to work on the service request.

4. Click **View Events** to review the event log and troubleshoot the service request.

5. View the event details:
   - Protocol
   - Access Mode
   - Error Code
   - Error Message

6. Take any of the following actions for events that are in error:
   - Retry
Ignore

**Best practice**
It is best to retry each event in the order the events are generated. By default, the event table is sorted with the recent event on top, in reverse chronological order. Typically events should be retried when the problem indicated by the error message has been fixed.

**WARNING**
Delete service requests with caution. They cannot be recovered. You must have AR System Administrator permissions to delete service request records.

### Viewing service request details from a change request form

When someone submits a service request from which BMC Service Request Management subsequently generates a change request, you can view information about the originating request from the change request form. The information available includes the date on which the service request was submitted, who submitted it, and the related company. You can also view information about approvers, an activity log, and process flow diagram showing the status of the request.

1. Open a Change Request form.

2. In the navigation pane, click **Advanced Functions > View Service Request**.
Change request status transitions

This section describes the state transitions of a Change request, starting from Draft to Closed. Task Phases have not been included here.

State transitions - Draft to Closed

You can use the following change request status transition information to follow the flow of a change request from Draft to Completed status.
Note
The Change Implementer is applicable only when using the Classic View.

Figure 107: State transitions—Steps 1 to 7

1 A change request starts in the Draft status. Any related task groups or tasks are in Staged status.

2 When the request moves through the process flow:
- If approvers are mapped to the Review approval phase, the request remains in the Request For Authorization status.

- If no approvers are mapped to the Review approval phase, the request moves to the Request for Change status and requires the change manager or the change coordinator to move it forward.

- If no approvers are mapped to any of the approval phases and you are using only the standard approvals, the request moves to the Planning In Progress status and requires the change manager or the change coordinator to move it forward.

- If the Timing of the request is Latent, it moves to the Completed status.

3 The Review approval phase requires that the request be approved before it can move forward. If the request is approved, it moves to the Request for Change status.

4 If no approvers are mapped to the Business Approval phase, the request moves to the Planning In Progress status and requires the change manager or the change coordinator to move it forward.

   By default, No Impact changes follow the Business Approval - No Impact phase and move forward to the Scheduled status.

5 The Business Approval phase requires that the request be approved before it can move forward.

   - If the request is approved, it moves to the Planning In Progress status.

   - If the request is cancelled, it moves to the Cancelled status.
6 When the change manager or the change coordinator add dates to the request, or when the Status Reason of all the tasks has been marked as Staging Complete, the request moves to the Scheduled for Review status.

Figure 108: State transitions—Steps 8 to 16

7 The change manager or the change coordinator can move the request to the Schedule for Approval status, cancel it, or move it back to the Planning In Progress status.
8 The request remains in the Scheduled for Approval status if there are approvers in the Implementation Approval phase. If no approvers are mapped to the phase, the request moves to the Scheduled status and requires the change manager or the change coordinator to move it forward.

9 If the request is approved, it moves to the Scheduled status. The change manager and the change coordinator can approve the request on behalf of approvers, if they are defined as alternates.

10 The change manager or the change coordinator must move the request to the Implementation in Progress status. For taskless changes only, the change implementer is notified.

11 When the change manager or the change coordinator move the request into the Implementation in Progress status, the task group is set to Work in Progress and the first task is set to Pending or Assigned.

12 Task implementers can start work on tasks. When all tasks are marked Closed, the change manager or the change coordinator enter information into Actual Start Date, Actual End Date, and Performance Rating fields to move the request to the Completed status.

   If the Status Reason is set to Final Review Complete, the request moves to Completed status. If the Status Reason is set to Final Review Required, the request moves to Close Down Approval phase.

13 After last task is marked as Closed, task group is set to Closed. Change automatically moves to Completed (Final Review Required) status when all tasks are completed and there are approvers for Close Down Approval phase. Change managers and change coordinators can approve requests on behalf of approvers if they are defined as alternates.

14 The approval group or individual approvers are notified that change requests require approval for Close Down Approval phase. The request is placed in Completed status with status reason of Final Review Required. If approved, Status Reason is automatically updated to Final Review Complete. If no approvers are mapped to the Close Down Approval phase, the request moves to the Completed status.

15 The change manager is notified when final review is completed. The request moves to Completed (Final Review Complete) status if all tasks are completed or if there are no approvers for the Close Down Approval phase. The Requested For user (Requester tab) is then notified.
Note
At this stage, the change manager can change the status of the request back to Planning in Progress or Pending, if required.

Figure 109: State transitions—Steps 17 to 19

16 After the final review is completed, the request moves into Closed status.
17 If a change has been rejected, it can be moved back to Cancelled status. The change manager or the change coordinator can also move it back to Draft status and start the process over. The Requested For user is notified of the rescheduled change.

18 If change request is cancelled, the Requested For user is notified.
   - If a change request is cancelled, all the task groups and tasks associated with the request are also cancelled.
   - If a task group is cancelled, all its tasks are cancelled.

State transitions of change requests

Some status transitions in the change request lifecycle can be performed only by users who have been assigned a specific role. For example, while all users can move a change request into Request For Authorization status, only a change manager can cancel a change request.

Note

Some status transitions in the change request lifecycle can be performed only by users who have been assigned a specific role. For example, while all users can move a change request into Request For Authorization status, only a change manager can cancel a change request.

This table describes the successive stages and approval phases of a change request. It also identifies legal status transitions for each of these forms.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Approval phase</th>
<th>Status</th>
<th>Description</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate</td>
<td></td>
<td>Draft</td>
<td>Verifies that all the fields required to generate the change request are entered in the Change form. Use the Draft status to record a change request without submitting it to the Change Management process. For information, see Initiate stage - Creating change requests on page 113.</td>
<td>Next stage</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Enter pending (or resume)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cancel</td>
</tr>
</tbody>
</table>

Appendix A  Change request status transitions 487
### State transitions of change requests

<table>
<thead>
<tr>
<th>Stage</th>
<th>Approval phase</th>
<th>Status</th>
<th>Description</th>
<th>Tasks</th>
</tr>
</thead>
</table>
| Initiate      | Review         | Request for Authorization | Change is in the Review approval phase. If it is approved, only then does it move forward to the Review & Authorize stage. For information, see Approval processes provided out-of-the-box on page 357. | ■ Approve  
■ Reject  
■ Cancel |
| Review & Authorize | Business Approval | Request for Change | Change is in the Business Approval phase. Enables approvers to review the request and authorize it. For information, see Approval processes provided out-of-the-box on page 357. | ■ Approve  
■ Reject  
■ Cancel |
| Plan & Schedule | Planning In Progress | Tasks can be built at any change status except Completed. For information, see Working with relationships on page 220. | ■ Next stage  
■ Enter pending (or resume)  
■ Relate CI  
■ Cancel |
| Plan & Schedule | Scheduled for Review | The change manager reviews and validates the change plans. For information, see Working with relationships on page 220. | ■ Next stage  
■ Enter pending (or resume)  
■ Cancel |
| Plan & Schedule | Implementation | Scheduled for Approval | Change is in the Implementation Approval phase. Each level of approvers must review the request and approve it. For information, see Approval processes provided out-of-the-box on page 357. | ■ Approve  
■ Reject  
■ Cancel |
<table>
<thead>
<tr>
<th>Stage</th>
<th>Approval phase</th>
<th>Status</th>
<th>Description</th>
<th>Tasks</th>
</tr>
</thead>
</table>
| Plan & Schedule       |                                 | Scheduled       | The request is included in the Forward Schedule of Changes (FSC) Calendar.                                                                                                                                     | ■ Next stage  
■ Enter pending (or resume)  
■ Relate CI  
■ Cancel                                                                                                                     |
| Implement             |                                 | Implementation in Progress | At least one task related to the request is in progress.  
For information, see Working with relationships on page 220.                                                                                   | ■ Next stage  
■ Enter pending (or resume)  
■ Cancel                                                                                                                     |
| Implement             | Close Down Approval             | Completed       | Change is in the Close Down Approval phase. The request is completed, but needs approval to reach the Closed stage.  
For information, see Approval processes provided out-of-the-box on page 357.                                                 | ■ Approve  
■ Reject  
■ Cancel                                                                                                                     |
| Implement             | Close Down Approval             | Completed       | Change is in the Close Down Approval phase. The request is completed, but requires final review approval to reach the Closed stage.  
For information, see Approval processes provided out-of-the-box on page 357.                                                 | ■ Approve  
■ Reject                                                                                                                     |
### Additional status values for change requests

This table describes the additional status values for change requests, for example, if an approval has been rejected.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Approval phase</th>
<th>Status</th>
<th>Description</th>
<th>Tasks</th>
</tr>
</thead>
</table>
| Implement   |                | Completed | Reviewers verify change was implemented and all required tasks have been completed. KPIs analyzed. | ■ Next stage  
■ Enter pending (or resume)  
■ Previous stage - Planning in Progress or Pending  
■ Cancel |
| Closed      |                | Closed   | If the status reason is Successful, Post Implementation Review has been completed and any necessary Closedown Approvals have been granted. No further activities are performed on the change request. Other status reasons include:  
■ Successful with Issues  
■ Unsuccessful  
■ Backed Out | None |

- For a helpful overview of how task statuses compare to change statuses, see [Relation of task statuses to change statuses on page 262](#).
- For state transition diagrams that depict the status flow of change requests, see [Change request status transitions on page 481](#).
Table 64: Additional change status values

<table>
<thead>
<tr>
<th>Change request status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Work on the request has been suspended temporarily. The Status Reason field is required to describe the reason for interruption.</td>
</tr>
<tr>
<td>Relate CI</td>
<td>In the Plan &amp; Schedule stage, you can search for configuration items and relate them to the change requests. For more information, see Working with related configuration items on page 246.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The request has been rejected by an approver at any Approval Phase.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The request is no longer required or current change plans must be modified.</td>
</tr>
</tbody>
</table>

Requirements for status reasons

Users can identify a requirement for additional status reasons. This table shows only the applicable status reasons. You must specify the status reason when the Change Request Status is Pending.

Table 65: Change request status reasons

<table>
<thead>
<tr>
<th>Change request status</th>
<th>Status reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning In Progress</td>
<td>■ Accepted</td>
</tr>
<tr>
<td></td>
<td>■ Assigned</td>
</tr>
<tr>
<td></td>
<td>■ Built</td>
</tr>
<tr>
<td>Implementation in Progress</td>
<td>■ In Rollout</td>
</tr>
<tr>
<td></td>
<td>■ In Development</td>
</tr>
<tr>
<td></td>
<td>■ In Test</td>
</tr>
<tr>
<td></td>
<td>■ In Built</td>
</tr>
<tr>
<td></td>
<td>■ In Rollback</td>
</tr>
<tr>
<td></td>
<td>■ In Documentation</td>
</tr>
<tr>
<td></td>
<td>■ In Verification</td>
</tr>
<tr>
<td>Change request status</td>
<td>Status reasons</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------</td>
</tr>
</tbody>
</table>
| Pending               | ■ Future Enhancement  
                        ■ Manager Intervention  
                        ■ Miscellaneous  
                        ■ Support Group Communication  
                        ■ Task Review  
                        ■ Vendor Purchase  
| Rejected              | ■ Insufficient Task Data  
                        ■ Insufficient Change Data  
                        ■ Schedule Conflicts  
| Completed             | ■ Final Review Required  
                        ■ Final Review Complete  
                        ■ Additional Coding Required  
| Closed                | ■ Successful  
                        ■ Successful with Issues  
                        ■ Unsuccessful  
                        ■ Backed Out  
                        ■ Automatically Cancelled  
| Cancelled             | ■ No Longer Required  
                        ■ Resources Not Available  
                        ■ To Be Re-Scheduled  
                        ■ Funding Not Available  

Additional status values for change requests

492  BMC Remedy Change Management User Guide
Change and Configuration Management (CCM)

This section provides an overview of Change and Configuration Management (CCM).

About Change and Configuration Management (CCM)

Closed loop integration with BMC Configuration Automation for Clients is the mechanism for the accelerated execution of a change request. It also provides verification that the change was successfully performed, based on requirements specified in the change request.

When you perform a change to the configuration of IT managed resources, you must maintain consistency and control through the entire process. A closed loop approach makes sure that the change is properly documented, assessed, tracked, implemented, and verified. A closed-loop CCM solution from beginning to end makes sure that the change requested was completed. All these stages are provided
in the CCM suite of products. This section provides an overview of the integration points between the components in the solution.

**Figure 110: BMC Remedy CCM solution overview**

The BMC CCM solution addresses three types of change essential to an IT organization:

- **Software packaging**
- **Patch deployment**
- **Software license management**

Among the numerous advantages in using BMC’s CCM solution are these:

- Consistent identification of Configuration Items (CI) and Software Library Items (SLI) throughout the change process, which improves communication between members of the support staff.
- Reduction of cost and overhead using an integrated out of the box solution that preserves flexibility.
- Automatic transfer of critical information between steps to maintain the integrity of the change.
- Closed loop verification of software-related tasks to make sure that the change was successful and to provide an audit trail.

At the heart of the CCM solution is the Remedy Administrator. The Remedy Administrator, in the context of ITIL, supports the following primary functions:
- Accounts for all IT assets.
- Provides accurate information to support other Service Management processes.
- Provides a sound basis for Incident, Problem, Change, Asset, and Release Management.
- Enables the verification (and correction) of records against the infrastructure.
- Provides access to federated data stored outside the Remedy Administrator, but linked to CIs, extending the Remedy Administrator functionality to a vast datastore of related information and detailed attributes.
  - Related information, such as detailed Incident or Discovery data, does not qualify as a CI, but its data relationships with CIs enable you to view it through the Remedy Administrator.
  - Detailed attributes, such as machine details or problem records, are CI attributes you do not track at the Remedy Administrator level.

## Processing Configuration Management tasks

A change request can include multiple configuration management tasks, each essential to the successful implementation of the change. The CCM Task Management Subsystem (TMS) manages these tasks in a sequence you define.

The CCM solution organizes tasks into three main categories:

- Policy-based
- Deployment-based
- Verification-based

### Policy-based tasks

BMC Configuration Automation for Clients enables you to maintain centralized control of packaged data and applications across the enterprise. You administer the state of each endpoint on your network using Policy Manager. A policy consists of a list of software packages or patches your targets (users, computers, or groups) are expected to have. Use Policy Manager to manage the state of software and data on an ongoing basis.

Policy-based tasks include:
- Deploying applications and data
- Deploying patches
- Harvesting licenses when you have exceeded maximum limits
- Enforcing the removal of unauthorized applications

**Deployment-based tasks**

BMC Configuration Automation for Clients also supports the deployment of large volumes of software or data, and execution of one-time jobs. You administer these tasks using Deployment Manager (DM). Use DM to run *deployment jobs* that typically do not require ongoing management. Deployment-based tasks include distribution of:

- Data
- Applications
- Commands and scripts

**Verification-based tasks**

The Task Management Subsystem launches verification tasks when it receives notification that a policy-based task has succeeded. You can verify compliance for policy-based tasks based on a target, package, or both.

You can configure TMS to launch verification tasks manually or automatically. The system verifies tasks based on:

- The compliance percentage of specified targets or software packages.
- A time window that you specify for completing the task.

**CCM solution overview**

The need for a company to have the latest version of a software program installed on their system is a perfect example of a typical CCM solution. The following scenario describes a CCM solution in which users interact with the BMC Remedy ITSM suite, including an IT Product/Service Catalog and fulfillment. Imagine users who need Adobe Acrobat on their computer. This requires that the IT organization undertake a service-related Change process.
The following figure illustrates how to initiate such a change request.

**Figure 111: Lifecycle of a change request**

1. **Initiate** — The user submits a service request to install the latest version of Adobe Acrobat. A manager receives a notification of the service request requiring approval. The manager sees no problem with this request for change (RFC) and approves it. Workflow then generates a change request ID.

   Business rules in BMC Remedy Change Management make sure that the RFC is automatically routed to the appropriate support group or individual. The Change Manager receives notification that an RFC has been assigned to him. In this scenario, the Change Manager is also the Change Coordinator.

   Because this request is not urgent, workflow routes the RFC as a standard change. However, the Change Manager recognizes that the entire company, not only this user, should receive the latest version of Acrobat. As a result, even though the change’s urgency is medium and its timing is normal, the impact of such a company-wide installation is extensive.

   If the request is urgent, for example, a mission critical server has crashed, then an entirely different business policy would be implemented.

2. **Review & Authorize** — The Change Manager plans a forward schedule of changes (FSC). The change request includes planning all the changes approved for
implementation, targeting dates, and estimating the risks and costs. The time segment for the change is scheduled on the calendar. The Change Manager reviews the RFC and verifies that the correct change request template and tasks are connected to the change request generated by the service request. Here the Change Manager relates the two Policy Manager and Compliance Check tasks (already provided with BMC Remedy Change Management) to the change request, and edits the appropriate change request and task information as necessary.

The Change Manager updates the RFC by adding the appropriate implementers or assignees for the tasks, and any Backout, Test, and Implementation plans, if needed. Finally, the Change Manager adds the appropriate date information for the tasks and updates the Status of the RFC from Planning in Progress to Scheduled.

3 Plan & Schedule—Because this is a standard change, the business rules dictate that this type of change does not require more approvals. The Change Manager approves it.

If the change request requires additional approvals, for example, because the change’s impact is widespread and potentially disruptive to users, the Change Manager initiates the approval process. In this case, each level of approvers must review the request and approve it. Within the ITIL framework, the Change Advisory Board (CAB) must approve all significant changes.

4 Implement—Workflow routes the tasks to the task implementers. BMC Configuration Automation for Clients takes over the process of task management and verification. The Task Management Subsystem (TMS) within BMC Remedy Change Management hands off policy, deployment, or verification tasks in the specified sequence. You can configure verification tasks to kick off manually or
automatically, but after TMS initiates them, they run automatically. The following figure illustrates the lifecycle of a configuration management task.

Figure 112: Lifecycle of a Configuration Management task

In CCM, task implementers can review the task, initiate a launch of the BMC Configuration Automation for Clients application suite, make any necessary edits to the deployment or policy, execute the task, and then verify that the task has been completed. Tasks are an important part of an automated, closed-loop solution that can automatically track an RFC from Initiation to Planning, Implementation, and Verification. All necessary information regarding the task identifier, target, and packages is automatically transferred to BMC Configuration Automation for Clients.

5 Create Policy — The task implementer receives notification of the task to install the latest version of Adobe Acrobat throughout the company. The task implementer uses BMC Remedy Change Management to view the Install Acrobat” task.

Unlike a change request process — where multiple users engage in the request, planning, approval, implementation, and review stages — a Configuration
Management task process benefits from automation features in the update or deployment stages.

In this scenario, the first step is saving a policy. The task implementer defines or updates a policy, then reviews job details.

**WARNING**

If you open a BMC Configuration Automation for Clients console window from BMC Remedy Change Management to edit a policy or deployment job, make sure you work on only one Configuration Management task during that session. Launching new browser windows can generate session conflicts and corrupt your data.

As the change request enters the Implementation stage, task implementers log their progress as they work to implement the change request and its related tasks. When the first task is completed, task implementers for the next stage in the sequence are notified of their task assignment. Task implementers can calculate the cost of implementing their tasks.

6 **Review Details** — The task implementer reviews the details and makes any necessary edits.

The task implementer views task details from TMS, retrieving data based on the Change ID and Task ID, and defines a new policy as required.

BMC Remedy Change Management fills out the program’s online form with the Remedy Administrator data the task requires, in this case, a target. The Remedy Administrator contains a single source of truth about the content and configuration of computers on your network. The Remedy Administrator is updated as task implementers work on the CIs that need improvement or alteration. In addition to the target information provided by the Remedy Administrator, the Definitive Software Library (DSL) provides source information about Software Library Items (SLIs). SLIs represent the packaged software and data available in the system.

Because the task implementer’s company has deployed the integrated CCM solution with seamless authentication, which uses web services as the communication protocol between BMC Remedy Change Management and BMC Configuration Automation for Clients, the task implementer can open the task from BMC Remedy Change Management or BMC Configuration Automation for Clients without having to retype a user ID and password.

7 **SPM:Update** — The task implementer uses Policy Manager to update policy information and store the policy in the directory service. When the policy is saved, Policy Manager sends a Success message to TMS.

8 **Get Details** — When tuners running on the endpoints check in, they receive their new policy and update the local system. Because packaged applications use the BMC Configuration Automation for Clients channel format, the process takes advantage of file compression, bandwidth throttling, checkpoint restart, and byte-
level and file-level differencing. The location of a package application is captured in the DSL as Software Library Items are available for future service requests. At the scheduled time, the Policy Service running on their systems updates all company computers.

9 **Query Compliance** — The verification task queries the BMC Configuration Automation for Clients inventory database for information about the compliance percentage you specified as the threshold for success, and elapsed time. The goal IT configured in the compliance task was to deploy the software on 80 percent of the company’s computers within seven days.

When the task achieves the specified compliance level or the time window expires, the verification process sends a status message to TMS. In this scenario, the verification process notifies TMS that the task completed successfully. In this case, at least 80 percent of the systems are in compliance within seven days.

All necessary information about the task identifier, target, and packages is automatically transferred to BMC Remedy Change Management.

If the task is not successful, the task verification process notifies TMS of the failure. Details of the failure from BMC Configuration Automation for Clients are recorded in the Work Info tab of the change request and the task is closed with a status reason of Failed.

The configuration management lifecycle is now finished. BMC Remedy Change Management picks up the process again at the Review step.

10 **Review and Close** — The change request enters the Review stage. The task implementer must now verify that the task has been completed.

**Figure 113: Review**

During the task and verification process, BMC Configuration Automation for Clients captures audit trail data, including:

- Task ID
- Change ID

- Time stamps

- Machines

In BMC Configuration Management’s Report Center, you can view predefined queries on the Machine Details page summarizing tasks performed on any computer. For more information, see the Report Center Administrator’s Guide (available on the Customer Support website) or Report Center help.

When all task implementers finish their tasks and mark them as Closed in BMC Remedy Change Management, CCM automatically verifies the status of the task and the system notifies the requester that the change request has been resolved.

If the task is successful, CCM marks the task as Closed. The requester is automatically notified that the change request has been resolved.

When the requester is notified of the status change, the requester can close the change request by setting Confirm Resolution to Closed. If the requester does not close the change request, the request closes automatically after a preconfigured time. If the change request is part of a dependent sequence, the Change Manager for the next change request in the sequence is notified.

Reviewers verify that the change request was completed successfully. For example, reviewers can analyze key performance indicators (KPIs) that apply performance analytics to the change, such as how many incidents the change eliminated. Reviewers can also analyze the accuracy of the Remedy Administrator.

The service request and the RFC are Closed.
Index

A
accelerators, process flow 29
accessing
  Change Calendar 95, 107
  Configuration Manager 438
  Operational Catalog Listing dialog box 95, 107
  Policy Manager 351
  Product Selection dialog box 95, 107
  View Broadcasts dialog box 94, 106
active variables
  described 422, 428, 451
activities 377
  assigning 329
  assignments, reviewing 379
  closing 387
  creating 326
  creating assignments 328, 379
  creating tasks 383
  dates 386
  financial information 385
  managing 325
  modifying 381
  reassigning 381
  templates 450
activity assignees
  about 375
  activities, working on 144, 376
  modifying activities 381
Activity form
  about 109
  functional areas 109
ad hoc
  change tasks, relating 265
  requests 475
Add Approver dialog box 369
Add Attachment dialog box 405, 407
adding
  alternate approvers 369
  approvers to change requests 367
  costs to change requests 183
  predefined task groups to change requests 267, 353
  predefined tasks to change requests 267, 353
  time segments 169
additional user roles 40
Advanced Qualification dialog box, generating reports 415
advanced qualifications, using to generate reports 415
Advanced Search Selection dialog box 97
allocating costs to CIs 186
alternate approvers
  acting as 370
  adding 369
alternate data sets, relating CIs to 251
application administrators
  configuring approvals 355
  responsibilities 42
  working with Change Management 42
approval central 362
Approval Process Configuration form 355, 362
approvals
  about 146, 339
  bypassing standard process 366
  change request 144, 148
  change requests 367
  creating 182
  default phases 362
  emergency 366
  multiple 364
  pending, viewing 148
  phases 487
  process 355
  process flow status bar, using 364
  release management approval processes 360
  release request 446
  status, viewing 31
approvers
about 355
adding alternate 369
adding to change requests 367
alternate, acting as 370
Change Advisory Board (CAB) 40
change requests 148
multiple 364
responsibilities 356
viewing 148
viewing non-approver notifications 371
working with Change Management 40
Approvers tab 339
Assigned Work table 468
assigning
automatically, change requests 212
change requests, about 211
change requests, manually 214
tasks to change implementers 216
reassigning change requests 219
reassigning release requests 318
release requests automatically 318
release requests manually 322
release requests, about 316
sequence numbers, change 128
sequence numbers, change request 243
task group sequence numbers 268
task sequence numbers 268
assigning change requests
manually 214
assignment
denying reassignment 157
assignment tab
change form 217
Change form 157
Assignment tab 328, 379
Change form 214
release form 322
Task form 270, 272, 344
assignments
accepting 344
availability, updating 394
creating work orders 328, 379
group notification 213, 321, 380
individual notification 321
individual notifications 213
Remedy Alert notification 321, 343
view 213
work orders 329, 379
Associate Time Segment to CIs dialog box 173, 299
Atrium Impact Simulator
change requests, creating 134
CI impact, viewing on change requests 237
audit logs, viewing 181
Authoring Group dialog box 406
auto-cost estimates 185
available time segments
search 170
B
Best Practice view
Change Management 32
Release Management 66
Best Practice view, described 32
best practices
CI naming conventions 454, 456
ITIL 28
process flow status 29
using CIs to diagnose user problems 453
blackout schedule, creating 164
BMC Atrium CMDB
functions defined by ITIL 494
viewing CI relationships 168
BMC Configuration Management Policy Manager...
See Policy Manager
BMC Remedy Alert 381
change coordinator notification 213
release coordinator notifications 321
task implementer notifications 343
BMC Remedy Change Management
scenarios 51
BMC SLM
Change Management, integrating with 189
Customer tab in change request 192
status gauge 190
tab (changes) 189, 192
tab (releases) 445
breadcrumb bar 79
Broadcast Details tab 404
Broadcast Search Criteria tab 403
Broadcast Submitter role 404
broadcasts
about 402
CI unavailability 260
create 403
creating 404
limiting 403
modify 403
view, 403
Build milestone for release management 309
Business Approval - No Impact phase 358, 483
Business Approval phase 359, 483
Business Event/Location Definition dialog box 159, 297
business events
  registering 158
  viewing in Change Calendar 201
business justification
  change requests 128
  release requests 286, 398
business models, sample 47
Business Time Segment dialog box 159, 165, 297, 298

C

Calbro Services 50
Calbro Services user data 35
calendars. See Change Calendar
Cancelled state 483
CCM. See Change and Configuration Management
changing request form views, described 32
change administrators. See application administrators
Change and Configuration Management
  about 493
  CCM solution 496
  predefined task groups 347
  predefined tasks 347
  Task Management Subsystem 495
change approvals
  status, viewing 31
Change Calendar
  filter criteria 197
  opening 197
  quick links 201
  time zone preferences 202
tooltip data 197
  viewing 194
  viewing business events 201
  viewing change requests 200
Change Calendar. See Change Calendar
Change Class 120
change coordinators
  accepting assignments 211, 316
  assignments notification 321
  change requests, creating 114
  notifying assignments 213
  reassigning change requests 219
  responsibilities 208
  using change form 93
  using Change Management Console 85
change dependencies, viewing 246, 340
Change Environment field 128
Change form
  about 93
  audit logs 181
  change templates, selecting 429
  Classification tab 127, 152
  copying change requests 431
  Date/System tab 151
  Dates tab 151, 307
designating change implementer 40
Email System link 96
e-mail, sending from 406
Financials tab 188
functional areas 93, 94
impacted areas 182
pages, sending from 406
Relationships tab 222, 231, 233, 234, 333, 335
Reminders link 96
Requester tab 124
stages, viewing 28
Task tab 265–267
Work Detail tab (Best Practice view) 130
Work Info tab (Classic view) 130
change implementers
  assigning change requests 216
  designating in Change form 40
  responsibilities 40
  working with Change Management 40
Change Initiation dialog box 119
Change Location Company field 125, 285
Change Location of the Requester tab 182
change management
  approvals process 146
  user roles 36
Change Management
  integrating with BMC SLM 189
introduction 21
requester role 471
roles, approver 355
roles, change manager 111
service targets, viewing 189
Change Management Console
about 113
CIs, searching for 459
Company and Console View 91
Configuration Manager, opening 438
flashboards 88
functional areas 85
generating reports 88
inventory
locations 436
inventory, reserving 437
inventory, using 437
relocating CIs 436
reminders 398
tooltip data 91
using 85

Change Management Dashboard form 206
Change Management Dashboard. See Dashboard
Change Management KPI flashboards
active variables 422
change manager
about 111
change managers
approvals process 146
approvals, about 355
approving change requests 144, 446
change request approvals 144
ITIL 355
managing SLM targets 189
planning change requests 305
reassigning change requests 156
responsibilities 112
user role 37
using Change Management Console 85, 113
working with Change Management 37

Change Reason field 126, 127
Change Relationship Search dialog box 243
change request lifecycle 36
change request status
relation to task status 262

change requests
approval phases 487
approvals 30, 147, 362
assigning, about 211
Atrium Impact Simulator 134
automatically assigning 212
basic steps, creating 114
calculating costs 183
Closed stage 153
completing 153
controlling progression 30
copying 431
costs 183
costs, modifying 185
creating 114
creating approvals 182
dependent 143
emergency 133
emergency requests, approvals 366
Initiate stage 114
lifecycle 497
modifying 138
peer 143
Plan & Schedule stage 149
planning 149
predefined task, task groups 353
process flow 28
Process Flow Status bar 29
progress, viewing 179
reassigning 219
registering time segments 157
rejecting 147
related change tasks 181
related CI 247
related configuration items 247
related predefined task groups, tasks 267
relationships 220
removing related 246, 340
resolving 153
Review & Authorize stage 140
rollbacks 156, 210
sample business model 47
sequence 143
SLM targets 189
stages 28, 487
status reason requirements 491
status transitions 487
viewing approvals 148
change tasks. See tasks
change template
associating custom process flows 430

Change Template Selection dialog box 429
change templates 429
   associating with custom process flows 430 using 115
change templates, creating 119
Change Type field
   changes 122
   Releases 284
CI Advanced Search form
   changes 165
   release 298
CI relationship types 230
CI Relationship Viewer 168
CI Relationships Search form
   change coordinator 247, 254
   task implementer 350
CI Status Information tab 258
CI unavailability
   additional information 255
   creating 253
   existing records 256
CI Unavailability Search form 254
CIs. See configuration items
Class field 126, 127
Classic view
   Change Management 34
   Release Management 67
Classification tab
   Change form 140
Close Down Approval phase
   approvers 359
   status transition 485
Close Down milestone in release management 312
Closed stage of changes 153
collision detection
   release requests 176, 291
Command Event Master permission 477
Company and Console View 91
Company field
   Change Location 125, 285
   multi-tenancy (change requests) 91, 125
   multi-tenancy (release requests) 285
Completed (Final Review Complete) state 485
Completed (Final Review Required) state 485
Completed Date field 155
Completed state 483, 485
Configuration Information form 247
configuration items
   additional unavailability, creating 255
   allocating costs to 186
   alternate data sets, relating 251
   change requests 220
   change requests, relating 247
   CI Relationship Viewer, using 168
   default global approval process 358
   impact on changes 237
   locations 436
   modify CI unavailability 259
   naming conventions, best practice 454, 456
   non-bulk 461
   outage information, modify 259
   problem diagnosis 453
   related change requests, viewing from 247
   related to change requests 246
   relationships in BMC Atrium CMDB, viewing 168
   relocating 436, 462
   searching for 459
   Service CI type 123
   status 457
   time segments, creating 164
   unavailability, broadcast 260
   unavailability, creating 253, 256
   unavailability, delete 260
   unavailable to change requests, relating 253
configuration management tasks
   about 495
   deployment-based 496
   life cycle 499
   policy-based 495
   predefined CCM 347
   verification-based 496
Configuration Manager, using 438
   consoles
      Overview 465
      Requester 471, 472
   conventions, documentation 19
   coordinator group field, behavior described 32, 66
   Copy Infrastructure Change dialog box 431
   Copy Related Relationships form 240
   copying
      change request relationships 240
      change requests 431
   copying tasks 432
   Cost Allocation form 187
   Cost User permissions 183
costs
  additional functions 188
  change request, calculating 183
  change requests, adding to 183
  configuration items, allocating to 186
  Cost User permissions 183
  estimating 185
  modifying change request 185
  negating 183
  reversing 183
Costs dialog box 184, 185, 259
create relationship to link 231
create release requests
  Best Practice view 277
  Classic view 282
creating
  additional CI unavailability 255
  approvals for change requests 182
  broadcasts 404
  change requests, dependent 243
  CI unavailability 253
  CI unavailability (alternate method) 256
  custom searches 409
  effort logs 217, 320
  related change requests 242
  relationships between change requests 222, 231, 243
  requester records 397
  service requests 474
  service targets in change requests 192
  time segments 158
  time segments, configuration items 164
  work order assignments 328, 379
  work order task groups 383
  work order tasks 383
creating, change requests
  as change coordinator 114
crystal reports
  license 411
custom process flows
  associate 430
  associating with change templates 430
custom searches 408, 409
  creating 409
  editing 411
customer field, behavior described 33
data sets
  alternate 251
  preferences 251
Date/System tab
  Change form 140
Dates
  activities 386
  change requests 151
  release requests 307, 311
denying reassignment
  change request 157
  change task 272
dependencies
  change request 220
  configuring enforcement levels 143
  creating between change requests 243
  specifying change request sequence 243
dependent change requests 220
Deployment Manager 496
Deployment milestone in release management 311
deployment-based tasks 496
DM. See Deployment Manager
documents available for ITSM 15
Draft state 482

E
Earliest Start Date 151
inging custom searches 411
effort logs
  creating for change 217
  creating for release 320
  tracking assignee time 273
e-mail 406
  Email System link on Change form 96
  Email System link on Release form 108
  sending from Change form 406
Email System dialog box 406
emergency change requests
  approving 366
  defining 133
enforcement, configuring dependency levels 143
Existing Configuration Item Unavailability dialog box 255

F
fields
  standards for labels 83
Final Review Complete status reason 485
Final Review Required status reason 485
Financials tab 188, 347
flashboards 88

D
Dashboard
  about 203
  using 203

BMC Remedy Change Management User Guide
forms
  Release Template Selection 449
  Add Approver 369
  Add Attachment 405, 407
  Advanced Qualification 415
  Advanced Search Selection 97
  Approval Process Configuration 355, 362
  Associate Time Segment to CIs 173, 299
  Authoring Group 406
  Business Event/Location Definition 159, 161, 297
  Business Time Segment 159, 165, 297, 298
  Change 28, 40, 93
  Change Management Dashboard 206
  Change Relationship Search 243
  Change Template Selection 429, 450
  CI Advanced Search 165, 298
  CI Relationships Search 247, 254, 350
  CI Unavailability Search 254
  Configuration Information 247
  Copy Infrastructure Change 431
  Copy Related Relationships 240
  Cost Allocation 187
  Costs 184, 185, 259
  Email System 406
  Existing Configuration Item Unavailability 255
  Impacted Areas 182
  Manage Inventory 436
  My Group Selection 346
  New/Modify Broadcasts 260
  Operational Catalog Listing 95, 107
  Paging System 407
  People 397
  Print Properties 202
  Product Selection 95, 107
  Registration for Shared Time Segment 162–164, 167, 168
  Relationship Attributes 350
  Relationships for Configuration Item 248
  Release 60, 105
  Reminder Details 400
  Reminders 400
  Risk Assessment Questions 142
  Search Inventory Locations 437
  Search Operational Categorization/Location Definition 159, 161
  Search Time Segment 163, 168
  Select Template 267, 349
  Simple Qualification 414
  Software Library Item Search 350
  Task 266
  Time Segment Analysis 170
  User Defaults 202
  User View 206
  Work Info 352

G

generating
  reports with advanced qualifications 415
  reports with qualifications 413
  reports without qualifications 412
  standard reports 412

global flag, multi-tenancy and 201
Global search 82
groups 267
  assignment notification 213, 321
  non-approver notifications, adding 372
  notifications of work order assignments 380
  viewing
    task 265
  See also support groups

I

icons
  Compute Level 121
  icons, recognizing 84
impact analysis in Review & Authorize stage of changes 140
Impact field
  change requests 120
  release requests 284
impacted areas, viewing 182
Implement stage
  task assignments 343
  tasks, working with 260
Implementation Approval phase 359, 485
Implementation in Progress state 485
In Production Date field 155
incident requests, viewing related service targets 189
Index Term 26, 75
individual non-approver notifications, adding 372
  individual notifications of work order assignments 380
Information Technology Infrastructure Library. See ITIL
Initiate milestone in release management 277
Initiate stage of change requests 114
inventory 460
  managing locations 436
  non-bulk CIs 461
  reserving 437, 462
  using 437
  viewing locations 436, 462
ITIL
  best practices 28
  BMC Atrium CMDB functions 494
  change managers 355

K
Key Performance Indicator (change),. See KPI flashboards
Key Performance Indicator (Release),. See KPI flashboards
known error request type 226
KPI flashboards
  changing the appearance of 424, 425
described 420, 450
enlarging 424, 425
opening the Flashboard console 423
view and display controls 424, 428, 452
viewing underlying records 424

L
LDAP Object request type 227
Lead Time field 122, 127
lifecycle
  change requests 36, 47
  release requests 60
limiting number of broadcast messages 403
Locked field (work information) 132
logs
  audit, viewing 181
effort (Change form) 217, 273
effort (Release form) 320

M
Manage Inventory dialog box 436
Manifest tab 291
manifests
  creating 288
  working with 323
Manufacturer field 123
messages,. See broadcasts
Model/Version field 123
modifying
  costs 185
  profile 393
  records 396
  reminders 400
  work orders 381
multi-tenancy
  Change Location Company field 125, 285
  changes 91, 125, 201
  Company field 91
global flag 201
  releases 285
  unknown users 473
My Group Selection dialog box 346
my searches
  custom searches 408, 409
  managing 408, 409

N
New Request Wizard, defined 474
New/Modify Broadcasts dialog box 260
Non-Approver Notifications dialog box 372, 373
non-approver notifications, adding individual 372
non-bulk CIs, placing in inventory 461
Non-Phased deployment type of releases 283
Notes field 128
notification
  individual 380
  Remedy Alerts 213
task implementer 343
Notification Audit tab 182
notifications
  activity assignment 380
  activity by BMC Remedy Alert 380
  adding individual or group non-approval 372
  audit log entries 181
  change management 400
group work order assignment 380
  groups 400
  individual work order assignment 380
  release management 443
  Remedy Alert 213, 321
  roles 401
  sending 400, 443
  triggering with state changes 400, 443
  viewing non-approver 371
See also assignments
Notifications tab (change requests) 408
Policy Manager
  Closed Loop Verification task and 353
  Create and Modify Policy task and 353
  launching 351
  managing software and data 495
  updating policies 500
  using SLIs 249
  policy-based tasks 495
predefined
  task groups 267, 347, 353
  tasks 267, 347, 353
predefined reports
  Crystal Reports 416, 444
  Web reports 416, 444
preferences
  advanced change management options 392
  advanced release management options 442
  change management 389, 439
  change request view 392
  data sets 251
  new change request form 390
  new release request form 440
  new Release request form 440
  release management 389, 439
  release request view 442
  search change request form 390
  search release request form 440
Print Properties dialog box 202
printing
  records 395
Priority field 121
Problem Investigation request type 228
process flow
  accelerators 29
  change request 28
  moving changes to another state 138
  moving releases to another state 286, 308–310, 312
  status bar 30
process flow status bar
  change management 29, 138
  change requests 29
  release management 286, 308–310, 312
  requests, approving 364
process flows. See custom process flows
Product Categorization fields 122
Product Name field 123
Product Selection dialog box 95, 107
profile, viewing and modifying 393
Qualifications
- Change request, customizing 192
- Qualification Builder in service targets 192
- Qualifications, generating reports with 413

Quick Links
- Change Calendar 201
- Release Console 110

Reassigning
- Change requests 156, 219
- Change requests, denying 157
- Release requests 318
- Tasks
  - Denying 272
  - Work orders 381
- Reassigning release requests 319
- Recent records, viewing 79
- Recording activities 130
  - Classic view 131
- Records
  - Handling 394
  - Modifying 396
  - Printing 395
  - Searching 395
- Refreshing data 467
- Registering
  - Business events 158
  - Operational categorizations 158
  - Time segments 157
  - Users 472
- Registration for Shared Time Segment form 162–164, 167, 168

Rejections
- Change requests 147
- Release requests 339, 447
- Resubmitting 367
- Related change requests 242
- Unavailable CIs 254
  - Without dependencies 242
- Related CIs with Costs Allocated table 187
- Related configuration items
  - Change requests 246
- Related predefined tasks 353

Relating
- Change requests 243
- Change tasks 265
- Configuration items to alternate data sets 251
- Configuration items to change requests 247
- New change requests 242
- Predefined task groups to change requests 267, 353
- Predefined tasks to change requests 267, 353
- Unavailable CIs to change requests 253
- Relationship Attributes dialog box 350

Relationships
- About 220
- Additional functions 245, 248, 340
- Change requests 220
- Copying 240
- Copying to CI related to change 248
- Creating 222, 231
- Define incident related to change 250
- Defining 222, 231, 331
- Incident to change 250
- Modifying 248
- Quick actions 234, 324, 335
- Relating change to LDAP object 249
- Relating change to SLI 249
- Relating CIs to alternate data sets 251
- Removing 248
- Request types 222
- Unrelate incident from change 250
- Unrelating CI 249
- Viewing 241

Relationships for Configuration Item dialog box 248

Relationships tab 233, 247, 333, 335
- Change coordinator 222, 231
- Change form 234
- Release form 332
- Release coordinator 67
- Release coordinators
  - Cess approvals 339
  - Introduction 275
  - Resassigning release requests 319
  - Resassigning requests 318
  - Using Release form 105
  - Using Release Management Console 276, 376

Release form
- Relationships tab 332, 333
release management

Build milestone 309
Close Down milestone 312
Deployment milestone 311
Initiate milestone 277
introduction 59
notifications, receiving 443
planning milestone 305
release coordinator role 275
scenario 55, 71
Test milestone 310
user roles 61

Release Management

use cases 71
See also Release Management Console

Release Management Console

about 100, 276, 376
tooltip data 91

Release Management KPI flashboards

active variables 451

release managers

approvals 446
managing SLM targets 445

Release Request form views, described 65

release requests

approvals 446
approvals process 146, 339
approving 339, 447
assigning, about 316
assigning, automatically 318
assigning, manually 322
assignment notification 321
available time segments, searching for 299
best practices 68
business justification 286, 398
completing 312
controlled environment, building 309
creating 277, 282
financial information 337
lifecycle 60
manifests 323
manifests, creating 288
milestones 60
modifying 304
monitoring 314
pending approvals 446
planning 305
progress 314
reassigning 318, 319
recording work information 301, 302
rejecting 339, 447
relationship types 333
relationships 330
Release Management Console and 100
resolving 312
rolling out 311, 312
rollup costs 337
scheduling 296
status 314
templates 448, 450
testing 310
type 229

Release Template Selection dialog box 449, 450
release templates

using 279
Release Type 281, 284
Release Type field

Releases 281
relocating CIs 436, 462
Reminder Details dialog box 400
reminders

about 398
create 398
deleting 400
modifying 400
Reminders link on Change form 96, 108
viewing 400
Reminders dialog box 400
reports
  about 411
generating 412
generating in change console 88
generating with advanced qualifications 415
generating with qualifications 413
generating without qualifications 412
predefined 416, 444
View Risk 143
Request for Authorization state 483
Request for Change state 483
request masters
  Command Event Master permission 477
defined 472
request types in relationships 222
Requested Start Date 151
Requester console
  Command Event Master permissions 477
  functions 466
  registered user permissions 472
  request master permissions 472
  unknown user permissions 472
Requester Contacted icon 125
requester records
  about 396
  creating 397
Requester tab
  activities 327
  Change form 124
requesters
  approval 355
  role 471
  See also requester records
resubmit change requests
  rejected 367
retrying events in order, best practice 479
Review approval phase 483
RFC Date 152
Risk Info icon 121
risks
  analysis 140
  assessment 140
  computing levels of 142
  levels, computing 140, 142
  Risk Level field (changes) 121
  Risk Level field (releases) 281, 285
  View Risk report 143
ROI flashboards 425
  active variables 428
roles
  application administrator 42
  approver 40, 355
  Broadcast Submitter 404
  change coordinator 37
  change implementer 40
  change manager 37, 111, 275, 375
  company executive 42
  ITSM 38, 40, 62
  Release Coordinator 67
  requester 471
  SMPM 43
  task implementer 38, 341
roles, Release Manager 68
rollback change request 210
rollback change requests 156
rollup in release requests 285

S
sample business model 47
scenarios 50, 71
Schedule assist
  search available times 170
Schedule Assist, using 170
Scheduled for Approval state 484, 485
Scheduled for Review state 484
Scheduled state 483, 485
Search Business Event/Location Definition form 159, 161, 297
Search Inventory Locations dialog box 437
Search Operational Categorization/Location Definition form 159, 161
Search Time Segment dialog box 163, 168
searching
  all records 409
  CIs 459
  inventory locations 461
  records 395
  time segments, available (change) 299
  time segments, available (release) 170
Select Template dialog box 267, 349
sending notifications 400, 443
Sequence field 128, 143
sequence numbers
  add to task, task groups 268
  adding 128
  adding to, change requests 243
  change request 143
Service CI type 123
Service field 123
Service field, behavior described 33, 66
service level targets... See SLM targets
service request details, viewing from Change Request form 479
service requests
  ad hoc requests 475
  creating 474
  events, retrying in order 479
  Service Request Wizard 474
  status 476
  See also Requester Console
service targets
  Change Management, viewing in 189
  change requests, creating for 192
  managing 189, 445
  related incident requests, viewing 189
  See also BMC SLM
setting
  change management view 392
  new request form options 390, 440
  preferences and options 389, 439
  release management view 442
  search request form options 390, 440
  view 392, 442
Simple Qualification dialog box, generating reports 414
SLIs.  See software library items
SMPM
  process overview of change management 89, 95, 107
  user roles 43
Software Library Item request type 230
Software Library Item Search dialog box 350
software library items
  relationships 230
  request type 221
Source list 132
Staged state 482
Staging Complete status reason 484
status
  Cancelled 483
  comparing change and task 262
  Completed 483, 485
  Completed (Final Review Complete) 485
  Completed (Final Review Required) 485
  Draft 482
  Implementation in Progress 485
  Planning in Progress 483, 484
  reason requirements for change requests 491
  Request for Authorization 483
  Request for Change 483
  Scheduled 483, 485
  Scheduled for Review 484
  Staged 482
  triggering notifications when changed 400, 443
  viewing in Change Management 189, 190
Status field 118, 278, 282
Status Flow tab 362
status gauge 190
status reasons
  Final Review Complete 485
  Final Review Required 485
  Staging Complete 484
status values
  change requests 490
  status values, selecting 469
Summary field
  Change form 120
  Release form 283
support groups 267
task groups 267
  See also groups
syntax statement conventions 19

tabs
  Approvers 339
  assignment 217
  Assignment 272, 328, 379
  Task form 344
  assignment, change form 157
  Broadcast Details 404
  Broadcast Search Criteria 403
  Change Location of the Requester 182
  CI Status Information 258
  Classification 140
  Customer, Qualification Builder in change requests 192
  Dates 151, 307, 311
  Financials 188
  Manifest 291
  Notification Audit 182
  Notifications 408
  Relationships 222, 231, 233, 234, 247, 332, 333, 335
  Requester 327
  SLM 189, 192, 445
  Status Flow 362
  Tasks 181, 260, 265–267, 384
  Work Info 269, 314, 381
targets, viewing SLM 189
Task form
  Assignment tab 270
  relating ad hoc tasks to change requests 266
task groups
creating work order 383
predefined 267, 353
predefined CCM 347
sequence numbers, assigning 268
support groups 267
viewing 265
See also groups
task implementers
about 341
accepting assignments 343
assignment notifications 343
responsibilities 341
tasks
handling 260
user role 38
using predefined CCM tasks 347
working with Change Management 38
task management system 495
installed with Change Management 261
integrated with Change Management 261
overview 261
tasks
about 260
accepting assignments 343
activities 383
ad hoc 265
adding work information 269
all task assignments 270
assignments 270
accepting 344
assignments notification 343
cancelling 271
closing 347
configuration management 495
copying 432
creating 265
creating work order 383
denying reassignment 272
deployment-based 496
financial information, adding 347
life cycle 499
manually tracking time 271
modifying 270, 346
monitoring 181
peer 268
planning time 270
policy-based 495
predefined 267, 347, 353
predefined CCM 347
reassigning 345
reviewing 500
sequence number assignments 268
status 262
time, automatically tracking 271
verification-based 496
viewing 181, 265
viewing assignments 346
Tasks tab 181, 260, 265-267, 384
Template field, behavior described 33, 66
templates
activity 450
change request 429
predefined task 267, 353
predefined task group 267, 353
release request 448
Test milestone in release management 310
Time Segment Analysis window 170
### Index

| A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z |
| time segments | additional functions | available | release | available (change) | blackout schedule, creating | CIs | configuration item | creating | registering | searching | selecting | server time and time zones |
| Timing Reason | TMS. | See task management system tracking | change request efforts | change request time | in effort log | efforts | task time manually | task time, manually | tracking automatically | change request time | task time | tracking manually | change request time | task time |
| User Defaults dialog box | user interfaces | standards for field labels |
| User roles | additional | change manager | change requests | release management | SMPM | task implementer | User View dialog box | users | registered | request master | unknown |
| V | Vendor Contact | vendor information | Vendor Ticket Information | verification-based tasks | View Access list | View Broadcasts dialog box | View Flow button | View Risk report | viewing | approval phases, default | assigned change requests | audit logs from Change form | business events in Change Calendar | Change Calendar | change request progress | change request relationships | change task groups | change tasks | CI related to change requests | configuration items relationships | impacted areas from Change form | incident requests related to service targets | inventory locations | non-approver notifications | preferences and options | profile | progress of release requests | release request approvals | reminders | service targets in Change Management | SLM targets | viewing change requests | in Change Calendar |
| W | web reports |
wizards
   Process Flow Status bar 29
   Service Request 474
Work Info
   edit 302
   editing 131
   view 302
   viewing 131
Work Info dialog box 352

Work Info tab 381
   adding information 269
   progress of change request, monitoring 314
Work Info Type list 131, 132, 302
work orders
   BMC Remedy Alert 380
   creating task groups 383
   notification of assignments 380